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About this Document

Installation by an IBM FileNet Certified Professional (FCP) recommended. For more information on the 
FCP program, contact your IBM service representative.

Every effort has been made to provide you with complete installation instructions. If information becomes 
available after the documentation release from which you accessed this guide, we will provide an updated 
version of the guide on the Information Management support page (www.ibm.com/software/data/
support/). As a general rule, you should refer to the web site to obtain the current version of this guide.

A new version of the guide will be distributed as of the release of any core IBM FileNet P8 Platform 
component (Content Engine, Process Engine, or Application Engine). Component fix packs are often 
released independently of one another and can also require updates of the guide. Check the edition 
number applied to this common guide to determine the product versions covered.

Send your comments by e-mail to comments@us.ibm.com. Be sure to include the name of the product, the 
version number of the product, and the name and part number of the book (if applicable). If you are 
commenting on specific text, include the location of the text (for example, a chapter and section title, a table 
number, a page number, or a help topic title).

NOTES

• This guide provides instructions for installing and/or upgrading the core IBM FileNet P8 Platform 
components to their current released version. Be aware that each release of an IBM FileNet P8 
component or expansion product can have multiple software updates available in the form of service 
packs, fix packs, and/or interim fixes, each with potentially different dependencies and installation 
requirements. Therefore, before you attempt to install or upgrade IBM FileNet P8 Platform, review the 
list of releases and their associated dependencies in the IBM FileNet Compatability Matrix on the 
Information Management support page (www.ibm.com/software/data/support/). See “Access IBM 
FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

• If you do not intend to upgrade all IBM FileNet P8 components and expansion products to the most 
current released version, review the dependencies for the version(s) you intend to install. These 
dependencies will be contained in a document and location on the IBM Customer Service and Support 
web site for FileNet customers (equivalent to those noted in the previous bullet).

• This guide assumes that to perform your installations you are using the 4.0.0b update of the generally 
released Content Engine software, which among other things adds support for JBoss as an application 
server.

• This guide contains links to the IBM FileNet P8 Platform online help system, where you will find 
important additional information that can help you make decisions about your installation. The ideal 
way to use this guide is as an online PDF installed within the help system. To take advantage of these 
links while using this guide, perform the documentation install tasks () before beginning your full IBM 
FileNet P8 Platform installation.

http://www.ibm.com/software/data/support/
http://www.ibm.com/software/data/support/
http://www.ibm.com/software/data/support/
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Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs

To access documentation for IBM FileNet products

1. Access the Product Documentation for FileNet P8 Platform support page
(http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422). 

2. Select the appropriate product link.

To access compatibility matrices and fix packs for IBM FileNet products

1. Access the Fix Packs for FileNet P8 Platform support page
(http://www-1.ibm.com/support/docview.wss?&uid=swg27010146) 

2. From the Fix Pack page:

• To access the compatibility matrix, under FileNet P8 Compatibility Matrices, click Matrix.

• To access the fix pack you need, under a specific product name, click the release number.

http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422
http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422
http://www-1.ibm.com/support/docview.wss?&uid=swg27010146
http://www-1.ibm.com/support/docview.wss?&uid=swg27010146


Typographical Conventions

This document uses the conventions in the following table to distinguish elements of text.

NOTE  Some path names in this document that are identical (except for the directory-separator character) 
on both UNIX® and Windows® platforms are specified in UNIX syntax only (that is, with forward-slash 
directory separators).

WARNING  This document contains examples of text to be typed on a command line. Be sure to manually 
type the command, rather than copying and pasting it from this document. Otherwise, your command line 
may contain unrecognized characters and will not execute properly.

Convention Usage

UPPERCASE Environment variables, status codes, utility names.

Bold Paths and file names, program names, clickable user-interface 
elements (such as buttons), and selected terms such as command 
parameters or environment variables that require emphasis.

Italic User-supplied variables and new terms introduced in text.

<italic> User-supplied variables that replace everything between and 
including the angle bracket delimiters (< and >).

Monospace Code samples, examples, display text, and error messages.



Revision Log

The following table identifies changes made to this document since the IBM FileNet P8 3.5.0 release.

Date Revision

03/09 Updates for documentation defects.

09/08 Updates for documentation defects.

07/08 The topic “Configure and start Application Engine (WebSphere)” on page 213 was 
updated to add procedures for WebSphere 6.1.

Added various defect-related updates for accuracy and usability improvements.

Added new cover page with IBM part numbers.

The topic “About this Document” on page 8 was updated with information on accessing 
IBM FileNet updates and documentation on the IBM web site.

08/07
3.5.3

The topics “Install Oracle Server for IBM FileNet P8” on page 63, “Install Oracle Client 
for IBM FileNet P8” on page 74, and “IBM FileNet P8 Database Character Sets” on 
page 372 were updated to add information for Oracle 10g.

06/07 
3.5.2d

In the topic “Install Oracle Server for IBM FileNet P8” on page 63, a note has been 
added that NLS_LENGTH_SEMANTICS should not be set at the Oracle system level.

In the topics “Install Content Engine (Typical)” on page 112 and “Install Content Engine 
(Custom)” on page 127, a note has been added to the “Deployment and authentication 
notes” section that explains which users require write access to the temp directory for 
logging.

In the Content Engine section of the topic “Gather Pre-upgrade Information” on 
page 301, provided clarification for the statement about running the Stored Search and 
Search Template Upgrade Tool for upgrades originating with IBM FileNet P8 2.0.1.



12/06 
3.5.2c

An item in “Installation Planning Considerations” on page 20 has been changed to 
remove an incorrect statement that Office Application Integration honors Workplace 
sign-ins.

In the topic “Install Content Engine (Custom)” on page 127, an incorrect registry name 
for verifying CFS-IS installation has been corrected.

In the topic “Install Process Engine (AIX)” on page 179, typographical errors in the file 
settings and commands have been corrected.

The topic “Configure Content Engine and SQL Servers for Windows 2003” on page 46 
has been updated with a Caution for SP1 and R2 users; they should consult the 
appendix “Configure an IBM FileNet P8 environment for Windows Server 2003 SP1 or 
R2” on page 375 instead.

The topic “Configure the Process Engine LDAP Connection” on page 204 has been 
updated to include alternative queries for performing partial instead of complete 
exports.

The topic “Verify Current Release Level” on page 312 has been changed to clarify what 
information to use from the Version Tools Technical Notice.

In the topic “Install Oracle Client for IBM FileNet P8” on page 74, a note has been 
added that the DBA must change init.ora to allow remote SYS login.

Date Revision



08/06

(3.5.2b)

The topics that cover documentation installs for all applicable platforms have been 
changed to include more details for Windows installation of the functional expansion 
documentation.

The topics that cover Application Engine uninstall for all applicable platforms have been 
changed to inform users of the Windows Task Manager shutdown screen in the AE 
Uninstall wizard.

The topic “Enable Application Engine to use ISRA” on page 287 has been change to 
include a Warning against changing the JNDI name variable during an ISRA 
installation.

The topic “Configure an IBM FileNet P8 environment for Windows Server 2003 SP1 or 
R2” on page 375 has been changed to include the R2 release.

A note about not changing the cookie name has been added to all topics that deal with 
configuring Application Engine by platform.

The topic “Set up Application Engine SSL security” on page 253 has been changed to 

include a step for updating the base URL, as well as a note about using JavaTM applets.

The topic “Install Application Engine” on page 205 and “Deploy multiple Application 
Engine instances” on page 284 were changed to clarify requirements for deployment of 
multiple instances of Application Engine on a single application server.

The topic “Install File Tracker” on page 278 was changed to remove the change option 
from the uninstall procedure.

The topics “Create groups and users required for IBM FileNet P8 installation” on 
page 49 and “Start Process Routers” on page 242 were changed to include the 
permissions required to start the router.

The topic “Install Application Engine” on page 205 was changed to include a reference 
to the Troubleshooting Guide for error and action details.

The topic “Install File Tracker” on page 278 was changed to clarify the note about 
installation dependencies on Application Integration.

The topic “Configure and start Application Engine (JBoss/Tomcat)” on page 223 was 
changed to correct a line in the jboss-app.xml file example.

The topic “Installation Planning Considerations” on page 20 has been changed to 
remove the statement that Content Engine and Process Engine must use the same 
database.

4/06
(3.5.2a)

The topic “Configure and start Application Engine (JBoss/Tomcat)” on page 223 was 
modified to update the instructions for disabling JBoss logging.

The new topic “Install File Tracker” on page 278 was added to provide instructions for 
installing the optional Workplace File Tracker application.

Removed or modified several references throughout this guide to Content Engine 
Administrators, as this is no longer a hard-coded group name.

Date Revision



12/05 The topic “Upgrade Overview” on page 297 was modified to indicate that the Web 
Content Manager (WCM), Email Manager (Capture), and IBM FileNet P8 Portlets 
functional expansions have been released for this version of IBM FileNet P8 Platform.

The topics “Install Process Engine (Solaris)” on page 167 and “Upgrade Process 
Engine (Unix)” on page 322 were modified regarding the instructions for enabling the 
anon ports. The maximum tcp_smallest_anon_port has been changed to 32768 to 
support extensible authentication.

12/05
(3.5.2)

The “Index” on page 391 was enhanced.

11/05
(3.5.1a)

The topic “Install Process Engine (AIX)” on page 179 was modified to reflect support for 
AIX 5.3.

The topics Task 7a on page 81 through Task 7f on page 107 were added to provide 
instructions for installing or (if necessary) performing search-related reindexing of the 
IBM FileNet P8 Platform documentation on supported application servers.

The topics “Installation Planning Considerations” on page 20, “Sample Configurations” 
on page 32, “Install DB2 server for Content Engine and Process Engine” on page 68, 
and “Install DB2 Client for Content Engine and Process Engine” on page 77 to remove 
information specific to support for remote DB2 database on AIX only, as support for 
DB2 on additional platforms is being introduced.   

10/05 The topic “Install Microsoft SQL Server for IBM FileNet P8” on page 58 was modified to 
add information to cover WCM requirements.  Also removed the directive to verify 
Mixed Mode authentication, because Mixed Mode is not a requirement in all cases. 
Rules for choosing authentication mode  were moved to the actual step, from the notes 
at the start of the task.

The topic “Install MS SQL Server Client software for IBM FileNet P8” on page 72 was 
updated to remove duplicate directives to test the connection to the remote SQL Server 
database.

The topic “Configure the Process Engine LDAP Connection” on page 204 was modified  
to remove information saying fnsw and fnadmin are automatically created by Process 
Engine installer on UNIX platforms.  Also added a note that the User and Group Base 
value must match what was specified as the DefaultRealm during installation and 
configuration of Content Engine.

The topic “Start the Pooled Process Manager (PPM)” on page 203 was updated to 
reflect the need to logon on as a member of the fnadmin group before trying to start the 
Task Manager.

The topic “Create groups and users required for IBM FileNet P8 installation” on page 49 
was updated to include DB2 users and groups.

The topic “Initialize the isolated region” on page 244 was modified to call for starting a 
supported browser rather than specifying Internet Explorer only.
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09/23/05
(3.5.1)

Added references to instructions for installing the 3.5.x Service Pack, which are located 
in separate platform-specific readmes on the component Service Pack media: Content 
Engine Service Pack CD, Process Engine Service Pack CD, Application Engine Service 
Pack CD, and Rendition Engine Service Pack CD.

Installation and Upgrade procedures for Rendition Engine have been relocated to a 
separate guide: FileNet P8 Documentation > FileNet P8 System Installation > Rendition 
Engine Installation and Upgrade.

The topic “Deploy multiple Application Engine instances” on page 284 was added to 
define the procedure for deploying multiple instances of Workplace on a single 
Application Engine server.

The topic “Install Process Engine (HP-UX)” on page 191 was modified to provide new 
information on time zone settings for Site and User.

The topic “Configure and start Application Engine (Sun Java Application Server)” on 
page 231 was modified to include instructions on how to configure classloader settings. 
In addition, the required code change in the server.policy file was updated.

The topic “IBM FileNet P8 Port Numbers” on page 364 was modified to include the port 
number used by Process Engine for Extensible Authentication communications.

The appendix topic “Configure an IBM FileNet P8 environment for Windows Server 
2003 SP1 or R2” on page 375 was added to address installation and configuration 
requirements when running the IBM FileNet P8 Platform on Windows 2003 Service 
Pack 1.

09/01/05
(3.5.0c)

The topic “Installation Planning Considerations” on page 20 was modified to provide a 
link to the IBM FileNet P8 Platform Performance Tuning Guide.

The topics “Install Process Engine (AIX)” on page 179, “Install Process Engine (HP-
UX)” on page 191, and “Install Process Engine (Solaris)” on page 167 were modified to 
clarify how to set and verify HP, AIX, and Solaris environment variables during Process 
Engine installation

The topic “Upgrade Planning Considerations” on page 297 was modified to address the 
need to delete and re-create Verity indexes after upgrading Content Engine to IBM 
FileNet P8 3.0.0.

08/12/05
(3.5.0b)

The topic “Installation Planning Considerations” on page 20 was modified to indicate 
that you must install Process Engine on Windows 2003 before installing SP1 and there 
is no longer any restriction regarding installing CFS-IS on Windows 2003 only.

The topic “Install FileNet P8 Platform documentation” on page 57 was modified to 
include information regarding reindexing multiple expansions.

The topic “Configure the Content Engine environment” on page 145 was modified to 
indicate that file store permissions for Apache should be at the share level, not the 
folder level.

Beginning with the topic “Install Process Engine (Windows)” on page 155, the Process 
Engine installation topics were modified to update the installation directory information 
to match the actual media layout location of setup.
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The Application Engine installation topics were restructured beginning with the topic 
“Install Application Engine” on page 205. In addition, this topic was modified to improve 
the Solaris installation instructions, including an updated path to the Solaris installer 
files: /cdrom/p8ae35sol/.

A new topic “Configure and start Application Engine (Oracle Application Server)” on 
page 228 was added to discuss support for the Oracle Application Server.

A new topic “Configure and start Application Engine (Sun Java Application Server)” on 

page 231 was introduced to outline support for the Sun JavaTM Application Server.

The topic “Set up Application Engine SSL security” on page 253 was modified 
regarding use of the UTCryptoKeyFile.properties file.

A new topic “Remove the IBM FileNet P8 Platform documentation” on page 347 was 
added to provide instructions for removing the installation of the IBM FileNet P8 
Platform documentation.

The topic “Upgrade Content Engine” on page 315 was modified to provide a manual 
workaround for upgrading the GCD from IBM FileNet P8 version 3.0.0 to 3.5.0.

The upgrade procedure steps in the topic “Upgrade Application Engine” on page 328 
were modified to indicate that you must restart AE if you modify the web.xml and 
actions.xml files.

The Application Engine port numbers in the topic “IBM FileNet P8 Port Numbers” on 
page 364 were updated.

06/10/05
(3.5.0a)

The topic “Installation Planning Considerations” on page 20 was modified to remove the 
restriction against installing CFS-IS on Windows Server 2003 from a network drive.

The topic “Database Considerations” on page 29 was modified to include information 
related to collocation of a Rendition Engine database with Content Engine and Process 
Engine databases.

The topics “Install Oracle Server for IBM FileNet P8” on page 63 and “Install Oracle 
Client for IBM FileNet P8” on page 74 were modified with updated Rendition Engine 
database requirements, as well as to indicate that IBM FileNet P8 supports the Oracle 
Advanced Security functionality of secure data transfer across network protocol 
boundaries for Content Engine (tested) and Process Engine (untested).

The topic “Install Oracle Server for IBM FileNet P8” on page 63 was modified to indicate 
that the Transaction Processing database type is not required for Process Engine when 
creating an Oracle database. In addition, Oracle Windows Interfaces is required for 
Oracle Client installations only on Windows machines that access CE-dedicated Oracle 
databases.

The topics “Install Content Engine (Typical)” on page 112 and “Install Content Engine 
(Custom)” on page 127 were modified to indicate that the path to the CE installation 
logs is a default path.
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The topic “Configure the Content Engine environment” on page 145 was modified to 
indicate that Content Engine cannot access a DB2 database if IBM DB2 Universal 
Database Version 8.2 FixPak 2 (equivalent to IBM DB2 Universal Database Version 8.1 
FixPak 9) is installed.

The topic “Create an object store and verify the Content Engine installation” on 
page 147 was modified due to the fact that installing Content Engine on a Windows 
domain controller is not supported. In addition, changes were also made regarding 
possible consequences of not having File Store Service on a machine where a remote 
file store is installed.

The topic “Install Process Engine (Windows)” on page 155 was modified to reflect the 
need for a non-numeric character as the first character in the f_maint password.

The topic “Perform additional configuration tasks” on page 256 was modified to include 
information regarding CFS-IS configuration tasks.

The topic “Install standalone IBM FileNet Enterprise Manager system” on page 263 
was modified to indicate that Terminal Services must not be installed on a machine 
where Process Engine is installed, as well as to document the Custom Setup screen in 
the Content Engine Setup wizard.

The topic “Configure remote Content Engine file stores” on page 267 was modified to 
indicate that file stores are allowed on DFS as well as NTFS file systems.

The topic “Upgrade Content Engine” on page 315 was modified to include a step to 
copy a Windows registry key so that the Process Engine Router will be re-created, to 
include a step to stop the Apache services monitor, and to provide a warning to ensure 
that all transactions have been processed before starting Content Engine upgrade.

Date Revision
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Installation Planning and Procedures

This installation section contains the following major topics:

• “Plan the Installation” on page 19

• “Prerequisite Tasks” on page 36

• “Installation Tasks” on page 80

• “Configuration/Startup Tasks” on page 237

• “Optional Installation Tasks” on page 258
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Plan the Installation

Before you begin to install the IBM FileNet P8 Platform:

• Retrieve updates to IBM FileNet P8 documentation and software from the IBM support page, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

• Review the “Installation Planning Considerations” on page 20 for a list of auxiliary documentation you 
should gather and a list of tasks you should perform before installing IBM FileNet P8 Platform software.

• Review the “Sample Configurations” on page 32.

• Read “Prerequisite Tasks” on page 36, “Installation Tasks” on page 80, “Configuration/Startup Tasks” 
on page 237, and “Optional Installation Tasks” on page 258 to become familiar with the tasks you will 
perform when setting up your IBM FileNet P8 Platform software.

NOTE  IBM recommends you follow the planning, installation, and configuration tasks in the order 
presented in these topics. If you do otherwise, or you install IBM FileNet P8 components on machines 
containing components for existing IBM FileNet P8 systems, you may encounter unforeseen problems or 
be required to perform additional setup steps. See the IBM FileNet P8 Platform Troubleshooting Guide on 
the IBM support page for details. See “Access IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs” on page 9.

http://www.css.filenet.com/docsvs/doccontent.asp?DocID=041120010
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Installation Planning Considerations

This section lists details that will help you prepare your environment for the installation of an IBM FileNet 
P8 system. In many cases, the items you see listed will be links to more detailed information, which will 
help you plan a system rollout. Please review this information thoroughly before you start to set up IBM 
FileNet P8 components or required third-party software.

General Requirements for all IBM FileNet P8 Systems

Whether you are installing IBM FileNet P8 Platform for the first time or upgrading from the 3.0.0 release, 
IBM FileNet P8 3.5.0 must first be installed and configured before applying the 3.5.x Service Pack. Follow 
the installation or upgrade tasks provided in this manual to either install a new 3.5.0 system, or upgrade an 
existing 3.0.0 system to 3.5.0. After your system is succesfully running 3.5.0, follow the procedures in 
“Apply Service Packs and patches for core components” on page 334 to apply the 3.5.x Service Packs.

• Gather auxiliary documentation.

NOTE To download this and other IBM FileNet product documentation from the IBM web site, 
see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

– IBM FileNet P8 Hardware and Software Requirements. This document provides details for all 
FileNet P8 system components, as well as the minimum supported levels of third-party software 
components. The information throughout the FileNet P8 Platform Installation and Upgrade Guide 
assumes you have met all applicable requirements listed in that document. 

– FileNet P8 Platform user and group security help found at: FileNet P8 Administration > Enter-
prise-wide Administration > Security > Users and groups. This help topic provides a complete 
list of the user and group roles, accounts, and responsibilities required to install, configure, and 
maintain a FileNet P8 system.

– IBM FileNet P8 Platform Security Questionnaire. This document provides a list of security-related 
questions that, when answered by your site, can provide valuable feedback to the FileNet 
Upgrade/Installation Assurance Team that will be helping you install and deploy your FileNet P8 
system.

– IBM FileNet P8 Platform Release Notes. This document provides details on new features, known 
issues, and resolved problems. 

– FileNet P8 Platform Shutdown and Startup help found at: FileNet P8 Administration > Enterprise-
wide Administration > Shutdown and Startup. This help topic describes how to shut down and 
restart FileNet P8 Platform components and some functional expansions. Manual, command line, 
and some sample batch file procedures are provided.

– Installing IBM FileNet P8 Platform in a Non-English Environment Technical Notice. This document 
will help you set up the product if your environment is not English-language based.

– IBM FileNet P8 Platform High Availability Technical Notice. This document provides details on how 
to set up your FileNet P8 system using clusters, farms, and other high-availability software and 
hardware. In so doing, the document also provides related disaster recovery information.

– IBM FileNet P8 Platform Deployment Guide. This document provides details on how to deploy a 
FileNet P8 system from a staging environment into a full production environment. 

– FileNet P8 Platform Troubleshooting Guide. This document provides troubleshooting information 
on all aspects of the product.
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– IBM FileNet P8 Platform Performance Tuning Guide. This document provides performance tuning 
information on all aspects of the product.

– IBM FileNet P8 Silent Installation Guide. This document provides details on how to do unattended 
installations of your FileNet P8 system.

– IBM FileNet P8 Platform Extensible Authentication Guide. This document provides instructions for 
supporting single sign-on (SSO) products from leading vendors including IBM, Netegrity, Oblix, 
RSA and others. The APIs enable FileNet partners and third-party developers to develop and sup-
port solutions for a broad range of SSO products.

– IBM FileNet P8 Rendition Engine Installation and Upgrade Guide. This document provides details 
on how to install and upgrade Rendition Engine and Publishing Plug-in components.

– For all optional components, see the IBM FileNet P8 3.5 version of the appropriate documentation, 
including: IBM FileNet P8 Content Federation Services for Image Services Guidelines, IBM FileNet 
P8 Process Analyzer Installation and Upgrade Guide, and IBM FileNet P8 Process Simulator 
Installation and Upgrade Guide.

• Consider the JavaTM requirements for the IBM FileNet P8 Documentation server. To enable the 
help Search functionality, you must install the IBM FileNet P8 Documentation from its CD onto a Java-
enabled application server (for example, any Java 2 Platform Enterprise Edition [J2EE] web application 
server supported by Application Engine).

Operating System Considerations

General

• Ensure hosts file contents. On each Windows-based FileNet P8 server, the Windows hosts file must 
contain the Windows server name and Internet Protocol (IP) address of all servers it will communicate 
with, including the remote database server, if applicable. The location of the hosts file depends on 
where the Windows software is installed. For Windows 2000, the file is in 
\winnt\system32\drivers\etc. For Windows 2003, the file is in \WINDOWS\system32\drivers\etc.

On each UNIX-based FileNet P8 server that does not use DNS (Domain Name Service) or NIS 
(Network Information Service), the /etc/hosts file must contain the name and Internet Protocol (IP) 
address of all servers it will communicate with, including the remote database server, if applicable.

Content Engine

Windows 2003

• Configure Microsoft® Distributed Transaction Coordinator (MSDTC) and COM+. To create object 
stores, you must manually configure MSDTC and COM+ on all servers running Content Engine and 
Microsoft SQL Server software. FileNet developed Content Engine using Microsoft COM+ technology. 
When a COM+ application requires a transaction to span multiple computers, using MSDTC makes 
the application more reliable by offering a unified mechanism. Content Engine, therefore, uses 
MSDTC to accomplish distributed transactions to achieve consistency, reliability and scalability. Refer 
to Windows Online Help on MSDTC and COM+, or refer to “Configure Content Engine and SQL 
Servers for Windows 2003” on page 46.

• Enable Microsoft Internet Information Services (IIS). If you plan to use the Content Engine WebDAV 
Provider, you must ensure that Microsoft Internet Information Services (IIS) software is enabled on all 
Content Engine servers. IIS is enabled by default when you install Windows 2000, but you must 
manually enable this service under Windows 2003.
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Firewall

• Ensure port availability. If you intend to move Content Engine into a DMZ outside your firewall, you 
need to open port 135 (used by DOM, RPC, DTC, etc.) for communication before starting the IBM 
FileNet P8 installation.

Process Engine

AIX

• Ensure minimum /tmp size. The /tmp directory must have 100MB free.

• Set Kernel. The Kernel must be set to 64-bit mode.

• Ensure minimum swap space. The swap space must be set to 1.5 - 2 times RAM. 

• Set Maximum Number of Processes allowed per user. The Maximum Number of Processes 
allowed per user must be set to at least 400.

• Set Maximum Kbytes of real memory allowed for MBUFS. The Maximum Kbytes of real memory 
allowed for MBUFS must be set to 0. Setting the MBUFS parameter to 0 causes the system to use the 
default amount of available memory. This default amount is approximately 1/8 to 1/4 the amount of real 
memory.

• Set Maximum Number of FIXED licenses (Num). The Maximum Number of FIXED licenses (Num) 
must be set to a minimum of16.

• Install required filesets. The following filesets must be installed and committed:

– bos.adt.libm

– bos.adt.lib

– bos.adt.base

– bos.perf.perfstat

– bos.perf.libperfstat

– bos.adt.debug

• Save existing .profile and .cshrc files. Prior to installing the Process Engine software, save the 
.profile and .cshrc files for the following users if they exist on the server:

– root

– oracle

– fnsw

Because Process Engine Setup modifies these files, saving them ahead of time will give you the option 
of restoring any customization that was in place prior to Process Engine installation. 

HP-UX

• Ensure minimum /tmp size. The /tmp directory must have 100MB free.

• Ensure minimum physical memory. The physical memory must be at least 512 MB. 

• Set Kernel. The Kernel must be set to 64-bit mode. See the topic “Install Process Engine (HP-UX)” on 
page 191 for a complete list of minimum Kernel values. 
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NOTE If you will be installing the 8.2 version of DB2 Client software, pay particular attention to the 
shmmax parameter. The minimum value documented for Process Engine may not be high enough to 
allow successful installation of the DB2 software. See the appropriate vendor documentation for the 
8.2 release for recommended kernel parameter settings.

• Ensure minimum swap space. The swap space must be set as follows:

– Two times RAM if RAM < 1GB

– 1.5 times RAM if RAM >= 1GB

• Save existing .profile and .cshrc files. Prior to installing the Process Engine software, save the 
.profile and .cshrc files for the following users if they exist on the server:

– root

– oracle

– fnsw

Because Process Engine Setup modifies these files, saving them ahead of time will give you the option 
of restoring any customization that was in place prior to Process Engine installation. 

Solaris

• Ensure minimum /tmp size. The /tmp directory must have 100MB free.

• Set Kernel. See the topic “Install Process Engine (Solaris)” on page 167 for a complete list of 
minimum Kernel values.

• Save existing .profile and .cshrc files. Prior to installing the Process Engine software, save the 
.profile and .cshrc files for the following users if they exist on the server:

– root

– oracle

– fnsw

Because Process Engine Setup modifies these files, saving them ahead of time will give you the option 
of restoring any customization that was in place prior to Process Engine installation. 

Windows 2000 and Windows 2003

• Ensure NTFS. Windows must be configured with NTFS.

• Install Process Engine before installing Windows Server 2003 Service Pack 1. If you will be 
installing SP1 for Windows 2003 server, you must install Process Engine 3.5.0 before installing the 
Microsoft service pack. 

Application Engine

• Ensure Linux® libraries. To install Application Engine, several legacy libraries are required. Add the 
compat-libstdc++-7.3-2.96.122.i386.RPM located on Disc 3 of the Red Hat AS 3.0 install media to your 
installation.

Network Considerations

• Ensure static IP addresses. Assign all IBM FileNet P8 servers a static IP address.
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• Ensure TCP/IP settings. Verify TCP/IP configuration settings on all UNIX and Windows servers and 
IBM FileNet Enterprise Manager clients.

• Ensure availability of required port numbers. Several port numbers are required by the various IBM 
FileNet P8 components. For a composite list, see “IBM FileNet P8 Port Numbers” on page 364.

Windows Domain Considerations

General

• Consider including all Windows-based IBM FileNet P8 servers in the Windows domain. In this 
regard:

– For a list of the components you can install only in a Windows domain, see the following topic 
“Content Engine” on page 24.

– For all other IBM FileNet P8 components on Windows servers, IBM recommends installation in the 
same Windows domain as Content Engine and Rendition Engine, if only to centralize your admin-
istrative tasks in the Active Directory environment. The associated primary DNS server address on 
each machine must point to the same DNS server as Content Engine and Rendition Engine. For 
more installation considerations related to Rendition Engine, see FileNet P8 Documentation > 
FileNet P8 System Installation > Rendition Engine Installation and Upgrade.

– You can use a single IBM FileNet Enterprise Manager instance to administer multiple object stores 
as long as they are in a single FileNet P8 domain (i.e., a “deployment” domain). You can do this by 
setting up Terminal Server (with Enterprise Manager installed) on a machine in the FileNet P8 
domain and running Enterprise Manager remotely, via Terminal Server Client, on a single 
machine. Do not install Terminal Services on any Process Engine machine.

• Be aware that IBM FileNet P8 3.5.x does not support multi-forest configurations.

Content Engine

• Ensure a Windows domain exists. You must have at least one Windows domain configured for your 
IBM FileNet P8 environment, regardless of your authentication provider (Windows Active Directory, 
Sun Java System Directory Server, or Novell eDirectory).   

• Ensure you have a Windows domain controller. If you have not done so already, run dcpromo on a 
designated Windows domain server to create and configure the Windows domain controller. The 
domain controller machine must have the following characteristics:

– Installed in Windows domain used for IBM FileNet P8 software.

– Configured as NTFS.

– Have a static IP address.

– Have the Content Engine primary DNS Server component installed and configured properly, 
including DNS forwarders if required (e.g., if the Primary DNS server, which is typically the domain 
controller, does not have all IP address information for all IBM FileNet P8 servers). In this regard, 
the Content Engine’s primary DNS TCP/IP setting must be the IP address of the DNS server hav-
ing IP information (in forward and reverse look-up zones) for all Content Engine servers, domain 
controllers in the Active Directory forest, and all Application Engine and Process Engine servers 
that may not be in the forest (i.e., those on UNIX servers).
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In IBM FileNet P8 production systems, be aware that if you install Content Engine on the domain 
controller machine, authentication/authorization performance may degrade if your authentication 
provider is Windows Active Directory.

• Be aware of the need to create a P8Apache user account. Apache requires the creation of a 
specific user account for Apache-based actions in applications such as IBM FileNet P8. See “Create 
groups and users required for IBM FileNet P8 installation” on page 49 for details.

• Determine what to install in the Windows domain. You must install the following software only on 
machines that are in the Windows domain:

– Content Engine (all components and services)

NOTES

• Before installing Content Engine on a machine, you must add the machine to the Windows 
domain.

• A standalone Process Engine server does not necessarily have to be a member of a Windows 
domain. By contrast, a server containing both Process Engine and Content Engine compo-
nents must be a member of a Windows domain.

– IBM FileNet Enterprise Manager

– Microsoft SQL Server

NOTE This SQL Server requirement applies only if you are using Windows authentication to the 
database. If instead you are using SQL Server authentication, you can install the database engine 
outside the Windows domain, or in a different Windows domain or forest.

– Rendition Engine (rendition servers and plug-ins)

• Be aware that you cannot rename Content Engine servers. Name your servers carefully. Once you 
install a Content Engine server component onto a server (Object Store Service, File Store Service, or 
Content Cache Service) and begin using your IBM FileNet P8 system, you cannot rename the server.

Security Authentication Considerations

General

• Extensible Authentication. IBM FileNet P8 3.5.1 Service Pack includes an API framework that 
provides the ability to configure Content Engine and Process Engine to redirect authentication 
requests to an external logon module that integrates with single sign-on (SSO) products from leading 
vendors including IBM, Netegrity, Oblix, RSA and others. The APIs will enable IBM FileNet partners 
and third-party developers to develop and support solutions for a broad range of SSO products. For 
complete instructions on configuring extensible authentication support for CE and PE, see IBM FileNet 
P8 Platform Extensible Authentication Guide on the IBM FileNet P8 Platform documentation server at 
FileNet P8 Documentation > FileNet P8 Administration > Enterprise-wide Administration > Security > 
Directory integration and authentication > FileNet P8 Platform Extensible Authentication Guide.

• Ensure you have a supported LDAP authentication provider. You must have one of the following 
directory services in place for authenticating your FileNet P8 users and groups:

– Microsoft Windows Active Directory

– Novell eDirectory

– Sun Java System Directory Server (formerly known as Sun ONE Directory Server)
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NOTE You must have Microsoft Windows Active Directory for use by Content Engine, even if Active 
Directory is not your directory service provider for Content Engine or any other IBM FileNet P8 
components.

• Check required user and group account privileges. For purposes of installing, configuring, and 
running the services for an IBM FileNet P8 system, you must use several user and group accounts with 
particular access privileges. For example:

– In some cases, you must use accounts that IBM FileNet software expects (e.g., the four-character 
fnsw local-machine user account that you must allow the Process Engine setup program to cre-
ate).

– In other cases, you can either use the default user and group names presented by the IBM FileNet 
P8 setup programs (e.g., Content Engine’s FNCE_<machinename> user account), or you can 
specify comparable accounts you want to use instead, based on your existing security policies and 
directory service accounts.

For a complete list of these required accounts and privileges, and the system-generated default 
names, see the help topic FileNet P8 Documentation > FileNet P8 Administration > Enterprise-wide 
Administration > Security > Users and groups.

• Be aware that logons to IBM FileNet P8 applications cannot share user credentials. The fact that 
you log on to IBM FileNet Enterprise Manager does not allow you to access Workplace without signing 
in. Note that some functional expansion add-ons that are Workplace integrated will support Workplace 
user tokens, and thus will not require a user to perform another sign-in to access Workplace 
functionality from the functional expansion application.

• For Content Engine, note the following:

– When you first run the Content Engine setup program in a Windows domain, you create a new 
FileNet P8 domain—an administrative entity, separate from a Windows domain, to manage Con-
tent Engine services. For each subsequent execution of the Content Engine setup program on a 
machine in the Windows domain, you can either join an existing FIleNet P8 domain or create 
another FileNet P8 domain.

– The Content Engine setup program requires at least one Windows domain user per FileNet P8 
domain to run Content Engine services and COM+ application. You can use the same user for all 
your servers in the domain, or you can have a unique user per Content Engine server. You may 
create that user yourself or allow the setup program to automatically create a default 
FNCE_<machinename> user and Content Engine Servers group. Any user account you create or 
designate, including the designated user for the WebDAV extension authentication to IIS, must be 
a member of the Active Directory domain in which Content Engine has been deployed.

– The Content Engine setup program prompts for the selection of at least one Lightweight Directory 
Access Protocol (LDAP) user/group account to be assigned administrative access to the Content 
Engine’s Global Configuration Data (GCD) and in turn the FileNet P8 domain. Thus, before you 
start to install Content Engine, you must create the initial user and group you want assigned 
Administrative access to the GCD. Alternatively, you can designate an existing Windows group 
account. Once the installation is complete, the users and groups assigned Administrative access 
to the GCD are displayed and modifiable from the Security page of the Enterprise Manager Root 
Domain property sheet. 

– If you are using Windows Active Directory for authentication, distribution groups are not supported 
when assigning rights for Object Store Administrators and Object Store Users. This is because 
Windows allows only security groups to be listed in Access Control Lists (ACLs) and does not 
allow distribution groups to be used for security purposes.
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• For Process Engine, note the following:

– The Process Engine server does not have to be joined to the Windows domain. It can remain 
stand-alone.

– When installing Process Engine, you must log on as the Administrator to the local machine. If the 
machine is joined to a domain, log on to the local machine and not the Windows domain.

• For Application Engine, note the following:

– At a minimum, the user who is installing Application Engine needs to fulfill the following:

• On UNIX systems, the user needs to have write access to the /bin directory and read, write, 
and execute access to the directory where you plan to install Application Engine. 

• On Windows systems, the user has to be a member of the local Administrators group or a user 
with equivalent permissions.

Microsoft Windows Active Directory

• Determine global setting requirements. For a complete list of global settings for this directory 
service, see the online help topic FileNet P8 Documentation > FileNet P8 Administration > Enterprise-
wide Administration > Security > Directory integration and authentication > Windows Active Directory.

• Be aware of the following user restrictions:

NOTE See “Configure for Windows Authentication” on page 38 for details on related Microsoft 
Windows Active Directory restrictions and requirements.

– Ensure that all users have Read access on the directory service. Note that this is likely the 
default setting. Access control settings in IBM FileNet P8 require that all users have Read access 
on the directory service. If you do not want to set Read access at the individual user level, you can 
establish this configuration by (1) setting up Anonymous Access privileges or (2) adding all users 
to an Authenticated Users group having Read access.

– Be aware of restrictions on using domain local groups. In mixed mode environments, domain 
local groups are not supported for securing IBM FileNet P8 objects unless Content Engine is 
installed on a domain controller, in which case authentication/authorization performance may 
degrade if your authentication provider is Windows Active Directory. In native mode, domain local 
groups are scoped to the domain where they were created. As such, a domain local group can be 
used to secure an IBM FileNet P8 object only if is created in the same Windows domain where 
IBM FileNet P8 is installed.

Novell eDirectory

• Determine global setting requirements. For a complete list of global settings for this directory 
service, see the online help topic FileNet P8 Documentation > FileNet P8 Administration > Enterprise-
wide Administration > Security > Directory integration and authentication > Novell eDirectory.

• Be aware of the following user restrictions:

NOTE See “Configure Authentication under Novell eDirectory” on page 44 for details on related Novell 
eDirectory restrictions and requirements.

– IBM FileNet P8 does not support global referrals. This restriction is in place because Novell 
eDirectory does not provide a referral error to chase for LDAP binds.

– Ensure that all users have Browse access on the directory service. Access control settings in 
IBM FileNet P8 require that all users have Browse access on the directory service. If you do not 
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want to set Browse access at the individual user level, IBM recommends you establish a Public 
trustee for the realm.

– Be aware that IBM FileNet P8 supports cross-realm group memberships. This feature means 
that IBM FileNet P8 supports a configuration in which groups are in one realm while some or all of 
its users are in another.

Sun Java System Directory Server

• Determine global setting requirements. For a complete list of global settings for this directory 
service, see the online help topic FileNet P8 Documentation > FileNet P8 Administration > Enterprise-
wide Administration > Security > Directory integration and authentication > Sun Java System Directory 
Server.

• Be aware of the following user restrictions:

NOTE See “Configure Authentication under Sun Java System Directory Server” on page 40 for details 
on related Sun Java System Directory Server restrictions and requirements.

– Ensure that all users have Read access on the directory service. Access control settings in 
IBM FileNet P8 require that all users have Read access on the directory service. If you do not want 
to set Read access at the individual user level, you can establish this configuration by (1) setting 
up Anonymous Access privileges or (2) adding all users to an Authenticated Users group having 
Read access. To support referrals and chaining, you will need to set up Anonymous Access.

• Ensure the following configuration settings:

– If one-way SSL is enabled, make sure that the Fully Qualified domain name of the Sun Java Sys-
tem Directory Server was used to request the certificate.

• Be aware of the following user restrictions:

– If multiple users within a realm have the same UID value, these users cannot log on via IBM 
FileNet P8 application sign in screens using their short name (uid). They must use their fully quali-
fied distinguished name. 

For example, consider two separate users in two different Organizational Units (OUs). 

uid=jdoe,ou=Sales,dc=filenet,dc=com 

uid=jdoe,ou=Marketing,dc=filenet,dc=com 

In this case neither user can log on with the short name (uid) of jdoe. Each user must use his fully 
qualified name. For example, jdoe in Marketing must enter all of the information necessary to 
create the fully qualified name uid=jdoe,ou=Marketing,dc=filenet,dc=com. (If a custom logon 
application is used, some of this information can be defaulted or hidden from the user.) 

– Users cannot have a blank password. If a user has a blank password, an error displays when try-
ing to log on (e.g., to Workplace or Enterprise Manager) or when trying to configure the Process 
Engine LDAP connection.

– User authentication expects either UID or CN as the primary attribute in a user DN. For example:

– uid=jdoe,ou=Engineering,dc=filenet,dc=com, or cn=john doe,ou=Engineering,dc=filenet,dc=com

– Be aware that FileNet P8 does not support Dynamic Groups. See FileNet P8 Documentation > 
FileNet P8 Administration > Security > Enterprise-wide Administration > Directory integration and 
authentication > Sun Java System Directory Server for related details and restrictions.
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Database Considerations

All platforms

• Determine your local vs. remote database engine preference. The database engine is local if it is 
installed on a server where you will also be installing Content Engine, Process Engine and/or 
Rendition Engine software. The database is remote if it is on a server where no Content Engine, 
Process Engine or Rendition Engine software is installed. The choice is yours with the exception of 
DB2, which must be remote from both Content Engine and Process Engine. An Oracle database must 
also be remote if it is installed on a Linux server.

• Determine what type(s) of database engine you want to use. IBM FileNet P8 components requiring 
databases support MS SQL Server, Oracle and DB2.

• Determine your NLS and character-set requirements. See “IBM FileNet P8 Database Character 
Sets” on page 372 for information.

Microsoft SQL Server

• Determine whether you want to use a dedicated or shared database. In this regard:

– Content Engine, Process Engine, and Rendition Engine can share a database engine, or they can 
each have a dedicated database engine.  The Process Analyzer functional expansion must have 
its own database engine.

– Content Engine, Process Engine, and Rendition Engine components can share an MS SQL 
Server instance or they can each have a dedicated instance. You can use the default instance or a 
named instance of your choosing.

– Content Engine, Process Engine, and Rendition Engine must each have their own databases. 

– Each Process Engine server must have a dedicated instance and database.

– An MS SQL Server database name cannot have a numeric value as the first character.

• Verify that a SQL Login exists for Rendition Engine purposes. For detailed information regarding 
the SQL Login and installation of Rendition Engine, see  FileNet P8 Documentation > FileNet P8 
System Installation > Rendition Engine Installation and Upgrade.

• Verify that a SQL Login exists for Content Engine purposes. Under MS SQL Server, you must 
ensure that a SQL Login account exists before you create your first Content Engine object store. For 
this purpose, you can create a specific user with access only to the object store database. Initially that 
user must have the create-database privilege. For Windows-integrated authentication, create the SQL 
Login so that it is associated with the Windows group used during Content Engine installation (e.g., 
Content Engine Servers group or its equivalent). If you are using SQL Authentication instead, you 
can use any database user. In either case, you must grant the account the following roles: 

– System Administrators 

– Security Administrators 

– Database Creators 

NOTE For Process Engine, the setup program creates the required PE database users.
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Oracle

General

• Determine whether you want to use a dedicated or shared database. In this regard:

– Content Engine, Process Engine, and Rendition Engine can share a database engine, or they can 
each have a dedicated (i.e., unique) database engine.

– Content Engine, Process Engine, and Rendition Engine can each have a dedicated Oracle data-
base instance, or they can share a database instance with one another or with non-FileNet appli-
cations.

– Each Process Engine server must have a dedicated instance and database.

– Content Engine, Process Engine, and Rendition Engine must each have their own tablespaces.

NOTE For detailed information regarding installation of Rendition Engine, see  FileNet P8 
Documentation > FileNet P8 System Installation > Rendition Engine Installation and Upgrade.

• Plan to use locally managed tablespaces. For performance reasons, IBM recommends that you 
create locally managed, rather than dictionary managed, tablespaces for Process Engine and Content 
Engine. (The tablespaces you create via Oracle Enterprise Manager are locally managed by default.)

• Be aware of database client software requirements. For both Content Engine and Process Engine, 
if the database is remote, you must install database client software on the Content Engine and 
Process Engine server.

Content Engine

• Microsoft Transaction Server (MTS) requirements. If Microsoft Transaction Server is not already 
installed, then:

– The Oracle Universal Installer will prompt you to install MTS after the database engine installation 
completes.

– On any machine where you will run Content Engine software against Oracle, you must install Ora-
cle Services for Microsoft Transaction Server (Oracle MTS Recovery Service) as part of the Ora-
cle Client installation.

Process Engine 

• Oracle sys password required. Under Oracle, the Process Engine Setup program prompts for the 
Oracle sys password near the beginning and the end of the installation. The password is required to 
run various SQL scripts that:

– Create an Oracle database account for FileNet P8 use.

– Create a number of stored procedures.

– Grant access levels to the default tablespace and temporary tablespace specified earlier in Pro-
cess Engine Setup.

Process Engine Setup will complete only if all these scripts run successfully. See “Process Engine 
SQL Scripts (Oracle databases only)” on page 369 for details about these scripts.
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DB2

General

• DB2 server must be remote. The DB2 database server must be remote from both Content Engine 
and Process Engine. See the IBM FileNet P8 Hardware and Software Requirements document for 
specifics on supported operating systems.

• DB2 server instances must be 64-bit. Instances created on the remote database server must be 64-
bit.

• DB2 client instances must be 32-bit. Instances created on the Process Engine and Content Engine 
servers must be 32-bit.

• Determine whether you want to use a dedicated or shared database. In this regard:

– Content Engine and Process Engine can share a database engine, or they can each have a dedi-
cated (i.e., unique) database engine.

– Content Engine and Process Engine can each have a dedicated DB2 instance, or they can share 
an instance with one another or with non-FileNet applications.

– Each Process Engine server must have a dedicated instance and database.

– Each Content Engine and Process Engine must have their own databases and tablespaces. 

• Plan to use DMS for tablespaces. For performance reasons, IBM recommends that you create 
database managed user and user temp tablespaces rather than system managed tablespaces for 
Process Engine and Content Engine. 

• Be aware of database client software requirements. For both Content Engine and Process Engine, 
if the database is remote, you must install database client software on the Content Engine and 
Process Engine server.

• Use DB2 default collation. For both Content Engine and Process Engine, use the default collation 
setting.

• Predefine several operating system users and groups. For Process Engine, an instance owner 
and fenced user, and groups must be created. Process Engine also requires two specific users be 
created, named f_sw and f_maint.For Content Engine, there are no specific users or groups to be 
created, but an operating system user must be identified for access to the Content Engine database. 
This could be an existing user. Database permissions will need to be granted to this user. See “Install 
DB2 server for Content Engine and Process Engine” on page 68 for details. 

• IBM recommends SERVER authentication. SERVER_ENCRYPT and CLIENT authentication are 
also supported.

• Be aware of recommended pagesizes. IBM recommends 8KB minimum pagesizes for Process 
Engine databases and requires 32KB minimum pagesizes for Content Engine databases.
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Sample Configurations

This topic shows you some simple examples of how to distribute IBM FileNet P8 Platform components 
across a variety of machines. Each example represents a minimum recommended configuration. The 
configurations include the major IBM FileNet P8 Platform components, both those that are core required 
components and those that are functional expansion add-ons.

This topic includes the following sample configurations:

• “Baseline Configuration” on page 32

• “Baseline Configuration With Optional Components” on page 33

• “Developer Configuration” on page 34

• “Demo Configuration” on page 34

In all the sample configurations, note that:

• None of the samples shows a database engine, but at least one is required. You can collocate either 
Microsoft SQL Server or Oracle database engines with IBM FileNet P8 Platform components on any of 
the servers shown, or you can install them on separate database servers. A DB2 database engine 
must be remote from Content and Process Engines. An Oracle database engine running on a Linux 
machine must be remote from all IBM FileNet P8 components.

• None of the samples shows the required MS Windows Active Directory domain controller. You can use 
Active Directory as your authentication provider or, optionally, use another LDAP directory/
authentication service. You can collocate other IBM FileNet P8 components with the domain controller 
and/or with whatever LDAP service you use.

• You can scale out the components, but the following graphics do not attempt to show this.

• To administer Application Engine, you can run IBM FileNet P8 Workplace clients either from the 
computers shown or from one or more browser clients.

• You can also run Workplace as a user client to create and access stored content and processes. 
Optionally, you can configure these clients to integrate with Microsoft Outlook and Office applications, 
or to work in conjunction with IBM FileNet eForms, IBM FileNet Web Content Manager (WCM), IBM 
FileNet P8 Portlets (e.g., for BEA WebLogic or IBM WebSphere), or IBM FileNet Records Manager, as 
they come available on a given release. You can also use WebDAV clients.

• If you want to apply business rules to Process Designer workflows, you can install the optional ILOG 
JRules which is not shown in the samples.

• Optional components not shown in the samples include: Records Manager, IBM FileNet P8 Portlets, 
Web Content Manager, Team Collaboration Manager, and Image Services Resource Adapter (ISRA).

Baseline Configuration

This configuration shows a typical setup where basic process and content capabilities are required. It 
includes only the core components, and not the other add-on components that are shipped with the IBM 
FileNet P8 Platform as functional expansions.
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Figure 1: Baseline Configuration

Baseline Configuration With Optional Components

This configuration is useful for environments that plan to utilize not only the core IBM FileNet P8 Platform 
components but also optional functional expansion components.

Figure 2: Baseline Configuration With Optional Components
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Developer Configuration

This configuration illustrates how a development team might set up an environment for building an 
application that leverages the IBM FileNet P8 Platform.

Figure 3: Developer Configuration

NOTES

• It is useful to share the Content Engine and Process Engine services among the development 
workstations.

• You can use terminal services to run the Enterprise Manager from developer workstations.

• Refer to the help topic FileNet P8 Documentation > Developer Help > Developer Roadmap > 
Introduction for information on setting up your development environment and installing the IBM FileNet 
P8 API toolkits.

Demo Configuration

This configuration supports demos, proof-of-concepts, and development on a single Windows server.
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Figure 4: Demo Configuration

NOTE

• IBM recommends that, in production environments, you avoid collocating Records Manager on the 
same server as Content Engine or Process Engine.
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Prerequisite Tasks

To set up and configure prerequisite software for IBM FileNet P8 Platform components

1. Install and configure a Windows domain for Content Engine (if you do not already have one in place). 
Do Task 1 on page 37.

NOTE A Windows domain is required for the Content Engine components regardless of the 
authentication provider.

2. Configure IBM FileNet P8 Platform authentication. Do one of the following:

• Task 2a on page 38 (Active Directory)

• Task 2b on page 40 (Sun Java System Directory Server)

• Task 2c on page 44 (Novell eDirectory)

3. Create IBM FileNet P8 Platform groups and users. Do Task 4 on page 49.

4. Install a database server for Content Engine and Process Engine.

a. For Content Engine, do one of the following:

• Task 5a on page 58 (Microsoft SQL Server)

• Task 5b on page 63 (Oracle)

• Task 5c on page 68 (DB2)

b. For Process Engine, do one of the following:

• Task 5a on page 58 (Microsoft SQL Server)

• Task 5b on page 63 (Oracle)

• Task 5c on page 68 (DB2)

5. Install database client software on any computer that needs to access a database engine (for example, 
a computer running IBM FileNet Enterprise Manager, Content Engine Object Store Service or File 
Store Service, or Process Engine). Do one of the following:

• Task 6a on page 72 (Microsoft SQL Server)

• Task 6b on page 74 (Oracle)

• Task 6c on page 77 (DB2)
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Task 1: Configure Windows Domain

Before you install IBM FileNet P8 Platform software, you must first create and configure a Windows 
domain.

At least one Windows domain must be configured for the IBM FileNet P8 environment regardless of the 
authentication provider (Windows, Sun or Novell) that is utilized.

• Verify that the boot partition (where IBM FileNet P8 software will be installed) is NTFS. Note that some 
features may not install properly or be unavailable if NTFS partitions are not available.

• The Windows domain controller must have a static IP address for proper DNS Server support.

• The Windows domain must have the DNS Server component installed and configured properly.

• Set up and configure the domain controller.

• Verify network configuration settings on all Windows servers (e.g. TCP/IP, DNS, subnet mask, etc.). 
The Content Engine requires a Windows Domain Controller in a primary DNS tree, which requires a 
static IP address in a DNS tree.

• Verify DNS configuration settings (e.g. Set Forwarders when required). DNS forwarders provide 
external DNS lookup functionality. If you are working in an “isolated” network, a DNS forwarder is not 
required. However, if you want to ‘see’ the Internet or other network resources, then a DNS forwarder 
pointing to a DNS server serving the external resources (Internet) is required.

• The following IBM FileNet P8 servers or components must be located on machines that are members 
of the Windows domain:

– Domain Controller

– Content Engine

– IBM FileNet Enterprise Manager only - client machines

– Servers that contain remote Content Engine File Store and File Store Service

– Servers that contain remote Content Cache Service 

– Servers that contain remote Object Store Service

– Microsoft SQL Server(s) - If using Windows Authentication, MS SQL Server(s) can be in the same 
forest, but don’t have to be in the same domain, as long as the MS SQL Login (e.g. Content 
Engine Servers Group) is in the same domain as Content Engine. For MS SQL Authentication, the 
MS SQL server can be either inside or outside of the forest where Content Engine is located.

• Proceed to the appropriate authentication provider topic: 

– “Configure for Windows Authentication” on page 38

– “Configure Authentication under Sun Java System Directory Server” on page 40

– “Configure Authentication under Novell eDirectory” on page 44
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Task 2a: Configure for Windows Authentication

NOTES 

These notes apply to machines where IBM FileNet P8 services will be installed and to the machine that will 
be configured as the Windows 2000 or Windows 2003 domain controller. This Windows domain will supply 
authentication support for the FileNet P8 domain.

• All Windows 2000 and Windows 2003 servers should have an NTFS hard drive partition where IBM 
FileNet P8 components will be installed. Generally, this will be the boot partition (drive C:).

• If you are using Domain Local Groups, be aware:

– In mixed-mode Windows domains, user members of Domain Local Groups will be recognized only 
if Content Engine is installed on the Domain Controller, in which case authentication/authorization 
performance may degrade if your authentication provider is Windows Active Directory.

– The Everyone account belongs to the Pre-Windows 2000 Compatible Access Group.

– In native-mode Windows domains, Domain Local Groups should exist in the same domain as Con-
tent Engine in an Active Directory forest; otherwise user/group members will not be recognized. 

• If at any time after initial installation you change any value of the authentication provider configuration 
data (such as DefaultRealm or UserDisplayName attribute), you will have to restart all instances of 
Object Store Service, File Store Service, Content Cache Store Service, Enterprise Manager and all 
applications using the IBM FileNet P8 API.

When DNS forwarders are required for your network configuration

DNS forwarders provide external DNS lookup functionality. If you are working in an “isolated” network, a 
DNS forwarder is not required. However, if you want to ‘see’ the Internet or other network resources, then 
a DNS forwarder pointing to a DNS server that is serving the external resources (e.g. Internet) is required. 
Take the following steps to enable DNS forwarders.

1. On the machine that is configured as the Windows DNS Server, log on with an account that can config-
ure the DNS components.

2. Start DNS. For example, on Windows 2003, choose Start > All Programs > Administrative Tools > 
DNS.

3. Right-click the <Your_computer_name> container and select Properties.

4. Select the Forwarders tab and verify the check box for Enable forwarders is selected.

NOTE If this feature is grayed out (unavailable), you will need to reconfigure your DNS server.

5. If you selected the check box, add an appropriate IP address and click OK.

NOTE This IP address may be the IP address of a DNS server that allows traffic to the Internet.

If installing Content Engine on a Windows domain controller

1. On the machine that is configured as the Windows domain controller, log on with an account that can 
manage domain security settings.

NOTE The following steps pertain to Windows 2003. The steps for Windows 2000 differ slightly and 
are noted in parentheses.

2. Choose Start > All Programs > Administrative Tools > Domain Controller Security Policy. 
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3. Expand Security Settings > Local Policies.

4. Select Users Rights Assignment.

5. In the right panel, double-click Allow Logon locally policy. (In Windows 2000, double-click Log on 
locally. You may need to scroll down the list to find this item.)

6. Click Add User or Group and then click Browse. (In Windows 2000, click Add and then click 
Browse.)

7. In the Select Users, Computers, or Groups dialog box, type Domain Users and click OK. In the Add 
Users and Groups dialog box, click OK. (In Windows 2000, double-click Domain Users in the Select 
Users and Groups dialog box and click OK.)

8. Close all open dialog boxes by clicking OK, and close the Domain Controller Security Policy snap-in.
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Task 2b: Configure Authentication under Sun Java System Directory 
Server

You will use this task to configure either the Sun Java System Directory Server (v 5.1 SP2) or Sun Java 
System Directory Server (v 5.2) on a Windows or UNIX server.

This task assumes that Sun Java System Directory Server is installed properly. Be sure to read all 
pertinent documentation from the 3rd-party software vendor.

All IBM FileNet P8 environments require a Windows domain. This includes a Windows domain controller 
and Windows accounts that are used for Content Engine services. In addition, Content Engine, Rendition 
Engine, and IBM FileNet Enterprise Manager only servers must reside in the same Windows domain. 

NOTES 

This step is performed on the Windows or supported UNIX computer that will be configured as the IBM 
FileNet P8 Platform Authentication server using a Sun Java System Directory Server (v 5.1 SP2 or 5.2).

• When configuring the Sun Java System Directory Server software, you may find references in the user 
interface to “iPlanet” or “Sun ONE”. These terms have been replaced by “Sun Java System Directory 
Server”.

• The Sun Java System Directory Server authentication scenario requires a Windows domain (domain 
controller) and various Windows accounts for the Content Engine component. The Content Engine 
server, Rendition Engine server and all IBM FileNet Enterprise Manager servers must be a member of 
the Windows domain.

• On Windows servers, Sun Java System Directory Server should be installed on an NTFS hard drive 
partition.

• If there are more than 2,000 users in the Directory Server, you must increase the resource limits in 
order to correctly display users in IBM FileNet P8. IBM recommends setting this limit to -1 (unlimited). 
You can either set this limit for the entire LDAP server or for the individual IBM FileNet P8 users. 
Instructions for either procedure appear below.

• You must have at least one IBM FileNet P8 Platform group and/or user account to create Content 
Engine object stores.

CAUTION Changing authentication configuration parameters should be done with care. If you do 
change any value of the authentication provider configuration data, you will have to restart all 
installations of the following:

• Object Store Service 

• File Store Service

Configure Sun Java System Directory Server (v 5.1 SP2) 

To set the resource limits for the entire directory server

NOTE User resource limits take precedence over server resource limits. Existing users who have a value 
specified for resource limits will not be affected by the changes made in the following steps.

1. From the server where Sun Java System Directory Server is installed, log on with an account that has 
rights to modify the Sun Java System Directory Server environment.

2. Run the Sun Java System Directory Server console and login.
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3. Expand the Domain > Server Group containers and select your Directory Server. Then right-click and 
select Open.

4. Select the Directory tab and expand config > plugins > ldbm database.

5. Double-click the config folder.

6. From the Property Editor sheet for cn=config,cn=ldbm database,cn=plugins,cn=config, change 
nsslapd-lookthroughlimit value to -1 and click OK.

7. Select the Configuration tab

8. Select the Performance tab, change the Size limit to -1 and click Save.

9. Select the Tasks tab and Restart the Directory Server.

To set the resource limits for individual IBM FileNet P8 users

You will need to perform the steps below any time you add additional IBM FileNet P8 users.

1. From the Sun Java System Directory Server console, expand the Domain > Server Group containers 
and select your Directory Server. Then click Open.

2. Select the Directory tab.

3. From the left pane, select the Object (OU, etc.) that contains the user(s) you want to change.

4. For each IBM FileNet P8 user whose limit you want to change, complete the following steps:

a. From the right pane, double-click on the user name.

b. Select Properties.

c. On the left pane of the Properties dialog, select Account.

d. Enter -1 in the Look through limit and size limit fields.

e. Click OK.

5. Restart the Directory Server.

To ensure users can view other user/group principals in the directory for security authorization of 
IBM FileNet P8 objects

1. From the Sun Java System Directory Server console, expand the Domain > Server Group containers 
and select your Directory Server, then click Open.

2. Select the Directory tab.

3. Right-click Set Access Permissions on all suffixes you wish to make available.

NOTE This is only necessary on all root-level suffixes. Sub suffixes should inherit the permissions from 
the root suffix(es).

4. Click New.

5. Give the ACI name a valid name (e.g. Authenticated Users).

6. Click Add.

7. On the Search area drop down box, choose Special Rights.

8. Click on All Authenticated Users, and click Add to add this principal for the access permission.
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9. Click the Rights tab, and set the minimum rights to read, compare, and search.

10. Click OK.

11. Click OK to close the Manage Access Control dialog.

NOTE If you disable anonymous query in the Sun Java System Directory Server, then non-FileNet P8 
services users will not be able to log on to IBM FileNet P8 unless you grant explicit read rights (via an ACI) 
to the suffix (realm) or suffixes (multi-realm) you want them to be able to access. The minimum required 
access rights are read and search.

Configure Sun Java System Directory Server (v 5.2)

To set the resource limits for the entire 5.2 Directory Server

NOTE User resource limits take precedence over server resource limits. Existing users who have a value 
specified for resource limits will not be affected by the changes made in the following steps.

1. From the server where Sun Java System Directory Server is installed, log on with an account that has 
rights to modify the Sun Java System Directory Server environment.

2. Run the Sun Java System Directory Server console and login.

3. Expand the Domain > Server Group containers and select your Directory Server. 

4. Right-click and select Open.

5. Select the Configuration tab.

6. Select the Performance container.

7. Select the Client Control tab.

8. For the LDAP group box, ensure that Size limit and Look-through limit are both set to Unlimited.

9. If changes were made, click Save.

10. Select the Tasks tab and Restart the Directory Server if changes were made.

To ensure users can view other user/group principals in the directory

1. From the Sun Java System Directory Server console expand the Domain > Server Group containers 
and select your Directory Server. 

2. Click Open.

3. Select the Directory tab.

4. Select your domain (suffix).

5. Right-click Set Access Permissions on all suffixes you wish to make available, all its users/group.

NOTE This is only necessary on all root-level suffixes. Sub suffixes should inherit the permissions from 
the root suffix(es).

6. Click New.

7. Give the ACI name a valid name (e.g. Authenticated Users).

8. Click Add.

9. On the Search area drop down box, choose Special Rights.
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10. Click on All Authenticated Users and click Add to add this principal for the access permission then 
click OK.

11. Click the Rights tab, and set the minimum rights to read, compare, and search.

12. Click OK.

13. Click OK to close the Manage Access Control dialog.

NOTE If you wish to utilize Smart or Suffix Referrals, it is important that the target (referred suffix or object) 
has anonymous (All Users) access permission with read, compare, and search rights.
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Task 2c: Configure Authentication under Novell eDirectory 

You will use this task to configure Novell eDirectory Server for IBM FileNet P8 Platform authentication on a 
Windows or UNIX server.

NOTES

• This task assumes that Novell eDirectory Server and Client components are properly installed.

• You perform this task on the Windows (2000 or 2003) or any supported UNIX server that will be 
configured as the IBM FileNet P8 Platform authentication server using Novell eDirectory Server.

• IBM FileNet P8 Platform does not support global referrals because eDirectory does not provide a 
referral error to chase for LDAP binds.

• The Novell Directory authentication scenario requires a Windows domain (domain controller) and 
various Windows accounts for the Content Engine component. The Content Engine server, Rendition 
Engine server and all IBM FileNet Enterprise Manager servers must be a member of the Windows 
domain.

• The Windows server where Novell eDirectory Server is installed, must have an NTFS hard drive 
partition.

• You must have at least one IBM FileNet P8 Platform group and/or user account to create Content 
Engine object stores.

• Novell eDirectory does not support descending order sorting.

• The Novell eDirectory administrator may have to create an index if the sorting attribute is not a default 
index created automatically by eDirectory. 

• CAUTION Changing authentication configuration parameters should be done with care. If you do 
change any value of the authentication provider configuration data, you will have to restart all 
installations of the following: 

• Object Store Service 

• File Store Service 

To configure Novell eDirectory Server software in a Windows or UNIX environment

1. Run the Novell eDirectory Console. 

2. Click the NDS Tree icon.

3. Create a New eDirectory tree or use an existing tree.

a. Enter the Tree Name.

b. Add a new container to the tree. This container type should be DC (domain).

NOTE Depending on your environment, you may need to add additional containers, such as 
Country, Organization, Organizational Unit, etc.

c. Uncheck the Require TLS for Simple Bind with Password option.

HINT If you miss this check box during installation, you can set this value (uncheck) later in the 
Novell Console.
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d. Click NDS Authentication and enter the following information:

• Login name

• Password

• Tree name (search and find with button)

• Context (e.g. DC=<your_eDirectory_domain_name>) 

NOTE This is not your Windows domain.

4. Right-click the domain name (dc) that was added above or select an existing domain, and select 
Trustee of this Object.

5. Click Add a Trustee.

6. Select Public.

7. Verify or select Browse Rights.

8. Apply the changes.

9. Refresh the tree.
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Task 3: Configure Content Engine and SQL Servers for Windows 2003

CAUTION  If you are installing on a Windows 2003 system that has already been upgraded to SP2, do not 
use these procedures in this topic. Instead, use the procedures provided in the appendix “Configure an 
IBM FileNet P8 environment for Windows Server 2003 SP1 or R2” on page 375.

The following procedures are required and must be run on the Content Engine and Microsoft SQL 
server(s) where Windows 2003 is installed.

At least one Windows domain (2000 or 2003) must be configured for the IBM FileNet P8 environment 
regardless of the authentication provider (Windows, Sun or Novell) that is utilized.

Important notes

• For Windows 2003 servers where Content Engine components will be installed, Microsoft Distributed 
Transaction Coordinator (MSDTC) and COM+ must be enabled on Object Store Service and SQL 
Server machines. Otherwise, Content Engine will not run correctly.

• If the MSDTC or COM+ access is not enabled then object store creation will fail when loading the 
Content Engine Add-ons.

• To complete this task, you must have access to the Windows 2003 media.

• The boot drive partition must be NTFS.

• In an environment with Content Engine on Oracle and Process Engine on MSSQL Server, MSDTC 
configuration changes for Windows 2003 are not needed.

To make configuration change for MSDTC and COM+

Do this procedure on each Content Engine machine and the Microsoft SQL Server machine (if it is remote 
from each Content Engine).

1. Log on to the Windows 2003 server with an account that has local administrator rights.

2. Select Start > Control Panel > Add or Remove Programs.

3. Select Add/Remove Windows Components.

4. Check Application Server and then click the Details button.

5. Verify Enable network COM+ access is selected.

6. Verify Enable network DTC access is selected.

7. Click OK.

8. Click Next

9. Click Finish.

10. In the console tree of the Component Services administrative tool, expand the Computers folder, 
and right-click the local computer icon.

11. Click Properties, and select the MSDTC tab, then click Security Configuration.
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12. In the Security Configuration dialog box, select (check) the following boxes, and then click OK:

• Network DTC Access

• Network Administration

• Network Transactions

13. Restart the server.

NOTE Remember to do this procedure on each Content Engine machine and the Microsoft SQL Server 
machine (if it is remote from each Content Engine).

To install IIS for Content Engine WebDAV support

This procedure and the following procedure are optional unless you need WebDAV support for Content 
Engine.

When installing Windows 2003 you need to install IIS (By default IIS is not installed).

1. Select Start > Control Panel > Add or Remove Programs.

2. Select Add/Remove Windows Components.

3. Select Application Server and click Details.

4. Select Internet Information Services (IIS) and click Details.

5. Select World Wide Web Service and click Details.

6. Select WWW Service and WebDAV Publishing components.

7. Click OK on all open dialogs.

8. Click Next to complete the installation of the new service.

To configure IIS for WebDAV support

1. Select Start > Programs > Administrative Tools > Internet Information Services (IIS) Manager.

2. Right-click the node for your computer and select Properties.

3. Select Enable Direct Metabase Edit and click OK.

4. Expand the tree view of the node for your computer and click the Web Service Extensions node.

5. Select All Unknown ISAPI Extensions from the list and click Allow.

6. Select WebDAV from the list and click Allow.

7. To enable Windows Webfolders to function in Windows 2003 Server, you must install one of the 
following on the Windows 2003 Server machine:

• At least the InfoPath component of Microsoft Office 2003 (via a Custom install)

• Microsoft Visual Studio .NET

8. Restart the server.
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To enable Windows 2003 IIS when acting as a WebDAV client

1. Select Start > Programs > Administrative Tools > Internet Information Services (IIS) Manager.

2. Enable and start the WebClient Service.

3. Close The IIS Manager.

To configure WebClient Service for WebDAV support

1. Select Start > Programs > Administrative Tools > Services.

2. Right-click the Web Client option and select Properties.

3. Set the Startup type to Automatic.

4. Set the Service status to Start and click OK.

5. Close the Administrative tools.
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Task 4: Create groups and users required for IBM FileNet P8 installa-
tion

All IBM FileNet P8 environments require a Windows Active Directory domain/forest, including a Windows 
domain controller and Windows accounts that are used for Content Engine services. This requirement 
applies regardless of the authentication provider you use (e.g., Windows Active Directory, Sun, or Novell).

This task assumes that an authentication provider is properly installed and configured.

NOTES

• Complete the IBM FileNet P8 Platform 3.5.x Security Questionnaire, available on the product support 
page, to help plan and deploy your environment.

• Process Engine requires that all accounts defined in the directory service have non-blank passwords. 
Even for IBM FileNet P8 components that do not enforce this requirement, IBM FileNet does not 
recommend leaving a blank password for any account.

• Under Active Directory authentication, IBM FileNet P8 supports only security groups, not distribution 
groups. Supported groups can have a scope of domain local (as long as they are in the same domain 
as Content Engine), global, or universal.

The following tables list the user and group accounts needed for installing and establishing the initial 
configuration of your IBM FileNet P8 system, including the minimum permissions required.

In many cases, as indicated, you will have to create these accounts ahead of time. In other cases, you can 
rely on the IBM FileNet P8 setup wizards to set up these accounts for you. 

NOTE For more details on these accounts and the roles and security permissions required for each, see 
the FileNet P8 Platform user and group security help found at FileNet P8 Administration > Enterprise-
wide Administration > Security > Users and groups. This help topic provides a complete list of the user 
and group roles, accounts, and responsibilities required to install, configure, and maintain an IBM FileNet 
P8 system.

Content Engine

Role/Account Description

<SQL Login> (MS SQL Server only) MS SQL Server Security Login 
required to enable the system to create Content 
Engine objects stores when requested by 
administrators.

Permissions:

• Server Roles: System, Security, Disk 
Administrators, and Database Creators

• Database Access: public and db_owner for all 
object store databases

<Oracle user> (Oracle only) Oracle database account required to 
enable the system to create Content Engine object 
stores when requested by administrators.

Permissions: CREATE SESSION, CREATE TABLE, 
and CREATE SEQUENCE roles

ftp://ftp.software.ibm.com/software/data/cm/filenet/docs/p8doc/35x/p8_351_SecurityQuest.doc
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<DB2 user> (DB2 only) An Operating System user on the database 
server with the following DB2 database permissions. 
In the case of a remote database, no equivalent users 
are needed on the Content Engine server. 

• Permission to connect 

• Permission to create tables in the tablespace 
(CREATETAB)

• Permission to use the tablespace (USE OF) (for 
User and User Temp tablespaces)

Accounts required for DB2 database setup 
and administration:

Groups

instance owner primary group

Users

instance owner

(DB2 only) Operating system user and group that 
must exist on the database server.

For details about these accounts, see “Install DB2 
server for Content Engine and Process Engine” on 
page 68 and “Install DB2 Client for Content Engine 
and Process Engine” on page 77.

Windows local Administrator role The Windows local machine administrator who:

• installs Content Engine.

• creates a FileNet P8 domain or adds a new server 
into an existing FileNet P8 domain (usually the 
same person who installs Content Engine).

Permissions: The Windows local machine 
administrator must also be a member of Domain 
Users

Content Engine

Role/Account Description
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<Content Engine Servers> group 
<FNCE_machinename> user 

The Windows Active Directory group and user 
accounts used for each machine on which Content 
Engine has been installed. You can create these 
accounts ahead of time (with names of your 
choosing), or allow the Content Engine Setup program 
to create them for you.

This group is used for Windows authentication when 
using SQL Server object stores.

The Content Engine's services - Object Store Service, 
File Store Service, and Content Cache Service - all 
run as the <FNCE_machinename> account of the 
machine on which they are installed. These machine 
accounts use a randomly created, globally unique 
password that is never displayed and which system 
administrators never need to know.

Permissions: Must have Full Control on:

• \Program Files\FileNet\Content Engine\sysconfig 
directory

• \FS_<filestorename> File Store directories

See the Security help noted on page 49 for further 
details.

GCD Administrators role The administrators who can add markings, AddOns, 
fixed content devices, and who can add or remove 
FileNet P8 domain objects. You must create these 
user and group accounts to be able complete Content 
Engine installation, but they are used for follow-on 
administration only (e.g., for adding and deleting 
object stores).

Permissions: Full Control over the GCD (which defines 
the FileNet P8 domain). 

Content Engine

Role/Account Description
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Authentication Service user role (Sun or Novell authentication only) Account used by 
Content Engine to connect to and search the directory 
server.

Assigned as the value of the ServiceUsername 
attribute during Content Engine installation (i.e., while 
running the GCD wizard and configuring the 
authentication provider).

Permissions: The service users must be configured 
with the following minimum rights for each realm:

• Sun Java System Directory Service: Read, 
Search, Compare

• Novell eDirectory: Compare, Read 

AddOn administrator role Any single member of the GCD administrators role 
needed to create FileNet P8 domain AddOns.This 
account is for internal purposes only, but you must 
specify it while installing Content Engine (i.e., when 
creating/joining a FileNet P8 domain via the GCD 
wizard).

Permissions: Full Control over the GCD (that defines 
the FileNet P8 domain). 

IIS user for Content Engine WebDAV role The Windows domain account that is used to access 
the IIS server for WebDAV connectivity to the Content 
Engine object stores.

Permissions: Domain privileges in the Windows 
domain that contains the FileNet P8 domain Content 
Engine servers.

<P8Apache> user This is the Windows account that logs on and runs the 
Apache2 service. Apache strongly recommends 
against running this service as LocalSystem.

See the Security help noted on page 49 for further 
details.

Content Engine

Role/Account Description
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object store administrators role The administrators who have Full Control access to an 
object store. Required for ongoing administration of 
the object store using the FileNet Enterprise Manager. 
The Enterprise Manager is designed to be run by 
object store administrators.

Specified each time the GCD administrator runs the 
Create Object Store wizard to create a new object 
store.

Permissions: Full Control over the object store: 
Connect to store; create new and modify existing 
objects (not including FileNet P8 domain objects); 
delete objects; set owner of any object; read and 
modify permissions. FileNet highly recommends that 
you not modify these default permissions.

Process Engine

Role/Account Description

local Administrator (Windows only) Installs the Process Engine software.

Permissions: Can be the local Windows Administrator or 
any local Windows user with equivalent permissions. Must 
also have administrator privileges on the database.

root user (UNIX only) Installs the Process Engine software.

Permissions: Must run in either the Bourne or Korn shell.

Accounts required by Process Engine 
Setup (UNIX only)

Groups

fnadmin
fnusr
<database administrators group; 
default group name = dba> 

Users

fnsw
<Oracle user; default user name = 
oracle>

Used for various Process Engine administration tasks. 
Process Engine installation procedures include instructions 
for creating these accounts. Create these accounts prior to 
launching the Process Engine Setup wizard. For details 
about these accounts, see the section for your Process 
Engine platform:

AIX: “Create or modify internal Process Engine users and 
groups” on page 180

HP-UX: “Create or modify internal Process Engine users 
and groups” on page 194

Solaris: “Create or modify internal Process Engine users 
and groups” on page 167

Content Engine

Role/Account Description
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Local accounts required by Process 
Engine Setup (Windows only)

Groups

fnadmin
fnusr
<database administrators group; 
default group name = dba> 
ORA_DBA (Oracle only)

Users

fnsw
<Oracle user; default user name = 
oracle> (Oracle only) 

Used for various Process Engine administration tasks. 
Process Engine Setup automatically creates these 
accounts with the required permissions; it is not necessary 
to create them prior to beginning Process Engine 
installation.

For details about these accounts, see the FileNet P8 
Platform user and group security help found at FileNet P8 
Administration > Enterprise-wide Administration > 
Security > Users and groups > Local accounts required 
by Process Engine Setup (Windows). 

Accounts required for DB2 database 
setup and administration:

Groups

instance owner primary group
fenced user primary group

Users

instance owner
fenced user
f_sw
f_maint

(DB2 only) Groups and users that must exist at the 
operating system level on the DB2 database server.  All 
must be created or identified prior to installation of Process 
Engine. Where they must be created and permissions 
required for them will vary depending upon the database 
authentication method used.

For details about these accounts, see “Install DB2 server for 
Content Engine and Process Engine” on page 68 and 
“Install DB2 Client for Content Engine and Process Engine” 
on page 77.

<Process Engine Administrator Group> Members of this group will administer and make 
configuration changes to Process Engine, including 
configuring the Process Engine's LDAP connection to the 
directory service.

There is no default name for this group, which you will 
designate in Process Task Manager when completing the 
task called “Configure the Process Engine LDAP 
Connection” on page 204.

Permissions: Must have read permission for the directory 
service. Also, the <Process Engine Service User> (see 
below) must be a member.

Process Engine

Role/Account Description
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<Process Engine Service User> Used by Process Engine software for most interactions with 
the directory service, except when authenticating a user 
who is logging on.

There is no default name for this user, which you will 
designate in Process Task Manager when completing the 
task called “Configure the Process Engine LDAP 
Connection” on page 204.

Permissions:

• Must belong to the <Process Engine Administrator 
Group> (see above).

• Additional requirements vary by directory service:

– Sun Java System Directory Service: Read, Search, 
Compare

Also, must have resource limits set to -1 (no limit) in 
the Look through limit and Size limit fields in the 
Sun Java System Directory Server Console. See 
“Configure Authentication under Sun Java System 
Directory Server” on page 40 for instructions on 
setting these limits.

– Novell eDirectory: Compare, Read 

– Active Directory: Add permission to read group 
membership across all accessed domains.

<Process Engine Configuration Group> Members of this group can make configuration changes to 
the workflow database. Defining this group is optional; if 
<Process Engine Configuration Group> it exists, only 
members of that group or of <Process Engine Administrator 
Group> can modify the workflow database configuration. If 
<Process Engine Configuration Group> does not exist, any 
user can modify the workflow database configuration.

There is no default name for this group, which you can 
designate in Process Task Manager when completing the 
task called “Configure the Process Engine LDAP 
Connection” on page 204.

Permissions: None required

Process Engine

Role/Account Description
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Application Engine

Role/Account Description

local Administrator (Windows only) Installs the Application Engine software.

Permissions: Must be a member of the local 
Administrators group or a user with equivalent 
permissions.

<installation user> (UNIX only) Installs the Application Engine software.

Permissions: Must have write access to the /bin 
directory and read, write, and execute access to the 
directory where you plan to install Application Engine.

Users and groups to designate as members of 
the Application Engine administrator role

Members have administrative privileges for 
Application Engine.

You will specify members of this role as when 
completing the task called “Set bootstrap preferences” 
on page 238.

Permissions: None. This is an internally managed role 
not used for directory service transactions.

Users who can start the process router Starts the process router.

Permissions: must have read/write/execute 
permission to the \Router subfolder (Windows) or /
Router subdirectory (UNIX) where the router is 
installed.
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Rendition Engine

Role/Account Description

<SQL Login>  Any user with SQL Server's “Create Database” 
permission.  Any SQL Server user with SQL Server's 
"Database Creators" server role. 

In SQL Server Enterprise Manager, navigate to 
Security > Logins. Right-click the user's name and 
select Properties. Click the Server Roles tab and 
select at least Database Creators. 

This user is a safer alternative to using SQL Server's 
SA or SYS users, which will also satisfy the 
configuration requirements. (This user is not the same 
as the FNRE_Admin user.) 

<FNRE_Admin> A Windows domain user account that must be added 
to the local Administrators group on all Rendition 
Engine servers.

Permissions: Domain privileges in the Windows 
domain that contains the FileNet P8 domain and local 
administrator privileges on the machine where 
Rendition Engine is installed.
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Task 5a: Install Microsoft SQL Server for IBM FileNet P8

This task uses 3rd-party software. Be sure to read all pertinent documentation from the 3rd-party software 
vendor. Contact your system/network/database administrator with 3rd-party vendor or environment 
questions before continuing.

NOTES

Install Microsoft SQL Server on either the computer where the Process Engine, Rendition Engine, or 
Content Engine software will be installed (subsequently referred to as a local database) or on a 
separate server (subsequently referred to as a remote database). For information regarding 
installation of Microsoft SQL Server and Rendition Engine, see  FileNet P8 Documentation > FileNet 
P8 System Installation > Rendition Engine Installation and Upgrade.

• Windows 2003 Service Pack 1. If you plan on installing Windows 2003 SP1, refer to “Configure an 
IBM FileNet P8 environment for Windows Server 2003 SP1 or R2” on page 375.

• If your Microsoft SQL Server database will be remote, then after completing the procedures in this 
topic you must also complete the procedures in“Install MS SQL Server Client software for IBM FileNet 
P8” on page 72 on the machine where you will install Process Engine.

• The Microsoft SQL Server must be in the same Active Directory forest if you want to use Windows 
authentication for connecting to the SQL Server database instance. Otherwise, if using SQL 
Authentication, there is no need to be in the same forest.

• Choose your security (authentication) mode for Microsoft SQL Server based on the following criteria:

– If Content Engine does not need to support WCM-configured object stores, you may choose either 
Windows Authentication or Mixed Mode (Windows Authentication and SQL Server Authentica-
tion); otherwise you must choose Mixed Mode.

– Process Engine requires Mixed Mode.

– Rendition Engine requires Mixed Mode. 

• The MS SQL instance can optionally be shared by the Content Engine, Process Engine, and Rendition 
Engine components.

• Process Engine and the optional Process Analyzer cannot share an instance. For information on SQL 
Server requirements for Process Analyzer Engine, see the Process Analyzer Installation and Upgrade 
Guide.

• Each Process Engine server must have a dedicated instance and database.

• If you are using Microsoft SQL Server with Windows Authentication, a Windows Active Directory group 
account (default: Content Engine Servers) must be configured as a valid Microsoft SQL Server Login.

• Database creation for Content Engine can be handled by the object store creation wizard, or you can 
manually create the database used by the Content Engine object stores. An existing database that 
was manually created (as required by Process Engine) must be empty for the object store wizard to 
use it.

• IBM suggests that you record the values for the following settings as you work through the database 
installation. This information must be entered during subsequent installations. Be aware that Process 
Engine Setup allows only alphanumeric characters and underscores.

– Server name

– Instance (e.g. P8_inst)
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– Dedicated database name (e.g. VWdb)

– Dedicated file group (e.g. vwdata_fg) 

– TCP/IP port number assigned 

To install and configure Microsoft SQL Server

Refer to Microsoft’s SQL Server 2000 installation instructions, which are available at http://
msdn.microsoft.com/library/default.asp?ShowPane=false&URL=/library/psdk/sql/getstart_4fht.htm. In 
addition, when installing Microsoft SQL Server software:

• Log on as a local user with administrator privileges on the computer where the database will be 
installed.

• Create a database instance for use by IBM FileNet P8 software, or verify that such an instance already 
exists. 

• If creating a new instance, indicate an appropriate name based on whether Content Engine, Process 
Engine, or Rendition Engine will use the instance, and whether the database is local or remote. Be 
aware of the following rules for instance names:

– The name cannot exceed 16 characters

– The first character cannot be numeric or '$

– The name cannot contain special characters, except an underscore or period.

– The name cannot contain spaces

– The name cannot be "Default" or "MSSQLServer"

• Verify a Custom Microsoft SQL Server installation. 

• Verify the authentication Mode. Choose your security (authentication) mode for Microsoft SQL Server 
based on the following criteria:

– If Content Engine does not need to support WCM-configured object stores, you may choose either 
Windows Authentication or Mixed Mode (Windows Authentication and SQL Server Authentication); 
otherwise you must choose Mixed Mode.

– Process Engine requires Mixed Mode.

– Rendition Engine requires Mixed Mode. 

• Verify the sa password for your site.

• Select the database collation settings. Specify one of the following:

• Dictionary order, case-insensitive, for use with 1252 Character Set (or any case-insensitive 
MS SQL Server collation). Case-insensitive collation is the Microsoft default and the setting most 
used in IBM FileNet P8 environments (because it offers search results without regard to character 
case). 

• Dictionary order, case-sensitive, for use with 1252 Character Set (or any case-sensitive MS 
SQL Server collation). Select case-sensitive MS SQL Server collation only if you are sure your site 
actually requires (and will continue to require) searches that must differentiate upper-case from 
lower-case characters (in property choice lists, folder names, etc.).

CAUTION  Select your MS SQL Server collation setting carefully. Switching collation settings after 
installation can be difficult and time-consuming, especially if you want to switch from case-sensitive to 

http://msdn.microsoft.com/library/default.asp?ShowPane=false&URL=/library/psdk/sql/getstart_4fht.htm
http://msdn.microsoft.com/library/default.asp?ShowPane=false&URL=/library/psdk/sql/getstart_4fht.htm
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case-insensitive collation after significant user activity. Also, be aware that if you have a case-sensitive 
database, and you want to perform a case-insensitive search (programmatically or otherwise), you will 
likely encounter serious performance degradation on MS SQL Server because the database cannot 
use column (i.e., property) indexes in these cases.

• Assign a TCP/IP port number for the instance.

– If your instance is the only instance on the server, you can accept port 1433 (default value) in the 
TCP/IP port number box. If you already have a default or other instance on the server, set 0 as the 
port number to allow dynamic assignment at instance startup, or set a specific port number. 

– If the instance is for Content Engine where an object store will be used by WCM.

– If the instance is for Rendition Engine to be used by WCM.

– If the instance is for Content Engine and you have defined a static port number that is anything but 
1433, you must also follow the steps in “Configure a server alias” on page 62.

• Verify that the required Microsoft SQL Server 2000 Service Pack is installed. See the IBM FileNet P8 
Hardware and Software Requirements.   

To configure Microsoft SQL Login for Content Engine

On the Microsoft SQL database computer, use Microsoft SQL Server Enterprise Manager to create a 
Microsoft SQL Login for the Content Engine Windows Service Account (e.g. Content Engine Servers).

1. Start the Microsoft SQL Enterprise Manager.

2. Expand the Microsoft SQL Server <Server name>[\<Instance name>] node. 

3. Expand the Security folder, right-click Logins and select New Login.

4. For Windows Authentication (Content Engine must be in same Active Directory forest as SQL Server), 
locate and select the Content Engine Windows Service Account group (e.g. DOMAIN\Content Engine 
Servers) using the Find button. For SQL Server Authentication, create a new user and password (take 
note of this information for when creating object stores). For Mixed Mode, verify the sa password for 
your site.

5. Select the following Roles:

• If you will create the database via IBM FileNet Enterprise Manager, grant "DOMAIN\Content 
Engine Servers" group (or the SQL Login db user) the "Database Creator" server role, which can 
be revoked after the object store is created.

• If you will pre-create the database via SQL Server Enterprise Manager, grant "DOMAIN\Content 
Engine Servers" group (or the SQL Login db user) "Public" and "db_owner" access to the new 
database.

NOTE If you wish IBM FileNet Enterprise Manager to perform object store backups and restores, the 
Microsoft SQL Login must have at least the System Administrators and Security Administrators 
roles selected.

6. Click OK to save the new login.

To prepare a database for Process Engine

Perform the following steps to create the Process Engine database and modify the tempdb database 
setting. You can specify a different database name, file name, and data filegroup name. Be sure to record 
your entries for use during installation of the Process Engine software.
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To create the Process Engine database

1. If it is not already running, start the Microsoft SQL Enterprise Manager.

2. Expand the <Server name>[\<Instance name>] folder. 

3. Right-click the Databases object and select New Database. 

4. Give the new database a name (e.g. VWdb).

5. From the Data Files tab, add a new File Name for the database (e.g. vw_data).

6. Specify a disk location for the file.

7. Specify the Initial size (e.g. 200).

8. Specify a Filegroup (e.g. vwdata_fg).

9. Click OK to save.

NOTE You will need these values for the Process Engine installation.

To modify the tempdb database

1. If it is not already running, start the Microsoft SQL Enterprise Manager.

2. Expand the <Server name>[\<Instance name>] folder. 

3. Expand the Databases object.

4. Right-click the tempdb object and select Properties.

5. From the Data Files tab, change the Space allocated for the tempdb to at least 80 MB

6. Click OK to save.

7. Close the SQL Enterprise Manager.

To manually create a Microsoft SQL database for Content Engine object store(s)

Use the following steps to manually create a database for a Content Engine object store. Each object store 
you create will require a separate, empty database.

1. If it is not already running, start the Microsoft SQL Enterprise Manager.

2. Expand the <Server name>[\<Instance name>] folder. 

3. Right-click the Databases object and select New Database. 

4. Give the new database a name.

5. From the Data Files tab:

• Accept default disk location or enter a new value.

• Specify the Initial size (e.g., 200 MB) of the database.

6. Click OK to save.
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Configure a server alias 

If the database instance is for Content Engine and has a static TCP/IP defined that is anything other than 
the default port 1433, you must take the following steps.

1. On the server that has MS SQL Server installed, determine the TCP/IP port assignment of the MS 
SQL Server instance. 

2. Open the MS SQL Server Client Network Utilities application.

3. Select the DB-Library Options tab, de-select Automatic ANSI to OEM conversion. 

4. Select the Alias tab and click the Add button.

5. Select the TCP/IP option from the Network libraries.

6. Uncheck the Dynamically determine port option.

7. Enter the Server alias: (e.g., <server_name>\<instance_name>)

8. Enter the Server name: (e.g.,<server_name>\<instance_name>)

9. Enter the Port number determined during setup. 
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Task 5b: Install Oracle Server for IBM FileNet P8

The procedures in this task describe how to install and configure an Oracle database that is dedicated or 
shared by one or more of the following IBM FileNet P8 components:

• dedicated to Content Engine

• dedicated to Process Engine

• dedicated to Rendition Engine

• shared by two or more of Content Engine, Process Engine, and Rendition Engine

• In the shared configuration, the IBM FileNet P8 components use the same database instance. You can 
also share the database with other (non-FileNet) applications. In the dedicated configuration, Content 
Engine, Process Engine, and Rendition Engine use separate database instances. Each Process 
Engine server must have a dedicated instance and database.

NOTE If Content Engine and IBM FileNet Image Services use the same Oracle server, each must have its 
own Oracle instance.

A database is local if it is on a machine where you will also be installing Content Engine, Process Engine, 
or Rendition Engine. A database is remote if it is on a machine where no Content Engine, Process Engine, 
Rendition Engine is installed.

For information regarding installation of Oracle Server and Rendition Engine, see FileNet P8 
Documentation > FileNet P8 System Installation > Rendition Engine Installation and Upgrade.

NOTES

• Perform this task on the UNIX or Windows machine that will host the Oracle database to be used by 
Content Engine, Process Engine, or Rendition Engine.

• Make sure that the machine that will host the database satisfies all pre-installation requirements 
specified in the Oracle installation documentation.

• For Content Engine and Process Engine, IBM FileNet P8 supports the Oracle Advanced Security 
functionality of secure data transfer across network protocol boundaries.

• If you will be installing Process Engine on a UNIX machine hosting the Oracle database, be sure that 
the value of the Oracle environment variable ORACLE_HOME (the pathname for the Oracle Server 
software) is a string of at most 53 characters. If the string has more than 53 characters, the Process 
Engine installer will not find the Oracle software, causing the installation to fail.

• If the machine where you install the Oracle database will also host an installation of Content Engine 
and/or Process Engine, the machine must meet the Content Engine and/or Process Engine 
requirements listed in the IBM FileNet P8 Hardware and Software Requirements.

• Refer to IBM FileNet P8 Hardware and Software Requirements for operating-system Service Pack and 
Oracle version and patch set requirements. The Oracle patches are available at OracleMetaLink. The 
Oracle patch-installation procedure may be less complicated if done before you create any databases.

• If your Oracle database will be remote, then after completing the procedures in this topic you must also 
complete the procedures in “Install Oracle Client for IBM FileNet P8” on page 74 on each machine 
where you will install Content Engine, Process Engine, or Rendition Engine.

http://metalink.oracle.com
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• The machine where you install the Oracle database must meet the following requirements if it will also 
be hosting an installation of Process Engine:

– The machine must have a static IP address.

– (Windows) The file system must be NTFS.

• Transaction Processing is the required configuration type for the database that supports Content 
Engine. Choose this configuration type if your database will be will be dedicated to Content Engine or 
shared with Process Engine.

• Do not set NLS_LENGTH_SEMANTICS at the system level. If you are sharing the Oracle installation 
for Content Engine with other applications that require this setting, set NLS_LENGTH_SEMANTICS at 
the session level for those applications.

Install an Oracle database engine

The following procedure shows the minimal choices (specific to the needs of Content Engine and 
Process Engine) for installing a database engine. Consult the Oracle9i or Oracle 10g installation 
documentation for complete preinstallation requirements and instructions. The size requirement for 
a database dedicated to Rendition Engine is specified in the file Oracle-Repository.sql (located on the 
Rendition Engine installation CD).

•  For Oracle 9i, choose the following from the list of available product components. 

– Oracle9i Server

– Oracle Net Services

• Oracle Net Listener

– Oracle9i Development Kit 

• Oracle Call Interface (OCI) 

– (Windows) Oracle Windows Interfaces

• Oracle Services for Microsoft Transaction Server

– Oracle9i Documentation (recommended)

• For Oracle 10g, choose the following from the list of available product components. 

– Oracle10g Server

– Oracle Net Services

• Oracle Net Listener

– Oracle Call Interface (OCI) 

– (Windows) Oracle Windows Interfaces

• Oracle Services for Microsoft Transaction Server

– Oracle10g Documentation (recommended)

• If you are going to install Process Engine on this machine, verify/add/edit/uncomment the following 
lines in the file sqlnet.ora (create the file if it doesn’t exist) while the Oracle services/processes are 
stopped:

NAMES.DIRECTORY_PATH=(TNSNAMES)
SQLNET.AUTHENTICATION_SERVICES=(NTS)
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NOTE  If Oracle is configured to use LDAP, TNSNAMES must appear in the names_directory_path 
ahead of LDAPNAMES.

sqlnet.ora is typically in $ORACLE_HOME/network/admin on UNIX or 
ORACLE_HOME\network\admin on Windows operating systems.

1. Install the latest Oracle patch sets, as specified in the IBM FileNet P8 Hardware and Software Require-
ments.

2. Start the listener and the Oracle database service/processes (Windows/UNIX) if they haven't started 
automatically.

Create an Oracle database

Oracle documentation describes several ways to create a database. IBM recommends you use the 
Database Configuration Assistant (DBCA). 

IBM FileNet requires the following settings: 

• Database configuration type

If this database is dedicated to Content Engine, or if it will be shared by Content Engine and 
Process Engine, then Transaction Processing (also known as OLTP) is the required 
configuration type.

• Server process type

Dedicated Server Mode 

• Database character set

Choose a database character set as specified in “IBM FileNet P8 Database Character Sets” on 
page 372.

3. On the Creation Options screen, click Create Database.

Create tablespaces for Content Engine

Using Oracle Enterprise Manager or SQL*Plus, create a user, password, and default tablespace in the 
Oracle database for each object store that Content Engine will access. Grant CONNECT and RESOURCE 
roles to the user. These two roles combine to include the minimal privileges required by Content Engine: 
CREATE SESSION, CREATE TABLE, and CREATE SEQUENCE. IBM FileNet Enterprise Manager will 
prompt you for this user and password when you create an object store corresponding to the default 
tablespace.

NOTE  Because these two roles include other privileges as well, IBM recommends that you design your 
own roles if you prefer to grant only the minimal privileges required by Content Engine.

WARNING  The Oracle user you create for an object store must be unique. That is, multiple object stores 
must not share the same Oracle user. Otherwise, the objects you intend to add only to one object store will 
show up in all object stores that share the same Oracle user.

Tablespace names used by Content Engine can contain only alphanumeric and underscore characters. 
Names must start with an alphabetic character and must be at most 18 characters long.

For performance reasons, IBM recommends that you specify locally managed, instead of dictionary 
managed, tablespaces. (The tablespaces you create via Oracle Enterprise Manager are locally managed 
by default.)
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The following table shows the recommended minimum sizes of the permanent and temporary tablespaces 
for each object store that Content Engine will access. (The tablespace names shown in the table are 
arbitrary.)

If you are not using Oracle Enterprise Manager to create the user and tablespaces, refer to “Set Up Oracle 
tablespaces manually” on page 367 for examples on how to use SQL commands to manually create the 
user and the permanent and temporary tablespaces for an object store.

Create tablespaces for Process Engine

Using Oracle Enterprise Manager or SQL*PLus, create the tablespaces shown in the following table for the 
Process Engine. Note that the indexing tablespace (vwindex_ts) is optional. Tablespace names used by 
Process Engine can contain only alphanumeric and underscore characters. Names must start with an 
alphabetic character and must be at most 18 characters long.

The recommended tablespace names, types, and minimum sizes are shown in the following table:

NOTE If you don't create vwindex_ts, vwdata_ts will be used for indexes.

Tablespace Name Tablespace Type Minimum Size (MB) Description

test1 Permanent 200 Permanent 
tablespace for object 
store

temptest1 Temporary 400 Temporary 
tablespace for object 
store.

Tablespace Name Tablespace Type Minimum Size (MB) Description

vwdata_ts Permanent 200 Default name of the 
dedicated FileNet 
default tablespace

vwtemp_ts Temporary 400 Default name of the 
dedicated FileNet 
temporary 
tablespace

vwindex_ts (optional) Permanent 200 Default name of the 
optional index 
tablespace.
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Set environment variables for the Oracle and root users on UNIX database server

If your Oracle database runs on a UNIX machine, set the following environment variables in the .profile, 
.cshrc, or .login file before using the Oracle database. (On Windows, these variables are set by the Oracle 
Universal Installer.)

• For the oracle user, set the following.

– ORACLE_SID

– ORACLE_HOME

– Set PATH to $ORACLE_HOME/bin (HP-UX and 32-bit Solaris only)

– Set LD_LIBRARY_PATH to $ORACLE_HOME/lib (HP-UX and 32-bit Solaris only)

– Set LD_LIBRARY_PATH to $ORACLE_HOME/lib32 (64-bit Solaris only)

– Set LIBPATH to $ORACLE_HOME/lib32:$ORACLE_HOME/lib (AIX only)

– Set SHLIB_PATH to $ORACLE_HOME/lib32 (HP-UX only)

• For the root user, set ORACLE_HOME.

Configuring automatic transaction recovery

In a distributed database environment, Oracle MTS Recovery Service (automatically installed with Oracle 
Services for Microsoft Transaction Server) can resolve in-doubt transactions on the computer that started 
the failed transaction.

To enable automatic transaction recovery, perform the tasks shown in the section "Scheduling Automatic 
Microsoft Transaction Server Recovery" in Oracle Services for Microsoft Transaction Server Developer's 
Guide (Oracle Part Number A95496-01).

In addition, if you are using an Oracle Fail Safe configuration, perform the procedure shown in “Modifying 
Registry Values for Oracle Fail Safe Configurations” in Oracle Services for Microsoft Transaction Server 
Developer's Guide (Oracle Part Number A95496-01).

Editing the listener.ora file

IBM recommends that you use the Oracle utilities to configure the listener, which creates the listener.ora 
file. If for some reason you need to manually update the listener.ora file (for example, to change the 
database name), refer to “Set Up Oracle tablespaces manually” on page 367.
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Task 5c: Install DB2 server for Content Engine and Process Engine

This task uses 3rd-party software. Be sure to read all pertinent documentation from the 3rd-party software 
vendor. Contact your system/network/database administrator with 3rd-party vendor or environment 
questions before continuing. When this procedure has been completed, proceed to “Install DB2 Client for 
Content Engine and Process Engine” on page 77.

NOTES

• Only a remote DB2 database is supported.

• Content Engine and Process Engine do not share a database but can share the instance. Two 
databases must be created and there are different requirements for each.

• Each Process Engine server must have a dedicated instance and database.

• Content Engine and Process Engine have different requirements for DB2 users and groups.

• See “IBM FileNet P8 Database Character Sets” on page 372 for information on character set 
requirements.

IBM recommends using Database Managed Space (DMS) for user and user temp tablespaces for both 
Content Engine and Process Engine. 

IBM recommends that you record the values for the following settings as you work through the database 
installation. This information must be entered during subsequent installations of Process Engine and 
Content Engine. Be aware that Process Engine Setup allows only alphanumeric characters and 
underscores.

• DB2 Server name

• DB2 server database instance name(s) (e.g. P8_inst)

• Content Engine and Process Engine dedicated database names (e.g. VWdb)

• Dedicated tablespace names (e.g. vwdata) 

• TCP/IP port number assigned to the DB2 instance

• f_sw password (Process Engine only)

• f_maint password (Process Engine only)

• User ID and password for Content Engine DB2 user

Create DB2 users and groups 

You must create operating system users and groups to function as instance owners and the primary group 
for the instance owner. for both Content Engine and Process Engine. A fenced user and a primary group 
for the fenced user must be created for Process Engine. You may specify your own user and group names 
as long as they adhere to system naming rules and DB2 naming rules. 

• Instance Owner - one is required if the database instance is being shared by Content Engine and 
Process Engine, two instance owners are required if Content Engine and Process Engine will have 
separate database instances.

• Instance Owner primary group - one is required if the database instance is being shared by Content 
Engine and Process Engine, two instance owner primary groups are required if Content Engine and 
Process Engine will have separate database instances.
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The instance owner home directory is where the DB2 instance will be created.  

• Fenced User 

• Fenced User primary group 

The fenced user runs user-defined functions (UDFs) and stored procedures outside the address 
space used by the DB2 database.   

Each instance should have its own home file system.

Each instance owner must have a unique home directory. All of the files necessary to run the instance are 
created in the home directory of the instance owner’s user ID/username.  

The instance owner and its primary group are associated with every instance. The instance owner is 
assigned during the process of creating the instance. 

The primary group of the instance owner automatically becomes the system administration group for the 
instance and gains SYSADM authority as a database administrator (DBA) over the instance. Other user 
IDs or user names that are members of the primary group of the instance owner also gain this level of 
authority.

NOTE The root user cannot act as a DBA. You must log on as the instance owner to act as the DBA.  

When the database authentication type is set to SERVER or SERVER_ENCRYPT, two additional operating 
system users must be created for Process Engine on the database server where the DB2 database 
resides. See “Create additional DB2 users and groups (Process Engine, SERVER or SERVER_ENCRYPT 
authentication only)” on page 70.

Content Engine does not have requirements for specific users or groups to be created. Create a new 
operating system user or identify an existing operating system user to grant DB2 permissions for. This user 
ID and password will be required later when creating Object Stores. The DB2 permissions required for this 
user are:

• Permission to connect 

• Permission to create tables in the tablespace (CREATETAB)

• Permission to use the tablespace (USE OF) (for User and User Temp tablespaces)

Install DB2 ESE 

As root user, create a temporary file system with 2.0 GB of free space to contain the tar.Z and the 
uncompressed installation file.

Install the DB2 UDB Enterprise Edition. Content Engine and Process Engine both need 64-bit instances 
and a single instance can be shared.

When the installation is finished, view the status report or go to /tmp to view all DB2 install logs to ensure 
there are no errors.

Make note of the TCP/IP port number assigned to the instance or instances, as the port number will be 
needed during the DB2 client configuration steps. The port number assigned can be found in the /etc/
services file, associated with the DB2 instance(s) just created.

After a successful installation, the DB2 instance should be up and running. Continue with the next section.

Create DB2 instance(s)

Content Engine and Process Engine can share an instance, or each engine can have its own instance.  
Both Content Engine and Process Engine require 64-bit instances.
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Set TCP/IP as the default protocol

Log on as the instance owner and set DB2COMM by executing:

db2set DB2COMM=tcpip

Determine Page Size and User Fields

When you create a DB2 database, you have a choice of several page sizes for your tablespace: 4 KB, 8 
KB, 16 KB, and 32 KB. The page size you choose affects the number and size of the user-defined index 
fields, and it also affects the maximum row length of the tables within that tablespace.  

The important thing to remember is that the total row length of all the fields (including system and 
user) cannot be larger than the page size. The DB2 page size you select when you create the database 
must be large enough to hold at least one complete record. DB2 cannot retrieve a partial record or spread 
a single record onto two pages.  

DB2 can, however, retrieve multiple records in one page if the page size is large enough.  

Create the DB2 Databases for Content Engine and Process Engine

Log on as the database instance owner as defined earlier.

The database name needs to be unique and from 1 to 8 characters long. For example, VWdb This is the 
default database name in the Process Engine installer.    

Create the DB2 Tablespace

Create additional DB2 users and groups (Process Engine, SERVER or SERVER_ENCRYPT 
authentication only)

Create the following two additional operating system users with SYSADM authority to access the DB2 
database.

• f_sw

– Primary runtime Process Engine database user.

– Used only by the Process Engine software to access the DB2 database.

IBM
Recommended 
Tablespace Name

Actual
Assigned Name

Minimum
Size (MB)

Actual
Created Size

Minimum
Page Size (KB)

vwdata_ts
(for PE)

200 8 (recommended)

cedata_ts
(for CE)

256 32 (required)

user temporary ts
(for CE)

40 32 (required)

system temporary ts
(for CE)

40 32 (required)
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– Must be a member of operating system group having SYSADM authority of the DB2 instance that 
will be used by the Process Engine software.

• f_maint

– Process Engine Database maintenance user.

– Mainly used by the customer for database maintenance.

– Recommended to be member of group having SYSADM authority of the DB2 instance that will be 
used by the Process Engine software.

Unlike the instance owner user, these users don’t need to have separate file systems for their home 
directories. They must belong to the primary group of the instance owner.  

After creating the new users and setting their group memberships, log off as root user, log on as each of 
the new users, and change the password to avoid connection problems the first time they’re used.

Grant database permissions for f_sw and f_maint (Process Engine, CLIENT authentication only)

If you will be using DB2 client authentication, the f_sw and f_maint users do not exist on the database 
server but will need to be created on the client. These two users will need to be granted the following 
permission in the DB2 database for Process Engine.

• f_sw

• Primary runtime PE database user.

• Used only by the PE software to access the DB2 database.

• Must be granted the following permissions in the DB2 database:

– Connect

– Createtab

– Bindadd

– db2set DB2_SNAPSHOT_NOAUTH=on

• f_maint

• Process Engine Database maintenance user.

• Mainly used by the customer for database maintenance.

• Must be granted the following permissions in the DB2 database:

– dbadm

– db2set DB2_SNAPSHOT_NOAUTH=on
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Task 6a: Install MS SQL Server Client software for IBM FileNet P8

This task uses 3rd-party software. Be sure to read all pertinent documentation from the 3rd-party software 
vendor. Contact your system/network/database administrator with 3rd-party vendor or environment 
questions before continuing.

NOTES

• Microsoft SQL Server should have been installed on either the computer where the Process Engine or 
the Content Engine software will be installed (subsequently referred to as a local database) or on a 
separate server (subsequently referred to as a remote database). 

• Remote MS SQL Server databases are supported by Process Engine, Content Engine, Rendition 
Engine, and Publishing Plug-in Server (Content Engine server).

• Remote MS SQL connections for Rendition Engine and Content Engine are handled by Microsoft Data 
Access Components, which is installed by default on IBM FileNet Enterprise Manager, and Rendition 
Engine servers.

• The Microsoft SQL Server must be in the same Active Directory forest if you want to use Windows 
authentication for connecting to the SQL Server database instance. Otherwise, if using SQL 
Authentication, there is no need to be in the same forest.

To install MS SQL Server Client software for remote MS SQL database access

Ensure that all users and groups defined on the local server are also defined and granted security 
permissions on the database server.

1. Install the MS SQL Server Client software, the MS SQL Server Service Pack, and test the database 
communications.

a. Log on with an account that has local administrator privileges on the computer where the MS SQL 
Server client software will be installed.

b. Install the MS SQL Server Client software using the following options: 

i. On the Installation Selection dialog, choose Create a new instance of SQL Server, or install 
Client Tools. 

ii. On the Installation Definition dialog, choose Client Tools Only. 

iii. Accept the defaults for the rest of the installation. 

c. When the installation is complete, (for Windows 2000) click Start > Programs > Microsoft SQL 
Server > Client Network Utility or (for Windows 2003) click Start > All Programs > Microsoft 
SQL Server > Client Network Utility.

d. On the DB-Library Options tab, de-select Automatic ANSI to OEM conversion. 

e. Download and install the required Microsoft SQL Server 2000 Service Pack, as indicated in the 
IBM FileNet P8 Hardware and Software Requirements.
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To configure Process Engine or Content Engine to use an MS SQL Server database engine on a 
different subnet

Remote MS SQL Server databases on different subnets are supported by the Process Engine and Content 
Engine servers. 

1. On the server that has MS SQL Server installed, determine the TCP/IP port assignment of the MS 
SQL Server instance.

2. Open the MS SQL Server Client Network Utilities application on the Process Engine or Content Engine 
server.

3. Select the DB-Library Options tab, de-select Automatic ANSI to OEM conversion. 

4. Select the Alias tab and click the Add button.

5. Select the TCP/IP option from the Network libraries.

6. Uncheck the Dynamically determine port option.

7. Enter the Server alias: (e.g., <machine_name>\<instance_name>)

8. Enter the Server name: (e. g., <machine_name>\<instance_name>)

9. Enter the Port number determined during setup.

Test the connection between the MS SQL Server Client installation and the remote database engine

If the MS SQL Server Client software was installed, test the connection by entering the following at a 
command prompt:

isql -E -S <servername>[\<instance_name>]

or

isqlw -E -S <servername>[\<instance_name>]

If the connection fails, be sure to resolve the problem before proceeding.

If the MS SQL Client software was not installed, test the connection per the following steps.

1. Create a file named test.udl on the Desktop or in a file system.

2. Run test.udl.

3. Select the OLEDB provider for MS SQL Server from the Provider tab.

4. Click on the Connection tab and choose the appropriate information.
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Task 6b: Install Oracle Client for IBM FileNet P8

The procedure in this task describe how to install the Oracle Client software to prepare for the installation 
of Content Engine, Process Engine, or Rendition Engine.

NOTES

• Install Oracle Client on any machine that will host Content Engine, Process Engine, Rendition Engine, 
or any other IBM FileNet P8 component that needs to access an Oracle database.

• Make sure that the machine where you will install Oracle Client satisfies all pre-installation 
requirements specified in the Oracle installation documentation.

• The Process Engine installer must log in to Oracle using SYS as SYSDBA credentials. Because 
Oracle 9i disables remote SYS login by default, a DBA must change this before the installation can 
take place. Modify init.ora to allow remote SYS login.

• If you will be installing Process Engine on a UNIX machine hosting Oracle Client software, be sure that 
the value of the Oracle environment variable ORACLE_HOME (the pathname for the Oracle Client 
software) is a string of at most 53 characters. If the string has more than 53 characters, the Process 
Engine installer will not find the Oracle software, causing the installation to fail.

• For operating-system Service Pack and Oracle version and patch set requirements, see the IBM 
FileNet P8 Hardware and Software Requirements.

For information regarding installation of Oracle Client and Rendition Engine, see FileNet P8 
Documentation > FileNet P8 System Installation > Rendition Engine Installation and Upgrade.

To install the Oracle client

The following procedure shows the minimal choices (specific to the needs of Process Engine) for 
installing a database client. Consult the Oracle9i or Oracle 10g installation documentation for 
complete preinstallation requirements and instructions. From the Available Products screen, click 
Oracle9i Client.

1. For Oracle 9i, choose the following from the list of available product components. 

• Oracle9i Client

• Oracle Network Utilities

• Oracle Database Utilities

• SQL*PLUS

• (Windows) Oracle Windows Interfaces

• Oracle Services for Microsoft Transaction Server

2. For Oracle 10g, choose the following from the list of available product components.

• Oracle10g Client

• Oracle Network Utilities 

• Oracle Database Utilities

• SQL*PLUS
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• (Windows) Oracle Windows Interfaces

• Oracle Services for Microsoft Transaction Server

3. Using Oracle Net Configuration Assistant, test the connection to the Oracle database server with an 
appropriate Oracle user and password.

NOTE If the database is to be used by Rendition Engine, you can also configure the connection to the 
database from the Database Configuration tab of the Vista Configuration application. For more 
information, see the topics under  FileNet P8 Documentation > FileNet P8 System Installation > 
Rendition Engine Installation and Upgrade. 

4. If you are going to install Process Engine software on this machine, and your remote Oracle database 
uses the Unicode character set AL32UTF8, then for each user who will access Process Engine 
software on the machine, set the value of the Oracle environment variable parameter NLS_LANG to 
reflect the PE-supported locale and (non-Unicode) character set on the machine.

• (Windows) Set/modify the value of the NLS_LANG key via System Properties in the Control Panel.

• (UNIX) Add NLS_LANG to the shell environment login files for each user who will be logging onto 
the machine to run IBM FileNet P8 software.

NOTE To affect the environment for only Process Engine, set NLS_LANG for just the fnsw user. (On 
Windows platforms, fnsw is created by the Process Engine installer; on UNIX platforms, you manually 
create fnsw as part of the Process Engine installation task.)

5. If you are going to install Process Engine software on this machine to connect to a remote Oracle 
database, set the value of an environment variable for the oracle user to a default connect identifier, 
such as the Oracle net service name or the database service name. The name of the environment 
variable depends on which operating system is on this machine:

• (Windows) LOCAL

• (UNIX) TWO_TASK

6. If you are going to install Process Engine software on a UNIX machine to connect to a remote Oracle 
database, set the following environment variables in the startup file of the default oracle user.

• ORACLE_SID

• ORACLE_HOME

• Set PATH to $ORACLE_HOME/bin (HP-UX and 32-bit Solaris only)

• Set LD_LIBRARY_PATH to $ORACLE_HOME/lib (HP-UX and 32-bit Solaris only)

• Set LD_LIBRARY_PATH to $ORACLE_HOME/lib32 (64-bit Solaris only)

• Set LD_LIBRARY_PATH_64 to $ORACLE_HOME/lib (64-bit Solaris only)

• Set LIBPATH to $ORACLE_HOME/lib32:$ORACLE_HOME/lib (AIX only)

• Set SHLIB_PATH to $ORACLE_HOME/lib32 (HP-UX only)

7. If you are going to install Process Engine on this machine, verify/add/edit/uncomment the following 
lines in the file sqlnet.ora (create the file if it doesn’t exist) while the Oracle services/processes are 
stopped:

NAMES.DIRECTORY_PATH=(TNSNAMES)
SQLNET.AUTHENTICATION_SERVICES=(NTS)
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sqlnet.ora is typically in $ORACLE_HOME/network/admin on UNIX or 
ORACLE_HOME\network\admin on Windows operating systems.

8. Install all required Oracle patches, as specified in the IBM FileNet P8 Hardware and Software 
Requirements. These patches are available at OracleMetaLink.

http://metalink.oracle.com
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Task 6c: Install DB2 Client for Content Engine and Process Engine

This task uses 3rd-party software. Be sure to read all pertinent documentation from the 3rd-party software 
vendor. Contact your system/network/database administrator with 3rd-party vendor or environment 
questions before continuing.

NOTES

In this task you will:

• Install and configure the DB2 client software 

• Create several operating system users 

• Create a client instance to connect to the remote DB2 server instance (Process Engine, UNIX only)

Before starting this task you will need the following information:

• The database names on the remote database server for both Content Engine and Process Engine 
databases

• The TCP/IP port number(s) for the remote database instance(s) 

• The passwords assigned to the f_sw and f_maint users (Process Engine only)

• The username and password of the operating system user on the database server (Content Engine 
only)

Make note of the database aliases created in this task as they will be needed in the Content Engine and 
Process Engine installation steps: 

• In Process Engine setup, this information will be entered in response to the prompt for the database 
alias name.  

• In the Content Engine Object Store Creation Wizard, this information will be entered in response to the 
prompt for the database alias name.  

Install DB2 Client software

To install the DB2 Client, you must be logged on as root user (UNIX) or as Administrator (Windows).   

Install the DB2 Administration Client or the DB2 Run-Time Client. Content Engine and Process Engine 
both need 32-bit instances and a single client instance can be shared. 

NOTE On Windows, an instance is automatically created during installation of the client software.

When the installation is finished, view the status report or go to /tmp (UNIX) or \My Documents\DB2log 
(Windows) to view all DB2 install logs to ensure there are no errors. 

Reboot the Content Engine DB2 client.

Create DB2 Users and Groups (Process Engine, UNIX only)

Operating system users and groups must be created for the client instance on UNIX platforms only. Two 
users and two groups are required to create and use DB2 client instance for Process Engine on a UNIX 
platform. You may specify your own user and group names as long as they adhere to system naming rules 
and DB2 naming rules. 

• Instance Owner - one is required for Process Engine.

• Instance Owner primary group - one is required for Process Engine.
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The instance owner home directory is where the DB2 instance will be created.  

• Fenced User - Process Engine only

• Fenced User primary group - Process Engine only

The fenced user runs user-defined functions (UDFs) and stored procedures outside the address 
space used by the DB2 database.   

Each instance should have its own home file system.

Each instance owner must have a unique home directory. All of the files necessary to run the instance are 
created in the home directory of the instance owner’s user ID/username.  

The instance owner and its primary group are associated with every instance. The instance owner is 
assigned during the process of creating the instance. 

The primary group of the instance owner automatically becomes the system administration group for the 
instance and gains SYSADM authority as a database administrator (DBA) over the instance. Other user 
IDs or user names that are members of the primary group of the instance owner also gain this level of 
authority.

NOTE The root user cannot act as a DBA. You must log on as the instance owner to act as the DBA.  

When the database authentication type is set to SERVER or SERVER_ENCRYPT, the following two 
additional operating system users must be created on the database server where the DB2 database 
resides.  

Create instances (Process Engine, UNIX only)

Depending upon your configuration, create one or more 32-bit instances as required.

Create additional DB2 users and groups (Process Engine, CLIENT authentication only)

Create the following two additional operating system users with SYSADM authority to access the DB2 
database.

• f_sw

– Primary runtime Process Engine database user

– Used only by the Process Engine software to access the DB2 database.

• f_maint

– Process Engine Database maintenance user

– Mainly used by the customer for database maintenance

Unlike the instance owner user, these users don’t need to have separate file systems for their home 
directories.  

After creating the new users and setting their group memberships, log off as root user, log on as each of 
the new users, and change the password to avoid connection problems the first time they’re used.

Catalog the DB2 server node

Reboot the server and log on as the instance owner on the Process Engine or Content Engine. 

Use the db2ca tool, or catalog the DB2 server node as follows:

db2 catalog tcpip node <server alias> remote <server name> server <server side instance tcpip port 
#>
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For example: 

db2 catalog tcpip node aix20nod remote hqvwais20 server 60004

Catalog the Content Engine and Process Engine databases

Use the db2ca tool, or create aliases for the DB2 database.

For example:

db2 catalog database PEDBAIX at node aix20nod [as <alias name>]

db2 catalog database CEDBAIX at node aix20nod [as <alias name>]

Verify the connection to the DB2 database

Since the DB2 database is located on a remote server, verify that TCP/IP communications have been 
configured successfully on both server and client computers.  

You can use the DB2 Configuration Assistant on a Windows client(enter db2ca at a command prompt) to 
connect the DB Client to the DB2 database on the remote database server. You can also use db2 at a 
command prompt.

Verify the ability to log on to the DB2 database

After successfully connecting to the remote DB2 database, you can check the connection using either the 
Command Line Processor (CLP) or db2. Launch the Command Line Processor and enter for example:  

> db2=> connect to <db_alias_name> user f_sw using <f_sw password>

or from a command prompt using db2 :

> db2 connect to <db_alias_name> user f_sw using <f_sw password>
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Installation Tasks

To install the core IBM FileNet P8 Platform components

1. Install the IBM FileNet P8 Platform documentation for your application server. Do one of the following:

• Task 7a on page 81 (WebSphere)

• Task 7b on page 86 (WebLogic)

• Task 7c on page 92 (JBoss)

• Task 7d on page 97 (Tomcat)

• Task 7e on page 102 (Oracle Application Server)

• Task 7f on page 107 (Sun Java Application Server)

2. Set up Content Engine.

a. Install Content Engine. Do one of the following:

• Task 8a on page 112 (typical install)

• Task 8b on page 127 (custom install)

b. Configure the Content Engine environment. Do Task 9 on page 145.

c. Create an Object Store. Do Task 10 on page 147.

3. Set up Process Engine.

a. Install Process Engine. Do one of the following:

• Task 11a on page 155 (Windows 2000)

• Task 11b on page 167 (Sun Solaris)

• Task 11c on page 179 (AIX)

• Task 11d on page 191 (HP-UX)

b. Start the Pooled Process Manager (PPM). Do Task 12 on page 203.

c. Configure the LDAP connection. Do Task 13 on page 204.

4. Install Application Engine. Do Task 14 on page 205.

5. Set up Application Engine. Do one of the following:

• Task 15a on page 213 (WebSphere)

• Task 15b on page 220 (WebLogic)

• Task 15c on page 223 (JBoss/Tomcat)

• Task 15d on page 228 (Oracle Application Server)

• Task 15e on page 231 (Sun Java Application Server)

• Task 15f on page 234 (generic server)

6. Install Service Packs and associated Hot Fix Packs. Do Task 16 on page 236. 
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Task 7a: Install IBM FileNet P8 Platform documentation (WebSphere)

This topic covers the installation, and (if necessary) search-related reindexing of your IBM FileNet P8 
Platform documentation on a WebSphere application server. Because the IBM FileNet P8 Platform 

documentation includes a JavaTM-based full-text search engine, it runs as a web-based application.

You must install the IBM FileNet P8 Platform documentation on a web application server if you intend to 
access online help from within any IBM FileNet P8 applications (for example, Workplace, Enterprise 
Manager, Process Task Manager, and Records Manager) or use the full-text search feature. 

NOTES 

• You may install the IBM FileNet P8 Platform documentation and Application Engine on the same 
machine.

• To ensure proper documentation search functionality, enable JavaScriptTM support on the user's 
browser client. 

• Because of the number of possible network and web configurations, contact your network or web 
administrator for specific system, software, and security requirements.

• Under WebSphere, IBM FileNet P8 documentation must be installed and deployed as a WAR file 
(ecm_help.war).  You cannot deploy as an EAR file because in that case the IBM FileNet P8 help 
remains packaged and the internal documentation search engine will not function as expected.  

• The requirements described in this topic may also exist for associated custom application help, or for 
any customizations you may have applied to the IBM FileNet P8 Platform documentation. This 
documentation requirement may also exist for associated custom applications. For further details on 
customizing or localizing IBM FileNet P8 Platform documentation, see the file ecm_help/transkit/
P8DocTransKit.htm on the IBM FileNet P8 Platform Documentation CD or wherever you install the IBM 
FileNet P8 Platform documentation.

• If you are upgrading your IBM FileNet P8 Platform installation and have downloaded a refresh of the 
documentation from the IBM support website, see “Upgrade IBM FileNet P8 Platform Documentation” 
on page 306 for instructions on upgrading the documentation.

Overview of procedures

Perform the procedures in the following subtopics in the order presented, unless otherwise directed below:

• “Install IBM FileNet P8 Platform documentation” on page 82 -- Begin here if you are installing the IBM 
FileNet P8 Platform documentation for the first time. 

• “Install functional expansion documentation” on page 82 -- Begin here if you have already installed the 
IBM FileNet P8 Platform documentation and need to add on the documentation for IBM FileNet 
functional expansions (e.g., Process Analyzer, Process Simulator, IBM FileNet eForms, Content 
Federation Services for Image Services, Records Manager, Web Content Manager, Team 
Collaboration Manager, or IBM FileNet P8 Portlets).

•  “Update documentation search index” on page 83 -- Perform this procedure only after you have added 
on documentation for your functional expansions. Otherwise, if you install only IBM FileNet P8 Platform 
documentation, which has a baseline search index, you may skip this procedure.

• “Complete and verify the documentation installation” on page 84 -- Perform this final procedure in all 
cases, but only after you have installed the IBM FileNet P8 Platform documentation, added on 
documentation for your functional expansions, and (where required) regenerated the search index.
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Install IBM FileNet P8 Platform documentation

This procedure establishes the web application for documentation associated with IBM FileNet P8 
Platform. It assumes that your WebSphere application server is already installed and operational. 

To install the IBM FileNet P8 Platform documentation

1. If this is a Windows server, verify that Microsoft Windows Internet Information Services (IIS Admin Ser-
vice, Simple Mail Transport Protocol (SMTP), and World Wide Web Publishing Service) are stopped 
and set to manual. 

NOTE Skip this step if the application server will contain Content Engine software.

2. Insert or mount the IBM FileNet P8 Platform Documentation CD, as follows:

(UNIX) Insert and mount the IBM FileNet P8 Platform Documentation CD.

(Windows) Insert the IBM FileNet P8 Platform Documentation CD.

3. From the WebSphere Administrative Console, Install a New Application using the ecm_help.war file 
located on the Documentation CD. Follow all WebSphere installation screens.

NOTE  The Context Root (def: ecm_help) and installation directory can be user-defined, so 
substitute your actual location for these commands.

4. Continue as follows:

• If you need to install documentation for functional expansions, go on to the procedure in the follow-
ing topic, “Install functional expansion documentation” on page 82.

• If you have no further documentation to install, go on to the procedure in the topic “Complete and 
verify the documentation installation” on page 84.

Install functional expansion documentation

Use the procedure in this topic to install documentation for functional expansions onto an existing IBM 
FileNet P8 Platform documentation server. If you have no such documentation to add on, skip to the 
procedure “Complete and verify the documentation installation” on page 84.

To install functional expansion documentation

1. Determine the functional expansion documentation media source or location:

• For most functional expansions, use the Documentation CD included as part of the particular soft-
ware's CD set.

• For Content Federation Services for Image Services, use the Documentation directory on the 
software CD.

2. If the IBM FileNet P8 Platform documentation application is running, stop it on the machine where the 
documentation is installed, and verify that no processes are accessing the documentation web 
application. On UNIX or Windows, stop the application from the Administrative Console.

3. Copy the functional expansion documentation to the IBM FileNet P8 Platform documentation server, 
as follows:

• (UNIX) When copying functional expansions, use a cp copy command from a terminal to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help direc-
tory installed on the existing IBM FileNet P8 Platform documentation server.
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cp -R <mount_location> <target_destination>

WARNING  Care should be taken when copying folders in UNIX. Dropping-and-dragging of folders 
‘replaces’ any existing folder(s). Also note that your switch (-R) requirements may be different from 
the example shown. Contact your system administrator if you have questions about proper syntax.

• (Windows) Use a copy command from a command prompt or drop-and-drag the files to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help directory 
installed on the existing IBM FileNet P8 Platform documentation server.

• (Content Federation Services for Image Services) Copy the cfs_guide.pdf from the Documenta-
tion directory on the software CD into the ecm_help/cfs_help directory deployed on the existing 
IBM FileNet P8 Platform documentation server.

NOTE  Repeat this step for each of your functional expansions or custom applications. You can copy 
more than one functional expansion documentation set to the documentation application server before 
continuing (e.g., eForms and WCM) so you end up with one ecm_help directory containing multiple 
sets of functional expansion files added in.

4. Download the latest web-posted updates of installation and upgrade guide PDFs for the various 
functional expansion documentation (as well as IBM FileNet P8 Platform) to the ecm_help/
installation directory. 

5. Go on to the procedure in the following topic, “Update documentation search index” on page 83.

Update documentation search index

Perform this procedure only if you have refreshed the core IBM FileNet P8 Platform documentation, or 
installed functional expansion documentation onto your IBM FileNet P8 Platform documentation server. 
Otherwise, skip to the procedure in the following topic, “Complete and verify the documentation installation” 
on page 84.

NOTE  Any time you update the documentation search index, a backup of the files in the existing 
Index\core directory will be automatically copied to the Index\IndexOld subdirectory. You can reapply 
these backed-up files to the core subdirectory (after first removing the new files created there) if you need 
to return to your previous indexed state.

To update the documentation search index 

1. If the IBM FileNet P8 Platform documentation application is running, stop the application from the 
Administrative Console on the machine where the documentation is installed, and verify that no pro-
cesses are accessing the documentation application.

NOTE  Make sure you have copied the help for all your various functional expansions to a designated 
application server location containing the IBM FileNet P8 Platform documentation. Otherwise, you will 
have to repeat this procedure if you add new help later.

2. Open a command prompt (or terminal) on the application server.

3. From the command prompt or terminal, navigate to the search subdirectory under your ecm_help root 
directory.
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4. Using a text editor, open the search-indexing script file that is appropriate to your application server 
operating system.

NOTE  You may need to set the permissions on this file as it is set to read-only on the CD.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

5. If necessary, set the JAVA_HOME variable in the script file with the path to your JRE installation. The 
default examples are:

(UNIX) JAVA_HOME="/usr/java/j2sdk1.4.1_02"

(Windows) SET JAVA_HOME=c:\j2sdk1.4.2

NOTE  The JavaTM Run Time Environment (JRE) installation subdirectory can be user-defined, so 
substitute your actual location, as appropriate.

6. Save your changes and close the text editor.

NOTE  If you intend to run the search indexer on a UNIX application server, ensure that you add 
execute permissions (chmod 755) to the indexFiles.sh file.

7. Run the following updated search-indexing script file that is appropriate to your application server 
operating system.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

8. NOTE  As you run the search-indexing script, you may notice periodic Parse Abort errors. You can 
ignore these error conditions, as they are benign and do not affect the overall indexing process.

9. Go on to the next procedure.

Complete and verify the documentation installation

Perform this procedure after you have installed (and, if necessary, reindexed) the IBM FileNet P8 Platform 
documentation on the application server.

To complete and verify the WebSphere documentation installation 

1. Start the IBM FileNet P8 Platform documentation application from the Administrative Console.

2. Verify that the application server and the new IBM FileNet P8 Platform documentation web site are 
running, as follows:

a. From your web browser, access the following URL. The documentation's Help Directory should 
open.

http://<docserver>:<port#>/<contextRoot>/

where:

docserver is the name of the Java web server.

port# is the port number (def: 9080).
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contextRoot is the value of the Map to URL field that you specified when you deployed the 
IBM FileNet P8 Platform documentation application. If you specified /ecm_help, then the 
contextRoot is ecm_help.

Example: http://yourdocserver:9080/ecm_help/

NOTE  You can use multi-part root folders (e.g., /docs/ecm_help) if your application server 
supports them.

b. Click the Search link on the Help Directory toolbar. The documentation Search page should open.

c. Select one of the Search query result links. The associated help page should open.

NOTE  When it is time to configure the online help location for the various IBM FileNet P8 components, 
either while running Setup programs or later via site preferences settings, use the URL in Step a on 
page 84.
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Task 7b: Install IBM FileNet P8 Platform documentation (WebLogic)

This topic covers the installation, and (if necessary) search-related reindexing of your IBM FileNet P8 
Platform documentation on a WebLogic application server. Because the IBM FileNet P8 Platform 
documentation includes a Java-based full-text search engine, it runs as a web-based application.

You must install the IBM FileNet P8 Platform documentation on a web application server if you intend to 
access online help from within any IBM FileNet P8 applications (for example, Workplace, Enterprise 
Manager, Process Task Manager, and Records Manager) or use the full-text search feature.

NOTES 

• You may install the IBM FileNet P8 Platform documentation and Application Engine on the same 
machine.

• To ensure proper documentation search functionality, enable JavaScript support on the user's browser 
client. 

• Because of the number of possible network and web configurations, contact your network or web 
administrator for specific system, software, and security requirements.

• The requirements described in this topic may also exist for associated custom application help, or for 
any customizations you may have applied to the IBM FileNet P8 Platform documentation. This 
documentation requirement may also exist for associated custom applications. For further details on 
customizing or localizing IBM FileNet P8 Platform documentation, see the file ecm_help/transkit/
P8DocTransKit.htm on the IBM FileNet P8 Platform Documentation CD or wherever you install the IBM 
FileNet P8 Platform documentation.

• If you are upgrading your IBM FileNet P8 Platform installation and have downloaded a refresh of the 
documentation from the IBM website support page, see “Upgrade IBM FileNet P8 Platform 
Documentation” on page 306 for instructions on upgrading the documentation.

• Under WebLogic, IBM FileNet P8 documentation must be installed and deployed as a flat-file directory 
(\ecm_help). You cannot deploy as a WAR file or EAR file because, in both cases, the IBM FileNet P8 
help remains packaged and the internal documentation search engine will not function as expected.  

• For WebLogic application server, you cannot directly deploy from the CD. Therefore, you must first 
copy the IBM FileNet P8 Platform documentation files from the CD to the PC where WebLogic is 
running, as described in this procedure.

Overview of procedures

Perform the procedures in the following subtopics in the order presented, unless otherwise directed below:

• “Install the IBM FileNet P8 Platform documentation” on page 87 -- Begin here if you are installing the 
IBM FileNet P8 Platform documentation for the first time. 

• “Install functional expansion documentation” on page 88 -- Begin here if have already installed the IBM 
FileNet P8 Platform documentation and need to add on the documentation for IBM FileNet functional 
expansions (e.g., Process Analyzer, Process Simulator, IBM FileNet eForms, Content Federation 
Services for Image Services, Records Manager, Web Content Manager, Team Collaboration Manager, 
or IBM FileNet P8 Portlets).

•  “Update the documentation search index” on page 89 -- Perform this procedure only after you have 
added on documentation for your functional expansions. Otherwise, if you install only IBM FileNet P8 
Platform documentation, which has a baseline search index, you may skip this procedure.
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• “Complete and verify the documentation installation” on page 90 -- Perform this final procedure in all 
cases, but only after you have installed the IBM FileNet P8 Platform documentation, added on 
documentation for your functional expansions, and (where required) regenerated the search index.

Install the IBM FileNet P8 Platform documentation

This procedure establishes the web application for documentation associated with IBM FileNet P8 
Platform. It assumes that your WebLogic application server is already installed and operational.

To install the IBM FileNet P8 Platform documentation

1. For WebLogic software version 7.0.x, perform the following steps. For other versions of the software, 
continue to Step 2.

a. Make a backup copy of the startup script, open it in a text editor, and add the following JARs to the 
CLASSPATH statement.

(UNIX) startWLS.sh

• <install_location>/ecm_help/WEB-INF/lib/lucene-1.4.2.jar

• <install_location>/ecm_help/WEB-INF/lib/lucene-demos-1.4.2.jar

• <install_location>/ecm_help/WEB-INF/lib/filenet.jar

(Windows) startWLS.cmd

• <install_location>\ecm_help\WEB-INF\lib\lucene-1.4.2.jar

• <install_location>\ecm_help\WEB-INF\lib\lucene-demos-1.4.2.jar

• <install_location>\ecm_help\WEB-INF\lib\filenet.jar

b. Save and close the startWLS.sh or startWLS.cmd file.

2. If this is a Windows server, verify that Microsoft Windows Internet Information Services (IIS Admin 
Service, Simple Mail Transport Protocol (SMTP), and World Wide Web Publishing Service) are 
stopped and set to manual. 

NOTE Skip this step if the application server will contain Content Engine software.

3. Insert or mount the IBM FileNet P8 Platform Documentation CD, as follows:

(UNIX) Insert and mount the IBM FileNet P8 Platform Documentation CD.

(Windows) Insert the IBM FileNet P8 Platform Documentation CD.

4. Copy the IBM FileNet P8 Platform documentation files from the CD to the computer where WebLogic 
application server is running. Note that the location you choose will be the directory from which 
WebLogic deploys the documentation application. If you later add functional expansion 
documentation, then you will perform that task from the deployment directory that you choose now.

• If running WebLogic application server on a local PC, copy the expanded ecm_help directory 
structure from the CD to the PC.

• If running WebLogic application server on a remote PC on the network, we recommend that you 
copy the ecm_help.war file from the CD to the PC, then extract the files to the ecm_help direc-
tory.

5. Deploy the IBM FileNet P8 Platform documentation application using the procedure applicable to your 
version of WebLogic.
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WebLogic software version 7.0.x

a. From the WebLogic Server Console, click <mydomain> > Deployments > Web Application 
Modules.

b. Click Configure a new Web Application Module.

c. From the right pane of the WebLogic Server Console, browse to and select ecm_help.

d. Select <myserver> from Available Servers and click the right-arrow button so the <myserver> 
becomes the target server. Verify that the Application Name is ecm_help.

e. Click Configure and Deploy.

WebLogic software version 8.1.x

a. From the WebLogic Server Console, click <mydomain> > Deployments > Web Application 
Modules.

b. Click Deploy a new Web Application Module....

c. From the right pane of the WebLogic Server Console, browse to and select the radio button for the 
ecm_help folder.

d. Click Target Module.

e. Click Deploy.

6. Continue as follows:

• If you need to add on documentation for functional expansions, go on to the procedure in the fol-
lowing topic, “Install functional expansion documentation” on page 88.

• If you have no further documentation to install, then go on to the procedure in the topic “Complete 
and verify the documentation installation” on page 90.

Install functional expansion documentation

Use the procedure in this topic to install documentation for functional expansions into an existing IBM 
FileNet P8 Platform documentation application. If you have no such documentation to add on, skip to the 
procedure “Complete and verify the documentation installation” on page 90.

To install functional expansion documentation

1. Determine the documentation media source or location:

• For most functional expansions, use the Documentation CD included as part of the particular soft-
ware's CD set.

• For Content Federation Services for Image Services, use the Documentation directory on the 
software CD.

2. Identify the directory where you deployed the IBM FileNet P8 Platform documentation application. This 
is the directory location where you copied the expanded ecm_help, or extracted ecm_help.war to the 
ecm_help directory.

3. Stop the WebLogic server where you deployed the IBM FileNet P8 Platform documentation 
application.
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4. Copy the functional expansion documentation to the IBM FileNet P8 Platform documentation 
application, as follows:

• (UNIX) When copying functional expansions, use a cp copy command from a terminal to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help direc-
tory installed on the existing IBM FileNet P8 Platform documentation server.

cp -r <mount_location> <target_destination>

WARNING  Care should be taken when copying folders in UNIX. Dropping-and-dragging of folders 
may replace any existing folder(s). Also note that your switch (-r) requirements may be different 
from the example shown. Contact your system administrator if you have questions about proper 
syntax.

• (Windows) Use a copy command from a command prompt or drop-and-drag the files to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help directory 
installed on the existing IBM FileNet P8 Platform documentation server.

• (Content Federation Services for Image Services) Copy the cfs_guide.pdf from the Documenta-
tion directory on the software CD into the ecm_help/cfs_help directory on the IBM FileNet P8 
Platform documentation server.

NOTE  Repeat this step for each of your functional expansions. You can copy more than one functional 
expansion documentation set to the documentation application server before continuing (e.g., eForms 
and WCM) so you end up with one ecm_help directory containing multiple sets of functional 
expansion files added in.

5. Download the latest web-posted updates of installation and upgrade guide PDFs for the various 
functional expansion documentation (as well as IBM FileNet P8 Platform) to the ecm_help/
installation directory. 

6. Go on to the procedure in the following topic, “Update the documentation search index” on page 89.

Update the documentation search index

Perform this procedure only if you have refreshed the core IBM FileNet P8 Platform documentation, or 
installed functional expansion documentation onto your IBM FileNet P8 Platform documentation server. 
Otherwise, skip to the procedure in the following topic, “Complete and verify the documentation installation” 
on page 90.

NOTE  Any time you update the documentation search index, a backup of the files in the existing 
Index\core directory will be automatically copied to the Index\IndexOld subdirectory. You can reapply 
these backed-up files to the core subdirectory (after first removing the new files created there) if you need 
to return to your previous indexed state.

To update the documentation search index 

1. Make sure the WebLogic server where you deployed the IBM FileNet P8 Platform documentation 
application is stopped. For the search indexer to run, no other processes can be accessing the IBM 
FileNet P8 Platform documentation.

2. Open a command prompt or terminal on the application server.

3. From the command line, navigate to the search subdirectory under the application root directory, for 
example, ecm_help.
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4. Using a text editor, open the search-indexing script file that is appropriate to your application server 
operating system.

NOTE  You may need to set the permissions on this file as it is set to read-only on the CD.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

5. If necessary, set the JAVA_HOME variable in the script file with the path to your JRE installation. The 
default examples are:

(UNIX) JAVA_HOME="/usr/java/j2sdk1.4.1_02"

(Windows) SET JAVA_HOME=c:\j2sdk1.4.2

NOTE  The Java JRE installation subdirectory can be user-defined, so substitute your actual location, 
as appropriate.

6. Save your changes and close the text editor.

NOTE  If you intend to run the search indexer on a UNIX application server, ensure that you add 
execute permissions (chmod 755) to the indexFiles.sh file.

7. Run the following updated search-indexing script file that is appropriate to your application server 
operating system.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

NOTE  As you run the search-indexing script, you may notice periodic Parse Abort errors. You can 
ignore these error conditions, as they are benign and do not affect the overall indexing process.

8. Go on to the next procedure.

Complete and verify the documentation installation

Perform this procedure after you have installed (and, if necessary, reindexed) the IBM FileNet P8 Platform 
documentation on the application server.

To complete and verify the documentation installation 

1. If the WebLogic server where you deployed IBM FileNet P8 Platform documentation application is not 
running, start it.

2. Verify that the application server and the new IBM FileNet P8 Platform documentation web site are 
running, as follows:

a. From your web browser, access the following URL. The documentation's Help Directory should 
open.

http://<docserver>:<port#>/<contextRoot>/

where:

docserver is the name of the Java web server.

port# is the port number (def: 7001).
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contextRoot is the value of the Map to URL field that you specified when you deployed the 
IBM FileNet P8 Platform documentation application. If you specified /ecm_help, then the 
contextRoot is ecm_help.

Example: http://yourdocserver:7001/ecm_help/

NOTE  You can use multi-part root folders (e.g., /docs/ecm_help) if your application server 
supports them.

b. Click the Search link on the Help Directory toolbar. The documentation Search page should open.

c. Select one of the Search query result links. The associated help page should open.

NOTE  When it is time to configure the online help location for the various IBM FileNet P8 components, 
either while running Setup programs or later via site preferences settings, use the URL in Step a on 
page 90
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Task 7c: Install IBM FileNet P8 Platform documentation (JBoss)

This topic covers the installation, and (if necessary) search-related reindexing of your IBM FileNet P8 
Platform documentation on a JBoss application server. Because the IBM FileNet P8 Platform 
documentation includes a Java-based full-text search engine, it runs as a web-based application.

You must install the IBM FileNet P8 Platform documentation on a web application server if you intend to 
access online help from within any IBM FileNet P8 applications (for example, Workplace, Enterprise 
Manager, Process Task Manager, and Records Manager) or use the full-text search feature.

NOTES 

• You may install the IBM FileNet P8 Platform documentation and Application Engine on the same 
machine.

• A valid Java JSDK must be installed for the JBoss application server.

• To ensure proper documentation search functionality, enable JavaScript support on the user's browser 
client. 

• Because of the number of possible network and web configurations, contact your network or web 
administrator for specific system, software, and security requirements.

• The requirements described in this topic may also exist for associated custom application help, or for 
any customizations you may have applied to the IBM FileNet P8 Platform documentation. This 
documentation requirement may also exist for associated custom applications. For further details on 
customizing or localizing IBM FileNet P8 Platform documentation, see the file ecm_help/transkit/
P8DocTransKit.htm on the IBM FileNet P8 Platform Documentation CD or wherever you install the IBM 
FileNet P8 Platform documentation.

• If you are upgrading your IBM FileNet P8 Platform installation and have downloaded a refresh of the 
documentation from the IBM website support page, see “Upgrade IBM FileNet P8 Platform 
Documentation” on page 306 for instructions on upgrading the documentation.

Overview of procedures

Perform the procedures in the following subtopics in the order presented, unless otherwise directed below:

• “Install the IBM FileNet P8 Platform documentation” on page 93 -- Begin here if you are installing the 
IBM FileNet P8 Platform documentation for the first time. 

• “Install functional expansion documentation” on page 93 -- Begin here if have already installed the IBM 
FileNet P8 Platform documentation and need to add on the documentation for IBM FileNet functional 
expansions (e.g., Process Analyzer, Process Simulator, IBM FileNet eForms, Content Federation 
Services for Image Services, Records Manager, Web Content Manager, Team Collaboration Manager, 
or IBM FileNet P8 Portlets).

•  “Update the documentation search index” on page 94 -- Perform this procedure only after you have 
added on documentation for your functional expansions. Otherwise, if you install only IBM FileNet P8 
Platform documentation, which has a baseline search index, you may skip this procedure.

• “Complete and verify the documentation installation” on page 96 -- Perform this final procedure in all 
cases, but only after you have installed the IBM FileNet P8 Platform documentation, added on 
documentation for your functional expansions, and (where required) regenerated the search index.
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Install the IBM FileNet P8 Platform documentation

This procedure establishes the web application for documentation associated with IBM FileNet P8 
Platform. It assumes that your JBoss application server is already installed and operational. 

To install the IBM FileNet P8 Platform documentation

1. If this is a Windows server, verify that Microsoft Windows Internet Information Services (IIS Admin Ser-
vice, Simple Mail Transport Protocol (SMTP), and World Wide Web Publishing Service) are stopped 
and set to manual. 

NOTE  Skip this step if the application server will contain Content Engine software.

2. Insert or mount the IBM FileNet P8 Platform Documentation CD, as follows:

(UNIX) Insert and mount the IBM FileNet P8 Platform Documentation CD.

(Windows) Insert the IBM FileNet P8 Platform Documentation CD.

3. Create a directory for the IBM FileNet P8 Platform documentation. For example:

(UNIX) /home/usr/apps/jboss_ver/server/default/deploy/P8_docs.war

(Windows) C:\jboss-3.2.3\server\default\deploy\P8_docs.war

NOTES 

• The installation directory must have a .war extension as shown above.

• The installation directory can be user-defined, so substitute your actual location for these com-
mands.

4. Unpack the ecm_help.war file or copy the ecm_help directory contents to the directory you just 
created.

5. Continue as follows:

• If you need to install documentation for functional expansions, go on to the procedure in the follow-
ing topic, “Install functional expansion documentation” on page 93.

• If you have no further documentation to install, go on to the procedure in the topic “Complete and 
verify the documentation installation” on page 96.

Install functional expansion documentation

Use the procedure in this topic to install documentation for functional expansions onto an existing IBM 
FileNet P8 Platform documentation server. If you have no such documentation to add on, skip to the 
procedure “Complete and verify the documentation installation” on page 96.

To install functional expansion documentation

1. Determine the functional expansion documentation media source or location:

• For most functional expansions, use the Documentation CD included as part of the particular soft-
ware's CD set.

• For Content Federation Services for Image Services, use the Documentation directory on the 
software CD.
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2. If the application server is running, use the following command to stop it on the machine where the 
documentation is installed, and verify that no processes are accessing the documentation web 
application:

(UNIX) <path> /shutdown.sh -S

(Windows) <path> \shutdown.bat -S

3. Copy the functional expansion documentation to IBM FileNet P8 Platform documentation server, as 
follows:

• (UNIX) When copying functional expansions, use a cp copy command from a terminal to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help direc-
tory installed on the existing IBM FileNet P8 Platform documentation server.

cp -irv --reply=no <mount_location> <target_destination>

WARNING  Care should be taken when copying folders in UNIX. Dropping-and-dragging of folders 
‘replaces’ any existing folder(s). Also note that your switch (-irv) requirements may be different 
from the example shown. Contact your system administrator if you have questions about proper 
syntax.

• (Windows) Use a copy command from a command prompt or drop-and-drag the files to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help directory 
installed on the existing IBM FileNet P8 Platform documentation server.

• (Content Federation Services for Image Services) Copy the cfs_guide.pdf from the Documenta-
tion directory on the software CD into the ecm_help/cfs_help directory deployed on the existing 
IBM FileNet P8 Platform documentation server.

NOTE  Repeat this step for each of your functional expansions or custom applications. You can copy 
more than one functional expansion documentation set to the documentation application server before 
continuing (e.g., eForms and WCM) so you end up with one ecm_help directory containing multiple 
sets of functional expansion files added in.

4. Download the latest web-posted updates of installation and upgrade guide PDFs for the various 
functional expansion documentation (as well as IBM FileNet P8 Platform) to the ecm_help/
installation directory.

5. Go on to the procedure in the following topic, “Update the documentation search index” on page 94.

Update the documentation search index

Perform this procedure only if you have refreshed the core IBM FileNet P8 Platform documentation, or 
installed functional expansion documentation onto your IBM FileNet P8 Platform documentation server. 
Otherwise, skip to the procedure in the following topic, “Complete and verify the documentation installation” 
on page 96.

NOTE  Any time you update the documentation search index, a backup of the files in the existing 
Index\core directory will be automatically copied to the Index\IndexOld subdirectory. You can reapply 
these backed-up files to the core subdirectory (after first removing the new files created there) if you need 
to return to your previous indexed state.
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To update the documentation search index 

1. If the JBoss server is running, use the following command to stop it on the machine where the docu-
mentation is installed, and verify that no processes are accessing the documentation web application:

(UNIX) <path> /shutdown.sh -S

(Windows) <path> \shutdown.bat -S

NOTE  Make sure you have copied the help for all your various functional expansions to a designated 
application server location containing the IBM FileNet P8 Platform documentation. Otherwise, you will 
have to repeat this procedure if you add new help later.

2. Open a command prompt (or terminal) on the application server.

3. From the command prompt (or terminal), navigate to the search subdirectory under your ecm_help 
root directory.

4. Using a text editor, open the search-indexing script file that is appropriate to your application server 
operating system:

NOTE  You may need to set the permissions on this file as it is set to read-only on the CD.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

5. If necessary, set the JAVA_HOME variable in the script file with the path to your JRE installation. The 
default examples are:

(UNIX) JAVA_HOME="/usr/java/j2sdk1.4.1_02"

(Windows) SET JAVA_HOME=c:\j2sdk1.4.2

NOTE  The Java JRE installation subdirectory can be user-defined, so substitute your actual location, 
as appropriate.

6. Save your changes and close the text editor.

NOTE  If you intend to run the search indexer on a UNIX application server, ensure that you add 
execute permissions (chmod 755) to the indexFiles.sh file.

7. Run the following updated search-indexing script file that is appropriate to your application server 
operating system.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

NOTE  As you run the search-indexing script, you may notice periodic Parse Abort errors. You can 
ignore these error conditions, as they are benign and do not affect the overall indexing process.

8. Go on to the next procedure.
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Complete and verify the documentation installation

Perform this procedure after you have installed (and, if necessary, reindexed) the IBM FileNet P8 Platform 
documentation on the application server.

To complete and verify the JBoss documentation installation 

1. Start the IBM FileNet P8 Platform documentation web application by running the following JBoss com-
mand: 

(UNIX) run.sh

(Windows) run.bat

2. Verify that the application server and the new IBM FileNet P8 Platform documentation web site are 
running, as follows:

a. From your web browser, access the following URL. The documentation's Help Directory should 
open.

http://<docserver>:<port#>/<contextRoot>/

where:

docserver is the name of the Java web server.

port# is the port number (def: 80).

contextRoot is the value of the Map to URL field that you specified when you deployed the 
IBM FileNet P8 Platform documentation application. If you specified /ecm_help, then the 
contextRoot is ecm_help.

Example: http://yourdocserver:80/ecm_help/

NOTE  You can use multi-part root folders (e.g., /docs/ecm_help) if your application server 
supports them.

b. Click the Search link on the Help Directory toolbar. The documentation Search page should open.

c. Select one of the Search query result links. The associated help page should open.

NOTE  When it is time to configure the online help location for the various IBM FileNet P8 components, 
either while running Setup programs or later via site preferences settings, use the URL in Step a on 
page 96.
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Task 7d: Install IBM FileNet P8 Platform documentation (Tomcat)

This topic covers the installation, and (if necessary) search-related reindexing of your IBM FileNet P8 
Platform documentation on a Tomcat application server. Because the IBM FileNet P8 Platform 
documentation includes a Java-based full-text search engine, it runs as a web-based application.

You must install the IBM FileNet P8 Platform documentation on a web application server if you intend to 
access online help from within any IBM FileNet P8 applications (for example, Workplace, Enterprise 
Manager, Process Task Manager, and Records Manager) or use the full-text search feature. 

NOTES 

• You may install the IBM FileNet P8 Platform documentation and Application Engine on the same 
machine.

• A valid Java JavaTM Software Development Kit (JSDK) must be installed for the Tomcat application 
server.

• To ensure proper documentation search functionality, enable JavaScript support on the user's browser 
client. 

• Because of the number of possible network and web configurations, contact your network or web 
administrator for specific system, software, and security requirements.

• The requirements described in this topic may also exist for associated custom application help, or for 
any customizations you may have applied to the IBM FileNet P8 Platform documentation. This 
documentation requirement may also exist for associated custom applications. For further details on 
customizing or localizing IBM FileNet P8 Platform documentation, see the file ecm_help/transkit/
P8DocTransKit.htm on the IBM FileNet P8 Platform Documentation CD or wherever you install the IBM 
FileNet P8 Platform documentation.

• If you are upgrading your IBM FileNet P8 Platform installation and have downloaded a refresh of the 
documentation from the IBM website support page, see “Upgrade IBM FileNet P8 Platform 
Documentation” on page 306 for instructions on upgrading the documentation.

Overview of procedures

Perform the procedures in the following subtopics in the order presented, unless otherwise directed below:

• “Install IBM FileNet P8 Platform documentation” on page 98 -- Begin here if you are installing the IBM 
FileNet P8 Platform documentation for the first time. 

• “Install functional expansion documentation” on page 98 -- Begin here if have already installed the IBM 
FileNet P8 Platform documentation and need to add on the documentation for IBM FileNet functional 
expansions (e.g., Process Analyzer, Process Simulator, IBM FileNet eForms, Content Federation 
Services for Image Services, Records Manager, Web Content Manager, Team Collaboration Manager, 
or IBM FileNet P8 Portlets).

•  “Update the documentation search index” on page 99 -- Perform this procedure only after you have 
added on documentation for your functional expansions. Otherwise, if you install only IBM FileNet P8 
Platform documentation, which has a baseline search index, you may skip this procedure.

• “Complete and verify the documentation installation” on page 101 -- Perform this final procedure in all 
cases, but only after you have installed the IBM FileNet P8 Platform documentation, added on 
documentation for your functional expansions, and (where required) regenerated the search index.



INSTALLATION AND UPGRADE GUIDE
Install IBM FileNet P8 Platform documentation (Tomcat)

98
Install IBM FileNet P8 Platform documentation

This procedure establishes the web application for documentation associated with IBM FileNet P8 
Platform. It assumes that your Tomcat application server is already installed and operational. 

To install the IBM FileNet P8 Platform documentation

1. If this is a Windows server, verify that Microsoft Windows Internet Information Services (IIS Admin Ser-
vice, Simple Mail Transport Protocol (SMTP), and World Wide Web Publishing Service) are stopped 
and set to manual. 

NOTE  Skip this step if the application server will contain Content Engine software.

2. Insert or mount the IBM FileNet P8 Platform Documentation CD, as follows:

(UNIX) Insert and mount the IBM FileNet P8 Platform Documentation CD.

(Windows) Insert the IBM FileNet P8 Platform Documentation CD.

3. Create a directory for the IBM FileNet P8 Platform documentation. For example:

(UNIX) /export/home/apps/Tomcat_ver/webapps/ecm_help

(Windows) C:\Program Files\Apache Software Foundation\Tomcat 5.0\webapps\P8_docs

NOTE  The installation directory can be user-defined, so substitute your actual location, as 
appropriate.

4. Unpack the ecm_help.war file or copy the ecm_help directory contents to the directory you just 
created.

5. Continue as follows:

• If you need to add on documentation for functional expansions) go on to the procedure in the fol-
lowing topic, “Install functional expansion documentation” on page 98.

• If you have no further documentation to install, go on to the procedure in the topic “Complete and 
verify the documentation installation” on page 101.

Install functional expansion documentation

Use the procedure in this topic to install documentation for functional expansions onto an existing IBM 
FileNet P8 Platform documentation server. If you have no such documentation to add on, skip to the 
procedure  “Complete and verify the documentation installation” on page 101.

To install functional expansion documentation

1. Determine the functional expansion documentation media source or location:

• For most functional expansions, use the Documentation CD included as part of the particular soft-
ware's CD set.

• For Content Federation Services for Image Services, use the Documentation directory on the 
software CD.
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2. If the application server is running, use the following command to stop it on the machine where the 
documentation is installed, and verify that no processes are accessing the documentation web 
application:

(UNIX) shutdown.sh

(Windows) shutdown.bat

3. Copy the functional expansion documentation to the IBM FileNet P8 Platform documentation server, 
as follows:

• (UNIX) When copying functional expansions, use a cp copy command from a terminal to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help direc-
tory installed on the existing IBM FileNet P8 Platform documentation server.

cp -R <mount_location> <target_destination>

WARNING  Care should be taken when copying folders in UNIX. Dropping-and-dragging of folders 
may replace any existing folder(s). Also note that your switch (-r) requirements may be different 
from the example shown. Contact your system administrator if you have questions about proper 
syntax.

• (Windows) Use a copy command from a command prompt or drop-and-drag the files to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help directory 
installed on the existing IBM FileNet P8 Platform documentation server.

• (Content Federation Services for Image Services) Copy the cfs_guide.pdf from the Documenta-
tion directory on the software CD into the pre-existing ecm_help/cfs_help directory on the IBM 
FileNet P8 Platform documentation server.

NOTE Repeat this step for each of your functional expansions. You can copy more than one functional 
expansion documentation set to the documentation application server before continuing (e.g., eForms 
and WCM) so you end up with one ecm_help directory containing multiple sets of functional 
expansion files added in.

4. Download the latest web-posted updates of installation and upgrade guide PDFs for the various 
functional expansion documentation (as well as IBM FileNet P8 Platform) to the ecm_help/
installation directory. 

5. Go on to the procedure in the following topic, “Update the documentation search index” on page 99.

Update the documentation search index

Perform this procedure only if you have refreshed the core IBM FileNet P8 Platform documentation, or 
installed functional expansion documentation onto your IBM FileNet P8 Platform documentation server. 
Otherwise, skip to the procedure in the following topic, “Complete and verify the documentation installation” 
on page 101.

NOTE  Any time you update the documentation search index, a backup of the files in the existing 
Index\core directory will be automatically copied to the Index\IndexOld subdirectory. You can reapply 
these backed-up files to the core subdirectory (after first removing the new files created there) if you need 
to return to your previous indexed state.
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To update the documentation search index 

1. If the Tomcat server is running, use the following command to stop it on the machine where the docu-
mentation is installed, and verify that no processes are accessing the documentation web application:

(UNIX) shutdown.sh

(Windows) shutdown.bat

NOTE  Make sure you have copied the help for all your various functional expansions to a designated 
application server location containing the IBM FileNet P8 Platform documentation. Otherwise, you will 
have to repeat this procedure if you add new help later.

2. Open a command prompt (or terminal) on the application server.

3. From the command prompt or terminal, navigate to the search subdirectory under your ecm_help root 
directory.

4. Using a text editor, open the following search-indexing script file that is appropriate to your application 
server operating system:

NOTE  You may need to set the permissions on this file, as it is set to read-only on the CD.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

5. If necessary, set the JAVA_HOME variable in the indexFiles script file with the path to your JRE 
installation. The default examples are:

(UNIX) JAVA_HOME="/usr/java/j2sdk1.4.1_02"

(Windows) SET JAVA_HOME=c:\j2sdk1.4.2

NOTE  The Java JRE installation subdirectory can be user-defined, so substitute your actual location, 
as appropriate.

6. Save your changes and close the text editor.

NOTE  If you intend to run the search indexer on a UNIX application server, ensure that you add 
execute permissions (chmod 755) to the indexFiles.sh file.

7. Run the following updated search-indexing script file that is appropriate to your application server 
operating system.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

NOTE  As you run the search-indexing script, you may notice periodic Parse Abort errors. You can 
ignore these error conditions, as they are benign and do not affect the overall indexing process.

8. Go on to the next procedure.
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Complete and verify the documentation installation

Perform this procedure after you have installed (and, if necessary, reindexed) the IBM FileNet P8 Platform 
documentation on the application server.

To complete and verify the documentation installation 

1. Start the IBM FileNet P8 Platform documentation web application by running the following Tomcat 
command: 

(UNIX) run.sh

(Windows) run.bat

2. Verify that the application server and the new IBM FileNet P8 Platform documentation web site are 
running, as follows:

a. From your web browser, access the following URL. The documentation's Help Directory should 
open.

http://<docserver>:<port#>/<contextRoot>/

where:

docserver is the name of the Java web server.

port# is the port number (def: 80).

contextRoot is the value of the Map to URL field that you specified when you deployed the 
IBM FileNet P8 Platform documentation application. If you specified /ecm_help, then the 
contextRoot is ecm_help.

Example: http://yourdocserver:80/ecm_help/

NOTE  You can use multi-part root folders (e.g., /docs/ecm_help) if your application server 
supports them.

b. Click the Search link on the Help Directory toolbar. The documentation Search page should open.

c. Select one of the Search query result links. The associated help page should open.

NOTE  When it is time to configure the online help location for the various IBM FileNet P8 components, 
either while running Setup programs or later via site preferences settings, use the URL in Step a on 
page 101.
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Task 7e: Install IBM FileNet P8 Platform documentation (Oracle Appli-
cation Server)

This topic covers the installation, and (if necessary) search-related reindexing of your IBM FileNet P8 
Platform documentation on an Oracle Application Server. Because the IBM FileNet P8 Platform 
documentation includes a Java-based full-text search engine, it runs as a web-based application.

You must install the IBM FileNet P8 Platform documentation on a web application server if you intend to 
access online help from within any IBM FileNet P8 applications (for example, Workplace, Enterprise 
Manager, Process Task Manager, and Records Manager) or use the full-text search feature. 

NOTES 

• You may install the IBM FileNet P8 Platform documentation and Application Engine on the same 
machine.

• To ensure proper documentation search functionality, enable JavaScript support on the user's browser 
client. 

• Because of the number of possible network and web configurations, contact your network or web 
administrator for specific system, software, and security requirements.

• The requirements described in this topic may also exist for associated custom application help, or for 
any customizations you may have applied to the IBM FileNet P8 Platform documentation. This 
documentation requirement may also exist for associated custom applications. For further details on 
customizing or localizing IBM FileNet P8 Platform documentation, see the file ecm_help/transkit/
P8DocTransKit.htm on the IBM FileNet P8 Platform Documentation CD or wherever you install the IBM 
FileNet P8 Platform documentation.

• If you are upgrading your FileNet P8 Platform installation and have downloaded a refresh of the 
documentation from the IBM website support page, see “Upgrade IBM FileNet P8 Platform 
Documentation” on page 306 for instructions on upgrading the documentation.

Overview of procedures

Perform the procedures in the following subtopics in the order presented, unless otherwise directed below:

• “Install the IBM FileNet P8 Platform documentation” on page 103 -- Begin here if you are installing the 
IBM FileNet P8 Platform documentation for the first time. 

• “Install functional expansion documentation” on page 104 -- Begin here if have already installed the 
IBM FileNet P8 Platform documentation and need to add on the documentation for IBM FileNet 
functional expansions (e.g., Process Analyzer, Process Simulator, IBM FileNet eForms, Content 
Federation Services for Image Services, Records Manager, Web Content Manager, Team 
Collaboration Manager, or IBM FileNet P8 Portlets).

•  “Update the documentation search index” on page 105 -- Perform this procedure only after you have 
added on documentation for your functional expansions. Otherwise, if you install only IBM FileNet P8 
Platform documentation, which has a baseline search index, you may skip this procedure.

• “Complete and verify the documentation installation” on page 106 -- Perform this final procedure in all 
cases, but only after you have installed the IBM FileNet P8 Platform documentation, added on 
documentation for your functional expansions, and (where required) regenerated the search index.
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Install the IBM FileNet P8 Platform documentation

This procedure establishes the web application for documentation associated with IBM FileNet P8 
Platform. It assumes that your Oracle Application Server is already installed and operational. 

You can install the IBM FileNet P8 Platform documentation application directly from the IBM FileNet P8 
Platform Documentation CD. However, if you are accessing your Oracle Application Server over a network, 
we recommend that you first copy the ecm_help.war file from the CD to the PC on which your application 
server is running. You would then deploy the IBM FileNet P8 Platform documentation from the PC.

To install the IBM FileNet P8 Platform documentation

1. If this is a Windows server, verify that Microsoft Windows Internet Information Services (IIS Admin Ser-
vice, Simple Mail Transport Protocol (SMTP), and World Wide Web Publishing Service) are stopped 
and set to manual. 

NOTE Skip this step if the application server will contain Content Engine software.

2. Insert or mount the IBM FileNet P8 Platform Documentation CD, as follows:

(UNIX) Insert and mount the IBM FileNet P8 Platform Documentation CD.

(Windows) Insert the IBM FileNet P8 Platform Documentation CD.

3. Open the Oracle Enterprise Manager console.

4. Choose an OC4J instance in which to run the IBM FileNet P8 Platform documentation application.

5. Go to the Application page of the selected OC4J instance.

6. Click Deploy WAR File.

7. On the Deploy Web Application page, set the fields.

• In the Web Application field, specify the location of the ecm_help.war file.

• In the Map to URL field, enter a name by which the application will be invoked in the URL. For 
example, if you enter /ecm_help, the URL to the IBM FileNet P8 Platform documentation server 
will be http://<host>:<port>/ecm_help.

8. Click Deploy. If the application deploys successfully, click OK on the Confirmation page. The 
Applications page for the OC4J instance lists the IBM FileNet P8 Platform documentation application.

9. Continue as follows:

• If you need to add on documentation for functional expansions, go on to the procedure in the fol-
lowing topic, “Install functional expansion documentation” on page 104.

• If you have no further documentation to install, then start the IBM FileNet P8 Platform documenta-
tion application that you just deployed.

On the Home page, select the OC4J instance to which you deployed the IBM FileNet P8 Platform 
documentation application, then click Restart. If restart is successful, you will get a confirmation 
page. Go on to the procedure in the topic “Complete and verify the documentation installation” on 
page 106.
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Install functional expansion documentation

Use the procedure in this topic to install documentation for functional expansions into an existing IBM 
FileNet P8 Platform documentation application. If you have no such documentation to add on, skip to the 
procedure “Complete and verify the documentation installation” on page 106.

To install functional expansion documentation

1. Determine the documentation media source or location:

• For most functional expansions, use the Documentation CD included as part of the particular soft-
ware's CD set.

• For Content Federation Services for Image Services, use the Documentation directory on the 
software CD.

2. Identify the directory where you deployed the IBM FileNet P8 Platform documentation application.

Oracle deploys applications in the directory structure of the application's OC4J instance, for example, /
OraHome_1/j2ee/< OC4J instance>/applications/ecm_help/ecm_help.

3. Stop the OC4J instance where you deployed the IBM FileNet P8 Platform documentation application. 

On the Home page, select the OC4J instance to which you deployed the documentation application, 
then click Stop.

4. Copy the functional expansion documentation to the IBM FileNet P8 Platform documentation 
application, as follows:

• (UNIX) When copying functional expansions, use a cp copy command from a terminal to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help direc-
tory installed on the existing IBM FileNet P8 Platform documentation server.

cp -r <mount_location> <target_destination>

WARNING  Care should be taken when copying folders in UNIX. Dropping-and-dragging of folders 
may replace any existing folder(s). Also note that your switch (-r) requirements may be different 
from the example shown. Contact your system administrator if you have questions about proper 
syntax.

• (Windows) Use a copy command from a command prompt or drop-and-drag the files to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help directory 
installed on the existing IBM FileNet P8 Platform documentation server.

• (Content Federation Services for Image Services) Copy the cfs_guide.pdf from the Documenta-
tion directory on the software CD into the ecm_help/cfs_help directory on the IBM FileNet P8 
Platform documentation server.

NOTE  Repeat this step for each of your functional expansions. You can copy more than one functional 
expansion documentation set to the documentation application server before continuing (e.g., eForms 
and WCM) so you end up with one ecm_help directory containing multiple sets of functional 
expansion files added in.

5. Download the latest web-posted updates of installation and upgrade guide PDFs for the various 
functional expansion documentation (as well as IBM FileNet P8 Platform) to the ecm_help/
installation directory. 

6. Go on to the procedure in the following topic, “Update the documentation search index” on page 105.
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Update the documentation search index

Perform this procedure only if you have refreshed the core IBM FileNet P8 Platform documentation, or 
installed functional expansion documentation onto your IBM FileNet P8 Platform documentation server. 
Otherwise, skip to the procedure in the following topic, “Complete and verify the documentation installation” 
on page 106.

NOTE  Any time you update the documentation search index, a backup of the files in the existing 
Index\core directory will be automatically copied to the Index\IndexOld subdirectory. You can reapply 
these backed-up files to the core subdirectory (after first removing the new files created there) if you need 
to return to your previous indexed state.

To update the documentation search index 

1. Make sure the OC4J instance where you deployed the IBM FileNet P8 Platform documentation appli-
cation is stopped. For the search indexer to run, no other processes can be accessing the IBM FileNet 
P8 Platform documentation.

2. Open a command prompt or terminal on the application server.

3. From the command line, navigate to the search subdirectory under the application root directory, for 
example, ecm_help.

4. Using a text editor, open the search-indexing script file that is appropriate to your application server 
operating system:

NOTE You may need to set the permissions on this file, as it is set to read-only on the CD.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

5. If necessary, set the JAVA_HOME variable in the script file with the path to your JRE installation. The 
default examples are:

(UNIX) JAVA_HOME="/usr/java/j2sdk1.4.1_02"

(Windows) SET JAVA_HOME=c:\j2sdk1.4.2

NOTE  The Java JRE installation subdirectory can be user-defined, so substitute your actual location, 
as appropriate.

6. Save your changes and close the text editor.

NOTE If you intend to run the search indexer on a UNIX application server, ensure that you add 
execute permissions (chmod 755) to the indexFiles.sh file.

7. Run the following updated search-indexing script file that is appropriate to your application server 
operating system.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

NOTE As you run the search-indexing script, you may notice periodic Parse Abort errors. You can 
ignore these error conditions, as they are benign and do not affect the overall indexing process.

8. Go on to the next procedure.
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Complete and verify the documentation installation

Perform this procedure after you have installed (and, if necessary, reindexed) the IBM FileNet P8 Platform  
documentation on the application server.

To complete and verify the documentation installation 

1. If the IBM FileNet P8 Platform documentation application is not running, start it.

On the Home page, select the OC4J instance to which you deployed the IBM FileNet P8 Platform 
documentation application, then click Start. If startup is successful, you will get a confirmation page.

2. Verify that the application server and the new IBM FileNet P8 Platform documentation web site are 
running, as follows:

a. From your web browser, access the following URL. The documentation's Help Directory should 
open.

http://<docserver>:<port#>/<contextRoot>/

where:

docserver is the name of the Java web server.

port# is the port number (def: 80).

contextRoot is the value of the Map to URL field that you specified when you deployed the 
IBM FileNet P8 Platform documentation application. If you specified /ecm_help, then the 
contextRoot is ecm_help.

Example: http://yourdocserver:80/ecm_help/

NOTE  You can use multi-part root folders (e.g., /docs/ecm_help) if your application server 
supports them.

b. Click the Search link on the Help Directory toolbar. The documentation Search page should open.

c. Select one of the Search query result links. The associated help page should open.

NOTE  When it is time to configure the online help location for the various IBM FileNet P8 components, 
either while running Setup programs or later via site preferences settings, use the URL in Step a on 
page 106.
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Task 7f: Install IBM FileNet P8 Platform documentation (Sun Java 
Application Server)

This topic covers the installation, and (if necessary) search-related reindexing of your IBM FileNet P8 
Platform documentation on a Sun Java Application Server. Because the IBM FileNet P8 Platform 
documentation includes a Java-based full-text search engine, it runs as a web-based application.

You must install the IBM FileNet P8 Platform documentation on a web application server if you intend to 
access online help from within any IBM FileNet P8 applications (for example, Workplace, Enterprise 
Manager, Process Task Manager, and Records Manager) or use the full-text search feature. 

NOTES 

• You may install the IBM FileNet P8 Platform documentation and Application Engine on the same 
machine.

• To ensure proper documentation search functionality, enable JavaScript support on the user's browser 
client. 

• Because of the number of possible network and web configurations, contact your network or web 
administrator for specific system, software, and security requirements.

• The requirements described in this topic may also exist for associated custom application help, or for 
any customizations you may have applied to the IBM FileNet P8 Platform documentation. This 
documentation requirement may also exist for associated custom applications. For further details on 
customizing or localizing IBM FileNet P8 Platform documentation, see the file ecm_help/transkit/
P8DocTransKit.htm on the IBM FileNet P8 Platform Documentation CD or wherever you install the IBM 
FileNet P8 Platform documentation.

• If you are upgrading your IBM FileNet P8 Platform installation and have downloaded a refresh of the 
documentation from the IBM website support page, see “Upgrade IBM FileNet P8 Platform 
Documentation” on page 306 for instructions on upgrading the documentation.

Overview of procedures

Perform the procedures in the following subtopics in the order presented, unless otherwise directed below:

• “Install the IBM FileNet P8 Platform documentation” on page 108 -- Begin here if you are installing the 
IBM FileNet P8 Platform documentation for the first time. 

• “Install functional expansion documentation” on page 108 -- Begin here if have already installed the 
IBM FileNet P8 Platform documentation and need to add on the documentation for IBM FileNet 
functional expansions (e.g., Process Analyzer, Process Simulator, IBM FileNet eForms, Content 
Federation Services for Image Services, Records Manager, Web Content Manager, Team 
Collaboration Manager, or IBM FileNet P8 Portlets).

•  “Update the documentation search index” on page 110 -- Perform this procedure only after you have 
added on documentation for your functional expansions. Otherwise, if you install only IBM FileNet P8 
Platform documentation, which has a baseline search index, you may skip this procedure.

• “Complete and verify the documentation installation” on page 111 -- Perform this final procedure in all 
cases, but only after you have installed the IBM FileNet P8 Platform documentation, added on 
documentation for your functional expansions, and (where required) regenerated the search index.
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Install the IBM FileNet P8 Platform documentation

This procedure establishes the web application for documentation associated with IBM FileNet P8 
Platform. It assumes that your Sun Java Application Server is already installed and operational.

You can install the IBM FileNet P8 Platform documentation application from the ecm_help.war file or from 
the expanded directory, both of which are on the IBM FileNet P8 Platform Documentation CD. This 
procedure shows you how to deploy from the ecm_help.war file. 

If you are accessing your Sun Java Application Server over a network, we recommend that you first copy 
the ecm_help.war file from the CD to the PC on which your application server is running. You would then 
deploy the IBM FileNet P8 Platform documentation from the PC.

To install the IBM FileNet P8 Platform documentation

1. If this is a Windows server, verify that Microsoft Windows Internet Information Services (IIS Admin Ser-
vice, Simple Mail Transport Protocol (SMTP), and World Wide Web Publishing Service) are stopped 
and set to manual. 

NOTE Skip this step if the application server will contain Content Engine software.

2. Insert or mount the IBM FileNet P8 Platform Documentation CD, as follows:

(UNIX) Insert and mount the IBM FileNet P8 Platform Documentation CD.

(Windows) Insert the IBM FileNet P8 Platform Documentation CD.

3. Open the Sun Java Application Server Admin Console.

4. From the console, navigate to Application Server > Applications > Web Applications.

5. In the right pane, click Deploy. 

6. On the Deployment page, browse to and select the ecm_help.war file, then click Next.

7. On the Deploy Web Module page, set the Context Root field. Enter a name by which the application 
will be invoked in the URL. For example, if you enter /ecm_help, the URL to the IBM FileNet P8 
Platform documentation server will be http://<host>:<port>/ecm_help.

8. Click Finish to deploy the application.

9. Continue as follows:

• If you need to add on documentation for functional expansions, go on to the procedure in the fol-
lowing topic, “Install functional expansion documentation” on page 108.

• If you have no further documentation to install, then start the IBM FileNet P8 Platform documenta-
tion application that you just deployed.

On the Web Applications page, if the Enabled field is set to true, then the IBM FileNet P8 
Platform documentation application is already running. If the Enabled field is set to false, then 
select the IBM FileNet P8 Platform documentation application check box and click Enable. Go on 
to the procedure in the topic “Complete and verify the documentation installation” on page 111.

Install functional expansion documentation

Use the procedure in this topic to install documentation for functional expansions into an existing IBM 
FileNet P8 Platform documentation application. If you have no such documentation to add on, skip to the 
procedure “Complete and verify the documentation installation” on page 111.
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To install functional expansion documentation

1. Determine the documentation media source or location:

• For most functional expansions, use the Documentation CD included as part of the particular soft-
ware's CD set.

• For Content Federation Services for Image Services, use the Documentation directory on the 
software CD.

2. Identify the directory where you deployed the IBM FileNet P8 Platform documentation application.

From the Sun Java Application Server Admin Console, navigate to Application Server > 
Applications > Web Applications, and click the name of the IBM FileNet P8 Platform documentation 
application. The absolute directory of the IBM FileNet P8 Platform documentation application is 
displayed in the Location field. This is the directory that you will work with to install functional 
expansion documentation.

3. Stop the domain where you deployed the IBM FileNet P8 Platform documentation application. From 
the command line, enter the following command:

asadmin stop-domain <domain>

For example, if the application is deployed to the default domain, then you would specify domain1.

4. Copy the functional expansion documentation to the IBM FileNet P8 Platform documentation 
application, as follows:

• (UNIX) When copying functional expansions, use a cp copy command from a terminal to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help direc-
tory installed on the existing IBM FileNet P8 Platform documentation server.

cp -r <mount_location> <target_destination>

WARNING  Care should be taken when copying folders in UNIX. Dropping-and-dragging of folders 
may replace any existing folder(s). Also note that your switch (-r) requirements may be different 
from the example shown. Contact your system administrator if you have questions about proper 
syntax.

• (Windows) Use a copy command from a command prompt or drop-and-drag the files to copy the 
ecm_help directory structure from the associated Documentation CD over the ecm_help directory 
installed on the existing IBM FileNet P8 Platform documentation server.

• (Content Federation Services for Image Services) Copy the cfs_guide.pdf from the Documenta-
tion directory on the software CD into the ecm_help/cfs_help directory on the IBM FileNet P8 
Platform documentation server.

NOTE  Repeat this step for each of your functional expansions. You can copy more than one functional 
expansion documentation set to the documentation application server before continuing (e.g., eForms 
and WCM) so you end up with one ecm_help directory containing multiple sets of functional 
expansion files added in.

5. Download the latest web-posted updates of installation and upgrade guide PDFs for the various 
functional expansion documentation (as well as IBM FileNet P8 Platform) to the ecm_help/
installation directory. 

6. Go on to the procedure in the following topic, “Update the documentation search index” on page 110.
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Update the documentation search index

Perform this procedure only if you have refreshed the core IBM FileNet P8 Platform documentation, or 
installed functional expansion documentation onto your IBM FileNet P8 Platform documentation server. 
Otherwise, skip to the procedure in the following topic, “Complete and verify the documentation installation” 
on page 111.

NOTE  Any time you update the documentation search index, a backup of the files in the existing 
Index\core directory will be automatically copied to the Index\IndexOld subdirectory. You can reapply 
these backed-up files to the core subdirectory (after first removing the new files created there) if you need 
to return to your previous indexed state.

To update the documentation search index 

1. Make sure the domain where you deployed the IBM FileNet P8 Platform documentation application is 
stopped. For the search indexer to run, no other processes can be accessing the IBM FileNet P8 Plat-
form documentation.

2. Open a command prompt or terminal on the application server.

3. From the command line, navigate to the search subdirectory under the application root directory, for 
example, ecm_help.

4. Using a text editor, open the search-indexing script file that is appropriate to your application server 
operating system:

NOTE  You may need to set the permissions on this file as it is set to read-only on the CD.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

5. If necessary, set the JAVA_HOME variable in the script file with the path to your JRE installation. The 
default examples are:

(UNIX) JAVA_HOME="/usr/java/j2sdk1.4.1_02"

(Windows) SET JAVA_HOME=c:\j2sdk1.4.2

NOTE  The Java JRE installation subdirectory can be user-defined, so substitute your actual location, 
as appropriate.

6. Save your changes and close the text editor.

NOTE If you intend to run the search indexer on a UNIX application server, ensure that you add 
execute permissions (chmod 755) to the indexFiles.sh file.

7. Run the following updated search-indexing script file that is appropriate to your application server 
operating system.

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

NOTE  As you run the search-indexing script, you may notice periodic Parse Abort errors. You can 
ignore these error conditions, as they are benign and do not affect the overall indexing process.

8. Go on to the next procedure.
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Complete and verify the documentation installation

Perform this procedure after you have installed (and, if necessary, reindexed) the IBM FileNet P8 Platform 
documentation on the application server.

To complete and verify the documentation installation 

1. If the IBM FileNet P8 Platform documentation application is not running, start it.

From the Sun Java Application Server Admin Console, navigate to Application Server > 
Applications > Web Applications. Select the IBM FileNet P8 Platform documentation application 
check box and click Enable.

2. Verify that the application server and the new IBM FileNet P8 Platform documentation web site are 
running, as follows:

a. From your web browser, access the following URL. The documentation's Help Directory should 
open.

http://<docserver>:<port#>/<contextRoot>/

where:

docserver is the name of the Java web server.

port# is the port number (def: 80).

contextRoot is the value of the Map to URL field that you specified when you deployed the 
IBM FileNet P8 Platform documentation application. If you specified /ecm_help, then the 
contextRoot is ecm_help.

Example: http://yourdocserver:80/ecm_help/

NOTE  You can use multi-part root folders (e.g., /docs/ecm_help) if your application server 
supports them.

b. Click the Search link on the Help Directory toolbar. The documentation Search page should open.

c. Select one of the Search query result links. The associated help page should open.

NOTE  When it is time to configure the online help location for the various IBM FileNet P8 components, 
either while running Setup programs or later via site preferences settings, use the URL in Step a on 
page 111.
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Task 8a: Install Content Engine (Typical)

A Typical setup installs all of the following Content Engine program features:

• Object Store Service

• Content Cache Service

• Process Services Administrator (included in Object Store Service)

• File Store Service

• Administrative Tools (IBM FileNet Enterprise Manager)

• Debug Tools

• Content Engine WebDAV Provider

• IBM FileNet P8 Client Connectivity

• Publishing Foundation (Publishing Plug-in)

• Application Engine Web Connectivity (Java)

• Content Engine COM SDK

• IBM FileNet P8 Content Federation Services (CFS) Server for Image Services

The Typical setup option does not install IBM FileNet P8 Content Federation Services Server for Image 
Services (CFS-IS). If you want to install CFS-IS, and/or a subset of these Content Engine features, refer 
instead to “Install Content Engine (Custom)” on page 127.

NOTE  If you are installing Content Engine WebDAV provider, you must have Microsoft Internet Information 
Server (IIS) installed.

Deployment and authentication notes

• Some anti-virus software can cause problems with Content Engine installation. If you experience 
problems, disable your anti-virus software and try again.

• Even if you don’t use Windows Active Directory as your authentication provider, you still need to have it 
installed since Content Engine installation requires it, and the Windows Content Engine Service and 
COM Application user both require a Windows Active Directory user to run them.

• The server where you run a Typical type of Content Engine setup must be a member of the 
“deployment” Windows domain (whether that be the parent or child domain) prior to running Content 
Engine Setup wizard.

• The Content Engine setup will allow you to create or join a FileNet P8 domain during a Typical setup. 
You must create a FileNet P8 domain if you are installing Content Engine for the first time.

• The DefaultRealm value you specify during Content Engine installation should be the same as the 
User and Group Base value you specify (via Process Task Manager) to control user access to Process 
Engine.

• For logging purposes, grant these users write access to winnt\temp (for Windows 2000) or 
windows\temp (for Windows 2003): P8Apache (CatClient), fnce_<server> (catalog), Administrators 
(installer). Your environment may require write access for additional users.
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Third-party software notes

• If the Apache HTTP Server components are not installed on the machine, you will be prompted to 
install them. Follow the Apache setup screen prompts.

• WARNING The Apache HTTP Server is installed for IBM FileNet P8 client connectivity for Content 
Engine. By default, the Apache HTTP Server will be configured to use port 8008 for the installation. 
You can change this port assignment during setup. You should be aware of port assignments on your 
server. A conflict could arise if other programs are using port 8008.

• If the Microsoft Data Access Components (MDAC) is not set up on the machine, it will be installed 
without user intervention during Content Engine installation. If an earlier version of MDAC is installed, 
it will be overwritten.

Feature component notes

• File stores: A Typical type of Content Engine install on a server includes installation of File Store 
Service. If you do not intend to create or use file stores on this server, IBM recommends that you 
disable the File Store Service on the server. This assumes you will install a File Store Service on a 
remote file store server and disable all other features there.

• You can use IBM FileNet Enterprise Manager to administer multiple object stores in a single FileNet P8 
domain. To administer multiple FileNet P8 domains from a single client machine, you must install 
Terminal Server on at least one machine in each domain. This machine should have IBM FileNet 
Enterprise Manager installed and configured for that domain. From your single client machine, you can 
connect to each machine using Terminal Server and use IBM FileNet Enterprise Manager to 
administer that specific domain. However, be aware that you cannot install Process Engine on a 
machine where Terminal Server is installed.

• Documentation: Identify the URL for the IBM FileNet P8 Platform documentation website that is 
described in “Install FileNet P8 Platform documentation” on page 57. You will need this value to 
configure the Content Engine documentation setting. If you do not provide a documentation URL, the 
installer will place an empty icon on the system desktop. You can change this setting later in the IBM 
FileNet Enterprise Manager, in which case the system also updates the documentation URL icon.

• When the Content Engine Setup wizard installs Object Store Service, it also installs Content Cache 
Service. When installed, Object Store Service uses this local Content Cache Service as its content 
cache. To take advantage of the local content cache, it is recommended that you install your cache 
client applications (such as Workplace, Team Collaboration Management, etc.) on a machine at the 
same site (local area network or geographic location) where an Object Store Service is installed.

• WebDAV: Microsoft Windows 2000 or 2003 Internet Information Server (IIS) is required for WebDAV 
support. You will be prompted for a valid Windows account and password.

• CFS-IS: If you previously installed CFS-IS on another machine in your FileNet P8 domain, then the 
Content Engine install you are about to do on this machine cannot be a Typical install. You must 
instead do a Custom install (see “Install Content Engine (Custom)” on page 127), which must include 
CFS-IS. Otherwise, you won’t be able to work with an object store on this machine that uses an Image 
Services server as a fixed content device.

• Feature AddOns: While installing Content Engine, you have the option of installing feature AddOns. A 
feature AddOn consists of custom implementations of classes, objects, and properties that support 
specific product functionality, such as publishing, searching, email, and IBM FileNet eForms. For 



INSTALLATION AND UPGRADE GUIDE
Install Content Engine (Typical)

114
detailed information about standard AddOns and possible custom AddOns, refer to the following topics 
in the IBM FileNet P8 Online Help:

– FileNet P8 Administration > Content Engine Administration > Feature AddOns > FileNet P8 Core 
Feature AddOns

– FileNet P8 Administration > Content Engine Administration > View/modify P8 domain properties > 
XML Import dialog box (AddOn Configuration tab)

– FileNet P8 Administration > Content Engine Administration > FileNet P8 Domain > View/modify P8 
domain properties > FileNet P8 domain root properties (Import AddOns tab)

To install Content Engine using the Typical option

WARNING Do not rename any server after installing the Object Store Service, File Store Service, or 
Content Cache Service. If you need to rename a server, do so before installing Content Engine software.

1. Log on to the Windows server as an Active Directory domain user who is also a local administrator. 
You may need to be a Domain Account Operator or higher, depending on which option you choose 
when specifying the Windows service user to run the Content Engine services:

• If you allow Content Engine Setup to use an existing domain group and user account for the Con-
tent Engine Servers group role and FNCE_<machinename> user role respectively, you do not 
need Domain Account Operator privileges if you specify an existing user account and password.

• If you allow Content Engine Setup to create a new domain group and user account, Content 
Engine Servers and FNCE_<machinename> respectively, you need Domain Account Operator or 
higher privileges; and you’ll need to assign a new password to this account.

2. Insert the IBM FileNet P8 Content Engine CD into the CD-ROM drive, navigate to the ContentEngine 
folder, and click setup.exe. The Content Engine Setup wizard opens.

NOTE You can click Back at any time during the installation process to make changes in any previous 
wizard screen.

3. Complete the Setup screens as follows:

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine installation.

License Agreement Review and accept the license agreement for FileNet P8 software 
products, and then click Next.

Minimum Requirement This screen appears only if the server where you are installing 
Content Engine software does not meet the suggested minimum 
system requirements posted in the FileNet P8 Hardware and 
Software Requirements on the FileNet Customer Service and 
Support web site (http://www.css.filenet.com).

Click Next if you wish to proceed with the installation, but be aware 
that performance will be impacted. Or click Cancel to exit the wizard.

Customer Information Type your user name (required) and organization (optional). Accept 
or change the default install log location, and then click Next.

Setup Type Click Typical, accept or change the default install log location, and 
then click Next.

http://www.css.filenet.com
http://www.css.filenet.com
http://www.css.filenet.com/docsvs/doccontent.asp?DocID=052260002
http://www.css.filenet.com/docsvs/doccontent.asp?DocID=052260002
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WebDAV Configuration Type a valid Windows domain account and password (for example, 
WinOSDomain\Account_name) to use for WebDAV extension 
authentication. Then click Next.

NOTE This account is used for Microsoft Internet Information Server 
(IIS) logon authentication (not for Content Engine or object stores).

Install third-party software This screen appears only if you have not already installed third-party 
software required by Content Engine: MDAC and Apache HTTP 
Server.

NOTE If you don’t want to install the required third-party software at 
this time, but would rather install it yourself manually, click Cancel to 
stop the Content Engine Setup wizard.

If prompted to install third-party software, do the following:

a. Click Next.

b. Follow all screen prompts.

In most environments, you can accept the default installation 
values for third-party software unless otherwise noted.

Ready to Install Do the following:

a. If you already have a FileNet P8 Documentation web site 
installed, you can configure Content Engine components to 
access it, as follows.

NOTE If you don’t yet have a documentation web site 
installed, see “Feature component notes” on page 113.

i. Select the provided check box.

ii. Type the URL of the web site in the following format:

http://<docserver>:<port#>/<ecm_help>)

where:

docserver is the name of the Java web server

port# is the port number

ecm_help is the root folder of the documentation website

You can use multipart root folders if your application 
server supports them (e.g., /docs/ecm_help).

iii. Click Test to verify that the browser opens at the docu-
mentation URL. Then exit the browser.

b. Click Install to install Content Engine. (The installation will 
take several minutes.)

In this screen... Perform this action...
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To create or join a FileNet P8 domain

Determine whether you want to create or join a FileNet P8 domain as follows:

1. If you are currently installing initial Content Engine components (e.g., the initial Object Store Service) 
on the first server, which will become the IBM FileNet P8 master Global Configuration Data (GCD) 
server, continue at “To create a FileNet P8 domain” on page 117.

2. If you are currently installing subsequent Content Engine components (e.g., a second Object Store 
Service on another IBM FileNet P8 member server), and want to join an existing FileNet P8 domain, 
continue at “To join a FileNet P8 domain” on page 125.

To join a FileNet P8 domain, you will be asked to enter the name of a server where Content Engine 
Object Store Service in that FileNet P8 domain is installed.

If an error occurs, or if you have to click Cancel, while the GCD wizard is running, the wizard will attempt to 
roll back any changes it has made since being started. (Rollback includes deletion of services, Windows 
registry keys, the GCD sysinit folder, etc.) With successful automatic rollback, you do not need to do any 
manual cleanup. Simply re-run the wizard (e.g., after fixing the underlying problem that caused it to fail).

Click OK if you see an error message stating that the msdaora.dll file may not have been installed or is 
corrupt. This is a Microsoft-generated message and does not impact Content Engine installation.

Completing the Content 
Engine Setup wizard

Click Finish. This action completes the installation of Content Engine 
software and opens the GCD wizard to enable you to create a new, or 
join an existing, FileNet P8 domain.

NOTE If the GCD wizard does not start automatically, navigate to 
<drive>\Program Files\FileNet\Content Engine and double-click 
ConfigGCD.exe to manually start it.

 Continue at “To create or join a FileNet P8 domain” on page 116 

In this screen... Perform this action...
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To create a FileNet P8 domain

1. Complete the initial GCD wizard screens as follows:

In this screen... Perform this action...

P8 Domain Click Create New Domain and then click Next.

P8 Domain Service 
Account

Do the following:

a. Create a new, or assign an existing, Windows Active Direc-
tory account to run the Content Engine services on this 
machine by doing one of the following:

• Select the check box to accept the default account infor-
mation for the FileNet P8 Domain Content Engine Serv-
ers group (such as Content Engine Servers) and a 
Windows service logon account (such as 
FNCE_<machinename>) that is a member of the group. 
These accounts will be created if they do not already 
exist.

• Clear the check box, type an existing group name, click 
List Members, and select from the list a Windows ser-
vice logon account. The group must exist in the authenti-
cation domain in which you’re installing Content Engine. 
Also, if the group you select is a domain local or a univer-
sal group, its members must also be in the Content 
Engine’s authentication domain.

b. Type a password for the Windows service logon account, 
which will override any password previously supplied to the 
account. 

c. Click Next. 
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2. Specify attribute values for your particular authentication provider as follows.

For your choice of authentication provider, the Configure Authentication Provider screen shows an 
associated table of color-coded attribute names and values. You cannot directly supply values for red 
attributes, which instead are automatically set based on earlier input or associated entries on this 
screen. However, you must supply values directly for all blue attributes, some of which have modifiable 
default values.

Configure Authentication 
Provider

Do the following:

a. Accept the default SYSINIT path (for example, C:\Program 
Files\FileNet\Content Engine\sysconfig\sysinit, or click 
Edit to locate a valid folder for the sysinit.dat file. Click 
Reset if you have changed the path and want to restore its 
default.

If you don’t accept the default SYSINIT, be sure that the 
folder you choose is a shared folder with these permissions:

• Full Control for the group defined as Content Engine 
Servers

• Full Control for all Windows administrative users/groups 
that will directly maintain files (i.e., do backups and 
restores)

And be sure the share itself has one of the following 
permissions:

• Full Control for the Authenticated Users group (restrictive 
permissions on the folder will keep out unauthorized 
users)

• Full Control for Content Engine Servers and Windows 
administrative users/groups

b. Select an authentication provider from the provided list: 

• Windows Integrated

• Sun Java System Directory

• eDirectory (Novell)

c. Continue at Step 2 on page 118 for instructions on specifying 
all other information in the screen.

In this screen... Perform this action...
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Windows Integrated (Active Directory)

Sun Java System Directory Server

In this screen... Perform this action...

Configure Authentication 
Provider

Specify values for the following attributes. 

For more information on the attributes, click Help on the Configure 
Authentication Provider screen, or refer to “Configuring the 
connection to the Content Engine” in the IBM FileNet P8 
documentation topic FileNet P8 Administration > Enterprise-wide 
Administration > Security > Directory integration and authentication > 
Windows Active Directory.

DefaultRealm 

The name of a Windows domain where user accounts reside. The 
name should be the same as the User and Group Base value you 
specify (via Process Task Manager) to control user access to 
Process Engine.

UserDisplayNameAttribute (Default: samAccountName) 

A display name for a user object generated by the authentication 
provider.

GroupDisplayNameAttribute (Default: samAccountName)

A display name for a group object generated by the authentication 
provider.

After you have specified the required authentication attribute values, 
click Next and continue at Step 3 on page 123.

In this screen... Perform this action...

Configure Authentication 
Provider

Specify values for the following attributes.

For more information on the attributes, click Help on the Configure 
Authentication Provider screen, or refer to “Configuring the 
connection to the Content Engine” in the IBM FileNet P8 
documentation topic FileNet P8 Administration > Enterprise-wide 
Administration > Security > Directory integration and authentication > 
Sun Java System Directory Server.

Host 

Specify a fully qualified domain name, not an IP address, of the 
directory server host. Use the DNS server or a hosts file entry (on the 
Content Engine server) to resolve the host name of the authentication 
provider. 

WARNING Do not alter the Host value after Content Engine 
installation is complete.
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Port (Default: 389) 

The port number of the directory service. Choose the port number on 
the directory server that matches the EnableSSL attribute value.

WARNING Do not alter the port number after Content Engine 
installation is complete.

EnableSSL (Default: 0 = False) 

If EnableSSL is 1, the directory service will use an SSL connection.

If EnableSSL is 0, the directory service will use a non-SSL 
connection.

ChaseReferrals (Default: 0 = False)

If ChaseReferrals is 1, the directory service will allow logons by users 
it finds via directory referrals, and directory searches will return users 
and groups accessible via referrals.

DefaultRealm (Default: No value)

The DefaultRealm value you specify is listed first in the realms 
collection returned by the directory service (e.g., dc=mydomain,
dc=com). The value should be the same as the User and Group Base 
value you specify (via Process Task Manager) to control user access 
to Process Engine.

Required only if RestrictToDefaultRealm is 1 (True). Otherwise 
optional. 

RestrictToDefaultRealm (Default: 0 = Off)

If RestrictToDefaultRealm = 1 (On), DefaultRealm requires a value. 
The directory service will allow only users in the default realm to log 
on, and will search only the default realm for users and groups.

ServiceUserName

In the Query Authentication group box, type the (case sensitive) 
name of a user who can log on to the authentication provider.

ServicePassword

In the Query Authentication group box, type the password of the user 
you specified for the ServiceUserName. Click Logon. If the resulting 
logon to the authentication provider succeeds, the ServiceUserName 
and ServicePassword attribute values will display the user name and 
password you typed.

LogonAttribute (Default: uid)

Determines which LDAP attribute is used for logons to the directory 
service when the user doesn’t specify a full dn. Also determines the 
short name to be persisted in Content Engine databases.

In this screen... Perform this action...
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Novell eDirectory

GroupPersistAttribute (Default: cn)

Determines the LDAP short name to be persisted in Content Engine 
databases.

UserDisplayNameAttribute (Default: cn)

A display name for a user object generated by the authentication 
provider.

GroupDisplayNameAttribute 

A display name for a group object generated by the authentication 
provider.

After you have specified the required authentication attribute values, 
click Next and continue at Step 3 on page 123.

In this screen... Perform this action...

Configure Authentication 
Provider

Specify values for the following attributes.

For more information on the attributes, click Help on the Configure 
Authentication Provider screen, or refer to “Configuring the 
connection to the Content Engine” in the IBM FileNet P8 
documentation topic FileNet P8 Administration > Enterprise-wide 
Administration > Security > Directory integration and authentication > 
Novell eDirectory.

Host 

Specify a fully qualified domain name, not an IP address, of the 
directory service host. Use the DNS server or a hosts file entry (on 
the Content Engine server) to resolve the host name of the 
authentication provider. 

WARNING Do not alter the Host value after Content Engine 
installation is complete.

Port (Default: 389)

The port number of the directory service. Choose the port number on 
the directory server that matches the EnableSSL attribute value.

WARNING Do not alter the port number after Content Engine 
installation is complete.

EnableSSL (Default: 0 = False)

If EnableSSL is 1, the directory service will use an SSL connection.

If EnableSSL is 0, the directory service will use a non-SSL 
connection.

In this screen... Perform this action...
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DefaultRealm (Default: No value) 

The DefaultRealm value you specify is listed first in the realms 
collection returned by the directory service. The name should be the 
same as the User and Group Base value you specify (via Process 
Task Manager) to control user access to Process Engine.

Required only if RestrictToDefaultRealm is 1 (True). Otherwise 
optional. 

RestrictToDefaultRealm (Default: 0 = Off)

If RestrictToDefaultRealm = 1 (On), DefaultRealm requires a value. 
The directory service will allow only users in the default realm to log 
on, and will search only the default realm for users and groups.

ServiceUserName In the Query Authentication group box, type the 
(case sensitive) name of a user who can log on to the authentication 
provider.

ServicePassword 

In the Query Authentication group box, type the password of the user 
you specified for the ServiceUserName. Click Logon. If the resulting 
logon to the authentication provider succeeds, the ServiceUserName 
and ServicePassword attribute values will display the user name and 
password you typed.

LogonAttribute (Default: cn)

Determines which LDAP attribute is used for logons to the directory 
service when the user doesn’t specify a full dn. Also determines the 
short name to be persisted in Content Engine databases

GroupPersistAttribute (Default: cn)

Determines the LDAP short name to be persisted in Content Engine 
databases.

UserDisplayNameAttribute (Default: cn)

A display name for a user object generated by the authentication 
provider.

GroupDisplayNameAttribute (Default: cn)

A display name for a group object generated by the authentication 
provider.

After you have specified the required authentication attribute values, 
click Next and continue at Step 3 on page 123.

In this screen... Perform this action...
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3. Complete the remaining GCD wizard screens as follows. This step completes the configuration of the 
GCD, thereby creating the new FileNet P8 domain.

NOTE As shown in the following table, the GCD wizard will attempt to load the feature AddOns 
automatically. If it fails to do so (or if you are installing custom feature AddOns), you can load them 
manually, as described in “Load feature AddOns manually” on page 124.

In this screen... Perform this action...

Configure GCD Provider Accept the default values and click Next.

GCD Administrative 
Accounts

Do the following:

a. Using the Selection Criteria group box, specify a search for 
accounts in your authentication provider that need adminis-
trative access to Content Engine resources. 

b. Click Find to populate the Accounts Found box with your 
search results.

c. Click Add>> to move the desired accounts to the Accounts 
Selected box.

NOTE We recommend you select at least one user account 
(in the following format):

Active Directory

DOMAIN\samAccount or User Principal Name

Sun Java System Directory Server / Novell eDirectory

full name or full DN

Otherwise you will have to manually specify (rather than 
select from a list) an AddOn administrator in the AddOns 
screen (described later in this table). 

d. Click Next.

Ready to create P8 domain Type the FileNet P8 domain name, and then click Next to create the 
new domain.
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Load feature AddOns manually

Perform this procedure only if (1) feature AddOns did not install automatically from the AddOns screen 
presented during Content Engine setup, or (2) you want to install custom feature AddOns.

1. Log on to IBM FileNet Enterprise Manager.

2. Right-click the root icon in the left pane of the IBM FileNet Enterprise Manager and choose Properties 
from the option menu. The Enterprise Manager Domain Root Properties dialog box opens.

3. Click AddOns.

4. Click Add/Browse. The XML Import dialog box opens. 

5. Do the following:

a. Type any name (up to 256 alphanumeric characters) to assign to the AddOn.

b. Click Browse and select the import XML file. Refer to the P8 help topic FileNet P8 Administration 
> Content Engine Administration > Feature AddOns > FileNet P8 Core Feature AddOns and sub-
topics for the names of the XML files, predecessors, requirements, etc. corresponding to these 
AddOns.

c. (Optional) If this is not the first AddOn you are installing, choose the predecessor AddOn from the 
associated list. The predecessor AddOn is the one to be installed immediately prior to the one you 
are now specifying. Multiple AddOns can have the same predecessor.

d. Click Recommended.

e. Click OK.

AddOns Do the following:

a. Select an account from the administrative account selection 
list to be the AddOn administrator.

NOTE The selection list presents only the user accounts (not 
group accounts) that you entered in the GCD Administrative 
Accounts screen described earlier in this table. If the list 
contains no account names, type the name of a user account 
that is a member of one of the groups you selected in the 
GCD Administrative Accounts screen.

b. Type a valid password for the administrative account.

c.  Click Finish.

d. If a message pops up to indicate successful configuration of 
the GCD and Content Engine, click OK. Otherwise, continue 
at “Load feature AddOns manually” on page 124.

NOTE Check the Content Engine installation logs to verify the 
installation. Unless you have selected another location, the logs are 
at their default location: \winnt\temp (on Windows 2000) or 
\Windows\temp (on Windows 2003).

In this screen... Perform this action...
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6.  If you have another AddOn to install, repeat Step 2 through Step 5. Otherwise, you are done.

To join a FileNet P8 domain

Complete the GCD wizard screens as follows:

In this screen... Perform this action...

P8 Domain Do the following:

a. Click Join Existing Domain.

b. Type the name of any Content Engine server that contains 
an Object Store Service and is in the FileNet P8 domain you 
want to join.

c. Click Next.

NOTE If you typed the name of a server that does not (yet) contain a 
Content Engine Object Store Service or is for some reason not 
currently being recognized by your Windows DNS server as a 
legitimate server name, an error message will display. In this case, 
do one of the following:

• Click Yes to return to the P8 Domain screen and type in a 
different (existing) Content Engine server name. 

• Click No to proceed to the Join Domain screen described below, 
where you will have to manually enter some additional values 
that would otherwise be filled in for you and not modifiable (e.g., 
the SYSINIT Path and P8 Domain Service Group fields).

Join Domain If the domain name shown on the Join Domain wizard screen is blank 
or does not match the FileNet P8 domain you would like to join, go 
back to the previous P8 Domain screen and enter the name of a 
different (existing) Content Engine server that contains an Object 
Store Service and is in the FileNet P8 domain you want to join.

Assuming you entered a valid Content Engine server name on the 
previous P8 Domain screen and experienced no interceding error 
message, do the following:

a. Verify that the default Windows Service Logon account 
shown is the one you want.

b. Type a Password value for the account shown.

c. Click Finish. Content Engine joins the FileNet P8 domain. 
Click OK when the wizard announces that the GCD and Con-
tent Engine are successfully configured, and you are done.

If, for some reason, you chose to continue to this screen after 
entering a not (yet) recognized Content Engine server name on the 
previous P8 Domain screen, you will have to manually enter values in 
the following fields and then click Finish to complete this procedure.
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SYSINIT Path 

The path to the sysinit.dat file on a server that hosts a Content 
Engine Object Store Service and is in the FileNet P8 domain you 
want this new Content Engine server to join. If the field is blank, 
specify the value as in the following example (where the server 
hosting the Object Store Service is named CEServer1):

\\CESERVER1\FNCE_CESERVER1$\sysinit.dat 

P8 Domain Service Group 

The name of a group with permission to add a computer to a FileNet 
P8 domain. Example: Content Engine Servers. If this field is blank, 
you must enter the same name you specified when creating the 
FileNet P8 domain on the master GCD server. Also, if the group is a 
Windows domain local group or a universal group, its members must 
also be in the Windows deployment domain (i.e., containing the 
Content Engine servers).

Use Default accounts 

For this check box, do one of the following:

• Leave it selected to accept the default account information for the 
Windows Service Logon account shown.

• Clear it if you want to choose an account for Content Engine 
Service logon from the Members list. Then click List Members 
and select one of the accounts to display it as the new Windows 
Service Logon account.

If you choose default users, you will have to re-specify their 
existing passwords. If you choose non-default users, you are free 
to specify each password.

Password 

You must supply a valid password for the Windows Service Logon 
account. If the account (e.g., FNCE_machinename) already exists, 
the new password will overwrite the existing password for the 
account.

NOTE Check the Content Engine installation logs to verify the 
installation. Unless you have selected another location, the logs are 
at their default location: \winnt\temp (on Windows 2000) or 
\Windows\temp (on Windows 2003).

In this screen... Perform this action...
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Task 8b: Install Content Engine (Custom)

A Custom setup allows you to select which Content Engine features to install:

• Object Store Service

• Content Cache Service

• Process Services Administrator (included in Object Store Service)

• File Store Service

• Administrative Tools (IBM FileNet Enterprise Manager)

• Debug Tools

• Content Engine WebDAV Provider

• IBM FileNet P8 Client Connectivity

• Publishing Foundation (Publishing Plug-in)

• Application Engine Web Connectivity (Java)

• Content Engine COM SDK

• IBM FileNet P8 Content Federation Services Server for Image Services (CFS-IS)

Deployment and authentication notes

• Even if you don’t use Windows Active Directory as your authentication provider, you still need to have 
it installed since Content Engine installation requires it, and the Windows Content Engine Service and 
COM Application user both require a Windows Active Directory user to run them.

• When installing Content Engine components (e.g., Object Store Service or File Store Service, or the 
IBM FileNet Enterprise Manager), the servers where these components are installed must be 
members of the “deployment” Windows domain (whether that be the parent or child domain) prior to 
running setup.

• The Content Engine setup will allow you to create or join a FileNet P8 domain during a Custom setup. 
You must create a FileNet P8 domain if you are installing Content Engine for the first time.

• The DefaultRealm value you specify during Content Engine installation should be the same as the 
User and Group Base value you specify (via Process Task Manager) to control user access to Process 
Engine.

• For logging purposes, grant these users write access to winnt\temp (for Windows 2000) or 
windows\temp (for Windows 2003): P8Apache (CatClient), fnce_<server> (catalog), Administrators 
(installer). Your environment may require write access for additional users.

Third-party software notes

• If the Apache HTTP Server components are not installed on the machine, you will be prompted to 
install them. Follow the Apache setup screen prompts.

• WARNING The Apache HTTP Server is installed for IBM FileNet P8 client connectivity for the Content 
Engine. By default, the Apache HTTP Server will be configured to use port 8008 for the installation. 
You can change this port assignment during setup. You should be aware of port assignments on your 
server. A conflict could arise if other programs are using port 8008.
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• If the Microsoft Data Access Components (MDAC) is not set up on the machine, it will be installed 
without user intervention during Content Engine installation. If an earlier version of MDAC is installed, it 
will be overwritten.

• If you are installing Content Engine WebDAV provider, you must have Microsoft Internet Information 
Server (IIS) installed.

Feature component notes

• File stores: If you intend to avoid creating or using file stores on the initial Content Engine server, IBM 
recommends that you disable the File Store Service on that server. This assumes you will install a File 
Store Service on a remote file store server and disable all other features there. 

• You can use IBM FileNet Enterprise Manager to administer multiple object stores in a single IBM 
FileNet P8 domain. To administer multiple IBM FileNet P8 domains from a single client machine, you 
must install Terminal Server on at least one machine in each domain. This machine should have IBM 
FileNet Enterprise Manager installed and configured for that domain. From your single client machine, 
you can connect to each machine using Terminal Server and use IBM FileNet Enterprise Manager to 
administer that specific domain. However, be aware that you cannot install Process Engine on a 
machine where Terminal Server is installed.

• Documentation: Identify the URL for the IBM FileNet P8 Platform documentation website that is 
described in “Install FileNet P8 Platform documentation” on page 57. You will need this value to 
configure the Content Engine documentation setting. If you do not provide a documentation URL, the 
installer will place an empty icon on the system desktop. You can change this setting later in the IBM 
FileNet Enterprise Manager, in which case the system also updates the documentation URL icon.

• When the Content Engine Setup wizard installs Object Store Service, it also installs Content Cache 
Service. When installed, Object Store Service uses this local Content Cache Service as its content 
cache. To take advantage of the local content cache, it is recommended that you install your cache 
client applications (such as Workplace, Team Collaboration Management, etc.) on a machine at the 
same site (local area network or geographic location) where an Object Store Service is installed.

• WebDAV: Microsoft Windows 2000 or 2003 Internet Information Server (IIS) is required for WebDAV 
support. You will be prompted for a valid Windows account and password.

• CFS-IS: If you previously installed CFS-IS on another machine in your FileNet P8 domain, then the 
Content Engine install you are about to do on this machine must include CFS-IS. Otherwise, you won’t 
be able to work with an object store on this machine that uses an Image Services server as a fixed 
content device.

Each installation of CFS-IS will require the machine's hosts file to include an entry for the Image 
Services server, or you must change the DNS configuration information on the server so that your 
machine can find the Image Services server.

• Feature AddOns: While installing Content Engine, you have the option of installing feature AddOns. A 
feature AddOn consists of custom implementations of classes, objects, and properties that support 
specific product functionality, such as publishing, searching, email, and IBM FileNet eForms. For 
detailed information about standard AddOns and possible custom AddOns, refer to the following topics 
in the IBM FileNet P8 Online Help:

– FileNet P8 Administration > Content Engine Administration > Feature AddOns > FileNet P8 Core 
Feature AddOns

– FileNet P8 Administration > Content Engine Administration > View/modify P8 domain properties > 
XML Import dialog box (AddOn Configuration tab)
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– FileNet P8 administration > Content Engine Administration > FileNet P8 Domain > View/modify P8 
domain properties > FileNet P8 domain root properties (Import AddOns tab)

To install the Content Engine using the Custom option

WARNING Do not rename any server after installing the Object Store Service, File Store Service, or 
Content Cache Service. If you need to rename a server, do so before installing Content Engine software.

1. Log on to the Windows server as an Active Directory domain user who is also a local administrator. 
You may need to be a Domain Account Operator or higher, depending on which option you choose 
when specifying the Windows service user to run the Content Engine services:

• If you allow Content Engine Setup to use an existing domain group and user account for the Con-
tent Engine Servers group role and FNCE_<machinename> user role respectively, you do not 
need Domain Account Operator privileges if you specify an existing user account and password.

• If you allow Content Engine Setup to create a new domain group and user account, Content 
Engine Servers and FNCE_<machinename> respectively, you need Domain Account Operator or 
higher privileges; and you’ll need to assign a new password to this account.

2. Insert the IBM FileNet P8 Content Engine CD into the CD-ROM drive, navigate to the ContentEngine 
folder, and click setup.exe. The Content Engine Setup wizard opens.

NOTE You can click Back at any time during the installation process to make changes in any previous 
wizard screen.

3. Complete the Setup screens as follows: 

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine installation.

License Agreement Review and accept the license agreement for FileNet P8 software 
products, and then click Next.

Minimum Requirement This screen appears only if the server where you are installing 
Content Engine software does not meet the suggested minimum 
system requirements posted in the FileNet P8 Hardware and 
Software Requirements on the FileNet Customer Service and 
Support web site (http://www.css.filenet.com).

Click Next if you wish to proceed with the installation, but be aware 
that performance will be impacted. Or click Cancel to exit the wizard.

Customer Information Type your user name (required) and organization (optional). Accept 
or change the default install log location, and then click Next.

Setup Type Click Custom, accept or change the default install log location, and 
then click Next.

http://www.css.filenet.com/docsvs/doccontent.asp?DocID=052260002
http://www.css.filenet.com/docsvs/doccontent.asp?DocID=052260002
http://www.css.filenet.com
http://www.css.filenet.com
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Custom Setup By default, the program features list shows all Content Engine 
components, except FileNet P8 Content Federation Services Server 
for Image Services, selected for installation. 

a. To specify the features you want to install, do the following 
for each entry in the list:

i. Highlight the entry and select from its drop-down list 
(click the icon to the left of the entry) whether to install 
the feature or not.

ii. If you choose to install the feature, click Disk Usage to 
confirm that you have sufficient disk space for it.

You must select the Object Store Service feature if you are 
installing your first Content Engine server, which will be the 
FileNet P8 master Global Configuration Data (GCD) server 
(editable in the setup wizard).

If you want to install only the IBM FileNet Enterprise Manager 
administrative client software, select Administrative Tools 
and deselect all the other features.

NOTE If you are installing WebDAV, you must have Microsoft 
Internet Information Server (IIS) installed.

b. Accept (or click Change to alter) the default Content Engine 
installation directory. 

c. Click Next.

FileNet P8 Content 
Federation Services Server 
for Image Services Setup

This screen appears only if you selected FileNet P8 Content 
Federation Services Server for Image Services for installation at the 
Custom Setup screen. 

Click Browse if you want to alter the default installation directory. 
Then click Next.

WebDAV Configuration This screen appears only if you selected Content Engine WebDAV 
Provider at the Custom Setup screen.

Type a valid Windows domain account and password (for example, 
WinOSDomain\Account_name) to use for WebDAV extension 
authentication. Then click Next.

NOTE This account is used for Microsoft Internet Information Server 
(IIS) logon authentication (not for the Content Engine or object 
stores).

In this screen... Perform this action...
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Install third-party software This screen appears only if you have not already installed third-party 
software required by Content Engine: MDAC and Apache HTTP 
Server.

NOTE If you don’t want to install the required third-party software at 
this time, but would rather install it yourself manually, click Cancel to 
stop the Content Engine Setup wizard.

If prompted to install third-party software, do the following:

a. Click Next.

b. Follow all screen prompts.

In most environments, you can accept the default installation 
values for third-party software unless otherwise noted.

Ready to Install Do the following:

a. If you already have an IBM FileNet P8 Documentation web 
site installed, you can configure Content Engine components 
to access it, as follows.

NOTE If you don’t yet have a documentation web site 
installed, see “Feature component notes” on page 128.

i. Select the provided check box.

ii. Type the URL of the web site in the following format:

http://<docserver>:<port#>/<ecm_help>)

where:

docserver is the name of the Java web server

port# is the port number

ecm_help is the root folder of the documentation website

You can use multipart root folders if your application 
server supports them (e.g., /docs/ecm_help). 

iii. Click Test to verify that the browser opens at the docu-
mentation URL. Then exit the browser.

b. Click Install to install Content Engine. (The installation will 
take several minutes.)

In this screen... Perform this action...
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To create or join a FileNet P8 domain

Determine whether you want to create or join a FileNet P8 domain as follows:

1. If you are currently installing initial Content Engine components (e.g., the initial Object Store Service) 
on the first server, which will become the IBM FileNet P8 master Global Configuration Data (GCD) 
server, continue at “To create a FileNet P8 domain” on page 133.

2. If you are currently installing subsequent Content Engine components (e.g., a second Object Store 
Service on another FileNet P8 member server), and want to join an existing FileNet P8 domain, 
continue at “To join a FileNet P8 domain” on page 142.

To join a FileNet P8 domain, you will be asked to enter the name of a server where Content Engine 
Object Store Service in that FileNet P8 domain is installed.

If an error occurs, or if you have to click Cancel, while the GCD wizard is running, the wizard will attempt to 
roll back any changes it has made since being started. (Rollback includes deletion of services, Windows 
registry keys, the GCD sysinit folder, etc.) With successful automatic rollback, you do not need to do any 
manual cleanup. Simply re-run the wizard (e.g., after fixing the underlying problem that caused it to fail).

Click OK if you see an error message stating that the msdaora.dll file may not have been installed or is 
corrupt. This is a Microsoft-generated message and does not impact Content Engine installation.

FileNet P8 Content 
Federation Services Server 
for Image Services Setup

This screen appears only if you selected FileNet P8 Content 
Federation Services Server for Image Services for installation at the 
Custom Setup screen.

Do the following as prompted:

a. Insert the FileNet P8 Content Federation Services Server for 
Image Services CD into the CD-ROM drive. 

b. In the Location text box type, or click Browse to navigate to, 
the folder path containing the installation software (4.0.x.y). 

c. Click OK.

d. Click OK again to confirm that the folder contains the correct 
version of the FileNet P8 Content Federation Services Server 
for Image Services software. This action starts the installa-
tion.

Completing the Content 
Engine Setup wizard

Click Finish. This action completes the installation of Content Engine 
software and opens the GCD wizard to enable you to create a new, or 
join an existing, FileNet P8 domain. 

NOTE If the GCD wizard does not start automatically, navigate to 
<drive>\Program Files\FileNet\Content Engine and double-click 
ConfigGCD.exe to manually start it.

 Continue at “To create or join a FileNet P8 domain” on page 132 

In this screen... Perform this action...
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To create a FileNet P8 domain

1. Complete the initial GCD wizard screens as follows:.

In this screen... Perform this action...

P8 Domain Click Create New Domain and then click Next.

P8 Domain Service 
Account

Do the following:

a. Create a new, or assign an existing, Windows Active Direc-
tory account to run the Content Engine services on this 
machine by doing one of the following:

• Select the check box to accept the default account infor-
mation for the P8 Domain Content Engine Servers group 
(such as Content Engine Servers) and a Windows ser-
vice logon account (such as FNCE_<machinename>) 
that is a member of the group. (Note that 
FNCE_<machinename> cannot exceed 20 characters.) 
These accounts will be created if they do not already 
exist.

• Clear the check box, type an existing group name, click 
List Members, and select from the list a Windows ser-
vice logon account. The group must exist in the authenti-
cation domain in which you’re installing Content Engine. 
Also, if the group you select is a domain local or a univer-
sal group, its members must also be in the Content 
Engine’s authentication domain.

b. Type a password for the Windows service logon account, 
which will override any password previously supplied to the 
account. 

c. Click Next. 
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2. Specify attribute values for your particular authentication provider as follows.

For your choice of authentication provider, the Configure Authentication Provider screen shows an 
associated table of color-coded attribute names and values. You cannot directly supply values for red 
attributes, which instead are automatically set based on earlier input or associated entries on this 
screen. However, you must supply values directly for all blue attributes, some of which have modifiable 
default values.

Configure Authentication 
Provider

Do the following:

a. Accept the default SYSINIT path (for example, C:\Program 
Files\FileNet\Content Engine\sysconfig\sysinit, or click 
Edit to locate a valid folder for the sysinit.dat file. Click 
Reset if you have changed the path and want to restore its 
default.

If you don’t accept the default SYSINIT, be sure that the 
folder you choose is a shared folder with these permissions:

• Full Control for the group defined as Content Engine 
Servers

• Full Control for all Windows administrative users/groups 
that will directly maintain files (i.e., do backups and 
restores)

And be sure the share itself has one of the following 
permissions:

• Full Control for the Authenticated Users group (restrictive 
permissions on the folder will keep out unauthorized 
users)

• Full Control for Content Engine Servers and Windows 
administrative users/groups

b. Select an authentication provider from the provided list: 

• Windows Integrated

• Sun Java System Directory

• eDirectory (Novell)

c. Continue at Step 2 on page 134 for instructions on specifying 
all other information in the screen.

In this screen... Perform this action...
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Windows Integrated (Active Directory)

Sun Java System Directory Server

In this screen... Perform this action...

Configure Authentication 
Provider

Specify values for the following attributes. 

For more information on the attributes, click Help on the Configure 
Authentication Provider screen, or refer to “Configuring the 
connection to the Content Engine” in the IBM FileNet P8 
documentation topic FileNet P8 Administration > Enterprise-wide 
Administration > Security > Directory integration and authentication > 
Windows Active Directory.

DefaultRealm 

The name of a Windows domain where user accounts reside. The 
name should be the same as the User and Group Base value you 
specify (via Process Task Manager) to control user access to Process 
Engine. Leave this blank or use a format like the following:

abc.xyz.com

UserDisplayNameAttribute (Default: samAccountName) 

A display name for a user object generated by the authentication 
provider.

GroupDisplayNameAttribute (Default: samAccountName)

A display name for a group object generated by the authentication 
provider.

After you have specified the required authentication attribute values, 
click Next and continue at Step 3 on page 139.

In this screen... Perform this action...

Configure Authentication 
Provider

Specify values for the following attributes.

For more information on the attributes, click Help on the Configure 
Authentication Provider screen, or refer to “Configuring the 
connection to the Content Engine” in the IBM FileNet P8 
documentation topic FileNet P8 Administration > Enterprise-wide 
Administration > Security > Directory integration and authentication > 
Sun Java System Directory Server.
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Host 

Specify a fully qualified domain name, not an IP address, of the 
directory server host. Use the DNS server or a hosts file entry (on the 
Content Engine server) to resolve the host name of the authentication 
provider. 

WARNING Do not alter the Host value after Content Engine 
installation is complete.

Port (Default: 389) 

The port number of the directory service. Choose the port number on 
the directory server that matches the EnableSSL attribute value.

WARNING Do not alter the port number after Content Engine 
installation is complete.

EnableSSL (Default: 0 = False) 

If EnableSSL is 1, the directory service will use an SSL connection.

If EnableSSL is 0, the directory service will use a non-SSL 
connection.

ChaseReferrals (Default: 0 = False)

If ChaseReferrals is 1, the directory service will allow logons by users 
it finds via directory referrals, and directory searches will return users 
and groups accessible via referrals.

DefaultRealm (Default: No value)

The DefaultRealm value you specify is listed first in the realms 
collection returned by the directory service.

Required only if RestrictToDefaultRealm is 1 (True). Otherwise 
optional. 

RestrictToDefaultRealm (Default: 0 = Off)

If RestrictToDefaultRealm = 1 (On), DefaultRealm requires a value. 
The directory service will allow only users in the default realm to log 
on, and will search only the default realm for users and groups.

ServiceUserName 

In the Query Authentication group box, type the (case sensitive) 
name of a user who can log on to the authentication provider.

ServicePassword 

In the Query Authentication group box, type the password of the user 
you specified for the ServiceUserName. Click Logon. If the resulting 
logon to the authentication provider succeeds, the ServiceUserName 
and ServicePassword attribute values will display the user name and 
password you typed.

In this screen... Perform this action...
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LogonAttribute (Default: uid)

Determines which LDAP attribute is used for logons to the directory 
service when the user doesn’t specify a full dn. Also determines the 
short name to be persisted in Content Engine databases.

GroupPersistAttribute (Default: cn)

Determines the LDAP short name to be persisted in Content Engine 
databases.

UserDisplayNameAttribute (Default: cn)

A display name for a user object generated by the authentication 
provider.

GroupDisplayNameAttribute 

A display name for a group object generated by the authentication 
provider.

After you have specified the required authentication attribute values, 
click Next and continue at Step 3 on page 139.

In this screen... Perform this action...
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Novell eDirectory

In this screen... Perform this action...

Configure Authentication 
Provider

Specify values for the following attributes.

For more information on the attributes, click Help on the Configure 
Authentication Provider screen, or refer to “Configuring the 
connection to the Content Engine” in the IBM FileNet P8 
documentation topic FileNet P8 Administration > Enterprise-wide 
Administration > Security > Directory integration and authentication > 
Novell eDirectory.

Host 

Specify a fully qualified domain name, not an IP address, of the 
directory service host. Use the DNS server or a hosts file entry (on 
the Content Engine server) to resolve the host name of the 
authentication provider. 

WARNING Do not alter the Host value after Content Engine 
installation is complete.

Port (Default: 389)

The port number of the directory service. Choose the port number on 
the directory server that matches the EnableSSL attribute value.

WARNING Do not alter the port number after Content Engine 
installation is complete.

EnableSSL (Default: 0 = False)

If EnableSSL is 1, the directory service will use an SSL connection.

If EnableSSL is 0, the directory service will use a non-SSL 
connection.

DefaultRealm (Default: No value) 

The DefaultRealm value you specify is listed first in the realms 
collection returned by the directory service.

Required only if RestrictToDefaultRealm is 1 (True). Otherwise 
optional. 

RestrictToDefaultRealm (Default: 0 = Off)

If RestrictToDefaultRealm = 1 (On), DefaultRealm requires a value. 
The directory service will allow only users in the default realm to log 
on, and will search only the default realm for users and groups.

ServiceUserName In the Query Authentication group box, type the 
(case sensitive) name of a user who can log on to the authentication 
provider.
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3. Complete the remaining GCD wizard screens as follows. This step completes the configuration of the 
GCD, thereby creating the new FileNet P8 domain.

NOTE As shown in the following table, the GCD wizard will attempt to load the feature AddOns 
automatically. If it fails to do so (or if you are installing custom feature AddOns), you can load them 
manually, as described in “Load feature AddOns manually” on page 141.

ServicePassword 

In the Query Authentication group box, type the password of the user 
you specified for the ServiceUserName. Click Logon. If the resulting 
logon to the authentication provider succeeds, the ServiceUserName 
and ServicePassword attribute values will display the user name and 
password you typed.

LogonAttribute (Default: cn)

Determines which LDAP attribute is used for logons to the directory 
service when the user doesn’t specify a full dn. Also determines the 
short name to be persisted in Content Engine databases

GroupPersistAttribute (Default: cn)

Determines the LDAP short name to be persisted in Content Engine 
databases.

UserDisplayNameAttribute (Default: cn)

A display name for a user object generated by the authentication 
provider.

GroupDisplayNameAttribute (Default: cn)

A display name for a group object generated by the authentication 
provider.

After you have specified the required authentication attribute values, 
click Next and continue at Step 3 on page 139.

In this screen... Perform this action...

Configure GCD Provider Accept the default values and click Next.

In this screen... Perform this action...
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GCD Administrative 
Accounts

Do the following:

a. Using the Selection Criteria group box, specify a search for 
accounts in your authentication provider that need adminis-
trative access to Content Engine resources. 

b. Click Find to populate the Accounts Found box with your 
search results.

c. Click Add>> to move the desired accounts to the Accounts 
Selected box.

NOTE We recommend you select at least one user account 
(in the following format):

Active Directory

DOMAIN\samAccount or User Principal Name

Sun Java System Directory Server / Novell eDirectory

full name or full DN

Otherwise you will have to manually specify (rather than 
select from a list) an AddOn administrator in the AddOns 
screen (described later in this table). 

d. Click Next.

Ready to create P8 domain Type the FileNet P8 domain name, and then click Next to create the 
new domain.

In this screen... Perform this action...
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Load feature AddOns manually

Perform this procedure only if (1) feature AddOns did not install automatically from the AddOns screen 
presented during Content Engine setup or (2) you want to install custom feature AddOns.

1. Log on to IBM FileNet Enterprise Manager.

NOTE If your custom installation does not include IBM FileNet Enterprise Manager, log on to IBM 
FileNet Enterprise Manager from a machine in the FileNet P8 domain where it is installed, map a drive 
from that machine to the machine where you want to load the AddOns, and then go on to Step 2.

2. Right-click the root icon in the left pane of the IBM FileNet Enterprise Manager and choose Properties 
from the option menu. The Enterprise Manager Domain Root Properties dialog box opens.

3. Click AddOns.

4. Click Add/Browse. The XML Import dialog box opens.

5. Do the following:

a. Type any name (up to 256 alphanumeric characters) you wish to assign to the AddOn.

b. Click Browse to select the import XML file for the add on function on the installation media or 
directory. Refer to the P8 help topic FileNet P8 Administration > Content Engine Administration > 
Feature AddOns > FileNet P8 Core Feature AddOns and subtopics for the names of the XML files, 
predecessors, requirements, etc. corresponding to these AddOns.

AddOns Do the following:

a. Select an account from the administrative account selection 
list to be the AddOn administrator.

NOTE The selection list presents only the user accounts (not 
group accounts) that you entered in the GCD Administrative 
Accounts screen described earlier in this table. If the list 
contains no account names, type the name of a user account 
that is a member of one of the groups you selected in the 
GCD Administrative Accounts screen.

b. Type a valid password for the administrative account.

c. Click Finish.

d. If a message pops up to indicate successful configuration of 
the GCD and Content Engine, click OK. 

e. Reboot the machine, as prompted, if you installed IBM 
FileNet P8 CFS Server for Image Services.

f. If the AddOns did not install automatically, continue at “Load 
feature AddOns manually” on page 141.

NOTE Check the Content Engine installation logs to verify the 
installation. Unless you have selected another location, the logs are 
at their default location: \winnt\temp (on Windows 2000) or 
\Windows\temp (on Windows 2003).

In this screen... Perform this action...
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c. (Optional) If this is not the first AddOn you are installing, choose the predecessor AddOn from the 
associated list. The predecessor AddOn is the one to be installed immediately prior to the one you 
are now specifying. Multiple AddOns can have the same predecessor.

d. Click Recommended.

e. Click OK.

6.  If you have another AddOn to install, repeat Step 2 through Step 5. Otherwise, skip to “To verify the 
IBM FileNet P8 Content Federation Services Server for Image Services installation” on page 144.

To join a FileNet P8 domain

1. Complete the GCD wizard screens as follows:

In this screen... Perform this action...

P8 Domain Do the following:

a. Click Join Existing Domain.

b. Type the name of any Content Engine server that contains 
an Object Store Service and is in the FileNet P8 domain you 
want to join.

c. Click Next.

NOTE If you typed the name of a server that does not (yet) contain a 
Content Engine Object Store Service or is for some reason not 
currently being recognized by your Windows DNS server as a 
legitimate server name, an error message will display. In this case, 
do one of the following:

• Click Yes to return to the P8 Domain screen and type in a 
different (existing) Content Engine server name. 

• Click No to proceed to the Join Domain screen described below, 
where you will have to manually enter some additional values 
that would otherwise be filled in for you and not modifiable (e.g., 
the SYSINIT Path and P8 Domain Service Group fields).
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Join Domain If the domain name shown on the Join Domain wizard screen is blank 
or does not match the FileNet P8 domain you would like to join, go 
back to the previous P8 Domain screen and enter the name of a 
different (existing) Content Engine server that contains an Object 
Store Service and is in the FileNet P8 domain you want to join.

Assuming you entered a valid Content Engine server name on the 
previous P8 Domain screen and experienced no interceding error 
message, do the following:

a. Verify that the default Windows Service Logon account 
shown is the one you want.

b. Type a Password value for the account shown.

c. Click Finish. Content Engine joins the FileNet P8 domain. 
Click OK when the wizard announces that the GCD and Con-
tent Engine are successfully configured, and continue at 
Step 2.

If, for some reason, you chose to continue to this screen after 
entering a not (yet) recognized Content Engine server name on the 
previous P8 Domain screen, you will have to manually enter values in 
the following fields and then click Finish to complete this procedure.

SYSINIT Path 

The path to the sysinit.dat file on a server that hosts a Content 
Engine Object Store Service and is in the FileNet P8 domain you 
want this new Content Engine server to join. If the field is blank, 
specify the value as in the following example (where the server 
hosting the Object Store Service is named CEServer1):

\\CESERVER1\FNCE_CESERVER1$\sysinit.dat 

P8 Domain Service Group 

The name of a group with permission to add a computer to a FileNet 
P8 domain. Example: Content Engine Servers. If this field is blank, 
you must enter the same name you specified when creating the 
FileNet P8 domain on the master GCD server. Also, if the group is a 
Windows domain local group or a universal group, its members must 
also be in the Windows deployment domain (i.e., containing the 
Content Engine servers).

In this screen... Perform this action...
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2. Reboot the machine, as prompted, if you installed IBM FileNet P8 CFS Server for Image Services.

To verify the IBM FileNet P8 Content Federation Services Server for Image Services installation

If you installed the IBM FileNet P8 CFS Server for Image Services program feature as part of your Content 
Engine installation, verify that this feature is correctly installed:

1. In the Services control panel for Windows, verify that IBM FileNet CFS Server for Image Services is 
listed.

2. In the Windows registry, verify that the Version value of the following key matches what you installed: 
HKEY_LOCAL_MACHINE\Software\FileNet\WAL\CurrentVersion\Version.

Use Default accounts 

For this check box, do one of the following:

• Leave it selected to accept the default account information for the 
Windows Service Logon account shown.

• Clear it if you want to choose an account for Content Engine 
Service logon from the Members list. Then click List Members 
and select one of the accounts to display it as the new Windows 
Service Logon account.

If you choose default users, you will have to re-specify their 
existing passwords. If you choose non-default users, you are free 
to specify each password.

Password 

You must supply a valid password for the Windows Service Logon 
account. If the account (e.g., FNCE_machinename) already exists, 
the new password will overwrite the existing password for the 
account.

NOTE Check the Content Engine installation logs to verify the 
installation. Unless you have selected another location, the logs are 
at their default location: \winnt\temp (on Windows 2000) or 
\Windows\temp (on Windows 2003).

In this screen... Perform this action...
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Task 9: Configure the Content Engine environment

To enable Content Engine access to a DB2 database

If your database is DB2, and you have installed IBM DB2 Universal Database Version 8.2 FixPak 2 
(equivalent to IBM DB2 Universal Database Version 8.1 FixPak 9), you must add the Content Engine 
Servers group (or its equivalent) to the local DB2USERS group on each Content Engine server. Otherwise, 
Content Engine will not be able to access the DB2 database.

To assign permissions for the FileNet P8 Apache User

The authentication domain P8Apache user logging on to the Apache service needs permissions on certain 
installed Apache folders. You must be a local administrator (or have equivalent permissions) on the 
Content Engine machine to perform this procedure.

NOTE The authentication domain P8Apache user must be created before you can complete P8Apache-
specific steps below.

1. Verify or create the authentication domain P8Apache user.

For additional details, see the installation task “Create groups and users required for IBM FileNet P8 
installation” on page 49.

2. On the Content Engine server navigate to the Apache installation directory (e.g., Default location: 
Program Files\Apache Group\Apache2).

3. Add the <authentication domain>\P8Apache user read and execute (RX) rights (Read & Execute, List 
Folder Contents, Read) to the script and document folders (\cgi-bin and \htdocs). 

4. Add the <authentication domain>\P8Apache user change rights (Modify, Read & Execute, List Folder 
Contents, Read, Write) to the Apache logs (\logs) folder. 

5. Add the <authentication domain>\P8Apache user read and execute (RX) rights (Read & Execute, 
Read) to the Apache.exe binary executable, whose default location is 
Program Files\Apache Group\Apache2\bin\Apache.exe.

6. Launch the Windows Services snap-in (for example, by choosing Start > Programs > Administrative 
Tools > Services).

7. Right-click the Apache2 service icon, choose Properties, and click Stop to stop the Apache2 service. 

8. Select the Log On tab and select Log on as: This account. 

9. Browse for, or type the P8Apache user in the Name box and click OK. Type and confirm the 
password, and click Apply.

10. If the P8Apache user was granted the “Log on as a service” user right, click OK.

11. From the General tab click Start to start the Apache2 service.

12. Close the Apache2 Properties page and the Services snap-in. 

Modify the Local Security Policy on the Content Engine Server(s)

1. On the Content Engine server, log in with an account that has local administrator rights. 

2. Select Start > Programs > Administrative Tools > Local Security Policy.

NOTE  If Content Engine is installed on the domain controller (supported in demo, non-production 
configurations only), select Domain Controller Security Policy instead of Local Security Policy.
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3. Expand Local Policies > User Rights Assignment.

4. Double-click Access this computer from the network and add all the Authentication domain 
group(s)/users that will need to logon to the Content Engine system. Everyone is the default. 

5. Click OK twice.

6. Double-click Act as part of the operating system and add the authentication domain P8Apache 
user.

7. Click OK twice.

8. Double-click Log on as a service and add the authentication domain P8Apache user.

9. Click OK twice.

10. Close the Administrative Tools application.

11. Log off and log back on to the computer (not as the P8Apache user). The new permissions are now set 
for the P8Apache account.

To set permissions for the file stores

For Windows Active Directory authentication, IBM recommends adding the following permissions on the 
shares containing local and remote file stores:

• Accounts: P8Apache User - Full Control, Authenticated Users - Full Control.

• Other accounts as required for your specific environment.

To enable trace logging on a standalone FileNet Enterprise Manager

If it isn't already running, start the Remote Registry Service on the machine where Content Engine is 
installed if you want to allow trace logging to be enabled on the Content Engine from machines where you 
will later install a remote FileNet Enterprise Manager.
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Task 10: Create an object store and verify the Content Engine 
installation

To create an object store, you need to know the following:

• Display name for new object store

• Object store description (optional)

• Server where Object Store Service is installed

• Database engine (SQL Server, Oracle, or DB2)

• (SQL Server) Type of authentication: Windows Authentication or Database Engine Authentication

• (Oracle) User name and password for the tablespace corresponding to the object store

• (DB2) SQL authorization ID and password for the database

• Database alias

• (SQL Server) Database name

• (Oracle) Net service name

• (DB2) Local database alias

• Whether to create a database store or a file store

• Initial administrative and user groups that can access the object store

Deployment notes

• You must create at least one object store in your  FileNet P8 domain.

• IBM recommends creating the first object store as a database store in order to save preferences.

• You can create the required shared folder for the object store’s local or remote file store either before or 
during execution of the Create an Object Store wizard. However, if your file store will be remote, it is 
strongly recommended that you first install File Store Service on the remote server. (Refer to 
“Configure remote Content Engine file stores” on page 267 for the procedure to do this.) Otherwise, a 
crash of the remote server could result in the loss of in-progress transactions involving the remote file 
store.

• The name you assign to a Content Engine object store must meet the following requirements:

• Can be no more than 64 alphanumeric characters.

• Can be different from the name of the associated database (SQL Server and DB2) or tablespace 
(Oracle).

• Must be unique from other object store names within FileNet P8 domain.

NOTE There may be other restrictions imposed by the underlying database programs which may be an 
issue. Consult your database documentation or administrator for any restrictions.

Authentication notes

• Depending on your environment, you can create a new Domain Local - Security group for each new 
object store. Distribution Groups are not supported.
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• Care must be taken when planning the groups that are given access to object stores at creation time. 
In order to add a new ‘default’ group to an object store that has gone into production, you can run the 
Security Script wizard in IBM FileNet Enterprise Manager (see the IBM FileNet P8 online help topic 
FileNet P8 Administration > Enterprise-wide Administration > Security > How to... > Update object 
store with new users and groups). It is recommended that a main ‘Domain Local - Security group’ be 
selected when the object store is created. New Domain Local - Security groups (or Domain users) 
could then be added to that group.

Database notes

• All the object stores you create for Content Engine must be based on the same database engine (SQL 
Server, Oracle, or DB2). For example, you cannot have one object store based on Oracle and another 
based on SQL Server.

• If using Windows Authentication, instead of SQL Server Authentication, for the SQL Server database 
engine, you must create a valid SQL Server login for the Windows Service Account group (e.g., 
Content Engine Servers).

• If Oracle is your database engine, the Oracle client must be installed on the Content Engine server. 
You cannot create an object store with an Oracle user name that contains a space or has mixed-case 
characters.

• You must create an Oracle tablespace for each object store prior to running the Create an Object 
Store wizard. Repeat this step for each object store you want to create. Once an object store is 
created, you can refine its definition and add content.

• The Create Object Store wizard will fail if you try to assign a new object store to a database/tablespace 
that is not completely empty.

Content store notes

• You can create two types of content stores: file stores and database stores. 

• Create a file store if you choose to store the contents of your documents or business objects in a 
Windows DFS or NTFS file system as part of your storage policy. The path name to a shared 
folder specifies the location of the new file store. 

• Create a database store if you choose to store the contents in the database as binary large objects 
(BLOBs).

• A fixed file store is a file store that has a connection to a third-party, large-capacity, fixed-content 
(possibly write-once) system. You must create a fixed content device (an IBM FileNet P8 object) before 
creating a fixed file store (see FileNet P8 Administration > Content Engine Administration > Content 
stores > File stores > How to... > Create file store).

• The file store and/or database names must be unique within an object store.

• File stores on encrypted NTFS devices are not supported.

To create an object store

Perform this procedure from a server where IBM FileNet Enterprise Manager is installed.

1. On a machine that has the IBM FileNet Enterprise Manager installed, log on as a GCD administrator.

2. Launch the IBM FileNet Enterprise Manager (double-click the desktop shortcut) and log on.

NOTE You will be required to log on when the IBM FileNet Enterprise Manager is started. Windows 
Integrated authentication will not require a password.
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3. Right-click the Object Stores container and choose New Object Store. 

4. Work through the initial Create Object Store wizard screens as follows:

5. Specify the required information shown in one of the following tables, based on your choice of 
database engine.

In this screen... Perform this action...

Welcome Click Next to proceed with the object store creation.

Name and Describe the 
Object Store

Type the display name for the object store. The symbolic name and 
description are entered automatically as you type the display name, 
but you can edit them before leaving this screen. Then click Next.

NOTE The symbolic name, used for internal programmatic purposes, 
must contain only ASCII characters and must begin with an 
alphabetic character.

Specify the Database 
Engine

Click SQL Server, Oracle, or DB2. Then continue at Step 5 for 
instructions on specifying the other information in the screen.
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SQL Server

Oracle

In this screen... Perform this action...

Specify the Database 
Engine

Select a database server name from the drop-down box, and then 
click Next.

NOTE If the Microsoft SQL database was configured with Named 
Instances, you must enter the database and instance name (e.g., 
YourServer\Your_Inst). If the database server is in a different Active 
Directory domain or forest, you must type the server name.

Specify Account 
Information

Select either Windows or Database Engine authentication and then 
click Next.

• For Database Engine authentication, enter a valid SQL Server 
user name and password.

• For Windows authentication, the MS SQL Server database 
server and Content Engine server must be in the same Windows 
Active Directory forest. For help with proper credentials for 
database connectivity, see the procedure “To Configure 
Microsoft SQL Login for Content Engine” in “Install Microsoft SQL 
Server for IBM FileNet P8” on page 58.

Specify the Database 
Name

Click either Create a New Database (and enter a new name) or 
Choose an Existing Database (and select the database name from 
the drop-down list). Then click Next and continue at Step 6.

NOTE The Content Engine software will detect all Object Store 
Service and SQL Server database installations available in your 
Windows domain and makes them available to you as choices when 
you run the Create Object Store wizard. The database you select 
must be empty.

In this screen... Perform this action...

Specify the Database 
Engine

Type the Oracle net service name and click Next.

Specify User Account 
Information

Type the Oracle user name and password you specified in creating 
the tablespace for this object store (see “Install Oracle Server for IBM 
FileNet P8” on page 63). Then click Next and continue at Step 6.
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DB2

6. Work through the following Create Object Store wizard screens:

In this screen... Perform this action...

Specify the Database 
Engine

Type the local database alias and click Next.

Specify User Account 
Information

Type the DB2 user name and password for the database (see “Install 
DB2 server for Content Engine and Process Engine” on page 68). 
Then click Next and continue at Step 6.

In this screen... Perform this action...

Specify the default Content 
Store

Click either Database Store or File Store, and then click Next. If you 
clicked Database Store, skip to Step 7.

Specify File Store Folder Click Local Server to use a folder on this server, or click Remote 
Server to use a folder on a remote server. Click Browse if no shared 
folders appear in the drop-down list. If the folder doesn’t yet exist, 
click New Folder. The file store folder must be shared and the 
P8Apache user and Authenticated Users group should be added to 
the permissions list for the share.
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Fixed File Store Do the following:

a. If you intend to use a fixed content device for your file stores, 
select the Fixed File Store check box and continue at Step b. 
Otherwise, clear the check box and skip to Step h.

b. Select a fixed content device from the selection list.

NOTES

• Hitachi Data Systems and IBM TSM/DR550 (Tivoli Stor-
age Manager) will appear in the selection list only if you 
have already installed Content Engine 3.5.1 Service 
Pack. See ““Install Service Packs and patches for core 
components” on page 236.

• Hitachi fixed content devices used for file stores must 
reside in the same Active Directory domain as the Con-
tent Engine servers.

• See IBM FileNet P8 Platform Release Notes for the latest 
information on FileNet certification of IBM TSM/DR550 
as a fixed content device.

c. If you selected FileNet Image Services, then IBM FileNet 
Enterprise Manager displays the Default IS Document Class 
group box, including the default document class of the 
selected fixed content device.

d. If you selected EMC Centera or SnapLock, IBM FileNet 
Enterprise Manager also displays retention information from 
which you can select a retention period.

e. (Optional) Clear the Create Referral File check box, and IBM 
FileNet Enterprise Manager will warn that full text indexing 
won’t be available for the new file store. (A referral file is used 
to reindex content stored in a fixed file store.)

f. (Optional) Click Selected below in the Default IS Document 
Class group box to override the default document class of the 
fixed content device. IBM FileNet Enterprise Manager then 
enables a selection list in the lower part of the group box and 
fills it with available IS document classes.

g. (Optional) If you clicked Selected below in Step f, you can 
choose an alternate default IS document class from the 
selection list.

h. Click Next and continue at Step 7.

In this screen... Perform this action...
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7. Work through the remaining Create Object Store wizard screens as follows:

NOTE If, as an object store administrator, you need to add more users or groups to the object store, use 
the Security Script wizard described in FileNet P8 Administration > Enterprise-wide Administration > 
Security > How to... > Update object store with new users and groups.

To verify the Content Engine installation

The following steps are the same whether you use Microsoft SQL Server, Oracle, or DB2 for the database 
engine.

1. Create a subfolder as follows:

a. Expand the Object Stores container and expand the node for the object store you just created.

b. Right-click the Root Folder icon, and select New Sub Folder.

c. Enter the Folder Name and click Create.

In this screen... Perform this action...

Specify object store 
administrators

Click Add... to add the FileNet P8 Domain groups and users that are 
likely to need administrative access to the object store. 

NOTE You may have to select a Realm from the drop-down box to 
get a list of the accounts from which you want to choose.

Select Users and Groups Click Find. Then press and hold the control (CTRL) key while you 
highlight (select) the required administrator groups/users using the 
left mouse button. With all required groups/users selected, release 
the CTRL key, click OK, and then click Next.

NOTE By default, the account used to create the object store will be 
added to the list of administrative users. At least one administrator 
user account must be added to the object store. Object store 
administrators will be able to log on to IBM FileNet Enterprise 
Manager and do administrative work on that object store.

Specify Initial User Groups Click Add... to add the FileNet P8 Domain groups that are likely to 
need basic non-administrative access to the object store.

NOTE You may have to select a Realm from the drop-down box to 
get a list of the accounts from which you want to choose.

Select Users and Groups Click Find, select the appropriate Content Engine groups/users, click 
OK, and then click Next. 

NOTE If you select no groups, the wizard will default to the 
#AUTHENTICATED-USERS group, which will enable all network 
users in the authentication realm to log on and access the object 
store (e.g., under Windows authentication, all accounts in Domain 
Users).

Completing the Create an 
Object Store Wizard

Click Finish to create the object store. When the status displayed in 
the Object Store Create Status window shows that the object store 
has been successfully created, click OK.
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2. Create a document as follows:

a. Expand the Root Folder container.

b. Right-click the subfolder you just created, and select New Document. 

c. Enter the Document Title (e.g., Coffee Bean.bmp), click With content, and click Next.

d. Click Browse/Add to select a file (e.g., c:\winnt\Coffee Bean.bmp), click Open, and then click 
Create. 

NOTE The new containment name should be Coffee Bean with a major version of 1.

3. Check out a document as follows:

a. Right-click the document object (Coffee Bean.bmp) you just created, and select Exclusive Check 
Out (Default). 

b. Navigate to the folder where you want the checked-out document to reside and click Open.

c. Click Yes to edit the file.

d. Make some change to the file and save it.

e. Close the application you used to edit the file.

4. Check in a document as follows:

a. Right-click the document object (Coffee Bean.bmp) you just edited, and select Check In. 

b. In the File Name field, click Browse/Add.

c. Select the file you have checked out (e.g., Coffee Bean.bmp) and click Open.

d. Click Check In.

e. Right-click the document object you just checked in and click the Versions tab of the Properties 
dialog box.

f. You should now see the Major Version field change once the document is checked in.

Using IBM FileNet Enterprise Manager to display file store status

The Windows user who logged on to IBM FileNet Enterprise Manager as an IBM FileNet P8 user and then 
created a file store will see the status of the file store as online, and will be able to add content to it. All 
other Windows users, even if logged on to IBM FileNet Enterprise Manager as the same IBM FileNet P8 
user who created the file store, will see its status as offline, and thus will not be able to add content to it.

To enable a Windows logon user to see an online status for a file store and to add content to it, you must 
add the user to the directory security of the file store with the following permissions: Modify, Read & 
Execute, List Folder Contents, Read, and Write. Alternatively, as a member of the Local Administrators 
group you can add the Windows logon user to the <DOMAIN>\Content Engine Servers group.
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Task 11a: Install Process Engine (Windows)

NOTES

• Before beginning this task, ensure that all applicable tasks listed in the “Installation Planning 
Considerations” on page 20 have been completed.

• Be sure to have the correct database information including server names, database and instance 
names, tablespace names, and filegroups.  Entering incorrect information during Process Engine 
installation could cause the installation to fail.  Recovery could mean uninstalling and re-installing the 
Process Engine software.

Verify the database connection (Oracle)

The database that Process Engine will use must be running and be fully configured for IBM FileNet use 
prior to starting Process Engine Setup. If the database will be remote, the database client software must 
also be installed and running on Process Engine when Process Engine Setup is started. See the “Install 
Oracle Server for IBM FileNet P8” on page 63 task for installation and configuration procedures.

Take the following steps to verify that the Oracle database instance used by Process Engine is accessible. 
Make whatever corrections are necessary before proceeding to “Install the Process Engine software” on 
page 157. 

1. Execute the following at a command prompt:

sqlplus

2. At the SQLPlus prompt, enter a DBA userid and password.

3. At the prompt, enter the following SQL command:

SQL> select instance_name, host_name, version from v$instance;

Following is an example of the information returned:

INSTANCE_NAME

----------------

HOST_NAME

----------------------------------------------------------------

VERSION

-----------------

p8dbshr
HQVWBUCS
9.2.0.7.0

In this example: 

the instance, ORACLE_SID=p8dbshr

the database server name is hqvwbucs

the oracle server is at the 9.2.0.7 version



INSTALLATION AND UPGRADE GUIDE
Install Process Engine (Windows)

156
Verify the database connection (SQL Server)

The database that Process Engine will use must be running and be fully configured for IBM FileNet use 
prior to starting Process Engine Setup. If the database will be remote, the database client software must 
also be installed and running on Process Engine when Process Engine Setup is started. 
See “Install Microsoft SQL Server for IBM FileNet P8” on page 58 for installation and configuration 
procedures.

Take the following steps to verify that the SQL Server database instance used by Process Engine is 
accessible. You will need to know both the Process Engine database and filegroup names. Make whatever 
corrections are necessary before proceeding to “Install the Process Engine software” on page 157.

In this example, the database is VWdb and the filegroup name is vwdata_fg. Both the database name and 
filegroup name must match what was defined when the database MS SQL server was installed and 
configured.

1. At a command prompt, enter:

isql -E -S<server name>\<instance name>

This command puts Process Engine into isql interactive mode.

2. At the isql prompt, enter:

1> use VWdb
2> go

This command verifies that the Process Engine database has been created. If you get another prompt 
with no error, you are attached to that database. 

3. Verify that the correct Process Engine filegroup was created. At the isql prompt, enter:

1> select substring(groupname,1,20) from sysfilegroups where groupname = '<defined filegroup>'
2> go

You should get a listing of the Process Engine filegroups, for example: 

groupname

___________

vwdata_fg

Verify the database connection (DB2)

1. At a command prompt, enter:

db2cmd

2. At the DOS prompt, start the DB2 Command Line Processor by typing:

db2

3. At the DB2 prompt, enter the following command:

connect to <database alias> user f_sw using <f_sw password>

DB2 will display the database connection information.
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Following is an example of the database connection command and the information returned:

db2 => connect to pedbwin user f_sw using f_sw

   Database Connection Information

Database server        = DB2/AIX64 8.2.0
SQL authorization ID   = F_SW
Local database alias   = PEDBWIN

In this example, the database alias is pedbwin and the f_sw user password is f_sw.

Install the Process Engine software

The Process Engine installation occurs in two parts that are separated by a restart of the system. After the 
restart, the second part of the installation continues automatically. 

1. Log on as a member of the local Administrators group or a user with equivalent permissions. The user 
you log on as must also be a database administrator.

2. Insert the Process Engine CD. If Autorun is enabled, the Setup program will start. Select Process 
Engine. Otherwise, execute Setup.exe. 

3. A sequence of installation screens will be presented.  Refer to the tables below for information on the 
screens you will see and the steps to take.

.

In this screen... Perform this action...

Welcome Click Next on the Welcome screen to proceed with the installation

Software License 
Agreement

Review and accept the license agreement for IBM FileNet P8 
software products, and then click Yes. You must accept the terms of 
the agreement to proceed with the installation.

Documentation 
Configuration

Enter the Documentation Server URL, which is where the IBM 
FileNet P8 Platform Documentation was installed. Your entry must be 
in the following format:

http://<docserver:port#>/<ecm_help>

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation website. You can 
use multi-part root folders 
(e.g.,/docs/ecm_help) if your application server supports them.
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Select Components Indicate whether you want to configure the Rules Engine interface to 
run on this Process Engine.

Click Yes if the JRules software is already installed on this computer 
or if you know where on this computer JRules will be installed later.

Click No if the JRules software is not and will not be installed on this 
computer, or if you do not know exactly where on this computer 
JRules will be installed later. 

If you later install JRules software on this Process Engine, follow the 
procedures in “Enable Rules Engine integration manually” on 
page 281 to enable Rules Engine integration manually.

Choose Destination Loca-
tion

NOTE This window is dis-
played only if you click Yes 
in the Select Components 
window to install iLog 
JRules.

Enter the full path to the iLog JRules software installation directory.

The directory you specify must already exist. Later during installation 
(in “Enable Rules Engine integration” on page 279), you will finish 
setting up Rules Engine integration.

Common Files Choose the destination directory for configuration files that will be 
shared with other IBM FileNet P8 components.

Domain Name Enter <domain name>:<organization>, where:

The maximum length of your <domain name> entry does not exceed 
20 characters.

The maximum length of your <organization> entry does not exceed 
20 characters.

Both your <domain name> and <organization> entries contain only 
alphanumeric characters and underscores.

A typical convention is to enter <your PE machine name>:FileNet. If 
the machine name includes hyphens, replace them with underscores 
in your entry.

Primary Server Selection Leave the box checked indicating that this is the primary Process 
Engine.

Executable Files Indicate the installation location for the executable files

Configuration Files Indicate the installation location for the configuration files

In this screen... Perform this action...
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Local or Remote RDBMS Indicate whether the database will be local or remote.

Depending upon your selection here you will be presented with a 
number of additional screens appropriate to database location and 
database software.  Proceed as appropriate to:

• “Remote Microsoft SQL database” on page 160

• “Local SQL database” on page 160

• “Remote DB2 database” on page 160

• “Remote Oracle database” on page 161

• “Local Oracle database” on page 162.

NOTE Only remote DB2 databases are supported.  

In this screen... Perform this action...
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Remote Microsoft SQL database

Local SQL database

Remote DB2 database 

In this screen... Perform this action...

Remote RDBMS Server Enter the name of the remote database server.

RDBMS Instance Name Enter the name of the instance to be used by Process Engine.  Leave 
the field blank if the default instance is to be used, otherwise enter the 
name of the instance that was created in “Install Microsoft SQL 
Server for IBM FileNet P8” on page 58.

Database Name Enter the name of the database to be used by Process Engine, as 
created in “Install Microsoft SQL Server for IBM FileNet P8” on 
page 58.  The default is VWdb.

FileNet Data Filegroup 
Name

Enter the name of the filegroup to be used for Process Engine data 
as created in “Install Microsoft SQL Server for IBM FileNet P8” on 
page 58.  The default is vwdata_fg. 

In this screen... Perform this action...

RDBMS Instance Name Enter the name of the instance to be used by Process Engine.  Leave 
the field blank if the default instance is to be used, otherwise enter the 
name of the instance that was created in “Install Microsoft SQL 
Server for IBM FileNet P8” on page 58.

Database Name Enter the name of the database to be used by Process Engine, as 
created in “Install Microsoft SQL Server for IBM FileNet P8” on 
page 58.  The default is VWdb.

FileNet Data Filegroup 
Name

Enter the name of the filegroup to be used for Process Engine data 
as created in “Install Microsoft SQL Server for IBM FileNet P8” on 
page 58.  The default is vwdata_fg. 

In this screen... Perform this action...

Database Alias Name Enter the database alias name as assigned in “Install DB2 Client for 
Content Engine and Process Engine” on page 77.  

FileNet Data Tablespace 
name

defaults to VWDATA_TS

DB2 Passwords Enter the password for the Operating System user f_sw. 

Enter the password set for this user in either  “Install DB2 server for 
Content Engine and Process Engine” on page 68 if database 
authentication is SERVER or SERVER_ENCRYPT, or “Install DB2 
Client for Content Engine and Process Engine” on page 77 if 
authentication is CLIENT.
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Remote Oracle database

DB2 Passwords

Although the screen title 
doesn’t change the 
question in the screen 
does.

Enter the password for the Operating System user f_maint.

Enter the password set for this user in either  “Install DB2 server for 
Content Engine and Process Engine” on page 68 if database 
authentication is SERVER or SERVER_ENCRYPT, or “Install DB2 
Client for Content Engine and Process Engine” on page 77 if 
authentication is CLIENT.

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the LOCAL, Oracle SID and Oracle 
Home variables.  

LOCAL This is the global database name or the server connecting 
string.

If the database is remote, the Oracle Home path you enter refers to 
the local Oracle Client installation directory.

Temporary Tablespace 
Name

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS but this entry must 
match the value you used when the temporary tablespace was 
created in “Install Oracle Server for IBM FileNet P8” on page 63.  

FileNet Data Tablespace 
Name

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS but this entry must match the value you 
used when the data tablespace was created in “Install Oracle Server 
for IBM FileNet P8” on page 63

Index Tablespace Name Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index tablespace is 
designated. Default value is VWINDEX_TS but this entry must match 
the value you used when the index tablespace was created in“Install 
Oracle Server for IBM FileNet P8” on page 63.  Leave blank of no 
separate index tablespace is desired. 

In this screen... Perform this action...



INSTALLATION AND UPGRADE GUIDE
Install Process Engine (Windows)

162
Local Oracle database

4. Review and verify the installation summary information. Click Next to proceed if all information is 
correct, or Back to make changes.

5. Oracle database only: When prompted, enter the Oracle sys password. The password is required to 
run the following SQL scripts: pe_install_scripts.sql, pe_filenet_site.sql, 
pe_create_stored_procedures.sql, and pe_grant_sp_permissions.sql. For further information about 
these scripts, see “Process Engine SQL Scripts (Oracle databases only)” on page 369.

NOTE If an error message indicates that the scripts did not run, you must resolve the errors before 
proceeding; see the IBM FileNet P8 Platform Troubleshooting Guide for further information.

6. When setup is complete, a prompt to restart the computer displays. Click Yes I want to restart my 
computer now and click Finish. Remove the CD before proceeding.

7. When the system restarts, log on using the same account you used in step 1. After you log on, the 
Process Engine setup will complete. If installation fails at this point, correct the errors that caused the 
failure and run the post-boot setup program by navigating to the Process Engine install folder and 
executing:

setup.exe  -postboot

Reasons for Setup failure could include:

• Inability to connect to the remote database.

• Incorrect password for the fnsw user identified to the IMS ControlService and/or Process Engine 
Services Manager.

• Other errors identified by inspection of the log files created by Setup.

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the Oracle SID and Oracle Home 
variables.

The Oracle Home path you enter refers to the local Oracle installation 
directory.

Temporary Tablespace 
Name

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS but this entry must 
match the value you used when the temporary tablespace was 
created in “Install Oracle Server for IBM FileNet P8” on page 63.  

FileNet Data Tablespace 
Name

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS but this entry must match the value you 
used when the data tablespace was created in “Install Oracle Server 
for IBM FileNet P8” on page 63

Index Tablespace Name Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used iff no index tablespace is 
designated. Default value is VWINDEX_TS but this entry must match 
the value you used when the index tablespace was created in “Install 
Oracle Server for IBM FileNet P8” on page 63.  Leave blank of no 
separate index tablespace is desired.
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NOTE  Not all error conditions can be resolved in this way.  It may be necessary to uninstall the Process 
Engine software and re-run setup.

8. When the dialog box informs you that Process Engine has been successfully installed, click OK.

9. Oracle database only: When prompted, enter the Oracle sys password. The password is required to 
run the SQL script pe_setup_users_defaults.sql. For further information about this script, see “Process 
Engine SQL Scripts (Oracle databases only)” on page 369.

NOTE If an error message indicates that the script did not run, or you are not prompted for the sys 
password, you must resolve any errors and run the script manually. See “Process Engine SQL Scripts 
(Oracle databases only)” on page 369.

10. Check all log files and verify that there were no errors or failures. Correct any errors before proceeding. 
Log files to check include:

• All .lst files in the <install drive>:\fnsw directory (Oracle databases only)

• All .log files in \fnsw_loc\logs directory and subdirectories

11. Proceed to “Complete additional configuration” on page 164.
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Complete additional configuration

Process Engine Setup automatically creates several internally required, local administrative users. (These 
local users have no corresponding LDAP accounts.) Because these users are created with default 
passwords, IBM strongly recommends resetting their passwords to maintain system security on each 
Process Engine.

For users other than fnsw, see the IBM FileNet Image Services documentation for instructions on using 
the referenced tools to change passwords.

User Name User Type Description How to modify

f_maint Database 
(Oracle, SQL)

Has DBA 
privileges. Used 
for RDBMS 
maintenance.

Execute set_f_maint_pw. 

See steps below.

fnsw Operating 
System

Primary 
Process Engine 
user. Used to 
execute 
Process Engine 
software and 
Services.

Execute Windows Control Panel 
-> Administrative Tools -> 
Computer Management -
>System Tools ->Local Users 
and Groups.

After you change the password 
for the fnsw user, you must also 
use the Windows Services tool 
to update the Log On tab for the 
IMS ControlService and the 
Process Engine Services 
Manager accordingly (because 
the fnsw user is used to start 
those services).

NOTE Process Engine activity 
will cease if the fnsw user’s 
password expires.

SysAdmin SEC (internal 
Process Engine 
security 
software)

Primary 
administrator 
user for FileNet 
software tools.

Execute Xapex -> Security 
Administration. Log on as 
SysAdmin.  NOTE Process 
Engine software must be 
running.

FieldService SEC Used internally 
by Process 
Engine 
software.

Operator SEC Used internally 
by Process 
Engine 
software.
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Set the f_maint password (Oracle and SQL)

1.Log on as the fnsw user or as a member of the local Administrators group or a user with equivalent 
permissions.

2.At a command prompt, enter:

set_f_maint_pw

3.Press Return at the prompt for the current password.

4.Enter a new password for f_maint when prompted. The password must be between 6 and 30 
characters. If the database is MS SQL, the first character cannot be numeric.

5.Confirm the new password when prompted.

Verify the /etc/services file settings

1. Log in as the Administrator user and check the \WINNT\system32\drivers\etc\services file to verify 
the following parameters:

tms              32768/tcp
cor               32769/tcp
nch              32770/udp
fn_snmpd    161/udp
fn_trapd      35225/udp

2. If necessary, add the parameters to the file and save the changes.

Verify TCP/IP parameter settings

1. Log in as the Administrator user and run regedit to verify the following registry key values.

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\MaxUserPort => 
65535 (default = 5000) 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\TcpTimedWaitDel
ay => 90 (default = 240, or 4 min)

2. If necessary, add or modify the parameters and save the changes. The value added should be 
DWORD.

Delete unnecessary users/groups (Oracle and SQL)

Process Engine Setup automatically creates several users (listed below) in the database. The Process 
Engine software does not require these users, so you can safely delete them.

• f_sqi

• f_operator

• f_cso

• f_open

(Optional. Oracle database only) Delete fnsw and oracle users from the ORA_DBA group

Remove the fnsw and oracle users from the ORA_DBA group.

To redirect log messages to the Image Services error log  

Enable the redirection of log messages to the Image Services error log. This redirection will log 
message to the Image Services error log as well as to the default Windows Event Log. By 
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enabling this redirection, you will be able to monitor the progress of the database object upgrade 
in a command window. 

To enable the redirection, change the LogToFiles value from 0 to 1 for the following registry key.

HKEY_LOCAL_MACHINE>SOFTWARE>FileNET>IMS>CurrentVersion

Start the Process Engine software

By default, the IMS Control Services Manager and Process Engine Services Manager are automatically 
started on system restart. However, the Process Engine software itself must be manually started or 
configured for automatic start. To start the software, take the following steps:

1. Log on as fnsw or as a member of the local Administrators group (or a user with equivalent permis-
sions). The default password is BPMPassword1.

2. Start Programs > FileNet P8 Platform > Process Engine > Process Task Manager.

3. To start the Process Service, from the Action menu, choose Start.
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Task 11b: Install Process Engine (Solaris)

NOTES

• Before beginning this task, ensure that all applicable tasks listed in the “Installation Planning 
Considerations” on page 20 have been completed.

• There are references to logging on as the root and fnsw users within these procedures. The root user 
must run in the Bourne or Korn shell and the fnsw user must run in the Korn shell.

• Be sure to have the correct database information including server names, database and instance 
names, tablespace names, and filegroups.  Entering incorrect information during Process Engine 
installation could cause the installation to fail.  Recovery could mean uninstalling and re-installing the 
Process Engine software.

Increase the Operating System Kernel Limits

1. Make a copy of the system file (with a new name). Log on as root, and enter a command similar to the 
following:

cp /etc/system /etc/system.save 

2. Edit the /etc/system file, using your preferred editor (for example, vi):

vi /etc/system 

3. Ensure that the following parameters are listed and are set to at least the values shown. With the 
exception of the value described in the Note below, you can enter higher values if your system requires 
them. 

set semsys:seminfo_semmap=50
set semsys:seminfo_semmni=2000
set semsys:seminfo_semmns=2000
set semsys:seminfo_semmnu=500
set semsys:seminfo_semmsl=512
set semsys:seminfo_semopm=256
set semsys:seminfo_semume=500
set semsys:seminfo_semvmx=32767
set semsys:seminfo_semaem=16384
set shmsys:shminfo_shmmax=20971520
set shmsys:shminfo_shmmin=0

NOTE The shminfo_shmmin value must be set to 0 or the Process Engine installation will fail. While 
you can change this value after installation, IBM does not recommend setting this value higher than 1.

set shmsys:shminfo_shmmni=2000
set shmsys:shminfo_shmseg=100
set msgsys:msginfo_msgmni=2048
set max_nprocs=1000
set fnsod:sod_Debug=0
set rlim_fd_max=1024
set rlim_fd_cur=256

4. Save your changes.

5. Reboot the server.
 Create or modify internal Process Engine users and groups

Using Solaris’ admintool, you must create or modify specific local groups and users required internally by 
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Process Engine prior to running Process Engine Setup. These required users and groups are detailed in 
the following tables. After making the changes, log out and log back in to pick up the changes. (Solaris 
uses the directory in the root file system called /home as users’ home directory. If you want to use /home, 
you will have to make a file system for it.).  

Verify National Language Character Set and Time Settings

• The default time mask varies on UNIX depending on the LANG and LC_TIME environment settings. 
Verify the current LC_TIME settings by entering:

locale -k t_fmt

The result might appear similar to this:

t_fmt=%r

User Name Action User Type Default 
Shell

Primary Group Secondary Group

fnsw Create Operating 
System

Ksh fnusr <Oracle Database 
Administrators Group; 
default = dba>, fnadmin

root Modify Operating 
System

Ksh fnusr, fnadmin

<Oracle 
User; default 
= oracle>

Modify, if 
database is 
local.

Create, if 
database is 
remote.

Database <Oracle 
Database 
Administrators 
Group; default = 
dba>

fnusr

Group Name Action Description Members

fnadmin Create Members have all privileges 
on Process Engine files and 
databases.

fnsw, root

fnusr Create Members have non-
administrator privileges on 
Process Engine files and 
databases.

fnsw, root, <Oracle User; 
default = oracle>

<Oracle 
Database 
Administrators 
Group; default 
= dba>

Modify, if database 
is local.

Create, if database 
is remote.

Members act as database 
administrators.

fnsw, <Oracle User; default = 
oracle>
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• The default mask must not be "%r". To change to a default mask that can be used with NLT, reset the 
LC_TIME environment to "C", then run the locale -k t_fmt command again to verify the change.

• The default shell environment should be modified to use the C time format.

• Change the /etc/profile for the entire system or change .profile files for each user that runs sh or ksh 
to include the following lines:

LC_TIME=C
export LC_TIME

• Verify the current LANG settings by entering:

locale

• This example shows the U.S. character set, ISO 8859-1. Be sure the character set specified on your 
server is appropriate for your locale. Also be sure it is consistent with the NLS_LANG if the character 
set is AL32UTF8.

LANG=en_US.ISO8859-1
LC_CTYPE=en_US.ISO8859-1
LC_NUMERIC=en_US.ISO8859-1
LC_TIME=en_US.ISO8859-1
LC_COLLATE=en_US.ISO8859-1
LC_MONETARY=en_US.ISO8859-1
LC_MESSAGES=en_US.ISO8859-1
LC_ALL=

Create Partitions

Process Engine requires the presence of the several partitions. You can use third-party software such as 
Veritas Volume Management to create these partitions, or software provided with the operating system, 
such as Solstice DiskSuite, to create soft partitions. Regardless of the tool you use, each partition has 
requirements for the mount point, size, user, group, and mode; these requirements are specified in the 
following tables. (The first table provides guidelines for Veritas Volume Management users, the second for 
Solstice DiskSuite users.) There are no requirements for the partition names; the names listed in the tables 
are examples. 

Volume Name Mount Point Minimum 
Size

User Group Mode

fnsw /fnsw 

file system

1000MB fnsw fnusr 775

local /fnsw/local

file system 

250MB fnsw fnusr 775

fn_sec_db0 (raw) n/a 

logical volume

12MB fnsw fnusr 664

fn_sec_rl0 (raw) n/a 

logical volume

4MB fnsw fnusr 664
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Following is an example of soft partitions created using Solstice DiskSuite. Partitions d100 and d101 will be 
used as fn_sec_db0 and fn_sec_rl0.

Verify the database connection (Oracle)

The database that Process Engine will use must be running and be fully configured for IBM FileNet use 
before you run Process Engine Setup. In addition, if the database is remote, the database client software 
must also be installed and running on Process Engine when Process Engine Setup is started. See Task 5b 
on page 63 task for database installation and configuration procedures.

Take the following steps to verify that the Oracle database you want Process Engine to use is accessible. 
Make whatever corrections are necessary before running Process Engine Setup. 

1. Execute the following at a command prompt:

su - oracle -c "sqlplus"

2. At the SQLPlus prompt, enter a DBA userid and password.

3. At the prompt, enter the following SQL command:

SQL> select instance_name, host_name, version from v$instance;

Following is an example of the information returned:

INSTANCE_NAME

----------------

HOST_NAME

----------------------------------------------------------------

VERSION

-----------------

p8dbshr
HQVWBUCS
9.2.0.7.0

Soft Partition Mount Point Minimum Size User Group Mode

d1 /fnsw

file system

1000MB fnsw fnusr 775

d2 (optional) /fnsw/local

file system 

250MB fnsw fnusr 775

d100 raw, none 12MB fnsw fnusr 664

d101 raw, none 4MB fnsw fnusr 664
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In this example: 

the instance, ORACLE_SID=p8dbshr

the database server name is hqvwbucs

the oracle server version is 9.2.0.7

Verify the database connection (DB2)

1. Log on as the client instance owner.

2. Execute the following at a command prompt:

db2

3. At the DB2 prompt, enter the following command:

connect to <database alias> user f_sw using <f_sw password>

DB2 will display the database connection information.

Following is an example of the database connection command and the information returned:

db2 => connect to pedbinst user f_sw using f_sw

   Database Connection Information

Database server        = DB2/AIX64 8.2.0
SQL authorization ID  = F_SW
Local database alias  = PEDBINST

In this example, the database alias is pedbinst and the f_sw user password is f_sw.

Install the Process Engine software 

1. Log on to the server as the root user.

2. Insert the Process Engine CD. From the console, navigate to the /cdrom/p8pe35sol directory and 
execute setup.sh. 

3. Indicate whether the database will be Oracle or DB2. Wait for files to finish unpacking.

If Process Engine uses an Oracle database, continue with Step 4.

If Process Engine uses a DB2 database, proceed to Step 5.

4. When prompted, enter the Oracle sys password. The password is required to run the following SQL 
scripts: pe_install_scripts.sql, pe_filenet_site.sql, pe_create_stored_procedures.sql, and 
pe_grant_sp_permissions.sql. For further information about these scripts, see “Process Engine SQL 
Scripts (Oracle databases only)” on page 369.

NOTE If an error message indicates that the scripts did not run, you must resolve the errors before 
proceeding. See “Process Engine SQL Scripts (Oracle databases only)” on page 369.
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5. A sequence of installation screens will be presented. Refer to the tables below for information on the 
screens you will see and the steps to take.

In this screen... Perform this action...

Welcome Click Next on the Welcome screen to proceed with the installation

Software License 
Agreement

Review and accept the license agreement for IBM FileNet P8 
software products, and then click Yes. You must accept the terms of 
the agreement to proceed with the installation.

Documentation 
Configuration

Enter the Documentation Server URL, which is where the IBM 
FileNet P8 Platform Documentation was installed. Your entry must be 
in the following format:

http://<docserver:port#>/<ecm_help>

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation website. You can 
use multi-part root folders 
(e.g.,/docs/ecm_help) if your application server supports them.

Rules Engine Support Indicate whether you want to configure the Rules Engine interface to 
run on this Process Engine.

Click Yes if the JRules software is already installed on this computer 
or if you know where on this computer JRules will be installed later.

Click No if the JRules software is not and will not be installed on this 
computer, or if you do not know exactly where on this computer 
JRules will be installed later. 

If you later install JRules software on this Process Engine, follow the 
procedures in “Enable Rules Engine integration manually” on 
page 281 to enable Rules Engine integration manually.

Choose Destination Loca-
tion

NOTE This window is dis-
played only if you click Yes 
in the Select Components 
window to install iLog 
JRules.

Enter the full path to the iLog JRules software installation directory.

The directory you specify must already exist. Later during installation 
(in “Enable Rules Engine integration” on page 279), you will finish 
setting up Rules Engine integration.

Common Files Choose the destination directory for configuration files that will be 
shared with other IBM FileNet P8 components.
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Domain Name Enter <domain name>:<organization>, where:

The maximum length of your <domain name> entry does not exceed 
20 characters.

The maximum length of your <organization> entry does not exceed 
20 characters.

Both your <domain name> and <organization> entries contain only 
alphanumeric characters and underscores.

A typical convention is to enter <your PE machine name>:FileNet. If 
the machine name includes hyphens, replace them with underscores 
in your entry.

Primary Server Selection Leave the box checked indicating that this is the primary Process 
Engine.

Local or Remote RDBMS Indicate whether the database will be local or remote.

Depending upon your selection here you will be presented with a 
number of additional screens appropriate to database location and 
database software.  Proceed as appropriate to:

• “Remote DB2 database” on page 174

• “Remote Oracle database” on page 174

• “Local Oracle database” on page 175

NOTE Only remote DB2 databases are supported.  

Database Selection 
Confirmation

This screen is presented as a confirmation of the type of database 
you chose to configure.  As directed in this screen, if you choose to 
change the database type, choose Cancel in this screen and re-run 
setup. Otherwise click Next to proceed.

In this screen... Perform this action...
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Remote DB2 database

Remote Oracle database

In this screen... Perform this action...

Database Alias Name Enter the database alias name as assigned in “Install DB2 Client for 
Content Engine and Process Engine” on page 77.  

Local DB2 instance owner 
name

Enter the DB2 client instance owner’s name.  Case sensitive.

FileNet Data Tablespace 
name

defaults to VWDATA_TS

DB2 Passwords Enter the passwords for the Operating System f_sw and f_maint 
users.

Enter the passwords set for these users in either  “Install DB2 server 
for Content Engine and Process Engine” on page 68 if database 
authentication is SERVER or SERVER_ENCRYPT, or “Install DB2 
Client for Content Engine and Process Engine” on page 77 if 
authentication is CLIENT.

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the Global Database name, Oracle 
Home, User Name, Oracle SID, Oracle DBA group name

The Oracle Home path you enter refers to the local Oracle Client 
installation directory.

Oracle Database 
Information

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS.

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index tablespace is 
designated. Default value is VWINDEX_TS.

All entries must match the value you used when the temporary 
tablespace was created in “Install Oracle Server for IBM FileNet P8” 
on page 63.  
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Local Oracle database

6. Enter the raw device file names for the fn_SEC_DB0 and fn_SEC_RL0 volumes. For example, if 
Solstice DiskSuite software was used, and fn_SEC_DB0 was on the d100 raw device, the entry would 
be:

/dev/md/rdsk/d100

7. Review the information on the installation process. Note that you can check the progress of the 
installation in the /fnsw/tmp-installer/MINI-INSTALLER.LOG file. Click Next when you are ready to 
proceed.

8. Review the summary information on the installation location for Process Engine. Click Next when you 
are ready to proceed.

9. Setup will run for several minutes. Progress is displayed and at some points may not advance for an 
extended period of time. To check the progress of the installation, monitor the /fnsw/tmp-installer/
MINI-INSTALLER.LOG file for current activity.

If the installation failed, check the /fnsw/tmp_installer/MINI_INSTALLER_ERROR.LOG file for 
errors.

10. (Oracle database only) When prompted, enter the Oracle sys password. The password is required to 
run the SQL script pe_setup_users_defaults.sql. For further information about this script, see 
“Process Engine SQL Scripts (Oracle databases only)” on page 369.

NOTE If an error message indicates that the script did not run, or you are not prompted for the sys 
password, you must resolve any errors and run the script manually. See “Process Engine SQL Scripts 
(Oracle databases only)” on page 369.

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the Oracle Home, User Name, 
Oracle SID, Oracle DBA group name

The Oracle Home path you enter refers to the local Oracle Client 
installation directory.

Oracle Database 
Information

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS.

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index tablespace is 
designated. Default value is VWINDEX_TS.

All entries must match the value you used when the temporary 
tablespace was created in “Install Oracle Server for IBM FileNet P8” 
on page 63.  
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11.  Check all log files and verify that there were no errors or failures. Correct any errors before 
proceeding. Log files to check include:

• All .lst and .log files in the /fnsw/local/logs/PE directory

• All .log files in the /fnsw/local/logs directory and all its subdirectories

Reset administrative user passwords

Process Engine Setup automatically creates several internally required, local administrative users. These 
local users have no corresponding LDAP accounts. Because these users are created with default 
passwords, IBM strongly recommends resetting the passwords for these users to maintain system security. 
See the IBM FileNet Image Services documentation for instructions on using the referenced tools. 

Set the f_maint password (Oracle only)

1. Log on as the fnsw user.

2. At a command prompt, enter:

set_f_maint_pw

3. Press Return at the prompt for the current password.

4. Enter a new password for f_maint when prompted. The password must be between 6 and 30 
characters.

5. Confirm the new password when prompted.

Delete unnecessary users

Process Engine Setup automatically creates several users (listed below) in the database. The Process 
Engine software does not require these users, so you can safely delete them.

• f_sqi

• f_operator

• f_cso

• f_open

(Optional. Oracle databases only) Delete fnsw user from the Oracle database administrators group

Remove the fnsw user from the <Oracle Database Administrators> group.

User Name User Type Description How to modify

f_maint Database (Oracle) Has DBA privileges. Used 
for RDBMS maintenance.

Execute 
set_f_maint_pw. See 
steps below.

SysAdmin SEC (internal Process 
Engine security software)

Primary administrator user 
for FileNet software tools.

Execute Xapex -> 
Security 
Administration. Log 
on as SysAdmin.FieldService SEC Used internally by Process 

Engine software.

Operator SEC Used internally by Process 
Engine software.
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Enable ports

When Solaris starts up, it takes the first several ports, called anon ports, to use for its communication 
daemons. By default, the maximum tcp_smallest_anon_port is 32768. IBM FileNet uses several ports 
higher than 32768.  See “IBM FileNet P8 Port Numbers” on page 364 for details on which ports IBM 
FileNet uses.

To use these ports on Solaris-based systems, you must first enable the ports by setting the smallest anon 
port to 32777. By doing so, the ports used by Solaris communication daemons will be 32777 or greater, 
leaving 32776 available for IBM FileNet use.

The Solaris platform provides several different tools such as the netstat command to determine if a port is 
in use.

To determine the current tcp_smallest_anon_port setting enter the following at the command prompt:

ndd -get /dev/tcp tcp_smallest_anon_port

If the port is less than 32777, you must enable port 32776.

To enable port 32776 on Solaris, use a text editor to edit the /etc/rc2.d/S69inet file. 

Enter the following line: 

ndd -set /dev/tcp tcp_smallest_anon_port 32777

Reboot the Process Engine server. 

Restore any custom modifications to the .profile or .cshrc. 

Process Engine Setup creates a new .profile or .cshrc file. If the previous versions of these files contained 
any custom settings, edit the new .profile or .cshrc file for the fnsw, root and oracle users accordingly. 
Saved files in are .profile.old.nn or .cshrc.old.nn, where nn is a sequential number. The latest saved 
version will be in the highest numbered file.

Verify the /etc/services file settings

1. Log in as the root user and check the /etc/services file to verify the following parameters:

tms            32768/tcp
cor             32769/tcp
nch            32770/udp
fn_snmpd  161/udp
fn_trapd     35225/udp

2. If necessary, add the parameters to the file and save the changes.

Clean up before starting Process Engine

1. Log in as fnsw.

2. Execute:

vwzap

3. Execute:

killfnsw -DAyS
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4. Execute:

ipcs -a 

and verify there is no entry with 0x464 pattern.

If there are any entries with this pattern, use ipcim to remove them.

Edit the /etc/inittab file

By default, the Process Engine software starts automatically on restart and needs to have the database 
already started when Process Engine comes up. If the database is not automatically started on restart, edit 
the /etc/inittab file on Process Engine to comment out the autostart of Process Engine.

Change:

fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1

to

#fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1

Verify that the database and Process Engine software are running

Be sure that both the database and Process Engine software are running before proceeding to the next 
task. By default, the IMS Control Services Manager and Process Engine Services Manager are 
automatically started on system restart. However, the Process Engine software itself must be manually 
started. To start the software, take the following steps:

1. Log on as fnsw.

2. Start Process Task Manager by entering the following at the command prompt:

vwtaskman

3. From the Action menu, choose Start.
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Task 11c: Install Process Engine (AIX)

NOTES

• Before beginning this task, ensure that all applicable tasks listed in the “Installation Planning 
Considerations” on page 20 have been completed.

• There are references to logging on as the root and fnsw users within these procedures. The root user 
must run in the Bourne or Korn shell and the fnsw user must run in the Korn shell.

• Be sure to have the correct database information including server names, database and instance 
names, tablespace names, and filegroups.  Entering incorrect information during Process Engine 
installation could cause the installation to fail.  Recovery could mean uninstalling and re-installing the 
Process Engine software.

Set Time Zone Parameters

Review and change the time zone parameters if necessary. In SMIT, choose System Environments -> 
Change/Show Date and Time -> Change Time Zone Using System Defined Values. Choose the Daylight 
Savings Time option if applicable. At the CUT Time Zone menu, choose the option associated with your 
site. For example, in California, the time zone needs to be set to the Pacific time zone (PST8PDT) Pacific 
U.S.; Yukon (cut -8).

Modify /etc/rc.net for AIX 5.1

1. As the root user, add the following statements at the end for /etc/rc.net file:

# setup for IS requirement
if [ -f /usr/sbin/no ] ; then
/usr/sbin/no -o tcp_sendspace=16384
/usr/sbin/no -o tcp_recvspace=16384
/usr/sbin/no -o tcp_keepidle=80
/usr/sbin/no -o tcp_keepintvl=20
/usr/sbin/no -o tcp_ephemeral_high=65535
/usr/sbin/no -o tcp_ephemeral_low=42767
/usr/sbin/no -o udp_ephemeral_high=65535
/usr/sbin/no -o udp_ephemeral_low=42767
fi

2. Restart the server (shutdown -Fr) for these settings to take effect.

3. Check the values by executing:

no -a | grep ephemeral
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Modify /etc/rc.dt and /etc/tunables/nextboot for AIX 5.2 and 5.3

1. As the root user, execute the following commands:

/usr/sbin/no -p -o tcp_sendspace=16384
/usr/sbin/no -p -o tcp_recvspace=16384
/usr/sbin/no -p -o tcp_keepidle=80
/usr/sbin/no -p -o tcp_keepintvl=20
/usr/sbin/no -p -o tcp_ephemeral_high=65535
/usr/sbin/no -p -o tcp_ephemeral_low=42767
/usr/sbin/no -p -o udp_ephemeral_high=65535
/usr/sbin/no -p -o udp_ephemeral_low=42767

or set them by editing the /etc/tunables/nextboot.

2. Add the following statements at the beginning for /etc/rc.dt file:

/usr/sbin/no -o tcp_sendspace=16384
/usr/sbin/no -o tcp_recvspace=16384
/usr/sbin/no -o tcp_keepidle=80
/usr/sbin/no -o tcp_keepintvl=20
/usr/sbin/no -o tcp_ephemeral_high=65535
/usr/sbin/no -o tcp_ephemeral_low=42767
/usr/sbin/no -o udp_ephemeral_high=65535
/usr/sbin/no -o udp_ephemeral_low=42767

3. Restart the server (shutdown -Fr) for these settings to take effect. 

4. Check the values by executing:

no -a | grep ephemeral
 Create or modify internal Process Engine users and groups

You must create or modify specific local groups and users required internally by Process Engine prior to 
running Process Engine Setup. These required users and groups are detailed in the following tables. After 
making the changes, log out and log back in to pick up the changes.

Because AIX does not allow users to create a group with an empty member list, you must create these 
groups and users in the following order:

• Create the fnusr group with root and Oracle User as its members.

• Create the fnsw user with fnusr as its primary group.
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• Create the fnadmin group with fnsw and root as its members.  

User Name Action User Type Default 
Shell

Primary Group Secondary Group

fnsw Create Operating 
System

Ksh fnusr <Oracle Database 
Administrators Group; 
default = dba>, fnadmin

root Modify Operating 
System

Ksh fnusr, fnadmin

<Oracle 
User; default 
= oracle>

Modify, if 
database is 
local.

Create, if 
database is 
remote.

Database <Oracle Database 
Administrators 
Group; default = 
dba>

fnusr

Group Name Action Description Members

fnadmin Create Members have all 
privileges on Process 
Engine files and 
databases.

fnsw, root

fnusr Create Members have non-
administrator privileges 
on Process Engine files 
and databases.

fnsw, root, <Oracle 
User; default = oracle>

<Oracle Database 
Administrators Group; 
default = dba>

Modify, if database is 
local.

Create, if database is 
remote.

Members act as 
database 
administrators.

fnsw, <Oracle User; 
default = oracle>
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Create Partitions

Process Engine requires the presence of several partitions. The following table documents the 
requirements.  

Verify the database connection (Oracle)

The database that Process Engine will use must be running and be fully configured for IBM FileNet use 
before you run Process Engine Setup. In addition, if the database is remote, the database client software 
must also be installed and running on Process Engine when Process Engine Setup is started. See “Install 
Oracle Server for IBM FileNet P8” on page 63 task for database installation and configuration procedures.

Take the following steps to verify that the Oracle database you want Process Engine to use is accessible. 
Make whatever corrections are necessary before running Process Engine Setup. 

1. Execute the following at a command prompt:

su - oracle -c "sqlplus"

2. At the SQLPlus prompt "Enter user-name", enter "sys as sysdba".

3. When prompted for a password, enter the password for the sys account.

4. At the prompt, enter the following SQL command:

SQL> select instance_name, host_name, version from v$instance;

Volume Name Mount Point Minimum 
Size

User Group Mode

fnsw /fnsw 

file system

1000MB fnsw fnusr 775

local /fnsw/local

file system 

250MB fnsw fnusr 775

fn_sec_db0 (raw) n/a 

logical volume

12MB fnsw fnusr 664

fn_sec_rl0 (raw) n/a 

logical volume

4MB fnsw fnusr 664
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Following is an example of the information returned:

INSTANCE_NAME

----------------

HOST_NAME

----------------------------------------------------------------

VERSION

-----------------

p8dbshr
HQVWBUCS
9.2.0.7.0

In this example: 

the instance, ORACLE_SID=p8dbshr

the database server name is hqvwbucs

the oracle server version is 9.2.0.7

Verify the database connection (DB2)

1. Log on as the client instance owner.

2. Execute the following at a command prompt:

db2

3. At the DB2 prompt, enter the following command:

connect to <database alias> user f_sw using <f_sw password>

DB2 will display the database connection information.
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Following is an example of the database connection command and the information returned:

db2 => connect to pedbinst user f_sw using f_sw

   Database Connection Information

Database server        = DB2/AIX64 8.2.0
SQL authorization ID  = F_SW
Local database alias  = PEDBINST

In this example, the database alias is pedbinst and the f_sw user password is f_sw.

Install the Process Engine software 

1. Log on to the server as the root user.

2. Set the DISPLAY environment variable.

3. Insert the Process Engine CD. 

4. Create a directory to mount the CD-ROM drive if you have not already done so:

mkdir /cdrom

5. Mount the CD-ROM drive to that directory:

mount -rv cdrfs /dev/cd0 /cdrom

where /dev/cd0 is the appropriate device name.

6. Verify that the CD-ROM mounted correctly, type:

mount

7. From the console, navigate to the /cdrom directory and execute setup.sh. 

8. Indicate whether the database will be Oracle or DB2. Wait for files to finish unpacking

If Process Engine uses an Oracle database, continue with Step 9.

If Process Engine uses a DB2 database, proceed to Step 10.

9. When prompted, enter the Oracle sys password. The password is required to run the following SQL 
scripts: pe_install_scripts.sql, pe_filenet_site.sql, pe_create_stored_procedures.sql, and 
pe_grant_sp_permissions.sql. For further information about these scripts, see “Process Engine SQL 
Scripts (Oracle databases only)” on page 369.

NOTE If an error message indicates that the scripts did not run, you must resolve the errors before 
proceeding. See “Process Engine SQL Scripts (Oracle databases only)” on page 369.

10. A sequence of installation screens will be presented.  Refer to the tables below for information on the 
screens you will see and the steps to take..

In this screen... Perform this action...

Welcome Click Next on the Welcome screen to proceed with the installation

Software License 
Agreement

Review and accept the license agreement for IBM FileNet P8 
software products, and then click Yes. You must accept the terms of 
the agreement to proceed with the installation.



INSTALLATION AND UPGRADE GUIDE
Install Process Engine (AIX)

185
Documentation 
Configuration

Enter the Documentation Server URL, which is where the IBM 
FileNet P8 Platform Documentation was installed. Your entry must be 
in the following format:

http://<docserver:port#>/<ecm_help>

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation website. You can 
use multi-part root folders 
(e.g.,/docs/ecm_help) if your application server supports them.

Rules Engine Support Indicate whether you want to configure the Rules Engine interface to 
run on this Process Engine.

Click Yes if the JRules software is already installed on this computer 
or if you know where on this computer JRules will be installed later.

Click No if the JRules software is not and will not be installed on this 
computer, or if you do not know exactly where on this computer 
JRules will be installed later. 

If you later install JRules software on this Process Engine, follow the 
procedures in “Enable Rules Engine integration manually” on 
page 281 to enable Rules Engine integration manually.

Choose Destination Loca-
tion

NOTE This window is dis-
played only if you click Yes 
in the Select Components 
window to install iLog 
JRules.

Enter the full path to the iLog JRules software installation directory.

The directory you specify must already exist. Later during installation 
(in “Enable Rules Engine integration” on page 279), you will finish 
setting up Rules Engine integration.

Common Files Choose the destination directory for configuration files that will be 
shared with other IBM FileNet P8 components.

Domain Name Enter <domain name>:<organization>, where:

The maximum length of your <domain name> entry does not exceed 
20 characters.

The maximum length of your <organization> entry does not exceed 
20 characters.

Both your <domain name> and <organization> entries contain only 
alphanumeric characters and underscores.

A typical convention is to enter <your PE machine name>:FileNet. If 
the machine name includes hyphens, replace them with underscores 
in your entry.

In this screen... Perform this action...
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Primary Server Selection Leave the box checked indicating that this is the primary Process 
Engine.

Local or Remote RDBMS Indicate whether the database will be local or remote.

Depending upon your selection here you will be presented with a 
number of additional screens appropriate to database location and 
database software.  Proceed as appropriate to:

• “Remote DB2 database” on page 187

• “Remote Oracle database” on page 187

• “Local Oracle database” on page 188

NOTE Only remote DB2 databases are supported.  

Database Selection 
Confirmation

This screen is presented as a confirmation of the type of database 
you chose to configure.  As directed in this screen, if you choose to 
change the database type, choose Cancel in this screen and re-run 
setup. Otherwise click Next to proceed.

In this screen... Perform this action...
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Remote DB2 database

Remote Oracle database

In this screen... Perform this action...

Database Alias Name Enter the database alias name as assigned in “Install DB2 Client for 
Content Engine and Process Engine” on page 77.  

Local DB2 instance owner 
name

Enter the DB2 client instance owner’s name.  Case sensitive.

FileNet Data Tablespace 
name

defaults to VWDATA_TS

DB2 Passwords Enter the passwords for the Operating System f_sw and f_maint 
users.

Enter the passwords set for these users in either  “Install DB2 server 
for Content Engine and Process Engine” on page 68 if database 
authentication is SERVER or SERVER_ENCRYPT, or “Install DB2 
Client for Content Engine and Process Engine” on page 77 if 
authentication is CLIENT.

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the Global Database name, Oracle 
Home, User Name, Oracle SID, Oracle DBA group name

The Oracle Home path you enter refers to the local Oracle Client 
installation directory.

Oracle Database 
Information

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS.

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index tablespace is 
designated. Default value is VWINDEX_TS.

All entries must match the value you used when the temporary 
tablespace was created in “Install Oracle Server for IBM FileNet P8” 
on page 63.  



INSTALLATION AND UPGRADE GUIDE
Install Process Engine (AIX)

188
Local Oracle database

11. Review the information on the installation process. Note that you can check the progress of the 
installation in the /fnsw/tmp-installer/MINI-INSTALLER.LOG file. Click Next when you are ready to 
proceed.

12. Review the summary information on the installation location for Process Engine. Click Next when you 
are ready to proceed.

13. Setup will run for several minutes. Progress is displayed and at some points may not advance for an 
extended period of time. To check the progress of the installation, monitor the /fnsw/tmp-installer/MINI-
INSTALLER.LOG file for current activity.

If the installation failed, check the /fnsw/tmp_installer/MINI_INSTALLER_ERROR.LOG file for errors.

14. (Oracle only) When prompted, enter the Oracle sys password. The password is required to run the 
SQL script pe_setup_users_defaults.sql. For further information about this script, see “Process Engine 
SQL Scripts (Oracle databases only)” on page 369.

NOTE If an error message indicates that the script did not run, or you are not prompted for the sys 
password, you must resolve any errors and run the script manually. See “Process Engine SQL Scripts 
(Oracle databases only)” on page 369.

15. Check all log files and verify that there were no errors or failures. Correct any errors before proceeding. 
Log files to check include:

• All .lst and .log files in the /fnsw/local/logs/PE directory

• All .log files in the /fnsw/local/logs directory and all its subdirectories

Reset administrative user passwords

During Process Engine software installation, several local users required internally by Process Engine are 
automatically created. To maintain security, IBM strongly recommends resetting the passwords for these 
users. The following table lists the users created, the level of system access each user has, and the tool 

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the Oracle Home, User Name, 
Oracle SID, Oracle DBA group name

The Oracle Home path you enter refers to the local Oracle Client 
installation directory.

Oracle Database 
Information

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS.

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index tablespace is 
designated. Default value is VWINDEX_TS.

All entries must match the value you used when the temporary 
tablespace was created in “Install Oracle Server for IBM FileNet P8” 
on page 63.  



INSTALLATION AND UPGRADE GUIDE
Install Process Engine (AIX)

189
used to change the password. See the IBM FileNet Image Services documentation for instructions on 
using the referenced tools. 

Set the f_maint password (Oracle only)

1. Log on as the fnsw user.

2. At a command prompt, enter:

set_f_maint_pw

3. Press Return at the prompt for the current password.

4. Enter a new password for f_maint when prompted. The password must be between 6 and 30 
characters.

5. Confirm the new password when prompted.

Delete unnecessary users

Process Engine Setup automatically creates several users (listed below) in the database. The Process 
Engine software does not require these users, so you can safely delete them.

• f_sqi

• f_operator

• f_cso

• f_open

(Optional. Oracle databases only.) Delete fnsw user from the Oracle database administrators group

Remove the fnsw user from the <Oracle Database Administrators> group. 

Restore any custom modifications to the .profile or .cshrc.  

Process Engine Setup creates a new .profile or .cshrc file. If the previous versions of these files contained 
any custom settings, edit the new .profile or .cshrc file for the fnsw, root and oracle users accordingly. 

User Name User Type Description How to modify

f_maint Database (Oracle) Has DBA privileges. 
Used for RDBMS 
maintenance.

Execute set_f_maint_pw. See steps 
below.

SysAdmin SEC (internal 
Process Engine 
security software)

Primary administrator 
user for FileNet 
software tools.

Execute Xapex -> Security 
Administration. Log on as SysAdmin.

FieldService SEC Used internally by 
Process Engine 
software.

Operator SEC Used internally by 
Process Engine 
software.
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Saved files in are .profile.old.nn or .cshrc.old.nn, where nn is a sequential number. The latest saved 
version will be in the highest numbered file.

Verify the /etc/services file settings

1. Log in as the root user and check the /etc/services file to verify the following parameters:

smux             199/tcp                         # snmpd smux port   
tms                32768/tcp
cor                 32769/tcp
nch                32770/udp
fn_trapd          35225/udp

2. If necessary, add the parameters to the file and save the changes.

Clean up before starting Process Engine

1. Log in as fnsw.

2. Execute:

vwzap

3. Execute:

killfnsw -DAyS

4. Execute:

ipcs -a 

and verify there is no entry with 0x464 pattern.

If there are any entries with this pattern, use ipcim to remove them.

Edit the /etc/inittab file

By default, the Process Engine software starts automatically on restart and needs to have the database 
already started when Process Engine comes up. If the database is not automatically started on restart, edit 
the /etc/inittab file on Process Engine to comment out the autostart of Process Engine

rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

to

#rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

Verify that the database and Process Engine software are running

Be sure that both the database and Process Engine software are running before proceeding to the next 
task. By default, the IMS Control Services Manager and Process Engine Services Manager are 
automatically started on system restart. However, the Process Engine software itself must be manually 
started. To start the software, take the following steps:

1. Log on as fnsw.

2. Start Process Task Manager by entering the following at the command prompt:

vwtaskman

3. From the Action menu, choose Start.
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Task 11d: Install Process Engine (HP-UX)

NOTES

• Before beginning this task, ensure that all applicable tasks listed in the “Installation Planning 
Considerations” on page 20 have been completed.

• There are references to logging on as the root and fnsw users within these procedures. The root user 
must run in the Bourne or Korn shell and the fnsw user must run in the Korn shell.

• Be sure to have the correct database information including server names, database and instance 
names, tablespace names, and filegroups.  Entering incorrect information during Process Engine 
installation could cause the installation to fail.  Recovery could mean uninstalling and re-installing the 
Process Engine software.

Perform symbolic links for X11 libraries

1. Log on as the root user.

2. At the prompt, execute the following: 

cd /usr/lib
ln -s /usr/lib/libX11.3 libX11.sl
ln -s /usr/lib/libXIE.2 libXIE.sl
ln -s /usr/lib/libXext.3 libXext.sl
ln -s /usr/lib/libXhp11.3 libXhp11.sl
ln -s /usr/lib/libXi.3 libXi.sl
ln -s /usr/lib/libXm.4 libXm.sl
ln -s /usr/lib/libXp.2 libXp.sl
ln -s /usr/lib/libXt.3 libXt.sl
ln -s /usr/lib/libXtst.2 libXtst.sl 

Check and optionally modify the timezone settings

HP-UX has two timezone settings: the kernel parameter timezone and the environment variable TZ. The 
value of both timezone settings must match. Review and, if necessary, change these settings on all 
servers.

1. As the root user, enter: 

sam

2. Select the Kernel Configuration option.

3. Select the Configurable Parameters option, then check the Pending Value for the timezone parameter. 
The default value is 420 minutes west of Greenwich Mean Time (GMT), which is the U.S. Mountain 
timezone.

Determine the number of minutes east or west of GMT for your location by multiplying the number of 
hours east or west of GMT by 60 minutes per hour. For example, the U.S. Pacific timezone is 8 hours 
west of GMT. Multiply 8 x 60 to get 480 minutes. If your timezone location is east of GMT, you should 
use a negative number. For example, Middle European Time is one hour east of GMT. Multiply -1 x 60 
to get -60 minutes for MET (Middle European Time).

4. If the Pending Value for the timezone parameter is correct, proceed to step 6. To change the value, 
continue with Step 5.
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5. To change the timezone kernel parameter value:

a. Select the timezone parameter by pressing the F3 key.

b. Select the Modify Configurable Parameter option from the Actions menu and press Return.

c. In the popup window that displays, the Specify New Formula/Value option should already be 
selected.

d. Tab to the Formula/Value field and type the new value. 

e. Tab to OK and press Return. When the popup window disappears, you should see the new value 
in the Pending Value column. 

f. Rebuild the kernel to make your change take effect:

i. Press the F4 key to access the menu bar.

ii. From the Action menu, select the Create a New Kernel option using the Arrow keys and press 
Return. 

iii. Answer Yes when prompted about creating the kernel now. 

iv. On the next screen, make sure the Move Kernel into Place and Shutdown/Reboot the System 
Now option is selected, tab to OK and press the Return key to reboot the system and make 
the new changes take affect.

6. As the root user, enter the following to check the current value of the TZ environment variable:

/sbin/set_parms timezone

7. If the current setting is not correct, choose the appropriate timezone from the menus displayed. 
Remember that the value must match that of the timezone kernel parameter. 

If you change the current setting, you will be prompted to reboot the server.

NOTE If the HP-UX set_parms command is not available on your server, the System Administrator should 
consult the HP-UX operating system documentation to determine the appropriate way to set the TZ 
environment variable. 

Configure kernel parameters

Ensure that the following parameters are set to at least the values shown unless otherwise noted. These 
values are sufficient to install and initialize the software but system tuning will be required, specifically for 
the nfiles and maxfiles parameters. See the following HP website for configuration details.

http://www.hp.com/products1/unix/java/infolibrary/prog_guide/java1/configuration.html 

Kernel Parameter Minimum Setting

maxdsiz 0x10000000 or 268435456 (256MB)

maxfiles 512 

nproc 1005

maxuprc 400

nfile 1024

ninode 1085

http://www.hp.com/products1/unix/java/infolibrary/prog_guide/java1/configuration.html
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semmns 2000

semmni 2000

semmap 2002

shmmax 0x20000000 or 536870912 (512MB)

shmseg 120

semmnu 1000

semume 500

msgmni 2048

msgseg 6640

msgtql 6640

msgmap 6642

bufpages 0 (required by Oracle)

dbc_max_pct 1 to 10 (required by Oracle, the value can not be greater than 10)

dbc_min_pct 5 (required by Oracle)

fs_async 0 (required by Oracle)

maxfiles_lim 1024

nflocks 200

npty 60

o_sync_is_o_dsync 0

timezone set appropriately See “Check and optionally modify the timezone settings” on 
page 191.

Kernel Parameter Minimum Setting
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Create or modify internal Process Engine users and groups

Using SAM, you must create or modify specific local groups and users required internally by Process 
Engine prior to running Process Engine Setup. These required users and groups are detailed in the 
following tables. After making the changes, log out and log back in to pick up the changes.

User Name Action User Type Default 
Shell

Primary Group Secondary Group

fnsw Create Operating 
System

Ksh fnusr <Oracle Database 
Administrators Group; 
default = dba>, 
fnadmin

root Modify Operating 
System

Ksh fnusr, fnadmin

<Oracle User; 
default = 
oracle>

Modify, if 
database 
is local.

Create, if 
database 
is remote.

Database <Oracle Database 
Administrators 
Group; default = 
dba>

fnusr

Group Name Action Description Members

fnadmin Create Members have all privileges on 
Process Engine files and databases.

fnsw, root

fnusr Create Members have non-administrator 
privileges on Process Engine files and 
databases.

fnsw, root, <Oracle 
User; default = oracle>

<Oracle Database 
Administrators 
Group; default = 
dba>

Modify, if 
database is 
local.

Create, if 
database is 
remote.

Members act as database 
administrators.

fnsw, <Oracle User; 
default = oracle>
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Create Partitions

Process Engine requires the presence of several partitions. The following table documents the 
requirements. 

Verify the database connection (Oracle)

The database that Process Engine will use must be running and be fully configured for IBM FileNet use 
before you run Process Engine Setup. In addition, if the database is remote, the database client software 
must also be installed and running on Process Engine when Process Engine Setup is started. See Task 5b 
on page 63 task for database installation and configuration procedures.

Take the following steps to verify that the Oracle database you want Process Engine to use is accessible. 
Make whatever corrections are necessary before running Process Engine Setup. 

1. Execute the following at a command prompt:

su - oracle -c "sqlplus"

2. At the SQLPlus prompt, enter a DBA userid and password.

3. At the prompt, enter the following SQL command:

SQL> select instance_name, host_name, version from v$instance;

Following is an example of the information returned:

INSTANCE_NAME
----------------
HOST_NAME
----------------------------------------------------------------
VERSION
-----------------
p8dbshr
HQVWBUCS
9.2.0.7.0

Volume Name Mount Point Minimum 
Size

User Group Mode

fnsw /fnsw 

file system

1000MB fnsw fnusr 775

local /fnsw/local

file system 

250MB fnsw fnusr 775

fn_sec_db0 (raw) n/a 

logical volume

12MB fnsw fnusr 664

fn_sec_rl0 (raw) n/a 

logical volume

4MB fnsw fnusr 664
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In this example: 

the instance, ORACLE_SID=p8dbshr

the database server name is hqvwbucs

the oracle server version is 9.2.0.7

Verify the database connection (DB2)

1. Log on as the client instance owner.

2. Execute the following at a command prompt:

db2

3. At the DB2 prompt, enter the following command:

connect to <database alias> user f_sw using <f_sw password>

DB2 will display the database connection information.

Following is an example of the database connection command and the information returned:

db2 => connect to pedbinst user f_sw using f_sw

   Database Connection Information

Database server        = DB2/AIX64 8.2.0
SQL authorization ID  = F_SW
Local database alias  = PEDBINST

In this example, the database alias is pedbinst and the f_sw user password is f_sw.

Mount Process Engine CD

1. Log in as root

2. Determine the CDROM drive device by executing the following: 

ioscan -funC disk

3. Using the device name returned, mount CD. The following is an example of the command, where /dev/
dsk/c0t1d0 is the device name identified above.

mount /dev/dsk/c0t1d0 /cdrom

Install the Process Engine software 

1. Log on to the server as the root user.

2. Insert the Process Engine CD. From the console, navigate to the /cdrom directory and execute 
setup.sh.

3. Indicate whether the database will be Oracle or DB2. Wait for files to finish unpacking

If Process Engine uses an Oracle database, continue with Step 4.

If Process Engine uses a DB2 database, proceed to Step 5.

4. When prompted, enter the Oracle sys password. The password is required to run the following SQL 
scripts: pe_install_scripts.sql, pe_filenet_site.sql, pe_create_stored_procedures.sql, and 
pe_grant_sp_permissions.sql. For further information about these scripts, see “Process Engine SQL 
Scripts (Oracle databases only)” on page 369.
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NOTE If an error message indicates that the scripts did not run, you must resolve the errors before 
proceeding. See “Process Engine SQL Scripts (Oracle databases only)” on page 369.

5. A sequence of installation screens will be presented.  Refer to the tables below for information on the 
screens you will see and the steps to take.

In this screen... Perform this action...

Welcome Click Next on the Welcome screen to proceed with the installation

Software License 
Agreement

Review and accept the license agreement for IBM FileNet P8 
software products, and then click Yes. You must accept the terms of 
the agreement to proceed with the installation.

Documentation 
Configuration

Enter the Documentation Server URL, which is where the IBM 
FileNet P8 Platform Documentation was installed. Your entry must be 
in the following format:

http://<docserver:port#>/<ecm_help>

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation website. You can 
use multi-part root folders 
(e.g.,/docs/ecm_help) if your application server supports them.

Rules Engine Support Indicate whether you want to configure the Rules Engine interface to 
run on this Process Engine.

Click Yes if the JRules software is already installed on this computer 
or if you know where on this computer JRules will be installed later.

Click No if the JRules software is not and will not be installed on this 
computer, or if you do not know exactly where on this computer 
JRules will be installed later. 

If you later install JRules software on this Process Engine, follow the 
procedures in “Enable Rules Engine integration manually” on 
page 281 to enable Rules Engine integration manually.

Choose Destination Loca-
tion

NOTE This window is dis-
played only if you click Yes 
in the Select Components 
window to install iLog 
JRules.

Enter the full path to the iLog JRules software installation directory.

The directory you specify must already exist. Later during installation 
(in “Enable Rules Engine integration” on page 279), you will finish 
setting up Rules Engine integration.

Common Files Choose the destination directory for configuration files that will be 
shared with other IBM FileNet P8 components.
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Domain Name Enter <domain name>:<organization>, where:

The maximum length of your <domain name> entry does not exceed 
20 characters.

The maximum length of your <organization> entry does not exceed 
20 characters.

Both your <domain name> and <organization> entries contain only 
alphanumeric characters and underscores.

A typical convention is to enter <your PE machine name>:FileNet. If 
the machine name includes hyphens, replace them with underscores 
in your entry.

Primary Server Selection Leave the box checked indicating that this is the primary Process 
Engine.

Local or Remote RDBMS Indicate whether the database will be local or remote.

Depending upon your selection here you will be presented with a 
number of additional screens appropriate to database location and 
database software.  Proceed as appropriate to:

• “Remote DB2 database” on page 199

• “Remote Oracle database” on page 199

• “Local Oracle database” on page 200

NOTE Only remote DB2 databases are supported.  

Database Selection 
Confirmation

This screen is presented as a confirmation of the type of database 
you chose to configure.  As directed in this screen, if you choose to 
change the database type, choose Cancel in this screen and re-run 
setup. Otherwise click Next to proceed.

In this screen... Perform this action...
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Remote DB2 database

Remote Oracle database

In this screen... Perform this action...

Database Alias Name Enter the database alias name as assigned in “Install DB2 Client for 
Content Engine and Process Engine” on page 77.  

Local DB2 instance owner 
name

Enter the DB2 client instance owner’s name.  Case sensitive.

FileNet Data Tablespace 
name

defaults to VWDATA_TS

DB2 Passwords Enter the passwords for the Operating System f_sw and f_maint 
users.

Enter the passwords set for these users in either  “Install DB2 server 
for Content Engine and Process Engine” on page 68 if database 
authentication is SERVER or SERVER_ENCRYPT, or “Install DB2 
Client for Content Engine and Process Engine” on page 77 if 
authentication is CLIENT.

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the Global Database name, Oracle 
Home, User Name, Oracle SID, Oracle DBA group name

The Oracle Home path you enter refers to the local Oracle Client 
installation directory.

Oracle Database 
Information

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS.

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index tablespace is 
designated. Default value is VWINDEX_TS.

All entries must match the value you used when the temporary 
tablespace was created in “Install Oracle Server for IBM FileNet P8” 
on page 63.  
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Local Oracle database

6. Enter the device file names for the fn_SEC_DB0 and fn_SEC_RL0 volumes.

7. Review the information on the installation process. Note that you can check the progress of the 
installation in the /fnsw/tmp-installer/MINI-INSTALLER.LOG file. Click Next when you are ready to 
proceed.

8. Review the summary information on the installation location for Process Engine. Click Next when you 
are ready to proceed.

9. Setup will run for several minutes. Progress is displayed and at some points may not advance for an 
extended period of time. To check the progress of the installation, monitor the /fnsw/tmp-installer/MINI-
INSTALLER.LOG file for current activity.

If the installation failed, check the /fnsw/tmp_installer/MINI_INSTALLER_ERROR.LOG file for errors.

10. (Oracle database only) When prompted, enter the Oracle sys password. The password is required to 
run the SQL script pe_setup_users_defaults.sql. For further information about this script, see “Process 
Engine SQL Scripts (Oracle databases only)” on page 369.

NOTE If an error message indicates that the script did not run, or you are not prompted for the sys 
password, you must resolve any errors and run the script manually. See “Process Engine SQL Scripts 
(Oracle databases only)” on page 369.

11. Check all log files and verify that there were no errors or failures. Correct any errors before proceeding. 
Log files to check include:

• All .lst and .log files in the /fnsw/local/logs/PE directory

• All .log files in the /fnsw/local/logs directory and all its subdirectories

12. Log off as the root user and log in as fnsw.

In this screen... Perform this action...

Oracle Environment 
Variables

Enter the appropriate values for the Oracle Home, User Name, 
Oracle SID, Oracle DBA group name

The Oracle Home path you enter refers to the local Oracle Client 
installation directory.

Oracle Database 
Information

Enter the Oracle tablespace to be used by Process Engine for 
temporary data.  Default value is VWTEMP_TS.

Enter the Oracle tablespace to be used for Process Engine data.  
Default value is VWDATA_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index tablespace is 
designated. Default value is VWINDEX_TS.

All entries must match the value you used when the temporary 
tablespace was created in “Install Oracle Server for IBM FileNet P8” 
on page 63.  
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Reset administrative user passwords

During Process Engine software installation, several local users required internally by Process Engine are 
automatically created. To maintain security, IBM strongly recommends resetting the passwords for these 
users. The following table lists the users created, the level of system access each user has, and the tool 
used to change the password. See the IBM FileNet Image Services documentation for instructions on 
using the referenced tools. 

Set the f_maint password (Oracle only)

1. Log on as the fnsw user.

2. At a command prompt, enter:

set_f_maint_pw

3. Press Return at the prompt for the current password.

4. Enter a new password for f_maint when prompted. The password must be between 6 and 30 
characters.

5. Confirm the new password when prompted.

Delete unnecessary users

Process Engine Setup automatically creates several users (listed below) in the database. The Process 
Engine software does not require these users, so you can safely delete them.

• f_sqi

• f_operator

• f_cso

• f_open

(Optional. Oracle databases only) Delete fnsw user from the Oracle database administrators group

Remove the fnsw user from the <Oracle Database Administrators> group.

Restore any custom modifications to the .profile or .cshrc. 

Process Engine Setup creates a new .profile or .cshrc file. If the previous versions of these files contained 
any custom settings, edit the new .profile or .cshrc file for the fnsw, root and oracle users accordingly. 

User Name User Type Description How to modify

f_maint Database (Oracle) Has DBA privileges. Used for 
RDBMS maintenance.

Execute set_f_maint_pw. 
See steps below.

SysAdmin SEC (internal 
Process Engine 
security software)

Primary administrator user for 
FileNet software tools.

Execute Xapex -> Security 
Administration. Log on as 
SysAdmin.

FieldService SEC Used internally by Process 
Engine software.

Operator SEC Used internally by Process 
Engine software.
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Saved files in are .profile.old.nn or .cshrc.old.nn, where nn is a sequential number. The latest saved 
version will be in the highest numbered file.

Verify the /etc/services file settings

1. Log in as the root user and check the /etc/services file to verify the following parameters:

snmp           161/udp  snmpd        # Simple Network Management Protocol Agent
snmp-trap    162/udp  trapd          # Simple Network Management Protocol Traps
tms               32768/tcp
cor                32769/tcp
nch               32770/udp
fn_trapd        35225/udp

2. If necessary, add the parameters to the file and save the changes.

Clean up before starting Process Engine

1. Log in as fnsw.

2. Execute:

vwzap

3. Execute:

killfnsw -DAyS

4. Execute:

ipcs -a 

Verify there is no entry with 0x464 pattern. If there are any entries with this pattern, use ipcim to 
remove them.

Edit the /etc/inittab file

By default, the Process Engine software starts automatically on restart and needs to have the database 
already started when Process Engine comes up. If the database is not automatically started on restart, edit 
the /etc/inittab file on Process Engine to comment out the autostart of Process Engine

rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1
to
#rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

Verify that the database and Process Engine software are running

Be sure that both the database and Process Engine software are running before proceeding to the next 
task. By default, the IMS Control Services Manager and Process Engine Services Manager are 
automatically started on system restart. However, the Process Engine software itself must be manually 
started. To start the software, take the following steps:

1. Log on as fnsw.

2. Start Process Task Manager by entering the following at the command prompt:

vwtaskman

3. From the Action menu, choose Start.
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Task 12: Start the Pooled Process Manager (PPM)

The Pooled Process Manager (PPM) is the link between the Process Router on an Application Engine or 
Content Engine and the VWJs processes on Process Engine. Workflow activity cannot occur unless the 
PPM is running.

To start the PPM

1. On Process Engine, log on as a member of the fnadmin group and start the Process Task Manager.

• Windows: Select Start > Programs > FileNet P8 Platform > Process Engine > Process Task 
Manager.

• UNIX: Enter vwtaskman from the command prompt.

2. Select PPM in the left pane (also referred to as the feature pane).

3. Enter the appropriate property values on the General and Advanced tabs. For descriptions of the 
properties, see FileNet P8 Administration > Enterprise-wide Administration > Process Task Manager > 
Process Engine > PPM (Pooled Process Manager).

NOTE If Process Engine and Application Engine are on opposite sides of a firewall, you must specify 
the Return Port property.

4. Click Apply to save your changes.

5. Click Start on the toolbar.
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Task 13: Configure the Process Engine LDAP Connection

Complete this task to configure the connection between Process Engine and the IBM FileNet P8 directory 
service.

NOTES

• If using Active Directory, get a complete export of the domain by executing:

ldifde –f <filename> 

This will provide the correct syntax for user and group base and serviceuserName. 

• If you wish to do only a partial export of the domain, you can use one of the following, and cut and 
paste the results into the LDAP configuration:

dsquery user -name <UserDisplayName>

dsquery group -name <GroupDisplayName>

• Ensure that you are using the correct directory server port.

To configure the LDAP connection

1. Log onto Process Engine as a member of fnadmin. 

On a Windows machine, Process Engine Setup automatically creates the fnadmin group and the fnsw 
user, and adds the fnsw user to the fnadmin group. 

On a UNIX machine, this user and group were manually created before running Process Engine setup.

2. Start the Process Task Manager. 

• Windows: Select Start > Programs > FileNet P8 Platform > Process Engine > Process Task 
Manager.

• UNIX: Enter vwtaskman from the command prompt. The terminal should support X Windows and 
the DISPLAY environment variable should be set.

3. Select Process Service in the feature pane.

4. If the Process Service is not already running, start it by choosing Start from the Action menu.

5. Select the LDAP tab.

6. On both the General and Advanced tabs, enter the appropriate value for each property. Most 
properties do not have a default value because they are system-specific; not entering values or 
entering incorrect values will disrupt runtime activity. For property descriptions, see FileNet P8 
Administration > Enterprise-wide Administration > Process Task Manager > Process Engine > Process 
Service > Configure the Process Service > Configure the Process Service LDAP connection 
(Workplace) > LDAP general properties.

NOTE The General tab includes properties (Communication Mode and Certificate Database) related 
to SSL security. In conjunction with setting these properties, you must complete the procedures in “Set 
up Process Engine SSL security” on page 251 to enable SSL security on Process Engine. The User 
and Group Base value must match what was specified as the DefaultRealm during installation and 
configuration of Content Engine.

7. After all parameters have been entered, click Apply and restart the Process Service when prompted.
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Task 14: Install Application Engine

This task includes Application Engine installation instructions for all supported application servers, for 
UNIX and Windows platforms. The installer will create the Application Engine folder structure and files 
needed for Application Engine. After installing the files, you must configure and start the Application 
Engine application. See “Configure and start Application Engine.” on page 212.

Before you install Application Engine

Read “Installation Planning Considerations” on page 20, “Operating System Considerations” on page 21, 
and “Security Authentication Considerations” on page 25, and make sure your installation location meets 
the requirements specific for Application Engine outlined in the IBM FileNet P8 Hardware and Software 
Requirements.

CAUTION (Linux only) To install Application Engine several legacy libraries are required. Add the compat-
libstdc++-7.3-2.96.122.i386.RPM located on Disc 3 of the RedHat AS 3.0 install media to your installation.

NOTES 

• To ensure proper functionality, performance, and ongoing maintenance, the Application Engine should 
only be installed once per application server (or virtual machine or WebSphere LPAR). You may, 
however, deploy multiple instances of a single Application Engine version per application server.

• Before logging on to Workplace for the first time, make sure at least one object store has been created 
on the Content Engine. See “Create an object store and verify the Content Engine installation” on 
page 147 for more information.

• If you plan to set up a web farm or clustered environment, in addition to these instructions, read and 
follow the instructions in the IBM FileNet P8 Platform High Availability Technical Notice.

• If you run the installer to upgrade Application Engine a confirmation screen will appear to verify that 
there is a version of Application Engine installed that can be upgraded. See “Upgrade Application 
Engine” on page 328 for more information. Also, be aware that the following installer screens will not 
appear on an upgrade: 

• Choose an application server

• Content Engine Java API Configuration 

• Application Engine User Security 

• User Token Security 

• Documentation Configuration

• Folder Location of bootstrap.properties 

To install the Application Engine software

1. Log on to the application server:

UNIX - logon as a user with write access to the /bin directory and read, write, and execute access 
to the directory where you plan to install Application Engine. 

Windows - log on as a member of the local Administrators group or a user with equivalent 
permissions.

2. Stop the application server if it is running.



INSTALLATION AND UPGRADE GUIDE
Install Application Engine

206
NOTE  (WebSphere only) Stopping the application server is not necessary for WebSphere 
installations.

3. Start the Application Engine Setup wizard:

AIX - Insert and mount the Application Engine CD. Navigate to /<mount_point>/ and execute 
AIXfilenet_app_engine_setup.bin.

HP-UX - Insert and mount the Application Engine CD. Navigate to /<mount_point>/ and execute 
HPUX11filenet_app_engine_setup.bin.

Linux - Insert and mount the Application Engine CD. Navigate to /<mount_point>/ and execute 
LINUXfilenet_app_engine_setup.bin.

Solaris - Insert and mount the Application Engine CD. Navigate to /cdrom/p8ae35sol/ and 
execute SOLARISfilenet_app_engine_setup.bin.

Windows - Insert the Application Engine CD. Navigate to CD-ROM (D:)\  and execute 
WINfilenet_app_engine_setup.exe.

4. Complete the Setup screens as follows:

In this screen... Perform this action...

License Agreement Review and accept the license agreement for IBM FileNet P8 
software products, and then click Next.

Directory Name For the Directory Name field, enter or browse to the location where 
you want to install the Application Engine software 
(<AE_install_path>), or accept the default location:

UNIX - /opt

Windows - C:\Program Files\

Click Next.

The installation program creates a FileNet directory at the selected 
location, and installs the Application Engine software in this directory:

UNIX - <AE_install_path>/FileNet/Workplace

Windows - <AE_install_path>\FileNet\Workplace

Choose the Setup Type Select the setup type, and click Next.

• Select Typical to install these components:

– Workplace web applications

– Process and Content Java APIs

• Select Custom to select the individual components to install:

– Workplace web applications

– Process and Content Java APIs

– Workplace Toolkit Source Code (for custom application 
development) 
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Verify Upgrade

NOTE  This screen only 
appears when you use the 
installer to perform an 
upgrade.

The setup wizard detects supported older versions of Application 
Engine. 

If the wizard detects a version that can be upgraded, click Next to 
proceed with the upgrade. 

If you don’t want to upgrade your Application Engine at this time, click 
Cancel to exit the wizard. 

Choose an application 
server

NOTE  This screen will not 
appear when you use the 
installer to perform an 
upgrade.

For WebSphere, choose WebSphere Application Server.

For WebLogic, choose WebLogic Application Server.

For JBoss/Tomcat, Oracle Application Server, Sun Java Application 
Server, and all other application servers, choose Generic J2EE 
Application Server.

Check the box if your application server uses JDK 1.3.x.

Click Next.

In this screen... Perform this action...
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Content Engine Java API 
Configuration

NOTE  This screen will not 
appear when you use the 
installer to perform an 
upgrade.

Configure the Content Engine Java API, as follows:

a. Content Engine client software URL:

Replace the sample server name and port number 
(CEserver.example.com:8008) with the Content Engine 
server name and Content Engine Apache (SOAP) port 
number for your Content Engine server on which the 
Application Engine Web Connectivity (Java) module resides. 
For information, see “IBM FileNet P8 Port Numbers” on 
page 364)

NOTE To change the Content Engine name later, or to 
connect to a different Content Engine, edit the 
WcmApiConfig.properties file. For information, go to the 
Documentation for IBM FileNet P8 Platform help and 
navigate to FileNet P8 Administration > Application Engine 
Administration > Key configuration files and logs.

b. Content Engine upload URL

Replace the sample server name and port number 
(CEserver.example.com:8008) with the Content Engine 
server name and Content Engine Apache (SOAP) port 
number to use when uploading document content to the 
Content Engine server.

c. Content Engine download URL

Replace the sample server name and port number 
(CEserver.example.com:8008) with the Content Engine 
server name and Content Engine Apache (SOAP) port 
number for your Content Engine server from which to 
download document content.

Click Next.

In this screen... Perform this action...
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Application Engine User 
Security

NOTE  This screen will not 
appear when you use the 
installer to perform an 
upgrade.

Configure Application Engine user security, as follows:

a. Select credentials protection, the encryption method to pro-
tect user logon credentials passed between Application 
Engine and Content Engine: 

• Clear encoding - encodes credentials using base 64 
encoding.

• Symmetric encryption - uses cryptography keys to 
encrypt and decrypt user credentials.

If you select symmetric encryption, the setup program 
generates a cryptography key file, 
CryptoKeyFile.properties, and places it in the default path 
or the path you specify.

b. (Optional) Check the box to create maximum strength keys.

By default the installer creates limited strength (128-bit) keys; 
if you check the box, the installer creates 448-bit keys. 

CAUTION If you are using JDK 1.4 or higher and choose to 
use maximum strength keys you must install the Unlimited 
Strength Jurisdiction Policy Files before logging in.  For 
information, see “Install unlimited strength .jar files.” on 
page 245. 

c. (If you selected Symmetric encryption) Make a note of the 
crypto key file path.

You will need the location when you set up symmetric 
encryption, see “Configure symmetric encryption” on 
page 245.

By default, the installation program installs the 
CryptoKeyFile.properties file to:

UNIX - <AE_install_path>/FileNet/Authentication/

Windows - <AE_install_path>\FileNet\Authentication\

Click Next.

NOTE The credentials protection method and path to the 
CryptoKeyFile.properties file are also recorded in the 
WcmApiConfig.properties file. For information, go to the 
Documentation for IBM FileNet P8 Platform help and navigate to 
FileNet P8 administration > Application Engine Administration > Key 
configuration files and logs.

In this screen... Perform this action...
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User Token Security

NOTE  This screen will not 
appear when you use the 
installer to perform an 
upgrade.

Configure user token security.

a. Check the box to create maximum strength keys.

By default, the installer creates limited strength (128-bit) 
keys; if you check the box, the installer creates 448-bit keys. 

CAUTION If you are using JDK 1.4 or higher and choose to 
use maximum strength keys you must install the Unlimited 
Strength Jurisdiction Policy Files before logging in. For 
information, see “Install unlimited strength .jar files.” on 
page 245. 

b. Make a note of the user token crypto key path.

The UTCryptoKeyFile.properties file contains the user 
token cryptography key used by IBM FileNet P8 applications 
to launch into each other without the need for additional login. 

The default  User Token Crypto key file path is:

UNIX - <AE_install_path>/FileNet/Authentication/

Windows - <AE_install_path>\FileNet\Authentication\

Click Next.

CAUTION For multiple applications to pass user tokens between one 
another, each participating application must use the same encryption 
key file. Copy the UTCryptoKeyFile.properties file installed with 
Application Engine to all servers that are hosting a token-sharing 
application. 

For information, go to the Documentation for IBM FileNet P8 Platform 
help and navigate to Developer Help > Workplace Integration and 
Customization Introduction > User Tokens > Configuring Applications 
to Use Tokens.

In this screen... Perform this action...
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Documentation 
Configuration

NOTE  This screen will not 
appear when you use the 
installer to perform an 
upgrade.

For the documentation URL, enter the Documentation Server URL, 
which is where the IBM FileNet P8 Platform Documentation is 
installed, then click Next. 

Your entry must be in the following format:

http://<docserver:port#>/<ecm_help>/

where: 

docserver is the name of the Java web server.

port# is the port number.

ecm_help is the root folder of the documentation website. You can 
use multi-part root folders (e.g., /docs/ecm_help) if your application 
server supports them.

See “Install FileNet P8 Platform documentation” on page 57 for more 
information. 

NOTE For information on how to reconfigure the Documentation 
URL, go to the Documentation for IBM FileNet P8 Platform help and 
navigate to FileNet P8 Administration > Application Engine 
Administration > Key configuration files and logs >  Bootstrap 
properties.

Folder Location of 
bootstrap.properties

NOTE  This screen will not 
appear when you use the 
installer to perform an 
upgrade.

Set the bootstrap.properties file location, then click Next.

NOTE Leave the location blank unless you are setting up a web farm/
clustered environment where multiple Application Engines will access 
the same bootstrap.properties file. For more information, see the IBM 
FileNet P8 Platform High Availability Technical Notice.

The bootstrap.properties file stores bootstrap preferences, a 
category of site preferences that affect connectivity and security. For 
specific information on bootstrap preferences see “Set bootstrap 
preferences” on page 238.

The file will be installed to:

UNIX -  <AE_install_path>/FileNet/Workplace/WEB-INF/

Windows - <AE_install_path>\FileNet\Workplace\WEB-INF\

CAUTION  Using a UNC admin share (ex: \\server\C$) for a shared 
bootstrap location is not supported. You may use an ordinary file 
share.

In this screen... Perform this action...
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5. (UNIX only) Log out and back in again to set the environment variables. 

6. View the app_engine_install_log_35.txt file, located in:

UNIX -  <AE_install_path>/FileNet/

Windows - <AE_install_path>\FileNet\

Verify that no errors or failures were logged. Correct any errors before proceeding.

NOTE See the IBM FileNet P8 Platform Troubleshooting Guide for more details about installation 
actions and errors.

7. Configure and start Application Engine. 

Follow the instructions for your specific application server to configure and start your Application 
Engine:

• Task 15a on page 213 (WebSphere)

• Task 15b on page 220 (WebLogic)

• Task 15c on page 223 (JBoss/Tomcat)

• Task 15d on page 228 (Oracle Application Server)

• Task 15e on page 231 (Sun Java Application Server)

• Task 15f on page 234 (generic application server)

Upload Directory Select the Upload Directory, then click Next.

The Upload Directory is the directory used by Workplace to store 
temporary copies of  files uploaded to Workplace. 

Leave the default option or browse for a directory to hold the 
temporary upload files.

CAUTION  Using a UNC admin share (ex: \\server\C$) for a shared 
upload directory location is not supported. You may use an ordinary 
file share.

Download Directory Select the Download Directory, then click Next.

The Download Directory is the directory used by Workplace to store 
temporary copies of  files downloaded from Workplace. 

Leave the default option or browse for a directory to hold the 
temporary download files.

CAUTION  Using a UNC admin share (ex: \\server\C$) for a shared 
download directory is not supported. You may use an ordinary file 
share.

Ready to Install Verify your selections, and click Next to install Application Engine.

Completing the Application 
Engine Setup wizard

Click Finish to complete the Application Engine installation.

In this screen... Perform this action...
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Task 15a: Configure and start Application Engine (WebSphere)

This topic covers the configuration, deployment, and start of your Application Engine application 
(Workplace) on WebSphere.

NOTE  Application Engine uses cookie names for passing session information between Application Engine 
and the client browser. This session information affects how Application Engine interacts with several 
applets, such as Process Designer, Search Designer, and Process Simulator. To avoid forcing end users to 
log in individually to each applet, do not configure the application server to use application-unique cookie 
names for the deployed Application Engine. For best results, use JSESSIONID for the cookie name.

To configure and start Application Engine (WebSphere 5.1)

1. Open the WebSphere Administrative Console.

2. Set JavaTM Virtual Machine (JVM) memory settings.

a. Expand Servers. Click Application Servers. Click <server name>. Under “Server Infrastructure”, 
select Java & Process Management. Select Process Definition and then select Java Virtual 
Machine. Enter the numbers for the Initial and Maximum Heap Size. 

NOTE  Please refer to your application server vendor's recommendation for Initial and Maximum 
heap size values.

b. Click Apply.

3. Install the Enterprise Application (Workplace). 

a. Verify that the app_engine.war file was created before you continue.

b. From the Administrative Console, expand Applications. Click Install New Application. The “Pre-
paring for the application installation” dialog opens. 

c. (If the Administrative Console is running locally) Select Local Path and enter or browse to the 
location of the app_engine.war file created by the setup program (see below for the default path). 
Do not enter the machine name.

d. (If the Administrative Console is remote) Select Server path and enter the fully-qualified path 
name to the app_engine.war file. Do not enter the machine name.

The default path is:

UNIX - <AE_install_path>/FileNet/Workplace/

Windows - <AE_install_path>\FileNet\Workplace\

e. Enter the context root: 

Enter Workplace and click Next to proceed to deploying a new application.

NOTE The context root is the name of the application you log in to using the web interface, e.g. 
http://<ApplicationEngineServerName>:<port#>/<Context Root>.

f. On the “Preparing for the application installation” screen, leave the defaults, and click Next.

g. On the “Application Security Warning” screen, click Continue.

h. At “Install New Application”, Step 1, specify the application name.

Enter Workplace, or the name you chose to call the application, click Next.
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i. At “Install New Application”, Step 2, specify the Virtual Host for the virtual host that you are plan-
ning to use. Check Workplace and keep the default virtual host (default_host), click Next.

j. At “Install New Application”, Step 3, configure your application server, then click Next. 

k. At “Install New Application”, Step 4, verify your configuration and click Finish. Once the configura-
tion is saved, click Save to Master Configuration.

l. Configure the Classloader settings.

i. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default Workplace).

ii. From the Configuration tab, set Classloader Mode to PARENT_LAST. 

iii. Verify that the WAR Classloader Policy is set to Module.

NOTE You do this only for the specific web application. There are similar settings for the entire 
application server. Do not change these.

m. Configure the Web Module Classloader setting.

i. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default Workplace). Under Related Items, click Web Modules. Click 
app_engine.war.

ii. From the Configuration tab, set Classloader Mode to PARENT_LAST. 

NOTE You do this only for the specific web application. There are similar settings for the entire 
application server. Do not change these.

n. Click Apply, Save, then Save changes to the Master Configuration.

o. Regenerate the web server plug-in. 

From the Administrative Console, expand Environment. Click Update Webserver Plugin, then 
click OK.

4. Stop and restart the application server, (and restart the HTTP server, if installed). 

5. Start the Enterprise Application: 

From the Administrative Console, expand Applications. Click Enterprise Application. Check the box 
to the left of the Workplace application (or whatever you named it), and click Start.

6. Enable Application Integration Installation. 

a. From the Administrative Console, expand Environment. Click Virtual Hosts.

b. Click the default_host (or the host your application is deployed under).

c. Click MIME Types, then click New.

d. In the MIME Type field, enter application/octet-stream

e. In the Extension(s) field, enter exe. Click OK.

f. Click Apply, Save, then Save changes to the Master Configuration.

g. Restart the Workplace application.

7. Set permissions for the user running the application server.
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If the local user that will be running the application server is different from the user that installed AE, 
you must give the user read/write permissions on the following (default) folders:

UNIX:

<WAS_HOME>/profiles/default/installedApps/<node_name>/app_engine_war.ear/
app_engine.war

<AE_install_path>/FileNet/

Windows (only required for NTFS formatted partitions):

<WAS_HOME>\profiles\default\installedApps\<node_name>\app_engine_war.ear\app_engi
ne.war

<AE_install_path>\FileNet\

8. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

The P8TASKMAN_HOME system environment variable should be set to:

 P8TASKMAN_HOME=<AE_install_path>/CommonFiles

To configure and start Application Engine (WebSphere 6.0)

1. Open the WebSphere Administrative Console.

2. Set JVM memory settings.

a. Expand Servers. Click Application Servers. Click <server name>. Under “Server Infrastructure”, 
select Java & Process Management. Select Process Definition and then select Java Virtual 
Machine. Enter the numbers for the Initial and Maximum Heap Size. 

NOTE  Please refer to your application server vendor's recommendation for Initial and Maximum 
heap size values.

b. Click Apply.

3. Install the Enterprise Application (Workplace). 

a. Verify that the app_engine.war file was created before you continue.

b. From the WebSphere Administrative Console, expand Applications. Click Install New Applica-
tion. The “Preparing for the application installation” dialog opens. 

c. (If the Administrative Console is running locally) Select Local Path and enter or browse to the 
location of the app_engine.war file created by the setup program (see below for the default path). 
Do not enter the machine name.

d. (If the Administrative Console is remote) Select Remote File System and enter the fully-qualified 
path to the app_engine.war file. Do not enter the machine name.

The default path is:

UNIX - <AE_install_path>/FileNet/Workplace/

Windows - <AE_install_path>\FileNet\Workplace\

e. Enter the context root: 

Enter Workplace and click Next to proceed to deploying a new application.
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NOTE The context root is the name of the application you log in to using the web interface, e.g. 
http://<ApplicationEngineServerName>:<port#>/<Context Root>.

f. On the “Preparing for the application installation” screen, leave the defaults, and click Next.

g. On the “Application Security Warning” screen, click Continue.

h. At “Install New Application”, Step 1, specify the application name.

Enter Workplace, or the name you chose to call the application, click Next.

i. At “Install New Application”, Step 2, Map modules to servers, specify the WebServer you are plan-
ning to use. Check Workplace and click Next.

j. At “Install New Application”, Step 3, Map virtual hosts for Web Modules, check Workplace and 
keep the default virtual host (default_host), click Next.

k. At “Install New Application”, Step 4, verify your configuration and click Finish. Once the configura-
tion is saved, click Save to Master Configuration.

l. Configure the Classloader settings.

i. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default Workplace).

ii. From the Configuration tab, set Classloader Mode to PARENT_LAST. 

iii. Verify that the WAR Classloader Policy is set to Module.

NOTE You do this only for the specific web application. There are similar settings for the entire 
application server. Do not change these.

iv. Click  Apply.

m. Configure the Web Module Classloader setting.

i. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default Workplace). Under Related Items, click Web Modules. Click 
app_engine.war.

ii. From the Configuration tab, set Classloader Mode to PARENT_LAST. 

NOTE You do this only for the specific web application. There are similar settings for the entire 
application server. Do not change these.

n. Click Apply, Save, then Save changes to the Master Configuration.

4. Stop and restart the application server, (and restart the HTTP server, if installed). 

5. Start the Enterprise Application: 

From the Administrative Console, expand Applications. Click Enterprise Application. Check the box 
to the left of the Workplace application (or whatever you named it), and click Start.

6. Enable Application Integration Installation. 

a. From the Administrative Console, expand Environment. Click Virtual Hosts.

b. Click the default_host (or the host your application is deployed under).

c. Click MIME Types, then click New.

d. In the MIME Type field, enter application/octet-stream



INSTALLATION AND UPGRADE GUIDE
Configure and start Application Engine (WebSphere)

217
e. In the Extension(s) field, enter exe. Click OK.

f. Click Apply, Save, then Save changes to the Master Configuration.

g. Restart the Workplace application.

7.  Set permissions for the user running the application server.

8. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

To configure and start Application Engine (WebSphere 6.1)

1. Open the WebSphere Administrative Console.

2. Set JVM memory settings.

a. Expand Servers. Click Application Servers. Click <server name>. Under “Server Infrastructure”, 
select Java & Process Management. Select Process Definition > Additional Properties > 
Java Virtual Machine. Enter the values for the Initial and Maximum Heap Size. 

NOTE  Please refer to your application server vendor's recommendation for Initial and Maximum 
heap size values. For IBM FileNet specific recommendations, see the IBM FileNet P8 Platform 
Performance Tuning Guide. To download this guide from the IBM support page, see “Access IBM 
FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

b. Click Apply.

3. Install the Enterprise Application (Workplace). 

a. Verify that the app_engine.war file was created before you continue.

b. From the WebSphere Administrative Console, expand Applications. Click Install New Applica-
tion. The “Preparing for the application installation” dialog box opens. 

c. (If the Administrative Console is running locally) Select Local Path and enter or browse to the 
location of the app_engine.war file created by the setup program (see below for the default path). 
Do not enter the machine name.

d. (If the Administrative Console is remote) Select Remote File System and enter the fully-qualified 
path to the app_engine.war file. Do not enter the machine name.

The default path is:

UNIX - <AE_install_path>/FileNet/Workplace/

Windows - <AE_install_path>\FileNet\Workplace\

e. Enter the context root: 

Enter Workplace and click Next to proceed to deploying a new application.

NOTE The context root is the name of the application you log in to using the web interface, e.g. 
http://<ApplicationEngineServerName>:<port#>/<Context Root>.

f. In the “Preparing for the application installation” screen, leave the defaults, and click Next.

g. If you see the “Application Security Warning” screen, click Continue.

h. At “Install New Application”, Step 1, specify the application name.

Enter Workplace, or the name you chose to call the application, click Next.
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i. At “Install New Application”, Step 2, Map modules to servers, specify the WebServer you are plan-
ning to use. Check Workplace and click Apply. Verify that the web server you specify is displayed 
to the right of Workplace. Click Next.

j. At “Install New Application”, Step 3, Map virtual hosts for Web Modules, check Workplace and 
keep the default virtual host (default_host), click Next.

k. At “Install New Application”, Step 4, verify your configuration and click Finish. Once the configura-
tion is saved, click Save to Master Configuration.

l. Configure the Classloader settings.

i. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default Workplace).

ii. From the Configuration tab,  click Class loading and update detection.

iii.  Change Classloader order from "Classes loaded with parent class loader first" to "Classes 
loaded with application class loader first." 

NOTE Do this only for the specific web application. Do not change the similar settings for the 
entire application server.

iv. Change the polling interval to a number appropriate for your environment.

v. Click  Apply.

m. Configure the Web Module Classloader setting.

i. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default Workplace). Under Modules, click Manage Modules. Click your 
application (Workplace).

ii. Set the "Class loader order" to "Classes loaded with application class loader first". 

NOTE Do this only for the specific web application. Do not change the similar settings for the 
entire application server.

n. Click Apply, click Save, and then click Save changes to the Master Configuration.

4. Stop and restart the application server, (and restart the HTTP server, if installed). 

5. Start the Enterprise Application: 

From the Administrative Console, expand Applications. Click Enterprise Application. Check the box 
to the left of the Workplace application (or whatever you named it), and click Start.

6. Enable Application Integration Installation. 

a. From the Administrative Console, expand Environment. Click Virtual Hosts.

b. Click the default_host (or the host your application is deployed under).

c. Click MIME Types, then click New.

d. In the MIME Type field, enter application/octet-stream

e. In the Extension(s) field, enter exe. Click OK.

f. Click Apply, click Save, then click Save changes to the Master Configuration.

g. Restart the Workplace application.
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7. Set permissions for the user running the application server.

If the local user that will be running the application server is different from the user that installed AE, 
you must give the user read/write permissions on the following (default) folders:

UNIX:

<WAS_HOME>/profiles/<server_instance>/installedApps/<node_name>/
app_engine_war.ear/app_engine.war

<AE_install_path>/FileNet/

Windows (only required for NTFS formatted partitions):

<WAS_HOME>\profiles\<server_instance>\installedApps\<node_name>\
app_engine_war.ear\app_engine.war

<AE_install_path>\FileNet\

8. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

The P8TASKMAN_HOME system environment variable should be set to:

 P8TASKMAN_HOME=<AE_install_path>/CommonFiles
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Task 15b: Configure and start Application Engine (WebLogic)

This topic covers the configuration, deployment, and start of your Application Engine application 
(Workplace) on WebLogic.

NOTE  The Application Engine uses cookie names for passing session information between the 
Application Engine and the client browser. This session information affects how the Application Engine 
interacts with several applets, such as Process Designer, Search Designer, and Process Simulator. To 
avoid forcing end users to log in individually to each applet, do not configure the application server to use 
application-unique cookie names for the deployed Application Engine. For best results, use JSESSIONID 
for the cookie name.

To configure and start Application Engine

1. (WebLogic 7.x using JDK1.3 only) Modify the java.security file. 

a. Use a text editor to open the java.security file used by WebLogic and typically stored in the follow-
ing location:

<JDK_1.3_HOME>/jre/lib/security

b. Add the following line, specifying a preference order that does not conflict with an existing entry:

security.provider.n=com.sun.crypto.provider.SunJCE

where n is the preference order value. For example, in the example below, you can specify a 
preference order value of 3 or higher.

The following is an example from the JDK 1.3 java.security file: 

#
# List of providers and their preference orders (see above):
#
security.provider.1=sun.security.provider.Sun
security.provider.2=com.sun.rsajca.Provider

c. Save and close the java.security file. 

2. (WebLogic 7.x only) Modify the application server startup script.

Make the following modification to the application server's startup script. If you are using a WebLogic 
domain, modify startWebLogic.cmd for Windows or startWebLogic.sh for UNIX. If you are not using 
a WebLogic domain, modify startWLS.cmd for Windows or startWLS.sh for UNIX. 

a. Modify the application classpath.

Find the CLASSPATH variable and add the jar file paths listed below. If the CLASSPATH variable 
doesn't exist, add it to the startup script. Do not delete or modify any existing jar file paths, and do 
not insert spaces.

NOTE  Items in bold below are only installed if you are using JDK 1.3, see “Check the box if your 
application server uses JDK 1.3.x.” on page 207. Do not include these in the classpath unless you 
are using JDK 1.3. 

UNIX (separate each entry with a colon):

<AE_install_path>/FileNet/lib2/activation.jar:
<AE_install_path>/FileNet/lib2/connector.jar:
<AE_install_path>/FileNet/lib2/jce1_2_2.jar:
<AE_install_path>/FileNet/lib2/local_policy.jar:
<AE_install_path>/FileNet/lib2/log4j-1.2.8.jar:
<AE_install_path>/FileNet/lib2/mailapi.jar:
<AE_install_path>/FileNet/lib2/soap.jar:
<AE_install_path>/FileNet/lib2/sunjce_provider.jar:
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<AE_install_path>/FileNet/lib2/US_export_policy.jar:
<AE_install_path>/FileNet/lib2/versionAE.jar:
<AE_install_path>/FileNet/lib2/xercesImpl.jar:
<AE_install_path>/FileNet/lib2/xml-apis.jar

Windows (separate each entry with a semicolon):

<AE_install_path>\FileNet\lib2\activation.jar;
<AE_install_path>\FileNet\lib2\connector.jar;

<AE_install_path>\FileNet\lib2\jce1_2_2.jar;
<AE_install_path>\FileNet\lib2\local_policy.jar;
<AE_install_path>\FileNet\lib2\log4j-1.2.8.jar;
<AE_install_path>\FileNet\lib2\mailapi.jar;
<AE_install_path>\FileNet\lib2\soap.jar;
<AE_install_path>\FileNet\lib2\sunjce_provider.jar;
<AE_install_path>\FileNet\lib2\US_export_policy.jar;
<AE_install_path>\FileNet\lib2\versionAE.jar;
<AE_install_path>\FileNet\lib2\xercesImpl.jar;
<AE_install_path>\FileNet\lib2\xml-apis.jar;

b. Modify the MaxPermSize.

Find the MEM_ARGS variable and append the following to any existing settings:

–XX:MaxPermSize=<size>m

Where <size> is the value, in MB, of the MaxPermSize. Please refer to your application server 
vendor's recommendation for a value for your configuration. 

NOTE  If the MEM_ARGS variable doesn't exist, add it to the startup script.

3. Start the application server.

4. Create a new Web Application:

• WebLogic 7.0.x

i. From the WebLogic Server Console, under <mydomain> expand Deployments, and click 
Web Applications.

ii. Click Configure a new Web Application.

iii. From the right pane of the WebLogic Server Console, browse to the Workplace folder in

UNIX - <AE_install_path>/FileNet 

Windows - <AE_install_path>\FileNet

Click select to select Workplace.

iv. Select <myserver> from Available Servers and click the right-arrow button so that <myser-
ver> becomes the target server. Verify that the Application Name is Workplace.

v. Click Configure and Deploy.

NOTE To verify that the deployment was successful, expand Deployments and Web 
Application Modules. The web application Workplace will be listed.

• WebLogic 8.1.x

i. From the WebLogic Server Console, <mydomain>, expand Deployments, and click Web 
Application Modules.

ii. Click Deploy a new Web Application Module...

iii. From the right pane of the WebLogic Server Console, browse to and select the radio button for 
the Workplace folder in
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UNIX - <AE_install_path>/FileNet 

Windows - <AE_install_path>\FileNet

Click Target Module to select Workplace.

iv. Verify that the Name field has the value Workplace.

v. Click Deploy.

NOTE To verify that the deployment was successful, expand Web Applications. The web 
application Workplace will be listed.

• WebLogic 9.2.x

i. From the WebLogic Server Console, <mydomain>, expand Deployments, and click Install.

ii. From the right pane of the WebLogic Server Console, browse to and select the radio button for 
the Workplace folder in

UNIX - <AE_install_path>/FileNet 

Windows - <AE_install_path>\FileNet

Click Target Module to select Workplace.

iii. Verify that the Name field has the value Workplace and the Location field has the right value. 
Accept the other default values,and click Finish.

NOTE To verify that the deployment was successful, click Deployments. The web application 
Workplace will be listed.

5. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed AE, you 
must give the user read/write permissions on the following folder:

UNIX:

<AE_install_path>/FileNet/

Windows (only required for NTFS formatted partitions):

<AE_install_path>\FileNet\

6. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

The P8TASKMAN_HOME system environment variable should be set to:

 P8TASKMAN_HOME=<AE_install_path>/CommonFiles
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Task 15c: Configure and start Application Engine (JBoss/Tomcat)

This topic covers the configuration, deployment, and start of your Application Engine application 
(Workplace) on JBoss/Tomcat.

NOTE  The Application Engine uses cookie names for passing session information between the 
Application Engine and the client browser. This session information affects how the Application Engine 
interacts with several applets, such as Process Designer, Search Designer, and Process Simulator. To 
avoid forcing end users to log in individually to each applet, do not configure the application server to use 
application-unique cookie names for the deployed Application Engine. For best results, use JSESSIONID 
for the cookie name.

To configure and start Application Engine

NOTE  The following procedure contain pathnames for both UNIX and Windows. If there is no difference in 
directory structure, a forward slash (/) will be used to separate the elements of a pathname for both UNIX 
and Windows.

1. (Application servers using JDK1.3 only) Modify the java.security file. 

a. Use a text editor to open the java.security file used by the application server, and typically stored in 
the following location:

 <JDK_1.3_Home>/jre/lib/security 

b. Add the following line, specifying a preference order that does not conflict with an existing entry:

security.provider.n=com.sun.crypto.provider.SunJCE

where n is the preference order value. In the example below, you can specify a preference order 
value of 3 or higher.

NOTE If you want to use a JCE provider other than SunJCE, make sure it is compatible with the 
JDK version in use and supports the Blowfish algorithm in ECM mode. Follow the JCE vendor’s 
instructions for installation.

The following is an example from the JDK 1.3 java.security file:

#
# List of providers and their preference orders (see above):
#
security.provider.1=sun.security.provider.Sun
security.provider.2=com.sun.rsajca.Provider 

c. Save and close the java.security file.

2. Configure the application server

JBoss (version 4.02 and higher only)

a. On the JBoss server, copy the /Workplace folder from: 

<AE_install_path>/FileNet/

to:

<JBoss_HOME>/server/default/deploy/

b. Append the extension .war to the Workplace folder:

<JBoss_HOME>/server/default/deploy/Workplace.war
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JBoss (version 4.01 and lower only)

To deploy Application Engine on JBoss version 4.01 and lower, you must configure isolated 
classloading for deployed web applications by deploying the web application within an enterprise 
application (EAR).  

a. Under <JBoss_HOME>/server/default/deploy, create a folder named <Web Application 
Name>.ear.  

Example: In the case of Workplace, name the folder Workplace.ear.

b. Within the /Workplace.ear folder create a /META-INF subdirectory .

c. Within /META-INF, create a file named application.xml with the following content:

<?xml version="1.0"?>
<application 

xmlns="http://java.sun.com/xml/ns/j2ee" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://java.sun.com/xml/ns/j2ee 
http://java.sun.com/xml/ns/j2ee/application_1_4.xsd" 
version="1.4">

<display-name><Web Application Name> EAR</display-name>
<description><Web Application Name> EAR</description>
<module>

<web>
      <web-uri><Web Application Name>.war</web-uri>
      <context-root><Web Application Name></context-root>
</web>

</module>
</application>

NOTE  Replace all occurrences of <Web Application Name> with the name of the web 
application.  

Example: For this example, use Workplace.

NOTE  If your web application name includes extended characters, save the application.xml file as 
a UTF-8 encoded file. 

d. Within /META-INF, create a file named jboss-app.xml with the following content:

<jboss-app>
<loader-repository>

<Web Application Name>:loader=<Web Application Name>.ear
   <loader-repository-config>
       java2ParentDelegaton=true
</loader-repository-config>

</loader-repository>
</jboss-app>

NOTE  Replace all occurrences of <Web Application Name> with the name of the web 
application.  

Example: For this example, use Workplace.

NOTE  If your web application name includes extended characters, save the jboss-app.xml file as 
a UTF-8 encoded file. 

e. Copy the /Workplace folder from: 

<AE_install_path>/FileNet/

to:

<JBoss_HOME>/server/default/deploy/<Web Application Name>.ear

f. Append the extension .war to the Workplace folder:



INSTALLATION AND UPGRADE GUIDE
Configure and start Application Engine (JBoss/Tomcat)

225
<JBoss_HOME>/server/default/deploy/<Web Application Name>.ear/Workplace.war

g. (JBoss 4.01 only) Remove .jar files.

i. Navigate to <JBoss_HOME>/server/default/deploy/<Web Application Name>.ear/Work-
place.war/WEB-INF/lib/.

Delete the following JAR files, as they are already included withJBoss:

• activation.jar

• jaxrpc.jar

• listener.jar

• mail.jar

• mailapi.jar

• smtp.jar

• xercesImpl.jar

ii. Remove the temp working directory for Workplace:

 <JBoss_HOME>/server/default/work/jboss.web/localhost/Workplace

NOTE  The directory will exist only if you have previously run the Workplace application on this 
JBoss application server.

Tomcat

a. On the Tomcat server, copy the /Workplace folder from: 

<AE_install_path>/FileNet/

to:

<Tomcat_HOME>/webapps/

b. (On a freshly installed Tomcat system only) On the Tomcat server, copy the tools.jar file from: 

<JDK_HOME>/lib

to:

<Tomcat_HOME>/common/lib/ 

3. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed AE, you 
must give the user read/write permissions on the following folders:

JBoss

– UNIX

<JBoss_HOME>/server/default/deploy/Workplace.war

<AE_install_path>/FileNet/

– Windows (only required for NTFS formatted partitions):

<JBoss_HOME>\server\default\deploy\Workplace.war
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<AE_install_path>\FileNet\

Tomcat

– UNIX:

<Tomcat_HOME>/webapps/Workplace

<AE_install_path>/FileNet/ 

– Windows (only required for NTFS formatted partitions):

<Tomcat_HOME>\webapps\Workplace

<AE_install_path>\FileNet\ 

4. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

The P8TASKMAN_HOME system environment variable should be set to:

 P8TASKMAN_HOME=<AE_install_path>/CommonFiles

5. Start the application server.

6. Logon to the application server console to confirm that the application server is running.

7. (Optional) Disable JBoss logging. 

In development mode, JBoss creates a large number of HTTP Access, “INFO”, “DEBUG” and 
“TRACE” log messages. This can cause unexpected behavior in the deployed IBM FileNet software. 
Using the following procedure, you can limit this type of excessive JBoss logging.

NOTE When logging is disabled, error messages will still be displayed in the JBoss console.

a. Edit the log4j.xml file (<JBOSS_HOME>/server/default/conf/log4j.xml).

i. Change all threshold values and priority values from "INFO", "DEBUG", or "TRACE" to 
"ERROR".

ii. Delete or comment out the "Preserve messages in a local file" to turn off the server log.

b. To turn off HTTP access logging, open jboss-service.xml with a text editor and delete or com-
ment out the "Access logger" section.

Location of jboss-service.xml:

• JBoss 3.x - <JBoss_Home>/server/default/deploy/jbossweb-tomcat41.sar/META-INF

• JBoss 4.1 - <JBoss_Home>/server/default/deploy/jbossweb-tomcat50.sar/META-INF

• JBoss 4.2 - <JBoss_Home>/server/default/deploy/jbossweb-tomcat55.sar/META-INF

c. (JBoss 3.x only) To turn off JCA debugging, open transaction-service.xml with a text editor and 
change the value of the "Debug" attribute from true to false.

Location of transaction-service.xml:

• JBoss 3.x - <JBoss_Home>/server/default/deploy

• JBoss 4.1 - File is not present in Jboss 4.1

• JBoss 4.2 - File is not present in Jboss 4.2

d. Open web.xml and change the logVerbosityLevel to "FATAL".
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Location of web.xml:

• JBoss 3.x - <JBoss_Home>/server/default/deploy/jbossweb-tomcat41.sar

• JBoss 4.1 - <JBoss_Home>/server/default/deploy/jbossweb-tomcat50.sar/conf

• JBoss 4.2 - <JBoss_Home>/server/default/deploy/jbossweb-tomcat55.sar/conf

e.  Restart the JBoss server.
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Task 15d: Configure and start Application Engine
(Oracle Application Server) 

This topic covers the configuration, deployment, and start of your Application Engine application 
(Workplace) on Oracle Application Server.

NOTE  The Application Engine uses cookie names for passing session information between the 
Application Engine and the client browser. This session information affects how the Application Engine 
interacts with several applets, such as Process Designer, Search Designer, and Process Simulator. To 
avoid forcing end users to log in individually to each applet, do not configure the application server to use 
application-unique cookie names for the deployed Application Engine. For best results, use JSESSIONID 
for the cookie name.

To configure and start Application Engine

1. Start the Oracle Application Server.

2. From the Oracle Admin Console, use an existing OC4J Instance or create and name a unique OC4J 
Instance to use with your Application Engine. 

3. Set JVM memory settings.

a. From the console, click the instance you created.

b. In the OC4J admin window that opens, click Administration.

c. Under Instance properties, click Server properties.

d. Under Command Line Options, edit the Java Options field.

Set your JVM memory settings by appending a minimum (-Xms<value>m) and maximum (-
Xmx<value>m) value to the entries in the field. 

CAUTION  By default the Oracle Xmx entry is set to 256 Mb. This is too small to successfully 
deploy the Workplace application. Oracle recommends setting the Xmx entry to 512 Mb. For more 
information, see the Oracle® Application Server Administrator’s Guide, chapter J.3.2.5 Problems 
Deploying Large OC4J Applications.

e. Click Apply to apply the settings. 

f. When prompted, click Yes to restart your OC4J server instance.

g. Click OK to close the confirmation window.

4. After the restart, from the console, verify that your HTTP server has been started. If not, start it. 

5. Deploy and configure the Workplace application.

a. In the console, select the OC4J Instance where you want to deploy the war file. 

b. Select the Applications tab.

c. Click Deploy War File. 

d. Browse to and select the Application Engine .war file:

 <AE_Install_path>/FileNet/Workplace/app_engine.war.

e. Provide an Application Name (eg. Workplace).

f. Provide a Map to URL value (eg. /Workplace). 



INSTALLATION AND UPGRADE GUIDE
Configure and start Application Engine (Oracle Application Server)

229
g. Click Deploy.

h. Once the application successfully deploys, click OK.

6. Set the workaroundOAS context-param to true.

After you deploy the Workplace application you must set the workaroundOAS context-param to true in 
the following file:

<Oracle_HOME>/j2ee/<OC4J_instance>/applications/<WebApp_name>/Workplace/WEB-
INF/web.xml

Where <WebApp_name> is the name of your web application (E.g. Workplace).

To set the workaroundOAS entry

a. Open the file web.xml for editing.

b. Find the workaroundOAS entry in the context-param section: 

    <context-param>
        <param-name>workaroundOAS</param-name>
        <param-value>true</param-value>

    </context-param> 

NOTE  If the workaroundOAS entry doesn’t exist, create it in the same section of the web.xml file 
as the other context-param elements.

c. Set the param-value entry to true.

d. Save the web.xml file.

7. Configure classloading settings.

After deployment, you must set the OC4J instance to allow for the loading of local classes first. 

a. In the console, click the OC4J instance you created in “From the Oracle Admin Console, use an 
existing OC4J Instance or create and name a unique OC4J Instance to use with your Application 
Engine.” on page 228.

b. Click Applications. 

c. Under Deployed Applications, click the Workplace application link (or the application name speci-
fied during deployment). 

d. Under Web Modules, click Workplace. 

e. Under Administration, click Advanced Properties. 

f. Use the Edit orion-web.xml field to enable class loading by un-commenting the following line:

<web-app-class-loader search-local-classes-first="true" include-war-manifest-class-
path="true" /> 

g. Click Apply to save the changes. 

h. When prompted, click Yes to restart your OC4J server instance.

i. Click OK to close the confirmation window.

8. From the admin console, verify that the Workplace application and the HTTP server have started. 

If they have not started, start them manually.
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9. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed AE, you 
must give the user read/write permissions on the following folders:

UNIX:

<AE_install_path>/FileNet/

Windows (only required for NTFS formatted partitions):

<AE_install_path>\FileNet\

10. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

The P8TASKMAN_HOME system environment variable should be set to:

 P8TASKMAN_HOME=<AE_install_path>/CommonFiles
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Task 15e: Configure and start Application Engine
(Sun Java Application Server)

This topic covers the configuration, deployment, and start of your Application Engine application 
(Workplace) on Sun Java Application Server.

NOTE  The Application Engine uses cookie names for passing session information between the 
Application Engine and the client browser. This session information affects how the Application Engine 
interacts with several applets, such as Process Designer, Search Designer, and Process Simulator. To 
avoid forcing end users to log in individually to each applet, do not configure the application server to use 
application-unique cookie names for the deployed Application Engine. For best results, use JSESSIONID 
for the cookie name.

To configure and start Application Engine

NOTE  The following procedure contain pathnames for both UNIX and Windows. If there is no difference in 
directory structure, a forward slash (/) will be used to separate the elements of a pathname for both UNIX 
and Windows.

1. Start the Sun Java Application Server. 

2. Set JVM memory settings.

a. From the admin console, in the left pane, click Application Server. 

b. Select the JVM Settings tab.

c. Click the JVM Options link.

d. Scroll to the bottom of the page and look for the following entry:

-Xmx512m 

NOTE  Please refer to your application server vendor's documentation for recommended values.

e. Click Save to save your settings.

3. Deploy and configure the Workplace application on your application server.

a. From the admin console, navigate to Application Server > Applications > Web Applications. 

b. In the right pane, click Deploy. 

c. Select the application to deploy by browsing to and selecting the Application Engine .war file: 

<AE_Install_path>/FileNet/Workplace/app_engine.war.

d. Click Next.

e. Change the Application Name and Context Root entries to Workplace. 

f. Click OK to deploy the application. 

4. Stop the Sun Java Application Server. 
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5. Copy the Workplace jars. 

Copy  the xercesImpl.jar, xml-apis.jar, and xalan.jar files from: 

<AE_Install_Path>/WEB-INF/lib

 to:

<Sun_Java_AS_home>/lib/endorsed

6. Edit processLauncher.xml and launcher.xml.

The files can be found in:

<Sun_Java_AS_home>/lib/

Comment out all references to the following properties:

• javax.xml.parsers.SAXParserFactory

• javax.xml.parsers.DocumentBuilderFactory

• javax.xml.transform.TransformerFactory"

• org.xml.sax.parser

• org.xml.sax.driver

7. Update your server.policy file.

Edit the server.policy file found in:

<Sun_Java_AS_home>/domains/<$your_domain>/config

The file must include the code highlighted bold in the example below.

Example: Basic set of required permissions granted to all remaining code

grant {
permission java.lang.RuntimePermission  "loadLibrary.*";
permission java.lang.RuntimePermission  "queuePrintJob";
permission java.net.SocketPermission    "*", "connect";
permission java.io.FilePermission       "<<ALL FILES>>", "read,write,delete";
// work-around for pointbase bug 4864405      
permission java.io.FilePermission "${com.sun.aas.instanceRoot}${/}lib${/}databases${/}-", 
"delete";
permission java.io.FilePermission "${java.io.tmpdir}${/}-", "delete";
permission java.util.PropertyPermission "*", "read";
permission java.lang.RuntimePermission      "modifyThreadGroup";

};
grant codeBase "file:${com.sun.aas.instanceRoot}/applications/j2ee-modules/Workplace/WEB-INF/-
" {
permission java.security.AllPermission;
};

8. Configure classloading settings.

Update the sun-web.xml file with the correct class-loader settings:

<class-loader delegate="false"/>

The sun-web.xml file is stored in the deployed Workplace directory:

<Sun_Java_AS_home>/domains/<$your_domain>/applications/j2ee-modules/Workplace/
WEB-INF/sun-web.xml
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Example sun-web.xml file:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE sun-web-app PUBLIC "-//Sun Microsystems, Inc.//DTD Application Server 8.1 Servlet 
2.4//EN" "<<<http://www.sun.com/software/appserver/dtds/sun-web-app_2_4-1.dtd>>>">
<sun-web-app>

<context-root>/Workplace</context-root>
<class-loader delegate="false"/>

</sun-web-app>

9. Remove .jar files.

Remove the ,jar files listed below from the following directory:

<Sun_Java_AS_home>/domains/<$your_domain>/applications/j2ee-modules/Workplace/
WEB-INF/lib/

Files to remove:

• xalan.jar 

• xercesImpl.jar

10. Start the Sun Java Application Server. 

11. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed AE, you 
must give the user read/write permissions on the following folders:

UNIX:

<AE_install_path>/FileNet/

Windows (only required for NTFS formatted partitions):

<AE_install_path>\FileNet\

12. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

The P8TASKMAN_HOME system environment variable should be set to:

 P8TASKMAN_HOME=<AE_install_path>/CommonFiles
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Task 15f: Configure and start Application Engine
(Generic application server)

This topic covers the configuration, deployment, and start of your Application Engine application 
(Workplace) on generic application servers.

NOTE  The Application Engine uses cookie names for passing session information between the 
Application Engine and the client browser. This session information affects how the Application Engine 
interacts with several applets, such as Process Designer, Search Designer, and Process Simulator. To 
avoid forcing end users to log in individually to each applet, do not configure the application server to use 
application-unique cookie names for the deployed Application Engine. For best results, use JSESSIONID 
for the cookie name.

To configure and start Application Engine:

1. (Application servers using JDK1.3 only) Modify the java.security file.

a. Use a text editor to open the java.security file used by the application server, and typically stored in 
the following location:

 <JDK_1.3_Home>/jre/lib/security 

b. Add the following line, specifying a preference order that does not conflict with an existing entry:

security.provider.n=com.sun.crypto.provider.SunJCE

where n is the preference order value. For example, in the example below, you can specify a 
preference order value of 3 or higher.

NOTE If you want to use a JCE provider other than SunJCE, make sure it is compatible with the 
JDK version in use and supports the Blowfish algorithm in ECM mode. Follow the JCE vendor’s 
instructions for installation.

The following is an example from the JDK 1.3 java.security file:

#
# List of providers and their preference orders (see above):
#
security.provider.1=sun.security.provider.Sun
security.provider.2=com.sun.rsajca.Provider 

c. Save and close the java.security file.

2. Start the application server.

3. Deploy and configure the Workplace application on your application server.

NOTES 

• If your application server requires a .war file to deploy the web application, this can be found at 
<AE_Install_path>/FileNet/Workplace/app_engine.war.

• The installer will create the Application Engine folder structure and files needed for the Application 
Engine application. Configure and deploy the Workplace application according to the instructions 
from your application server vendor.
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4. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed AE, you 
must give the user read/write permissions on the following folders:

UNIX:

<AE_install_path>/FileNet/

Windows (only required for NTFS formatted partitions):

<AE_install_path>\FileNet\

5. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set.

The P8TASKMAN_HOME system environment variable should be set to:

 P8TASKMAN_HOME=<AE_install_path>/CommonFiles
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Task 16: Install Service Packs and patches for core components

Install any Service Packs and patches containing new fixes and features for the IBM FileNet P8 Platform. 
See “Apply Service Packs and patches for core components” on page 334.
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Configuration/Startup Tasks

To configure the IBM FileNet P8 Platform components

1. Set bootstrap preferences. Do Task 17 on page 238.

2. Start Process routers. Do Task 18 on page 242.

3. Initialize the isolated region. Do Task 19 on page 244.

4. Configure symmetric encryption. Do Task 20 on page 245.

5. Set up Content Engine SSL security. Do Task 21a on page 249.

6. Set up Process Engine SSL security. Do Task 21b on page 251. 

7. Set up Application Engine SSL security. Do Task 21c on page 253.

8. Perform additional configuration tasks. Do Task 22 on page 256.

9. Familiarize yourself with IBM FileNet P8 system startup and shutdown procedures. Read the FileNet 
P8 Platform Shutdown and Startup help topic found at: FileNet P8 Administration > Enterprise-wide 
Administration > Shutdown and Startup. 
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Task 17: Set bootstrap preferences

Bootstrap preferences are a category of site preferences. The first time you log onto Application Engine 
after installation, the Bootstrap Preferences page displays. 

The following six bootstrap preference groups are available the first time you log in:

• Security Info (required for SSL only)

• User Token Settings

• Preference Settings (required)

• Banner Image

• Application Integration

• Administrator Access Role

For more information, go to the Documentation for IBM FileNet P8 Platform help and navigate to 
Workplace > Admin Tools > Site Preferences >  Bootstrap preferences.

NOTES 

• By successfully signing in to Workplace and saving the bootstrap preferences, you are verifying the 
Application Engine’s basic functionality such as user authentication as well as communication and 
storing of data on the Content Engine. 

• In addition to the preferences covered in this topic, more preferences can be set for the Workplace 
application using Workplace Site Preferences. For more information, go to the Documentation for IBM 
FileNet P8 Platform help and navigate to Workplace > Admin Tools > Site Preferences.

• After the initial bootstrap configuration, users with the Application Engine Administrators role can 
change any of these preferences by launching Workplace and navigating to Admin > Site 
Preferences > Bootstrap. 

• When you access the bootstrap preference page via the Site Preferences application, an additional 
preference, Guest info (to allow guest sign ins), is also available.

• In a web farm/clustered environment, all Application Engines share site preferences by using the same 
bootstrap.properties file. For more information, see the IBM FileNet P8 Platform High Availability 
Technical Notice.

• Bootstrap properties are stored in a separate file from other site preference. The default location for 
this file, bootstrap.properties, is:

– UNIX (WebSphere) - <WebSphere_home>/installed Apps/Workplace.ear/app_engine.war/
WEB-INF

– UNIX (all other application servers) - <AE_install_path>/FileNet/Workplace/WEB-INF

– Windows (WebSphere) - <WebSphere_home>\installed Apps\Work-
place.ear\app_engine.war\WEB-INF

– Windows (all other application servers) - <AE_install_path>\FileNet\Workplace\WEB-INF

• (New installations only) To allow users to create workflows subscriptions, you must configure the 
PWDesigner access role. For more information, see “(New installations only) To enable user access to 
the Workflow Subscription Wizard” on page 241.
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To set the bootstrap properties on first login

1. Log onto Application Engine: 

a. On any computer, open a browser and type:

http://<ApplicationEngineServerName>:<port#>/Workplace

b. Sign in. The Bootstrap Preferences page opens. 

NOTE It may take a few moments to complete the login on the first attempt.

NOTE The user who initially logs in and sets the bootstrap preferences is automatically added to 
the Application Engine Administrators role. For more information, go to the Documentation for IBM 
FileNet P8 Platform help and navigate to Workplace > Admin Tools > Site Preferences >  Access 
Roles preferences. 

2. Enter security info (required for SSL only)

a. Enter the SSL Host and port information for the SSL server.

b. Enter the Java Server HTTP port.

Use the Security info preference to redirect sign-ins through a Secure Socket Layer (SSL) server and 
to identify a remote Java server. This encrypts the user IDs and passwords when they travel over the 
network. See “Set up Application Engine SSL security” on page 253 for instructions on setting up SSL 
security for one or more Application Engines.

CAUTION  Once you’ve configured SSL, the Site Preferences application also runs under SSL to 
protect the guest account’s user ID and password. This means that when you run Site Preferences on 
an unsecured server that redirects sign-ins to an SSL server, you will be editing the Bootstrap 
preferences of the SSL server (stored in the bootstrap.properties file). This does not affect the 
General, Object Store, and Shortcut preferences; those preferences are retrieved from the preferences 
file saved in the object store. 

3. Configure user token settings.

User Tokens are used by IBM FileNet P8 applications to launch into each other without the need for 
additional login. 

a. Select whether or not to create user tokens for your Application Engine (Default: Yes).

b. Select whether or not the application will pick up generated tokens from other applications 
(Default: Yes).

c. Specify a Token timeout interval (1 - 15 minutes).

4. Specify preference settings (required).

Preference settings specify the name of the site preference file, its storage location (object store), and 
the documentation server URL (if installed). The site preferences file is checked into the object store 
the first time you log on to Workplace. The site preferences are stored as XML data in this file, <Site 
Preferences for Preferences name>.xml. Use Enterprise Manager to access this file, and navigate 
to Object Stores > Object Store location > Root Folder > Preferences.   

NOTE The bootstrap preferences are saved in the bootstrap.properties file, and not in the site 
preferences file.

a. Select an object store from the Object store location choice list. The preferences file will be 
saved in this object store. Workplace users must have access to this object store.
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b. Enter a preference file name in the Preferences name field.  

c. Enter the documentation server URL in the Documentation server filed. 

The format of the URL is:

http://<DocServerName>:<port#>/ecm_help/

where “DocServerName” is the name of your Java web server, “port#” is the port number, and 
“ecm_help” is the root directory of the documentation website.

NOTE If no documentation URL is specified, the Workplace Help link will default to http://
localhost. 

d. Enter the ISRA Interface Servlet URL.

For more information, see “Enable Application Engine to use ISRA” on page 287. 

5. Set Banner Image.

The banner image is the graphic that appears at the upper left -hand side of the Workplace application 
pages. If you have a banner image that you would like to use, follow this procedure.

a. Copy the new graphic file to the location of your choice on Application Engine in the /FileNet/
Workplace folder.

b. In the Path box, type the path (relative to the Workplace folder) to the new banner graphic file.

c. In the Image Width box, type the width of the image (in pixels). 

d. In the Image Height box, type the height of the image (in pixels).

6. Configure Application Integration.

Select No (default), if you do not want users to be prompted to add an email to an object store each 
time the email is sent.

Select Yes, if you want users prompted to add an email to an object store when the email is sent.

This preference setting only affects Outlook integration.

7. Add Application Engine Administrators.

Add the users and groups that will perform Application Engine administration tasks to the Application 
Engine Administrators role. 

NOTES 

• The user who initially logs in and sets the bootstrap preferences is automatically added to the 
Application Engine Administrators role. For more information, go to the Documentation for IBM 
FileNet P8 Platform help and navigate to Workplace > Admin Tools > Site Preferences >  Access 
Roles preferences.

• To modify the Access Roles after the initial bootstrap configuration, users with the Application 
Engine Administrators role can use the Access Roles section of the Workplace Site Preferences. 
Launch Workplace and navigate to Admin > Site Preferences > Access Roles. 

8. Click Apply (bottom, right-hand side of the page) to save your bootstrap settings.
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To add a single index for Application Name on the site preferences object store

To properly index access roles and improve login performance on Application Engine you must create an 
index for Application Name on the object store that contains the Workplace site preferences. Do this after 
you have successfully configured the bootstrap preferences.

1. On the Content Engine launch the IBM FileNet Enterprise Manager.

2. In the left pane, expand the Object Stores folder.

3. Expand the object store node where your preferences are stored. See “Specify preference settings 
(required).” on page 239 above.

4. Expand Other Classes and then Custom Object.

5. Right click Access Role and select Properties.

6. Select the Property Definitions tab.

7. Select Application Name and click Edit.

8. On the General tab of the Application Name Properties, if the Indexed field shows 'not indexed', click 
Set/Remove.

9. Select Set and then Single Indexed.

10. Click OK to set the index.  

11. Click OK to apply the change and close the Application Name Properties window.  

12. Click OK to close the Access Role Class Properties window.

(New installations only) To enable user access to the Workflow Subscription Wizard

To allow users to create workflows subscriptions, you must configure the PWDesigner access role using 
the Workplace Site Preferences, and give the users appropriate access rights to the workflow 
subscriptions classes. You can perform these steps in any order, and you must perform both steps any 
time you need to add or remove users.

1. Assign users as members of the PWDesigner access role. See Workplace > Admin Tools > Site Pref-
erences >  Access Roles preferences.

2. Run the security script wizard, load the workplacescript.xml file to add accounts to the Workflow 
Designer role. 

a. In IBM FileNet Enterprise Manager, select Root Domain > All Tasks > Run Security Script Wizard.

b. Load the <install_path>/ContentEngine/workplacescript.xml file.

For more information about how to use the Security Script wizard to assign the Workflow Designer role 
to user or group accounts, go to the Documentation for IBM FileNet  P8 Platform help and see FileNet 
P8 Administration > Content Engine Administration > Content Engine Wizard Help > Security Script.

For more information about the workplacescript.xml file and how roles are defined in the Enterprise 
Manager, see FileNet P8 Administration > Content Engine Administration > Managing Security > 
Security Script Wizard.
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Task 18: Start Process Routers

To enable workflow activity, at least one Process Router must be running on each Application Engine. In 
addition, a Process Router must be running on the Content Engine in a system where workflow 
subscriptions are used to automatically launch workflows. No matter where it is running, a Process Router 
corresponds to a single isolated region.

By default, a router is named vwrouter, running on the Application Engine and using as a default RMI PPM 
port number 32771.  If the host system, port number, or router name need to be changed, corresponding 
changes must be made on the Process Engine and on the Application Engine.  See  FileNet P8 
Administration > Enterprise-wide Administration > Process Task Manager > Application Engine > Process 
Routers and  FileNet P8 Administration > Workplace >Admin Tools > Site Preferences > General 
Preferences > General Settings - Tasks > Process Router.

To start a Process Router on an Application Engine

To start the router, you must have read/write/execute permissions for the /Router subdirectory (UNIX) or 
\Router subfolder (Windows) where the router is installed.

Note the following additional requirements for systems that include a remote HTTP server:

• If users need to access the Process Configuration Console via a remote HTTP server, you must start 
one Process Router on the HTTP server for each Process Router running on Application Engine. The 
Process Router on the HTTP server must use the same Process Router name and port number as the 
corresponding Application Engine Process Router. See “To start a Process Router on a remote HTTP 
server” on page 243 for details.

• If Process Engine and an Application Engine or a remote HTTP server are located on opposite sides of 
a firewall, you must add an entry to the hosts file on Process Engine, mapping the Application Engine’s 
or remote HTTP server’s IP address to its fully qualified name. 

1. Set the DISPLAY variable.

2. Start Process Task Manager on Application Engine.

a. Windows: Run the routercmd.bat command file, found in the \Router subfolder where you 
installed the Application Engine software.

b. UNIX: Run the routercmd.sh command file, found in the \Router subfolder where you installed the 
Application Engine software.

3. Select Process Routers in the left pane (also referred to as the feature pane).

4. If necessary, add a new Process Router.

a. Select New from the Action menu.

b. Enter the appropriate parameter values. For details, see FileNet P8 Administration > Enterprise-
wide Administration > Process Task Manager > Application Engine > Process Routers.

c. Click OK.

5. In the feature pane, select the Process Router you want to start and click Start on the toolbar.
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To start a Process Router on a remote HTTP server

The same version of the JVM installed on Application Engine must also be installed on the HTTP server.

1. Copy pe.jar from Application Engine to the HTTP server. On Application Engine, 
pe.jar is located at:

<directory where Application Engine is installed>:\FileNet\Workplace\WEB-INF\lib

2. Start a Process Router from the command line on the HTTP server, using the same Process Router 
name and port number you used for the corresponding Process Router on Application Engine. For 
details, see FileNet P8 Administration > Enterprise-wide Administration > Process Task Manager > 
Application Engine > Process Routers > Configure Process Router defaults.

3. If Application Engine and the HTTP server are separated by a firewall, add an entry to the hosts file on 
Process Engine, mapping the Application Engine’s or remote HTTP server’s IP address to its fully 
qualified name.

To add and start a Process Router on the Content Engine

1. From the Start menu, select Programs > FileNet P8 Platform > Process Service Administrator.

2. Expand the Process Service Administrator node.

3. Right-click Process Engine Routers and select New/New Router from the context menu.

4. As appropriate, add, edit, or retain the information displayed in the New Router window. For details, 
point a browser to the IBM FileNet P8 documentation server and navigate to: FileNet P8 Administration 
> Content Engine Administration > Events and subscriptions > How to... > Implement workflow 
subscriptions > Manage the Process Router. 

5. Select the router in the folder, and click the start icon on the toolbar.
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Task 19: Initialize the isolated region

Initialize an isolated region to create the default data structures (queues, workflow roster, and event log) 
necessary to process workflows in that region. 

To initialize the isolated region:

1. On a client computer (not Application Engine), start a supported browser.

2. Log on to Workplace. 

If you defined the Process Engine Configuration Group on the LDAP tab of Process Task Manager 
(when completing “Configure the Process Engine LDAP Connection” on page 204), you must log on as 
a member of either that group or the Process Engine Administrators Group, which was also defined on 
the LDAP tab, in order to initialize the isolated region.

3. In Workplace, click Admin and then click Process Configuration Console.

NOTE If your computer does not have the appropriate JavaTM Runtime Environment (JRE) installed, 
you will be prompted to download the JRE at this point; follow the prompts to complete the download. 
During the installation process, click the Browser tab and enter the following settings: 

– De-select (clear) the Internet Explorer option.

– If you will be using Netscape 6.0, select the Netscape option. 

For further information about the JRE download, click Help in Process Configuration Console, click 
Process Reference on the help page toolbar, and navigate to Concepts > Java Runtime Environment 
(JRE). 

4. Right-click the icon of the isolated region you want to initialize.

5. Select Connect from the displayed menu. 

6. Select Initialize Isolated Region from the Action menu. 

7. Click Yes at the prompt if you want to continue, or No to cancel the action. 

For further details about initializing an isolated region, in Process Configuration Console click the Help 
button and navigate to Isolated regions > Initialize an isolated region. 
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Task 20: Configure symmetric encryption

Encryption protects user credentials passed between Application Engine and Content Engine. Symmetric 
encryption uses a single crypto key to encrypt the credentials at one end of the process and to decrypt the 
credentials at the other end of the process. 

If you selected symmetric encryption during setup, the setup program generated an encryption key file 
called CryptoKeyFile.properties in the following default location:

• Windows/WebLogic, WebSphere, and Tomcat - <AE_install_path>\FileNet\Authentication

• Windows/Generic - <AppServer_home>\FileNet\Authentication

• UNIX - <AE_install_path>/FileNet/Authentication

To configure symmetric encryption

1. Copy the CryptoKeyFile.properties file from Application Engine to the following folder on the Content 
Engine(s):

C:\Program Files\FileNet\Content Engine\JavaAPIListener\Authentication

NOTES 

• If the Authentication folder doesn’t exist on the Content Engine server, create it.

• We recommend copying the folder over a secure link.

• If you copy the file to a location on the Content Engine other than the one listed above, you will 
also need to modify the Content Engine's registry to match the new name or path; the Content 
Engine installation adds the registry key CryptoKeyFile, with a value that defines the name of the 
file and the default path. 

CAUTION Back up your registry before making any changes.

To change the value, open the registry and navigate to:

HKEY_LOCAL_MACHINE\SOFTWARE\FileNet\ECM\Content 
Engine\JavaAPIListener\Authentication

Change the data value of CryptoKeyFile to the new path and filename.

2. Install unlimited strength .jar files.

NOTE Perform this step only if you are using JDK 1.4 or higher and have selected the Create 
unlimited strength keys option in the Application Engine User Security and/or User Token Security 
steps of the Application Engine installer. Failure to perform the step will cause EncryptionException 
messages or other errors indicating that a Java Security API provider for Blowfish is not available. The 
EncryptionException is caused by the wrong versions of (or absence of) required .jar files that provide 
unlimited strength security policy files in a Sun JDK 1.4 or higher environment. 

For more information, go to the Documentation for IBM FileNet P8 Platform website and navigate to 
Developer Help > Content Java API > Security > Working with Security > Creating Cryptographic Keys 
for Symmetric Encryption > Configuring a Security Provider for a J2EE Application Server 
Environment.
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To install unlimited strength .jar files:

a. Obtain the JDK version specific unlimited strength .jar files. 

• Sun JDK - Obtain the Sun unlimited strength policy files from the Sun product web site (http://
java.sun.com/j2se/). 

• IBM JDK - Obtain the IBM unlimited jurisdiction policy files from the IBM web site (http://
www.ibm.com/developerworks/java/jdk/security).

CAUTION  Make sure you install .jar files specific to the JDK version you are using.

b. Install the files into the JRE's /jre/lib/security folder by replacing files with the same names. 

c. Restart the application server.

3. (Do this step if you are experiencing problems with IBMJCE when using IBM JDKs, and if you have 
available another JCE provider.) 

Configure WebSphere to use this vendor's security provider. For more information, see the JCE 
provider's documentation. 

Example: If you are using SunJCE, do the following: 

a. Use a text editor to open the java.security file stored in the following location: <WAS_Home>/java/
jre/lib/security.

b. Add the line “security.provider.1=com.sun.crypto.provider.SunJCE” (shown in bold below) 
as the first line in the list of providers, and adjust the existing provider numbers accordingly: 

# 
# List of providers and their preference orders: 
# 
security.provider.1=com.sun.crypto.provider.SunJCE 
security.provider.2=sun.security.provider.Sun 
security.provider.3=com.ibm.crypto.provider.IBMJCE 
security.provider.4=com.ibm.jsse.IBMJSSEProvider 
security.provider.5=com.ibm.security.cert.IBMCertPath 
security.provider.6=com.ibm.crypto.pkcs11.provider.IBMPKCS11 

c. Save and close the java.security file. 

4. Verify symmetric encryption by logging into Application Engine: 

a. On any computer, open a browser and type:

http://<ApplicationEngineServerName>:<port#>/Workplace

b. Sign in. 

Web Farms/Cluster/SSL Environments

In an environment with multiple Application Engines, each Application Engine must share the 
WcmApiConfig.properties file and the CryptokeyFile.properties data with the Content Engine to 
identify the encryption method. 

NOTE You have the option of having each Application Engine use its own unique key, or have all share 
encryption keys, or all use a common encryption key.

http://java.sun.com/j2se/
http://java.sun.com/j2se/
http://www.ibm.com/developerworks/java/jdk/security
http://www.ibm.com/developerworks/java/jdk/security
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To set up symmetric encryption on multiple applications

1. Copy the WcmApiConfig.properties file to all Application Engines.

The WcmApiConfig.properties file identifies symmetric encryption as the credentials protection 
method, and the path to the CryptoKeyFile.properties file. Each Application Engine in the 
environment must have an identical WcmApiConfig.properties file.

The default location for the WcmApiConfig.properties file is:

<AE_install_path>\FileNet\Workplace\WEB-INF\

2. Copy the CryptokeyFile.properties file.

For encryption to work, the Content Engine and each Application Engine must share the same crypto 
key. 

To use the same crypto key for all Application Engines

Each AE may have its own unique CryptoKeyFile and the contents of each file can be copied into the 
CryptoKeyFile on the CE. 

a. Copy the CryptoKeyFile.properties file from one Application Engine to:

C:\Program Files\FileNet\Content Engine\JavaAPIListener\Authentication\

on the Content Engine server.

NOTES 

• We recommend copying the file over a secure link.

• If the Authentication folder doesn’t exist on the Content Engine server, create it.

b. Copy the CryptoKeyFile.properties file you copied to the Content Engine to the Authentication 
folder on all Application Engines in the environment, overwriting the existing CryptoKeyFile.prop-
erties file.

To use unique crypto keys for each Application Engine

Each Application Engine may have its own unique CryptoKeyFile.properties file as long as there is a 
copy of each Application Engine’s crypto key in the CryptoKeyFile.properties file stored on the 
Content Engine. 

NOTE This is useful especially if users want to have one Application Engine with limited strength jars 
and one with unlimited strength jars.

a. Copy the CryptoKeyFile.properties file from Application Engine to:

C:\Program Files\FileNet\Content Engine\JavaAPIListener\Authentication\

on the Content Engine server.

NOTES 

• We recommend copying the file over a secure link.

• If the Authentication folder doesn’t exist on the Content Engine server, create it.

b. Edit the CryptoKeyFile.properties file on the Content Engine server.

c. Add the contents of each unique CryptoKeyFile.properties file to the content of the Content 
Engine file.
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Change the encryption method

To change the encryption method, edit the CredentialsProtection entry in the 
WcmApiConfig.properties file. 

For information, go to the Documentation for IBM FileNet P8 Platform help and navigate to FileNet P8 
Administration > Application Engine Administration > Application Engine Security > 
WcmApiConfig.properties file.

NOTE If you installed Application Engine with Clear encryption and subsequently change the encryption 
method to Symmetric, you will have to manually create the CryptoKeyFile.properties file before you 
change encryption method. After creating the file you need to distribute it among your servers, see Step 2 
on page 247. 

For more information, go to the Documentation for IBM FileNet P8 Platform help and navigate to Developer 
Help > Content Java API > Security > Working with Security > Creating Cryptographic Keys for Symmetric 
Encryption.

Generate additional crypto keys

By default, the Application Engine setup program generates three crypto keys. To create additional keys, 
use the Content Java API class, MakeCryptoKeys. 

For information, go to the Documentation for IBM FileNet P8 Platform help and navigate to Developer Help 
> Content Java API > Security > Working with Security > Creating Cryptographic Keys for Symmetric 
Encryption.
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Task 21a: Set up Content Engine SSL security

By default, Content Engine is configured to support secure communications with Microsoft Active 
Directory. However, if your IBM FileNet P8 system uses Sun or Novell as the directory service provider, you 
must enable SSL on the Content Engine in order to use secure communications with the Sun or Novell 
directory service. 

CAUTION IBM strongly recommends enabling SSL. The option not to use SSL is provided primarily for 
development systems or other non-production systems where the security provided by SSL may not be 
required.

To enable SSL for Content Engine

1. Obtain and install a server certificate and a CA certificate on the Sun or Novell directory service. These 
certificates are available from third-party certificate authorities, such as VeriSign, or you can generate 
your own certificates if you have the necessary certificate management software installed. 

2. Enable SSL on the Sun or Novell directory service and set the SSL port number. The default SSL port 
number is 636; however, if you have more than one directory service that is using SSL on the server, 
you may need to use a non-default port number. See your Sun or Novell documentation for 
instructions.

3. Obtain a certificate authority (CA) certificate for the Content Engine. To obtain a CA certificate, do one 
of the following. The actual procedures will vary depending on the CA provider you select.

• Download the certificate from the CA provider and save it as a file on the Content Engine.

• Copy the CA certificate file from the Sun or Novell directory service computer to the Content 
Engine. Use this method if you saved the CA certificate as a file when enabling SSL on the direc-
tory service.

4. Import the CA certificate to the Content Engine, as described below.

5. If your authentication support is provided by Sun Java Directory Server or Novell eDirectory, add an 
entry for the authentication server in the hosts file on each machine where an Object Store Service or 
IBM FileNet Enterprise Manager client is installed:

<IP address> <hostname> <hostname - FQDN>

where:

<IP address> is the IP address of the authentication server
<hostname> is the name of the authentication server
<hostname - FQDN> is the fully qualified domain name of the authentication server

For example:

10.15.15.99    myHost    myHost.xyz.com

To import the CA certificate to Content Engine

1. Log on as the local administrator to the server where you plan to install Content Engine or IBM FileNet 
Enterprise Manager.

2. From the Microsoft Management Console (MMC), open the Certificates Snap-in. If the Certificates 
Snap-in is not already part of your MMC, add the snap-in by completing the following steps.

a. Open the MMC by selecting Start > Run from the Windows Task bar and typing mmc in the Run 
dialog.
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b. From the Console menu select Add\Remove Snap-in.

c. On Add/Remove Snap-in dialog click the Add button.

d. On the Add Standalone Snap-ins dialog, select Certificates from the list box and click the Add 
button.

e. On the Certificates snap-in dialog select the Computer Account radio button and click Next.

f. On the Select Computer dialog select the Local Computer radio button and click Finish.

g. Click Close on the Add Standalone Snap-ins dialog.

h. Click OK on Add/Remove Snap-in dialog.

3. On the MMC dialog, expand the Certificates node and then expand the Trusted Root Certification 
Authorities node.

4. Right-click on the Certificates folder and select All Tasks / Import. The Certificate Import Wizard 
appears.

5. Click Next.

6. On the File to Import dialog, click Browse and locate the CA certificate you copied to the Content 
Engine server. 

7. Click Next.

8. On the Certificate Store dialog, select Place all certificates in the following store and click Browse. 

9. Select the Show physical stores checkbox.

10. Expand the Trusted Root Certification Authorities node and select Local Computer.

11. Click OK.

12. Review the Certificate store field and ensure that Trusted Root Certification Authorities\Local 
Computer appears in this field. 

13. Click Next and then click Finish. The wizard displays a message informing you that the import was 
successful.

14. Click OK. 

15. In the right pane, verify that the certificate imported successfully into the Trusted Root Certification 
Authorities\ Certificates folder.
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Task 21b: Set up Process Engine SSL security

Process Engine supports both secure and clear text communications with the IBM FileNet P8 directory 
service. By default, Process Engine is configured to support clear text communications; user names and 
passwords are sent between Process Engine and the directory service unencrypted. To enable secure 
communications, you must enable SSL support on your directory service and on Process Engine. 

CAUTION IBM strongly recommends enabling SSL. The option not to use SSL is provided primarily for 
development systems or other non-production systems where the security provided by SSL may not be 
required.

To enable SSL for Process Engine:

1. Obtain and install a server certificate and a CA certificate on the directory service. These certificates 
are available from third-party certificate authorities, such as VeriSign, or you can generate your own 
certificates if you have the necessary certificate management software installed. 

2. Enable SSL on the directory service and set the SSL port number. See your directory service 
documentation for instructions.

3. Obtain a certificate authority (CA) certificate for Process Engine. To obtain a CA certificate, do one of 
the following. The actual procedures will vary depending on the CA provider you select.

• Download the certificate from the CA provider and save it as a file on Process Engine.

• Copy the certificate to your clipboard directly from the CA provider.

• Copy the CA certificate file from the directory service computer to Process Engine. Use this 
method if you saved the CA certificate as a file when enabling SSL on the directory service.

4. Create a certificate database for Process Engine, as described below.

5. Enable SSL support on Process Engine, via Process Task Manager. See “To enable SSL Security in 
Process Task Manager” on page 252 for further information.

To create a certificate database for Process Engine

NOTES

• Perform steps 1 – 5 of this procedure on a Windows 2000 or Windows XP client.

• This procedure uses the Mozilla certutil utility to generate the certificate database; documentation for 
this utility is available at:

http://www.mozilla.org/projects/security/pki/nss/tools/certutil.html 

1. Download and unzip Netscape Security Services (NSS) version 3.6.1 and Netscape Portable Runtime 
(NSPR) version 4.3 to a temporary location on a Windows 2000 or Windows XP client. NSS and NSPR 
are available for download from the Mozilla web site at:

NSS:

FTP: ftp://ftp.mozilla.org/pub/mozilla.org/security/nss/releases 
HTTP: http://ftp.mozilla.org/pub/mozilla.org/security/nss/releases 

NSPR:

FTP:  ftp://ftp.mozilla.org/pub/mozilla.org/nspr/releases 
HTTP:  http://ftp.mozilla.org/pub/mozilla.org/nspr/releases 

http://www.mozilla.org/projects/security/pki/nss/tools/certutil.html
ftp://ftp.mozilla.org/pub/mozilla.org/security/nss/releases/
ftp://ftp.mozilla.org/pub/mozilla.org/nspr/releases/v4.3/
http://ftp.mozilla.org/pub/mozilla.org/nspr/releases
http://ftp.mozilla.org/pub/mozilla.org/security/nss/releases
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2. Modify the environment variables by adding the bin and lib directories for NSS and the lib directory for 
NSPR to the beginning of the PATH environment variable.

3. At the command prompt, create the certificate databases as follows:

certutil -N -d <certificate_db_directory>

where <certificate_db_directory> is the certificate database directory. Note that this directory must 
exist before you run the certutil command. 

Certutil will prompt you to enter a password for the certificate databases and will then create three 
databases (cert7.db, secmod.db, and key3.db) in the location you specify.

4. Import the CA certificate into the certificate database as follows: 

certutil -A -n <certificate_name> -t C,C,C -d <certificate_db_directory> -i <certificate_file>

where:

<certificate_name> is the name you want to assign to the certificate. The certificate will appear in the 
cert7.db database under this name. 

<certificate_file> is the name and location of the certificate you copied to Process Engine, for example, 
c:\temp\root_CA.cer. 

5. Verify that the certificate was imported correctly as follows:

certutil -L -d <certificate_db_directory>

The system displays a list of certificates in the database.

6. Copy the <certificate_db_directory> you specified in Step 3 to the appropriate location on your 
Process Engine, depending on the Process Engine’s operating system:

UNIX: /fnsw/local/sd

Windows: \fnsw_loc\sd

7. (UNIX only) Assign read permission for all users on the cert7.db, secmod.db, and key3.db files by 
completing the following steps.

a. Change directories to the <certificate_db_directory>.

b. Execute the following statement.

chmod 644 cert7.db secmod.db key3.db

To enable SSL Security in Process Task Manager

After completing the procedures described in Step 1 through Step 4 on page 251, use Process Task 
Manager to set the Communication Mode and Certificate Directory properties on Process Engine 
accordingly:

Communication Mode: Choose Secure (one-way SSL) 

Certificate Directory: Enter the <certificate_db_directory>

In Process Task Manager, both properties are located on the LDAP/General properties tab, see “Configure 
the Process Engine LDAP Connection” on page 204 for instructions on accessing this tab.
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Task 21c: Set up Application Engine SSL security

This topic describes how to configure an Application Engine to direct sign-ins through an SSL (https) 
connection. It assumes that Application Engine(s) have already been installed.

IBM FileNet Application Engine supports the following methods of configuring an SSL environment:

• Full SSL support - A single AE server, where all of the software is running under SSL.

• One server SSL redirect - One AE server set up to redirect logon attempts on the non-SSL port to 
the SSL port.

• Two server SSL redirect - Two AE servers, where one is SSL-enabled, and the other redirects 
users to the SSL-enabled Application Engine server to log on.

To set up full SSL support on a single Application Server

1. Enable SSL on the application server that runs Application Engine (see your SSL documentation).

2. Test the SSL connection by signing into Application Engine using one of the following URLs:

https://<Application_Engine_server_name>:<SSL port>/Workplace

The entire sign-in process will be handled by the SSL-enabled host.

For more information about SSL port numbers, see “IBM FileNet P8 Port Numbers” on page 364.

To set up SSL redirect on a single Application Engine server

1. Enable SSL on the application server that runs Application Engine (see your SSL documentation).

2. Log onto Application Engine: 

a. On any computer, open a browser and type:

http://<Application_Engine_server_name>:<port#>/Workplace

b. Sign in as a user with Application Engine Administrator access role privileges. For more informa-
tion, go to the Documentation for IBM FileNet P8 Platform help and navigate to Workplace > 
Admin Tools > Site Preferences >  Access Roles preferences.

3. Set bootstrap preferences:

a. Navigate to Admin > Site Preferences > Bootstrap.

b. Set the Security info Site Preference, SSL Host:Port, to identify the alias host name and port 
number.

Use the IP address of the Application Engine server for the SSL Host entry.

For more information, see “Enter security info (required for SSL only)” on page 239.

c. Click Apply (bottom, right-hand side of the page) to save your bootstrap settings.

4. Update the base URL:

a. Navigate to Admin > Site Preferences > Refresh.

b. Enter the Workplace Base URL value in the provided field. The URL must contain a valid host 
name, and not contain “localhost" or an IP number. For example, http://myserver:7001/Workplace.

For more information, go to the Documentation for IBM FileNet P8 Platform help and navigate to 
Workplace > Admin Tools > Site Preferences > Refresh preferences.
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c. Click Refresh to update the base URL.

d. Click Exit to close Site Preferences.

5. Sign out of Workplace, and close your browser.

6. Test the SSL connection by signing into Application Engine using the following URL:

http://<Application_Engine_server_name>:<non-SSL port>/Workplace

NOTE  You will be redirected to the SSL-enabled port for sign in, then back to the non-SSL enabled 
port after sign-in is complete. Before sign-in, you should receive a warning that you are accessing 
pages over a secure connection (unless you turned this dialog off), and then Workplace will display.

To set up SSL redirect on two Application Engine servers

1. Install Application Engine on both computers so that both Application Engines use the same boot-
strap.properties file and site preferences file (the setup program will prompt you for a shared location).

During setup of the first Application Engine, create a share on the folder where the 
bootstrap.properties file is installed (the WEB-INF folder). Then during setup of the second Application 
Engine, specify the shared location from the first installation. The bootstrap.properties file must already 
exist when specifying a shared location. See “Setup WebLogic clusters” or “Setup WebSphere clones” 
in the IBM FileNet P8 Platform High Availability Technical Notice for specific instructions. 

CAUTION  The system clocks on the two Application Engine servers must be synchronized to within 
the Token time-out interval. For more information, go to the Documentation for IBM FileNet P8 Platform 
help and navigate to Workplace > Admin Tools > Site Preferences > Bootstrap Preferences > User 
token settings. 

2. Copy the UTCryptokeyFile.properties file.

For SSL redirect to work, each Application Engine must use the same User Token cryptographic key 
file. 

After installing the second Application Engine, copy the UTCryptoKeyFile.properties file from the first 
Application Engine server to the same location on the second Application Engine server. See “Make a 
note of the user token crypto key path.” on page 210 for information on the default location for the 
UTCryptoKeyFile.properties file.

NOTE  We recommend copying the file over a secure link.

3. Enable SSL on the application server that you are using for the SSL-enabled Application Engine (see 
your SSL documentation).

4. Log on to the non-SSL enabled Application Engine.

a. On any computer, open a browser and type:

http://<ApplicationEngineServerName>:<port#>/Workplace

b. Sign in as a user with Application Engine Administrator access role privileges. For more informa-
tion, go to the Documentation for IBM FileNet P8 Platform help and navigate to Workplace > 
Admin Tools > Site Preferences >  Access Roles preferences.

5. Set bootstrap preferences:

a. Navigate to Admin > Site Preferences > Bootstrap.

b. Set the Security info Site Preference, SSL Host:Port, to identify the alias host name and port 
number.
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For more information, see “Enter security info (required for SSL only)” on page 239.

c. Click Apply (bottom, right-hand side of the page) to save your bootstrap settings.

6. Update the base URL:

a. Navigate to Admin > Site Preferences > Refresh.

b. Enter the Workplace Base URL value in the provided field. The URL must contain a valid host 
name, and not contain “localhost" or an IP number. For example, http://myserver:7001/Workplace.

For more information, go to the Documentation for IBM FileNet P8 Platform help and navigate to 
Workplace > Admin Tools > Site Preferences > Refresh preferences.

c. Click Refresh to update the base URL.

d. Click Exit to close Site Preferences.

7. Sign out of Workplace, and close your browser.

8. Test the SSL connection by signing into Application Engine using the following URL:

http://<Application_Engine_server_name>:<non-SSL port#>/Workplace

NOTE  You will be redirected to the SSL-enabled server for sign in, then back to the non-SSL enabled 
server after sign-in is complete. Before sign-in, you should receive a warning that you are accessing 
pages over a secure connection (unless you turned this dialog off), and then Workplace will display.

Additional procedure for WebSphere 5.1

If you are using Workplace Application Integration to connect to port 80 on WebSphere, you need to 
enable URL rewriting for SSL sign-in to work properly.

To enable URL rewriting

1. Open the WebSphere Administrative Console and select Applications > Enterprise Applications 
from the left pane. Then select the Application Engine application (the default is app_engine.war).

2. From Additional Properties, select Web Container.

3. Click Session Management and click Edit Properties.

4. Select Overwrite for Overwrite Session Management.

5. Select Enable URL rewriting for Session tracking mechanism.

6. Click OK, then Save, and Save again to save changes to the Master configuration

7. Stop and restart the Application Server.

Using Java Applets in an SSL Environment

If you are using a Java applet in an SSL environment, you may experience an SSLHandshakeException 
because the appropriate certificate does not exist on your computer. Follow the instructions in the online 
help topic Workplace > Basics > Use Java Applets to resolve this issue.



INSTALLATION AND UPGRADE GUIDE
Perform additional configuration tasks

256
Task 22: Perform additional configuration tasks

Once you have completed the Installation Tasks, your core IBM FileNet P8 system will be up and running. 
Below is a list of additional configuration tasks you should complete (or at least review) to prepare the 
system for general use. Except where noted, the links go to the IBM FileNet P8 online documentation and 
start from the Contents panel in:

<Documentation URL, in the form http://webserver:port#/ecm_help>/_start_here.htm 

• Create additional users and groups using the Windows Active Directory Users and Computers snap-in. 
Refer to FileNet P8 Administration > Enterprise-wide Administration > Security > User and groups. 

• Configure Content Federation Services for Image Services Guidelines. Refer to the IBM FileNet P8 
Content Federation Services for Image Services Guidelines.

• Configure Application Engine to set the file types you want to open in a browser window rather than 
using the Image Viewer. Refer to FileNet P8 Administration > Application Engine Administration > Key 
configuration files and logs > content_redir.properties file.

• Set site preferences for the Workplace application. Refer to Workplace > Admin Tools > Site 
Preferences > About Site Preferences.

• Design searches and/or search templates for Workplace users. Refer to Workplace > Advanced Author 
Tools > Search Designer > About Search Designer.

• Design publishing templates for Workplace users. Refer to Workplace > Advanced Author Tools > 
Publishing Designer > About Publishing Designer.

• Configure security for publishing. Refer to Workplace > Advanced Author Tools > Publishing Designer 
> Security > Specify publication document security.

• Configure automatic workflow launch. Refer to FileNet P8 Administration > Content Engine 
Administration > Events and subscriptions > Concepts: workflow subscriptions.

• Create and configure the object stores that will contain business objects, folders, documents, workflow 
definitions, searches, and other objects. Refer to FileNet P8 Administration > Content Engine 
Administration > Object stores > How to... > Create object store.

• Define document classes and folders and set security for each class. Refer to FileNet P8 
Administration > Content Engine Administration > Classes.

• Review and, if necessary, edit the security of the network shared folders containing any file stores 
created for the object store. Refer to FileNet P8 Administration > Content Engine Administration > 
Content stores > File stores.

• Configure Process Engine for automatic startup. Refer to FileNet P8 Administration > Enterprise-wide 
Administration > Process Task Manager > Process Engine > Process Service > Start and stop 
Process Service > Configure the Process Service for automatic startup (Windows).

• Configure email notification. Refer to FileNet P8 Administration > Process Engine Administration > 
Workflow administration tasks > Coordinating workflow design > Email notification.

• Set Process Engine runtime options. Refer to Workplace > Admin Tools > Process Configuration 
Console > VWServices > View or modify VWService properties > Set runtime options.

• Set the default date/time mask for the Process Service. Refer to Process Engine > Process Task 
Manager > Process Service > Configuring Process Service > General properties.
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• Define additional isolated regions. Refer to FileNet P8 Administration > Process Engine Administration 
> Workflow administration tasks > Maintaining the workflow system > Using isolated regions to 
separate groups of users.

• For each isolated region:

– Define workflows. Refer to Workplace > Advanced author tools > Process Designer.

– Configure event logging options. Refer to Workplace > Admin tools > Process Configuration Con-
sole > Isolated regions > View or modify isolated region properties > Configure event logging 
options.

– Configure step processors. Refer to Workplace > Admin tools > Process Configuration Console > 
Isolated regions > View or modify isolated region properties >Configure custom step processors.

– Define and configure work queues. Refer to Workplace > Admin tools > Process Configuration 
Console > Queues > Configuring work queues.

– Define and configure component queues. Refer to Workplace > Admin tools > Process Configura-
tion Console > Queues > Configuring component queues.

– Define and configure workflow rosters. Refer to Workplace > Admin tools > Process Configuration 
Console > Queues > Rosters. 
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Optional Installation Tasks

To install optional IBM FileNet P8 components

NOTE You can install the optional IBM FileNet P8 components listed below in any order. After installing 
optional components, install any required patches as described in Task 35 on page 294.

• Install and configure IBM FileNet Publishing components. Do Task 23 on page 259.

• Enable Process Engine Component Integrator. Do Task 24 on page 260.

• Install an IBM FileNet Enterprise Manager on a dedicated computer. Do Task 25 on page 263.

• Set up remote Content Engine file stores. Do Task 26 on page 267.

• Install Workplace Application Integration. Do Task 27 on page 275.

• Install Workplace File Tracker. Do Step 28 on page 278.

• Enable Rules Engine integration. Do one of the following:

– Task 29 on page 279 (If you elected to configure the Rules Engine interface on this computer dur-
ing Process Engine Setup) 

– Task 30 on page 281 (If you elected not to configure the Rules Engine interface on this computer 
during Process Engine Setup)

• Set up Web Services Integration. Do Task 33 on page 292.

• Set up IBM FileNet System Manager. Do Task 34 on page 293.

• Install patches for optional components. Do Task 35 on page 294.

• Deploy multiple Application Engine instances. Do Task 31 on page 284.

• Enable Application Engine to use ISRA. Do Task 32 on page 287.
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Task 23: Install and configure IBM FileNet Publishing Components

Install the IBM FileNet Rendition Engine and associated Publishing Plug-in software to establish publishing 
capabilities. See FileNet P8 Documentation > FileNet P8 System Installation > Rendition Engine 
Installation and Upgrade. 
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Task 24: Enable the Process Engine Component Integrator

Via the Component Integrator functionality included in the IBM FileNet P8 Platform, a step in a workflow 
can access properties of documents, folders, and other objects in an object store. Using this functionality 
requires configuration on both Application Engine and Process Engine, as described in this task. 

Post-installation, you will also have to define workflows that incorporate Content Engine (CE) operations in 
order to use the out-of-the-box Component Integrator functionality. For further details on defining such 
workflows, in the Help for Process Designer, see Steps > Component Steps > General Properties > Using 
Content Engine (CE) operations in a workflow.

NOTE Also post-installation, users can extend the out-of-the-box Component Integrator functionality so 
that a workflow step can interact with an external entity such as a Java object or JMS messaging system. 
For further information, in the Help for Process Development see Developing Process Applications > 
Developing Work Performers / Component Integrator Operations > Developing Component Integrator-
Based Workflow Applications.

Specify username and password for the Java adaptor (on Application Engine)

1. Sign in to Workplace.

If you defined the Process Engine Configuration Group on the LDAP tab of Process Task Manager 
(when completing “Configure the Process Engine LDAP Connection” on page 204), you must log on as 
a member of either that group or the Process Engine Administrators Group, which was also defined on 
the LDAP tab, in order to complete the following steps.

2. In Workplace, click Admin and then click Process Configuration Console.

NOTE If your computer does not have the appropriate Java Runtime Environment (JRE) installed, you 
will be prompted to download the JRE at this point; follow the prompts to complete the download. 
During the installation process, click the Browser tab and enter the following settings: 

– De-select (clear) the Internet Explorer option.

– If you will be using Netscape 6.0, select the Netscape option. 

For further information about the JRE download, click Help in Process Configuration Console, click 
Process Reference on the help page toolbar, and navigate to Concepts > Java Runtime Environment 
(JRE). 

3. Select the Process Router icon that corresponds to the isolated region you initialized in “Initialize the 
isolated region” on page 244.

4. Click the appropriate Server # icon, then open the Component Queues folder.

5. Right-click the CE_Operations component queue and select Properties.

6. On the Adaptor tab of the displayed dialog box, enter a user name and password that will be used for 
identification and access on both Process Engine and Content Engine these operations will access. By 
default, the user name and password are set to Administrator and <no password>, respectively.  If you 
choose to use another user name and password, they must already exist on Application Engine. Use a 
user name without a domain qualifier such as “@company.com”.

For additional information about the fields on the Adaptor tab, click the Help button. To use the out-of-
the-box functionality, it is necessary to modify only the user name and password fields.

7. Click OK.
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Configure and start the Component Manager (on Application Engine)

Execute step 1 below if Application Engine is configured to use maximum strength symmetric encryption 
the JRE used to run the Process Task Manager that contains the Component Manager (which uses JDK 
1.4.x) must be updated with Unlimited Strength Jurisdiction Policy Files. Otherwise proceed to step 2 
below.

1. Install unlimited strength .jar files.

NOTE Perform this step only if you are using JDK 1.4 or higher and have selected the Create 
unlimited strength keys option in the Application Engine User Security and/or User Token Security 
steps of the Application Engine installer. Failure to perform the step will cause EncryptionException 
messages or other errors indicating that a Java Security API provider for Blowfish is not available. The 
EncryptionException is caused by the wrong versions of (or absence of) required .jar files that provide 
unlimited strength security policy files in a Sun JDK 1.4 or higher environment. 

For more information, go to the Documentation for IBM FileNet P8 Platform website and navigate to 
Developer Help > Content Java API > Security > Working with Security > Creating Cryptographic Keys 
for Symmetric Encryption > Configuring a Security Provider for a J2EE Application Server 
Environment.

To install unlimited strength .jar files:

a. Obtain the JDK version specific unlimited strength .jar files. 

• Sun JDK - Obtain the Sun unlimited strength policy files from the Sun product web site (http://
java.sun.com/j2se/). 

• IBM JDK - Obtain the IBM unlimited jurisdiction policy files from the IBM web site (http://
www.ibm.com/developerworks/java/jdk/security).

CAUTION  Make sure you install .jar files specific to the JDK version you are using.

b. Install the files into the JRE's /jre/lib/security folder by replacing files with the same names. 

c. Restart the application server.

2. Start Process Task Manager on Application Engine.

• Windows: Run the routercmd.bat command file, found in the \Router subfolder where you 
installed the Application Engine software.

• UNIX: Run the routercmd.sh command file, found in the \Router subfolder where you installed the 
Application Engine software.

3. Select Component Manager in the left pane (also referred to as the feature pane).

4. Modify the component properties as appropriate. For details, click the Help button and navigate to 
FileNet P8 Administration > Enterprise-wide Administration > Process Task Manager > Application 
Engine > Component Manager > Configure the Component Manager > General properties.

5. Click Start on the toolbar.

Specify connection between Process Engine and Component Manager (on Process Engine)

1. On Process Engine, start the Process Task Manager.

a. Windows: Select Start > Programs > FileNet P8 Platform > Process Engine > Process Task 
Manager.

b. UNIX: Enter vwtaskman from the command prompt.

http://java.sun.com/j2se/
http://java.sun.com/j2se/
http://www.ibm.com/developerworks/java/jdk/security
http://www.ibm.com/developerworks/java/jdk/security
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2. Select Process Service in the left pane (also referred to as the feature pane).

3. Select Server Connections tab.

4. In the Host field, enter the host name of the Application Engine server where Component 
Manager is running.

5. In the Event Port field, enter the port that the Component Manager listens to for incoming events.; the 
default is 32773. The port number you enter must match the number you entered in step 3 of 
“Configure and start the Component Manager (on Application Engine)” on page 261.
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Task 25: Install standalone IBM FileNet Enterprise Manager system

NOTES

• Refer to the IBM FileNet P8 Hardware and Software Requirements for the list of Windows operating 
systems on which IBM FileNet Enterprise Manager can be installed.

• The machine must be logged on to by a member of the Windows domain where the domain controller 
is located.

• The IBM FileNet Enterprise Manager does not require any other supporting Content Engine services 
or files to be located on the machine.

• To control tracing logging from a machine where a remote (standalone) IBM FileNet Enterprise 
Manager is installed, you must be logged on as a user who has local administrator rights on a machine 
where Content Engine is installed. Furthermore, the Remote Registry service must be running on the 
Content Engine machine.

• When installing Content Engine services (e.g., Object Store Service, File Store Service), or IBM 
FileNet Enterprise Manager, the machine that you are installing on must be a member of the 
“deployment” domain (whether that be the parent or child domain) prior to installing.

• You can use IBM FileNet Enterprise Manager to administer multiple object stores in a single FileNet P8 
domain. To administer multiple FileNet P8 domains from a single client machine, you must install 
Terminal Server on at least one machine in each domain. However, the machine cannot have Process 
Engine installed on it. This machine should have IBM FileNet Enterprise Manager installed and 
configured for that domain. From your single client machine, you can connect to each machine using 
Terminal Server and use IBM FileNet Enterprise Manager to administer that specific domain.

To install standalone Enterprise Manager system:

1. Make sure you are logged in with a domain account that  has local administrator privileges.

2. Insert the IBM FileNet P8 Content Engine CD into the CD drive, navigate to the ContentEngine folder, 
and click setup.exe.

3. Complete the Content Engine Setup wizard screens as follows:

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine installation.

License Agreement Review and accept the license agreement for IBM FileNet P8 
software products, and then click Next.

Minimum Requirement This screen appears only if the server where you are installing 
Content Engine software does not meet the suggested minimum 
system requirements posted in the FileNet P8 Hardware and 
Software Requirements on the FileNet Customer Service and 
Support web site (http://www.css.filenet.com).

Click Next if you wish to proceed with the installation, or click Cancel 
to exit the wizard.

Customer Information Type your user name (required) and organization (optional), and then 
click Next.

http://www.css.filenet.com/docsvs/doccontent.asp?DocID=052260002
http://www.css.filenet.com/docsvs/doccontent.asp?DocID=052260002
http://www.css.filenet.com
http://www.css.filenet.com
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Setup Type Click Custom, and then click Next.

Custom Setup To install only IBM FileNet Enterprise Manager:

a. In the program features list, highlight the Administrative Tools 
entry, and select from its drop-down list (click the icon to the 
left of the entry) to install the feature.

b. Click Disk Usage to confirm that you have enough disk 
space.

c. Highlight, in turn, each of the other items in the program fea-
tures list, and select from the drop-down list to make the fea-
ture not available.

d. Accept (or click Change to alter) the default Content Engine 
installation directory.

e. Click Next.

Install third-party software If prompted, install required third-party applications (e.g., Apache 
HTTP Server and MDAC), following all screen prompts.

NOTE If you don’t want to install the required third-party software at 
this time, but would rather install it yourself manually, click Cancel to 
stop the Content Engine Setup wizard.

If prompted to install third-party software, do the following:

a. Click Next.

b. Follow all screen prompts. 

In most environments, you can accept the default installation values 
for third-party software unless otherwise noted.

In this screen... Perform this action...
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To join an existing FileNet P8 domain

Run the GCD wizard to join to a FileNet P8 domain the IBM FileNet Enterprise Manager you just installed.

Ready to Install Do the following:

a. If you already have an IBM FileNet P8 Documentation web 
site installed, you can configure Content Engine components 
to access it, as follows.

NOTE If you don’t yet have a documentation web site 
installed, see “Feature component notes” on page 128.

i. Select the provided check box.

ii. Type the URL of the web site in the following format:

http://<docserver>:<port#>/<ecm_help>)

where:

docserver is the name of the Java web server

port# is the port number

ecm_help is the root folder of the documentation website

You can use multipart root folders if your application 
server supports them (e.g., /docs/ecm_help). 

iii. Click Test to verify that the documentation URL is cor-
rect.

b. Click Install to install Enterprise Manager. (The installation 
will take several minutes.)

Completing the Content 
Engine Setup wizard

Click Finish. This action completes the installation of Content Engine 
and opens the GCD wizard to enable you to join an existing FileNet 
P8 domain.

NOTE If the GCD wizard does not start automatically, navigate to 
<drive>\Program Files\FileNet\Content Engine and double-click 
ConfigGCD.exe to manually start it.

Continue at “To join an existing FileNet P8 domain” on page 265

In this screen... Perform this action...

P8 Domain Type the object store service host name and click Next to join a 
FileNet P8 domain.

NOTE Content Engine Object Store Service must already be installed 
on the host you specify.

In this screen... Perform this action...
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Reboot the machine, as prompted, if you installed IBM FileNet P8 CFS Server for Image Services.

Ready to create P8 domain Verify the FileNet P8 domain name in the Domain Name box, and 
then click Finish. Click OK when the wizard announces that the GCD 
and Content Engine are successfully configured, and you are done.

In this screen... Perform this action...
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Task 26: Configure remote Content Engine file stores

NOTES

• When installing Content Engine services (e.g. Object Store Service or File Store Service), or IBM 
FileNet Enterprise Manager, the machine that you are installing on must be a member of the 
"deployment" domain (whether that be the parent or child domain) prior to installing.

• File Store Service does not require any other supporting Content Engine services or files to be located 
on the machine.

• The partition that will contain the shared folder for the remote file store(s) must be Windows DFS or 
NTFS.

• Before configuring an Oracle-based remote file store, you must already have installed Oracle Client on 
the remote server.

To install remote IBM FileNet File Store Service on the remote server

1. Make sure you are logged in with a domain account that has local administrator privileges.

2. Insert the IBM FileNet P8 Content Engine CD into the CD-ROM drive, navigate to the ContentEngine 
folder, and click setup.exe. The Content Engine Setup wizard opens.

NOTE You can select the Back button at any time during the installation process to make changes to 
any previous dialog box.

3. Complete the Content Engine Setup wizard screens as follows:

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine installation.

License Agreement Review and accept the license agreement for IBM FileNet P8 
software products, and then click Next.

Minimum Requirement This screen appears only if the server where you are installing 
Content Engine software does not meet the suggested minimum 
system requirements posted in the IBM FileNet P8 Hardware and 
Software Requirements.

Click Next if you wish to proceed with the installation, or click Cancel 
to exit the wizard.

Customer Information Type your user name (required) and organization (optional), and then 
click Next.

Setup Type Click Custom, and then click Next.
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Custom Setup Do the following:

a. Set all program features except File Store Service to not be 
available for installation. 

b. Click Disk Usage to confirm that you have sufficient disk 
space for File Store Service.

c. Accept (or click Change to alter) the default Content Engine 
installation directory. 

d. Click Next.

Install third-party software If prompted, install required third-party applications (e.g., Apache 
HTTP Server and MDAC), following all screen prompts.

NOTE If you don’t want to install the required third-party software at 
this time, but would rather install it yourself manually, click Cancel to 
stop the Content Engine Setup wizard.

If prompted to install third-party software, do the following:

a. Click Next.

b. Follow all screen prompts. 

In most environments, you can accept the default installation values 
for third-party software unless otherwise noted.

In this screen... Perform this action...
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To join an existing FileNet P8 domain:

Run the GCD wizard to join the file store to a FileNet P8 domain.

Ready to Install Do the following:

a. If you already have an IBM FileNet P8 Documentation web 
site installed, you can configure Content Engine components 
to access it, as follows.

NOTE If you don’t yet have a documentation web site 
installed, see “Feature component notes” on page 113.

i. Select the provided check box.

ii. Type the URL of the web site in the following format:

http://<docserver>:<port#>/<ecm_help>)

where:

docserver is the name of the Java web server

port# is the port number

ecm_help is the root folder of the documentation website

You can use multipart root folders if your application 
server supports them (e.g., /docs/ecm_help). 

iii. Click Test to verify that the documentation URL is cor-
rect.

b. Click Install to install File Store Service. (The installation will 
take several minutes.)

Completing the Content 
Engine Setup wizard

Click Finish. This action completes the installation of Content Engine 
software and opens the GCD wizard to enable you to create a new, or 
join an existing, FileNet P8 domain.

NOTE If the GCD wizard does not start automatically, navigate to 
<drive>\Program Files\FileNet\Content Engine and double-click 
ConfigGCD.exe to manually start it.

Continue at “To join an existing FileNet P8 domain:” on page 269

In this screen... Perform this action...

P8 Domain Type the object store service host name and click Next to join a 
FileNet P8 domain.

NOTE Content Engine Object Store Service must already be installed 
on the host you specify.

In this screen... Perform this action...
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Join Domain If the domain name shown on the Join Domain wizard screen is blank 
or does not match the FileNet P8 domain you would like to join, go 
back to the previous P8 Domain screen and enter the name of a 
different (existing) Content Engine server that contains an Object 
Store Service and is in the FileNet P8 domain you want to join.

Assuming you entered a valid Content Engine server name on the 
previous P8 Domain screen and experienced no interceding error 
message, do the following:

a. Verify that the default Windows Service Logon account 
shown is the one you want.

b. Type a Password value for the account shown.

Click Finish. Content Engine joins the FileNet P8 domain. Click OK 
when the wizard announces that the GCD and Content Engine are 
successfully configured, and you are done. 

You can confirm that the Content Engine File Store Service is 
installed and started by finding the entry for it in the Windows 
Services panel.

If, for some reason, you chose to continue to this screen after 
entering a not (yet) recognized Content Engine server name on the 
previous P8 Domain screen, you will have to manually enter values in 
the following fields and then click Finish to complete this procedure.

SYSINIT Path 

The path to the sysinit.dat file on a server that hosts a Content 
Engine Object Store Service and is in the FileNet P8 domain you 
want this new Content Engine server to join. If the field is blank, 
specify the value as in the following example (where the server 
hosting the Object Store Service is named CEServer1):

\\CESERVER1\FNCE_CESERVER1$\sysinit.dat 

P8 Domain Service Group 

The name of a group with permission to add a computer to a FileNet 
P8 domain. Example: Content Engine Servers. If this field is blank, 
you must enter the same name you specified when creating the 
FileNet P8 domain on the master GCD server. Also, if the group is a 
Windows domain local group or a universal group, its members must 
also be in the Windows deployment domain (i.e., containing the 
Content Engine servers).

In this screen... Perform this action...
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To create the shared folder for remote file store use

This procedure creates a shared folder and sets the security on that folder.

1. Using either Windows Explorer or My Computer, navigate to the drive/folder where you would like to 
create the shared folder for the file store to be stored.

NOTE This shared folder will be the file store repository root folder for all data that will be stored in the 
object stores using the remote file store.

2. Create the new folder to be used for the remote file stores and remote object stores.

3. Right-click the new folder and select Sharing (Windows 2000) or Sharing and Security (Windows 
2003).

4. Click Share this folder and specify a share name.

5. Click Permissions. Give Authenticated Users group Full Control.

6. Click OK and then close the application.

To create a remote file store

This procedure is performed from a machine that has the IBM FileNet Enterprise Manager installed.

1. Launch the IBM FileNet Enterprise Manager and log on.

Use Default accounts 

For this check box, do one of the following:

• Leave it selected to accept the default account information for the 
Windows Service Logon account shown.

• Clear it if you want to choose an account for Content Engine 
Service logon from the Members list. Then click List Members 
and select one of the accounts to display it as the new Windows 
Service Logon account.

If you choose default users, you will have to re-specify their 
existing passwords. If you choose non-default users, you are free 
to specify each password.

Password 

You must supply a valid password for the Windows Service Logon 
account. If the account (e.g., FNCE_machinename) already exists, 
the new password will overwrite the existing password for the 
account.

NOTE To verify installation, you can find Content Engine installation 
logs in \winnt\temp (on Windows 2000) or \Windows\temp (on 
Windows 2003).

In this screen... Perform this action...
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2. Within the Servers folder (in the tree view of IBM FileNet Enterprise Manager) under the icon of the 
server where you want to create the new file store, right-click the File Stores folder and select New File 
Store.

3. Work through the Create a File Store wizard screens as follows:

In this screen... Perform this action...

Welcome Click Next to proceed with the file store creation.

Specify an Object Store Select from the list the object store to which you will assign the file 
store and then click Next.

Name and Describe the 
File Store

Type the name and description of the file store. The name must be 
unique within the specified object store. Then click Next.

Specify File Store Folder Click Remote Server and then do the following:

a. In the Remote Server box, type the UNC (e.g., 
\\YOUR_REMOTE_SERVER\remote_file_store1) of the 
shared folder you created in “To create the shared folder for 
remote file store use” on page 271. Alternatively, if you have 
mapped a drive to the shared folder, you can click Browse or 
select the shared folder from the Remote Server drop-down 
list.

b. In the File Store Folder box, accept or change the name the 
wizard assigns to the file store folder.

c. In the File Store Service box, accept or change the (default) 
name of the server hosting the File Store Service that will 
govern the remote file store.

NOTE You should always use the File Store Service on the 
server where the remote file store resides.

d. Click Next.
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Fixed File Store 4. Do the following:

a. If you intend to use a fixed content device for your file stores, 
select the Fixed File Store check box and continue at Step b. 
Otherwise, clear the check box and skip to Step h.

b. Select a fixed content device from the selection list.

NOTES

• Hitachi Data Systems and IBM TSM/DR550 (Tivoli Stor-
age Manager) will appear in the selection list only if you 
have already installed Content Engine 3.5.1 Service 
Pack. See ““Install Service Packs and patches for core 
components” on page 236.

• Hitachi fixed content devices used for file stores must 
reside in the same Active Directory domain as the Con-
tent Engine servers.

• See the IBM FileNet P8 Platform Release Notes for the 
latest information on FileNet certification of IBM TSM/
DR550 as a fixed content device.

c. If you selected IBM FileNet Image Services, then IBM FileNet 
Enterprise Manager displays the Default IS Document Class 
group box, including the default document class of the 
selected fixed content device.

d. If you selected a Centera or SnapLock fixed content device, 
IBM FileNet Enterprise Manager also displays retention infor-
mation from which you can select a retention period.

e. (Optional) Clear the Create Referral File check box, and IBM 
FileNet Enterprise Manager will warn that full text indexing 
won’t be available for the new file store. (A referral file is used 
to reindex content stored in a fixed file store.)

f. (Optional) Click Selected below in the Default IS Document 
Class group box to override the default document class of the 
fixed content device. IBM FileNet Enterprise Manager then 
enables a selection list in the lower part of the group box and 
fills it with available IS document classes.

g. (Optional) If you clicked Selected below in Step f, you can 
choose an alternate default IS document class from the 
selection list.

h. Click Next.

Completing the Create a 
File Store Wizard 

Click Finish. When the confirmation message shows that the file 
store has been successfully created, click OK.

In this screen... Perform this action...
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Using IBM FileNet Enterprise Manager to display file store status

The Windows user who logged on to IBM FileNet Enterprise Manager as an IBM FileNet P8 user and then 
created a file store will see the status of the file store as online, and will be able to add content to it. All 
other Windows users, even if logged on to IBM FileNet Enterprise Manager as the same IBM FileNet P8 
user who created the file store, will see its status as offline, and thus will not be able to add content to it.

To enable a Windows logon user to see an online status for a file store and to add content to it, you must 
add the user to the directory security of the file store with the following permissions: Modify, Read & 
Execute, List Folder Contents, Read, and Write. Alternatively, as a member of the Local Administrators 
group you can add the Windows logon user to the <DOMAIN>\Content Engine Servers group.
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Task 27: Install Application Integration

Install Application Integration if you want to integrate IBM FileNet Workplace with your Microsoft Office 
applications and Outlook. Complete the following procedure on each machine that will use Workplace 
Application Integration.

NOTES 

• You cannot collocate Workplace Application Integration with clients running IDM Desktop Applica-
tion Integration.

• The Application Integration software includes the Workplace File Tracker software. If you install 
Application Integration, do not install File Tracker on the same system.

To install the Application Integration software

1. Verify your computer meets the platform requirements documented in the IBM FileNet P8 Hardware 
and Software Requirements.

2. Log onto the machine with an account that has Administrator privileges. 

3. In Workplace, navigate to the Author page, General Tools view.

4. Scroll down and click Download Office Integration and do one of the following:

• Click Open to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save. Once the file is saved to your 
hard drive, double-click the file to run the installer.

The Welcome Wizard dialog box for Application Integration appears. Another Welcome dialog box 
appears.

5. Click Next.

NOTE  If you have Workplace Application Integration 2.0.1 currently installed, it is completely removed 
and replaced by the 3.5.0 version and a warning is displayed. 

If you have Workplace Application Integration 3.0.0 currently installed,  you are prompted about the 
impending upgrade.

Click Yes to upgrade to the current version you are installing or click No to end the installation. 

6. Read the license agreement, and then select I accept the terms to the license agreement, and then 
click Next. If you do not accept the license agreement, you cannot continue with the install. 

7. Do the following:

• Select the applications you want to integrate, and then click Next.

NOTE  The Application Integration Toolkit Components option is required to use Application 
Integration. 

• Under Install to, the default installation path is displayed. Click Change to specify a different loca-
tion on the Change Current Destination Folder dialog box, and then click OK. Click Next.

NOTE  You may see two default installation paths - one for Microsoft Office and Outlook, and 
another for the Toolkit Components. The Toolkit Components path only appears when the system 
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on which you are installing Application Integration has the Toolkit Components currently installed. 
You cannot modify the Toolkit Components installation path.

8. Enter the server name, port number and application name that defines the Workplace address. The 
server name is the name of the web server running Workplace, port number is the web server’s 
assigned port, application is the directory where you installed the IBM FileNet Workplace application 
files.

Check Server uses secure connection (SSL) if you are running full SSL to encrypt all 
communication with Workplace. 

NOTE  You can also leave these fields blank and enter the information when you log on to Workplace 
Application Integration.

9. Click Next.

10. Click Install.

11. After the install is complete, click Finish to complete the setup process.

To verify your Workplace Application Integration installation

1. Start Microsoft Word. 

2. From the File menu, click FileNet P8, point to Open Document, and then select Select Item. The 
Logon dialog box opens. 

3. Log on using any valid domain account. The available object stores in your environment are displayed.

NOTE  If you didn’t enter the Workplace Address information in Step 8 above, enter the server name, 
port number and application name that defines the Workplace address. The server name is the name 
of the web server running Workplace, port number is the web server’s assigned port, application is the 
directory where you installed the IBM FileNet Workplace application files. Check Server uses secure 
connection (SSL) if you use a full SSL to encrypt all communication with Workplace. Do not select 
this option if you use a SSL redirect during login. 

4. Close all dialog boxes and close Microsoft Word.

To uninstall or modify Workplace Application Integration

1. From the Start menu, click Settings, and then point to Control Panel.

2. Click Add/Remove Programs, and then highlight FileNet Workplace Application Integration 3.5.0.

3. Do one of the following:

• Click Remove, and then click Yes to confirm you want to uninstall Workplace Application Integra-
tion.

• Click Change to access maintenance tasks, and then click Next. You can modify, repair, or 
remove Application Integration using the maintenance tasks.

– Do one of the following:

• Select Modify to add or remove integration with Microsoft applications from your previous 
install. For example, if you have both Microsoft Office and Outlook installed, you can 
remove one of the applications using this option. The Custom Setup dialog box appears, 
where you highlight the option you want to add or remove. Click Next, and then click 
Install. Click Finish to complete the process.
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• Select Repair to re-install Workplace Application Integration to repair installation errors, 
and then click Next. Click Install to start the repair process. Click Finish to complete the 
process.

• Select Remove to remove Workplace Application Integration from your system, and then 
click Next. Click Remove. Once the application is removed from your system, click Finish 
to complete the process.
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Task 28: Install File Tracker

Install File Tracker if you want to use the Workplace file tracking feature.  Complete the following 
procedure on each machine that will use Workplace File Tracker.

NOTE If you have already installed Application Integration 3.5.1 hotfix pack 2 or later, then the File Tracker 
feature has already been installed. Do not perform this procedure if you already installed this version of 
Application Integration. If a previous version of Application Integration is installed, upgrade it to 3.5.1 hotfix 
pack 2 or a subsequent hotfix pack, and this will include the File Tracker installation. For details about the 
upgrade process, see “Upgrade Application Integration” on page 337.

To install the File Tracker software

1. Verify your computer meets the platform requirements documented in the IBM FileNet P8 Hardware 
and Software Requirements.

2. Log onto the machine with an account that has Administrator privileges. 

3. In Workplace, navigate to the Author page, General Tools view.

4. Scroll down and click Download File Tracker and do one of the following:

• Click Open to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the FileTracker.exe file locally, and then click Save. Once the file is saved to your hard drive, 
double-click the file to run the installer.

The Welcome Wizard dialog box for File Tracker appears. Another Welcome dialog box appears.

5. Click Next.

6. Read the license agreement, and then select I accept the terms to the license agreement, and then 
click Next. If you do not accept the license agreement, you cannot continue with the install. 

7. Do one of the following:

• Click Change if you want to install File Tracker to a different location. Specify the location to which 
you want to install File Tracker, and then click OK. Click Next.

• Click Next to accept the default location.

8. Click Install.

9. After the install is complete, click Finish to complete the setup process.

To uninstall Workplace File Tracker

1. From the Start menu, click Settings, and then point to Control Panel.

2. Click Add/Remove Programs, and then highlight FileNet Workplace File Tracker.

3. Click Remove, and then click Yes to confirm you want to uninstall Workplace File Tracker.
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Task 29: Enable Rules Engine integration

If you elected to configure the Rules Engine interface when prompted during Process Engine Setup, you 
must complete the following tasks to enable Rules Engine integration:

1. enabling the Rules Engine interface in the Process Task Manager and Process Configuration console

2. configuring the JRules startup file

Instructions for each of these tasks appear below.

If you did not configure Rules Engine integration during Process Engine Setup, complete “Enable Rules 
Engine integration manually” on page 281 rather than this task.

NOTES

• Before beginning this task, ensure that ILOG JRules is installed on Process Engine along with a 
version of the Java Runtime Engine (JRE) that is supported by JRules.

• In order to create and run business rules for Process workflows, ILOG JRules must be started from the 
command prompt using a custom startup file (runilog.bat on Windows or runilog on UNIX) provided by 
IBM FileNet. Before using this file, you must update the file with the location of ILOG JRules and the 
JRE that JRules uses. Failure to update and use the startup file will result in workflows that do not 
execute as expected or runtime errors.

To enable the Rules Engine interface

1. Start Process Task Manager on Process Engine.

a. Windows: Select Start > FileNet P8 Platform > Process Engine > Process Task Manager.

b. Solaris: Enter vwtaskman from the command prompt.

2. Select Process Service in the left pane (also referred to as the feature pane). If the Process Service is 
running, right-click on Process Service and select Stop from the context menu.

3. Click the Server Connections tab and modify the Rules Engine fields as appropriate. For details, click 
Help and navigate to FileNet P8 Administration > Enterprise-wide Administration > Process Task 
Manager > Process Engine > Process Service > Configure the Process Service > Server connections.

4. Restart the Process Service by right-clicking on Process Service and select Start from the context 
menu. 

5. Select Rules Engine in the feature pane.

6. Modify the Rules Engine properties as appropriate. For details, click Help and navigate to FileNet P8 
Administration > Enterprise-wide Administration > Process Task Manager > Process Engine > Rules 
Engine.

7. Click Start on the toolbar.

8. In Workplace, click Admin and then click Process Configuration Console.

9. In the left pane (also referred to as the scope pane), locate the Process Engine installation for which 
you want to enable Rules Engine integration and right-click one of the routers located under that 
Process Engine.

10. Select Connect from the context menu.
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11. In the scope pane, right-click on the appropriate Process Engine and select Properties from the 
context menu.

12. Select the Runtime Options tab.

13. Select the Enable Rules check box and click OK.

14. Select File > Exit from the Process Configuration Console menu and then close the window.

15. Start the Process Task Manager and restart (stop and start) the Process Service.

To configure the JRules startup file

1. Change permission for the startup file (runilog.bat on Windows or runilog on UNIX) to writable. The 
default location of the startup file is:

(Windows) \fnsw_loc\connectors\ILOG\runilog.bat 
(UNIX) /fnsw/local/connectors/ILOG/runilog

2. Edit the startup file and update the path information in the JDKHOME, ILRHOME, FNJARDIR entries 
as appropriate for your system. 

• JDKHOME indicates the location of the JRE that ILOG will use to run JRules. 

• ILRHOME indicates the location of JRules.

• FNJARDIR indicates the location of the Rules Engine program files and folders.

For example:

(Windows)

JDKHOME=C:\Program Files\Java\<supported version of JRE>
ILRHOME=D:\ILOG\JRules40
FNJARDIR=E:\fnsw_loc\connectors\ILOG

(UNIX)

JDKHOME=/usr/j2re1.4.0_04
ILRHOME=/opt/ILOG/JRules40
FNJARDIR=/fnsw/local/connectors/ILOG

3. Save the modified file.
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Task 30: Enable Rules Engine integration manually

If you elected not to configure the Rules Engine interface when installing Process Engine, you can 
manually enable the Rules Engine integration (reinstalling Process Engine is not necessary). Regardless 
of your selections during Process Engine installation, Process Engine Setup copies the Rules Engine 
program files and folders to <install drive>:\fnsw_loc\connectors\ILOG\ (Windows) or /fnsw/local/
connectors/ILOG (UNIX).

To manually enable Rules Engine, you must:

1. Edit the taskman.properties file and the fnrules.properties file.

2. (UNIX only) Assign ownership of /fnsw/local/connectors and its subdirectories to the fnsw user. At the 
command prompt, execute the following command:

chown -R fnsw:fnusr/fnsw/local/connectors

3. Enable the Rules Engine interface in the Process Task Manager and Process Configuration console.

4. Configure the JRules startup file.

Instructions for each of these tasks appear below.

If you configured Rules Engine integration during Process Engine Setup, complete “Enable Rules Engine 
integration” on page 279 rather than this task.

NOTES

• Before beginning this task, ensure that ILOG JRules is installed on Process Engine along with a 
version of the Java Runtime Engine (JRE) that is supported by JRules.

• In order to create business rules for Process workflows, ILOG JRules must be started from the 
command prompt using a custom startup file (runilog.bat on Windows or runilog on UNIX) provided by 
IBM FileNet. Before using this file, you must update the file with the location of ILOG JRules and the 
JRE that JRules uses. On UNIX systems you must also update the startup file to indicate the location 
of the JRE. Failure to update and use the startup file will result in workflows that do not execute as 
expected or runtime errors.

To edit the taskman.properties and fnrules.properties files

1. On Process Engine, open the taskman.properties file in a text editor and add the following lines. The 
taskman.properties file is located in /fnsw/bin (UNIX) or <install drive>:\fnsw\bin (Windows).

TaskManager.RulesEngine.ClassPath=<connector_home>\\resources;<connector_home>\\re.jar;
<connector_home>\\peResources.jar;<connector_home>\\ri.jar;<jrules_home>\\lib\\jrulesall.jar;<jr
ules_home>\\lib\\xercesImpl.jar;
<jrules_home>\\lib\\logging.jar;<jrules_home>\\lib\\sax.jar;<jrules_home>\\lib\\dom.jar;
<jrules_home>\\lib\\jmi.jar;<jrules_home>\\lib\\xalan.jar;<jrules_home>\\lib\\jviews.jar;
<jrules_home>\\lib\\sam.jar;<jrules_home>\\lib\\sdm.jar

TaskManager.RulesEngine.Props=<connector_home>\\fnrules.properties

TaskManager.RulesEngine=true

TaskManager.RulesEngine.VMArgs=-Xms256m -Xmx256m

where:

<jrules_home> is the location where JRules is installed. The default location in Windows is <install 
drive>:\ilog\jrules46. The default location in UNIX is /ilog/jrules46.
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<connector_home> is the location where the Rules Engine is installed. The default location in 
Windows is <install drive>:\FNSW_LOC\connectors\ILOG\. The default location in UNIX is /fnsw/
local/connectors/ILOG.

NOTE When entering the TaskManager.RulesEngine.ClassPath and TaskManager.RulesEngine.Props 
statements on UNIX, replace the semicolons shown in the above example (;) with colons (:).

2. Save and close the file.

3. Open the fnrules.properties file in a text editor and edit the following lines. The fnrules.properties file is 
located in /fnsw/local/connectors/ILOG (UNIX) or <install drive>:/fnsw_loc/connectors/ILOG 
(Windows).

JRULES_CONNECTOR.HOME = <connector_home>

JRULES_CONNECTOR.REPOSITORY_HOME = <connector_home>/repositories

JRULES_CONNECTOR.RULES_HOME = <connector_home>/rules

4. Save and close the file.

To enable the Rules Engine interface

1. Start Process Task Manager on Process Engine.

a. Windows: Select Start > FileNet P8 Platform > Process Engine > Process Task Manager.

b. UNIX: Enter vwtaskman from the command prompt.

2. Select Process Service in the left pane (also referred to as the feature pane). If the Process Service is 
running, right-click on Process Service and select Stop from the context menu.

3. Select the Server Connections tab and modify the Rules Engine fields as appropriate. For details, 
click Help and navigate to FileNet P8 Administration > Enterprise-wide Administration > Process Task 
Manager > Process Engine > Process Service > Configure the Process Service > Server connections.

4. Restart the Process Service by right-clicking on Process Service and select Start from the context 
menu. 

5. Select Rules Engine in the feature pane.

6. Modify the Rules Engine properties as appropriate. For details, click Help and navigate to FileNet P8 
Administration > Enterprise-wide Administration > Process Task Manager > Process Engine > Rules 
Engine.

7. Click Start on the toolbar.

8. In Workplace, click Admin and then click Process Configuration Console.

9. In the left pane (also referred to as the scope pane), locate the Process Engine installation for which 
you want to enable Rules Engine integration and right-click one of the routers located under that 
Process Engine. 

10. Select Connect from the context menu.

11. In the scope pane, right-click on the appropriate Process Engine and select Properties from the 
context menu.

12. Select the Runtime Options tab.

13. Select the Enable Rules check box and click OK.
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14. Select File > Exit from the Process Configuration Console menu and then close the window.

15. Start the Process Task Manager and restart (stop and start) the appropriate Process Service.

To configure the JRules startup file

1. Change permission for the startup file (runilog.bat on Windows or runilog on UNIX) to writable. The 
default location of the startup file is:

(Windows) <install drive>:\fnsw_loc\connectors\ILOG\runilog.bat 
(UNIX) /fnsw/local/connectors/ILOG/runilog

2. Edit the startup file and update the path information in the following variables.   

Windows

• ILRHOME indicates the location of JRules.

• CONNECTOR_HOME indicates the location of the Rules Engine program files and folders.

UNIX

• JDKHOME indicates the location of the JRE that ILOG will use to run JRules. 

• ILRHOME indicates the location of JRules.

• FNJARDIR indicates the location of the Rules Engine program files and folders.

For example:

Windows

ILRHOME=D:\ILOG\JRules46
CONNECTOR_HOME=E:\fnsw_loc\connectors\ILOG

UNIX

JDKHOME=/usr/j2re1.4.0_04
ILRHOME=/opt/ILOG/JRules46
FNJARDIR=/fnsw/local/connectors/ILOG

3. Save the modified file.

4. (Windows only) Ensure that the location of the JRE is set in your PATH system environment variable.
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Task 31: Deploy multiple Application Engine instances

This topic covers deployment of multiple instances of the Application Engine on a single application server. 
Each deployment of the Application Engine must use the same Content Engine, Process Engine, and 
router. Each deployment of the Application Engine may use different Site Preference settings and may 
provide access to different object stores.

NOTES  

• The procedure below assumes that you have already installed Application Engine and deployed one 
instance of Workplace. You may or may not have signed in and configured your bootstrap preferences.

• For more information on how to deploy and manage multiple identical applications, see your 
application server documentation. 

To deploy a second instance of the Workplace application

1. (WebLogic, JBoss/Tomcat only) Copy the installed Workplace folder.

On the Application Engine server, make a copy (<Workplace_copy>) of the installed Workplace folder 
found in:

<AE_install_path>/FileNet/

NOTES  

• The new application will deploy using the name you give the copy of the Workplace folder 
(<Workplace_copy>). 

• For JBoss/Tomcat you will copy the Workplace folder as part of the deployment. See below.

• For WebSphere, Oracle, and Sun Java, you will deploy the installed .war file under a new name.

2. (WebLogic only) Clean up the bootstrap.properties file.

NOTE  If you haven’t yet signed in to Workplace as part of you first Application Engine installation there 
is no need to clean up the file. 

When you first sign in to Workplace certain values in the bootstrap.properties file, such as the name 
and location of the site preferences file, are set. To use different settings for your new Workplace 
application you must remove the existing entries from the copied file. 

The bootstrap.properties file is located in:

<Workplace_copy>/WEB-INF/ 

Edit the bootstrap.properties file:

• Remove the value entered for the prefName setting - This entry contains the name of the site pref-
erences file stored on the object store.

• Remove the value entered for the objectStoreId - This entry contains the object store name 
where your site preferences will be stored.

• Remove or edit any of the other values as needed.

3. (Optional, WebLogic only) Clean up other relevant configuration files.

Some of the installed configuration files contain data that you might want to change:

• WcmApiConfig.properties 
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i. CredentialsProtection – Clear or Symmetric

ii. CryptoKeyFile – Path to the CryptoKeyFile.properties file.

iii. CredentialsProtection/UserToken – Clear or Symmetric 

iv. CryptoKeyFile/UserToken – Path to the UTCryptoKeyFile.properties file.

• Web.xml – Remove any comments and custom changes that should not apply to the second Work-
place instance.

• Actions.xml – Remove any comments and custom changes that should not apply to the second 
Workplace instance.

4. Deploy the second Workplace instance.

Follow the application server specific procedures below to deploy your second instance of Workplace 
using a unique name (<Workplace2> in the procedure below). 

When deploying the second instance, use the copied Workplace location/copied app_engine.war file to 
deploy the application:

• WebLogic:

<Workplace_copy>

• WebSphere/Oracle/Sun Java:

<Workplace>/app_engine.war

• JBoss/Tomcat:

The deployment instructions will instruct you how to copy the installed Workplace folder as part of 
deploying the application. Give the new folder a name other than Workplace, <Workplace_copy>.

To deploy the second Workplace instance

• WebSphere - See “Configure and start Application Engine (WebSphere)” on page 213. 

CAUTION  Deploy the war file with a different Context Root name, <Workplace_copy>.

• WebLogic - See “Configure and start Application Engine (WebLogic)” on page 220. 

CAUTION  The new application will deploy using the name you give the copy of the Workplace 
folder (<Workplace_copy>). 

• JBoss/Tomcat - See “Configure and start Application Engine (JBoss/Tomcat)” on page 223. 

CAUTION  The new application will deploy using the name you give the copy of the Workplace 
folder (<Workplace_copy>). 

• Oracle - See “Configure and start Application Engine (Oracle Application Server)” on page 228. 

CAUTION  Deploy the war file with a different Application Name and Map to URL, 
<Workplace_copy>.

• Sun Java - See “Configure and start Application Engine (Sun Java Application Server)” on 
page 231. 

CAUTION  Deploy the war file with a different Application Name and Context Root, 
<Workplace_copy>.

5. Sign in and set bootstrap preferences for the new application.
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Use the following URL when signing it to set the bootstrap preferences for your new Workplace 
instance.

http://<ApplicationEngineServerName>:<port#>/<Workplace_copy>



INSTALLATION AND UPGRADE GUIDE
Enable Application Engine to use ISRA

287
Task 32: Enable Application Engine to use ISRA

Image Services Resource Adapter (ISRA) is a J2EE connector to the FileNet Image Services (IS) libraries. 
Using ISRA, Workplace users can view IS documents and their associated annotations in the FileNet P8 
Image Viewer and, if they have the appropriate permissions, update the annotations.

To enable Workplace users to view documents using ISRA, the following steps must be completed:

• Install the Application Engine. 

• Install FileNet ISRA. 

For information on installing, configuring and deploying FileNet ISRA, refer to the Image Services 
Resource Adapter documentation on the FileNet ISRA Installation CD. 

TIP Use the Sample Application shipped with FileNet ISRA to confirm that the ISRA installation was 
successful.

WARNING In an ISRA upgrade situation, take care to use the same library name (JNDI connection 
factory name) that has been previously set in the ISRA install. Changing this variable can cause 
conflicts when accessing documents.

• Install the Application Engine ISRA Servlet. This servlet is being introduced for the first time in P8 
3.5.0. 

– The servlet must be deployed on the same application server as FileNet ISRA. 

– The servlet does not need to be collocated with the Application Engine. 

– ISRA has to be installed and deployed before you install and deploy the ISRA Servlet. 

• Configure Workplace Site Preferences.

ISRA SSL support

The following table details the supported for SSL configurations.

SSL Configuration SSL Support

ISRA Servlet and AE Collocated. AE configured for 
SSL logon redirect to a non-local host.

Supported

ISRA Servlet and AE Collocated. AE Configured for 
SSL logon redirect to a local host.

Supported

ISRA Servlet and AE Collocated. AE, and ISRA 
Servlet running under SSL.

Not Supported

ISRA Servlet remote from AE. AE configured for SSL 
logon redirect to a non-local host.

Supported

ISRA Servlet remote from AE. AE configured for SSL 
logon redirect to a local host.

Supported

ISRA Servlet remote from AE. AE running under SSL,  
ISRA Servlet not running under SSL. 

Supported
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To install and deploy the Application Engine ISRA Servlet

The FileNet P8 Application Engine installation CDs contain the ISRA servlet installation programs for the  
supported P8 AE platforms. 

1. Log on to the application server.

UNIX - logon as a user with write access to the /bin directory and read, write, execute access to the 
directory where you plan to install ISRA Servlet.

Windows - logon as a member of the local Administrators group or as a user with equivalent 
permissions.

2. Stop the application server if it is running.

3. Start the Application Engine ISRA Servlet Setup wizard:

UNIX - Insert and mount the Application Engine CD. Navigate to /<mount_point>/ and execute 
<Platform>filenet_ae_israservlet_setup.bin.

Windows - Insert the Application Engine CD. Navigate to CD drive and execute 
WINfilenet_ae_israservlet_setup.exe

4. Complete the Setup screens as follows:

ISRA Servlet remote from AE.  AE, and ISRA Servlet 
running under SSL.

Not Supported

In this screen... Perform this action...

License Agreement Review and accept the license agreement for FileNet P8 software, 
then click Next.

Directory Name For the Directory Name field, enter or browse to the location where 
you want to install the ISRA Servlet, or accept the default location:

• UNIX - /opt

• Windows - C:\Program Files\

Click Next

UNIX

<AE_israservlet_install_path>/FileNet/
ApplicationEngineISRAServlet>

Windows

<AE_israservlet_install_path>\FileNet\ApplicationEngineI
SRAServlet>

SSL Configuration SSL Support
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5. Check the file filenet_ApplicationEngineISRAServlet_install_log.txt, located in the 
<AE_israservlet_install path>\FileNet directory, to see if any errors occurred during the installation.

6. Install unlimited strength .jar files. 

Perform this step only if you selected the Create unlimited strength key option in the Application 
Engine User Token Security step of the Application Engine installation and the Application Engine 
ISRA Servlet is deployed on a different application server from the Application Engine. Failure to 
perform the step causes an EncryptionException when you login to the IS Server. 

For more information, refer to the section "Install unlimited strength .jar files" in “Configure symmetric 
encryption” Task 20 on page 245 in the Application Engine Install Guide.

7. Start the application server.

8. Deploying the Application Engine ISRA Servlet is similar to  deploying Workplace.

• WebSphere:

Deploy <AE_israservlet_install_path>\FileNet\ApplicationEngineISRAServlet\ae_isra.war file in 
the same way you deployed the app_engine.war file for Workplace.    

• WebLogic

Deploy <AE_israservlet_install_path>\FileNet\ApplicationEngineISRAServlet in the same way you  
deployed <AE_install_path>\FileNet\Workplace.

• JBoss:

Copy <AE_israservlet_install_path>\FileNet ApplicationEngineISRAServlet\ directory to 
<JBOSS_HOME>\server\default\deploy\ directory and rename it to 
ApplicationEngineISRAServlet.war.

9. Stop and restart the application server.

10. Verify the Application Engine ISRA Servlet installation. 

A diagnostic tool is available to verify that the ISRA Servlet is installed and deployed correctly. 

a. Launch your browser.

b. Enter the URL for the Application Engine ISRA Servlet, for example, 

http://<ApplicationEngineISRAServlet servername>:<port>/ApplicationEngineISRAServlet/ISRA

Create war File Check this box if you use a WebSphere application server. 

If the box is checked, the installation program will create the 
ae_isra.war file and a script that can also generate the ae_isra.war 
file.

User Token Security Make a note of the user token crypto key path. Click Next.

Ready to Install Verify your selections, and click Next to install the ISRA Servlet.

Completing the Setup Click Finish to complete the ISRA Servlet installation Wizard. 

In this screen... Perform this action...
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NOTE ApplicationEngineISRAServlet is the default context root. If you specified a different name for 
the context root when deploying the Application Engine ISRA Servlet, change the URL to match your 
configuration.

If the ISRA Servlet is installed and deployed correctly, a Congratulations message displays. For 
example: 

Congratulations! ISRA Interface Servlet is configured at this URL.

WcmApiConfigFile = D:\ISRAInterface\jsp\WEB-INF\WcmApiConfig.properties

WcmApiConfig file exists

CryptoKeyFile/UserToken = C:\Program 
Files\FileNet\Authentication\UTCryptoKeyFile.properties

CryptoKeyFile/UserToken exists 

FileNet ISRA classes are in the classpath

com.filenet.is.ra.cci.FN_IS_CciConnectionSpec 

To configure the Workplace site preferences

The Application Engine setup installs a pre-configured external service called Image Service, which 
includes the parameterized values necessary to access FileNet IS libraries from Workplace. Enable the 
service by setting the Image Service value in Site Preferences to Show (the default is Hide), as described 
in the following procedure. 

To enable the pre-configured Image Service

1. Sign in to Workplace as a user having the Application Engine Administrators access role. 

2. Launch Site Preferences as follows:

a. Select Admin.

b. Select Site Preferences.

3. Select External Services from the left options list.

4. Select Modify for the Image Service (under External Reference Services).

The External Reference Service Settings site preference page displays. 

5. Under General Information, locate Show on Select File page and change the value to Show.

6. Click Accept.

7. Click Apply.

To set the ISRA Interface Servlet URL

1. Select Bootstrap.

2. Under Preferences Settings, set the value of ISRA Interface Servlet URL. For example:

http://<servername>:<port>/ApplicationEngineISRAServlet/ISRA
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NOTE ApplicationEngineISRAServlet is the default context root. If you specified a different name for 
the context root when deploying the Application Engine ISRA Servlet, change the URL to match your 
configuration.

3. Click Apply.

4. Click Exit to exit the Site Preferences.

To log on to Image Services via LDAP

To log on to the Image Services library using your LDAP account, configure ISRA and Image Services for 
LDAP authentication. If the LDAP account with which you accessed Workplace is not valid for the Image 
Services library, or if LDAP authentication is not configured, you will be prompted to log on to the Image 
Services library.

For information on configuring LDAP authentication for ISRA, refer to the ISRA Installation and 
Deployment Guide. For information on configuring LDAP authentication for Image Services, refer to the 
Image Services System Tools Reference Manual.

To access IS library documents

For informations about accessing IS library documents, see Workplace > Workplace User Help > 
Manage documents > Add a document.
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Task 33: Install and Configure Web Services Integration

The necessary software required for Web Services integration with Content Engine and Process Engine is 
installed by default when you install Content Engine. 

However, you must perform related configuration procedures to enable Web Services integration with 
Content Engine and Process Engine. 

Refer to the following IBM FileNet P8 Documentation locations for instructions on how to enable the 
associated Web Services components:

Content Engine

FileNet P8 Documentation > Developer Help > Content Web Services > Enabling Content Engine Web 
Services

Process Engine

FileNet P8 Documentation > Developer Help > Process Development > Web Services Administration
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Task 34: Install and Configure IBM FileNet System Manager

The necessary software required for the System Manager performance monitoring component for Content 
Engine is installed by default when you install Content Engine. However, you must manually install the 
comparable software for Process Engine.

In both cases, you must also perform related configuration procedures to enable System Manager. 

Refer to the following IBM FileNet P8 Documentation location for instructions on how to enable the 
associated System Manager components:

FileNet P8 Documentation > FileNet P8 Administration > Enterprise-wide Administration > System 
Manager
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Task 35: Install patches for optional components

Install any patches or *SS fixes required for the IBM FileNet P8 Platform. To determine whether additional 
patches or *SS fixes are needed, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs” on page 9.
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Upgrade Planning and Procedures

This upgrade section contains the following major topics:

• “Plan the Upgrade” on page 296

• “Upgrade Core Components” on page 305

• “Upgrade Add-On Components” on page 335
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Plan the Upgrade

This section includes the following topics:

• “Upgrade Overview” on page 297.

• “Upgrade Planning Considerations” on page 297.

• “Gather Pre-upgrade Information” on page 301.

• “Before You Begin the Upgrade” on page 303.
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Upgrade Overview

This section lists details that will help you prepare your environment for the upgrade of an IBM FileNet P8 
system. In many cases, the items you see listed will be links to more detailed information, which will help 
you plan a system upgrade. Please review this information thoroughly before you start to upgrade IBM 
FileNet P8 components or required third-party software.

NOTES

• The IBM FileNet P8 Platform Installation and Upgrade Guide is intended for use by a FileNet Certified 
Professional (FCP) Technician or a Certified Technical Service Provider (TSP). To learn more about 
the FCP Certification program, please contact your IBM services representative.

• This guide does not address migrations to different operating systems, databases, or directory 
services. To migrate from one platform to another (for example, from MS SQL Server database engine 
to Oracle), you must contact your IBM FileNet representative to arrange a possible IBM FileNet 
Professional Services engagement. The upgrades described in the guide assume that you will:

– retain your basic platform configuration from the previous release. 

– make no changes to user or group definitions during the upgrade.

– apply only the necessary supported software updates and patches, as noted in this guide and in 
the IBM FileNet P8 Hardware and Software Requirements document.

If you are running FileNet P8 3.0.0, you must first upgrade to 3.5.0 before applying the 3.5.x Service Pack. 
Before proceeding with the upgrade procedure, verify that the following conditions have been met:

• An existing IBM FileNet P8 3.0.0 system is installed and configured. You cannot upgrade directly to 
IBM FileNet P8 Platform 3.5.x from any version prior to 3.0.0. 

• Your IBM FileNet P8 3.0.0 system does not include any of the following functional expansion add-on 
components. These components have not yet been released for this version of IBM FileNet P8 
Platform.

– Records Manager (RM)

– Team Collaboration Manager (TCM)

NOTE If your IBM FileNet P8 system includes any of the listed components you must wait for the 3.5.x 
version of the component(s) to be released before upgrading any of your core IBM FileNet P8 Platform 
components. 

If you are running IBM FileNet P8 3.5.0, you must apply the 3.5.x Service Pack by following the procedures 
in “Apply Service Packs and patches for core components” on page 334.

Upgrade Planning Considerations 

General Requirements for all IBM FileNet P8 Systems

• Gather auxiliary documentation.

NOTE To download this and other IBM FileNet product documentation from the IBM web site, 
see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

– IBM FileNet P8 Hardware and Software Requirements. This document provides details for all 
FileNet P8 system components, as well as the minimum supported levels of third-party software 
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components. The information throughout the FileNet P8 Platform Installation and Upgrade Guide 
assumes you have met all applicable requirements listed in that document. 

– FileNet P8 Platform user and group security help found at: FileNet P8 Administration > Enter-
prise-wide Administration > Security > Users and groups. This help topic provides a complete 
list of the user and group roles, accounts, and responsibilities required to install, configure, and 
maintain a FileNet P8 system.

– IBM FileNet P8 Platform Security Questionnaire. This document provides a list of security-related 
questions that, when answered by your site, can provide valuable feedback to the FileNet 
Upgrade/Installation Assurance Team that will be helping you install and deploy your FileNet P8 
system.

– IBM FileNet P8 Platform Release Notes. This document provides details on new features, known 
issues, and resolved problems. 

– FileNet P8 Platform Shutdown and Startup help found at: FileNet P8 Administration > Enterprise-
wide Administration > Shutdown and Startup. This help topic describes how to shut down and 
restart FileNet P8 Platform components and some functional expansions. Manual, command line, 
and some sample batch file procedures are provided.

– Installing IBM FileNet P8 Platform in a Non-English Environment Technical Notice. This document 
will help you set up the product if your environment is not English-language based.

– IBM FileNet P8 Platform High Availability Technical Notice. This document provides details on how 
to set up your FileNet P8 system using clusters, farms, and other high-availability software and 
hardware. In so doing, the document also provides related disaster recovery information.

– IBM FileNet P8 Platform Deployment Guide. This document provides details on how to deploy a 
FileNet P8 system from a staging environment into a full production environment. 

– FileNet P8 Platform Troubleshooting Guide. This document provides troubleshooting information 
on all aspects of the product.

– IBM FileNet P8 Platform Performance Tuning Guide. This document provides performance tuning 
information on all aspects of the product.

– IBM FileNet P8 Rendition Engine Installation and Upgrade Guide. This document provides details 
on how to install and upgrade Rendition Engine and Publishing Plug-in components.

• Apply the required minimum level of IBM FileNet P8 patches to the currently installed software 
before you upgrade. IBM FileNet patches and Hot Fix Packs often include feature updates that are 
required to ensure a successful upgrade. Therefore, prior to beginning your upgrade to IBM FileNet P8 
Platform 3.5.x, you must have applied at least the minimum level of patches or Hot Fix Packs to your 
installed 3.0.0 components, as noted in the following table.
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NOTE Over the life of IBM FileNet P8 3.5.x patch requirements could change. To determine what 
additional patches or Hot Fix Packs are available, see “Access IBM FileNet Documentation, 
Compatibility Matrices, and Fix Packs” on page 9.

For further details, see the “Hot Fix Pack and Patch Dependencies” topic in the IBM FileNet P8 
Platform Release Notes. See “Access IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs” on page 9.

• We recommend that you plan and test the upgrade on a designated test system first. Verify the 
upgrade is successful by running functionality and stress tests. After successful verification perform 
the production upgrade as directed by your IBM services representative. 

• Consider Rendition Engine upgrade requirements. The IBM FileNet CD package shipped as of the 
release of IBM FileNet P8 Platform 3.5.1 includes only a 3.5.1 version of Rendition Engine, not 3.5.0 
(unlike other core components). Therefore, to upgrade from a 3.0.0 IBM FileNet P8 Platform 
environment that includes Rendition Engine, you must perform all the following steps as part of a 
single upgrade process before you can again use Rendition Engine features. 

a. Upgrade Content Engine, Process Engine, and Application Engine to version 3.5.0.

NOTE At this point you can verify the functionality of these core components, but you will not be able to 
use Rendition Engine (Publishing) features until you perform the following steps. 

b. Apply the 3.5.1 Service Packs for Content Engine, Process Engine, and Application Engine.

c. Uninstall Rendition Engine 3.0.0. 

d. Install Rendition Engine 3.5.1. 

For complete details, see the IBM FileNet P8 Rendition Engine Installation and Upgrade Guide.

Third-party Software Considerations

The 3.0.0 and 3.5.x versions of IBM FileNet P8 support common levels of third-party software, with the 
exception of WebSphere. Major levels of WebSphere have been changed from 5.0.x and 5.1 on the IBM 
FileNet P8 3.0.0 release, to 5.1 and 6.0 on the IBM FileNet P8 3.5.0 release. The upgrade path for 
WebSphere 5.0 users is to first upgrade to WebSphere 5.1.1, which is supported by both IBM FileNet P8 
3.0.0 and 3.5.0 releases. After upgrading to IBM FileNet P8 3.5.x, you can upgrade to WebSphere 6.0.

Component Hot Fix Pack Software Build

Content Engine P8CE-3.0.0-004 kl165.015

Process Engine P8PE-3.0.0-002 pe165.015, pui165.021

Application Engine P8AE-3.0.0-006 per165.30.a17

FileNet eForms P8eF-3.0.0-002 raptor205.047

Process Analyzer P8PA-3.0.0-002 pa165.017

Process Simulator P8PS-3.0.0-002 ps165.007
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Operating System Considerations

Content Engine 

General

• Note that during upgrade, the Content Engine setup program will apply updates to required 
third-party software. You do not need to pre-install Apache HTTP or Microsoft MDAC upgrades prior 
to upgrading Content Engine since the IBM FileNet setup program will apply these upgrades for you.

Windows 2000 / 2003

• Upgrade to Windows 2003 only AFTER you upgrade Content Engine. A Windows 2003 upgrade is 
supported but not required for Content Engine 3.5.x. 

NOTE IBM FileNet field personnel indicate that most customers prefer to do a fresh installation of 
Windows 2003 rather than upgrading the Windows 2000 software. This is added reason to ensure that 
you first upgrade to Content Engine 3.5.x before moving to Windows 2003. This guides includes 
special instructions for applying Windows 2003 Service Pack 1. 

If you do upgrade to Windows 2003, be sure to see the “Configure Content Engine and SQL Servers 
for Windows 2003" in the IBM FileNet P8 Platform Installation and Upgrade Guide for the following 
procedures:

– Manually configure Microsoft Distributed Transaction Coordinator (MSDTC) and COM+. To 
create object stores, you must manually configure MSDTC and COM+ on all 2003 servers running 
Content Engine and Microsoft SQL Server software.

– Manually Enable Microsoft Internet Information Services (IIS) and configure for WebDAV. To 
use the Content Engine WebDAV Provider, you must ensure that Microsoft Internet Information 
Services (IIS) software is enabled on all Content Engine servers. IIS is enabled by default when 
you install Windows 2000.   

Process Engine

UNIX

Allocate a minimum of 500 MB of additional disk space to the /fnsw disk volume. This space is 
required for upgrades and is in addition to the minimum space requirements called in the IBM FileNet P8 
Hardware and Software Requirements. 

Windows

Reset the fnsw user’s password to the default value. The fnsw user’s password must be reset to the 
default value before running Process Engine setup for the upgrade. After you change the password for the 
fnsw user, you must also update the Log On tab for the IMS ControlService and the Process Engine 
Services Manager accordingly. If the password is not changed before the upgrade, the upgrade will fail. 
After successfully upgrading Process Engine, reset the password again.

Network Considerations

Ensure availability of required port numbers. For a composite list of port numbers required for IBM 
FileNet P8 3.5.x, see the  “IBM FileNet P8 Port Numbers” on page 364.
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Database Considerations

General

Update to the appropriate patches BEFORE you upgrade IBM FileNet P8 components. 

Oracle

Ensure you have applied appropriate Oracle patches to Oracle clients as well as servers. Be sure 
that clients remote to an Oracle database engines have comparable patches to the database server. 
Oracle clients include any machines remote from the Oracle database server where Content Engine, 
Process Engine, and IBM FileNet Enterprise Manager software is installed. You can download all the 
required Oracle9i database server patches from OracleMetaLink and install them.

MS SQL Server

No special considerations or changes required for upgrade to IBM FileNet P8 3.5.x.

Gather Pre-upgrade Information

General Considerations

• Note the IBM FileNet P8 Platform Documentation URL. If you have an existing application server in 
place with an IBM FileNet P8 Platform Documentation web site established, you can determine its URL 
by checking the Documentation server site preference in Workplace.

Database Engine

• Note your current Database Instance Names, NLS, Character set configurations. This 
information can help speed up the Installation/Upgrade Assurance Team's efforts to get the upgrades 
started and to troubleshoot any database-related problems as they arise.

Content Engine

• Ensure that you have the necessary local administrative user accounts and passwords to run 
the upgrade program on the various Content Engine servers and Enterprise Manager clients.

• You must know the password of the user (e.g. FNCE_<machine_name>) that runs the Content 
Engine services. If this is not available, you must reset the password to a known string before running 
the upgrade process.

• If you have previously upgraded from IBM FileNet P8 2.0.1 to IBM FileNet P8 3.0.0, ensure you 
have run the IBM FileNet P8 3.0.0 Stored Search and Search Template Upgrade tool 
(SSUpgrade.exe) prior to upgrading to IBM FileNet P8 3.5.x. SSUpgrade.exe can be found in the 
Upgrade Scripts directory. For details, see the IBM FileNet P8 Platform 3.0.0 Upgrade Guide.

• Note the P8 Apache user account information, including the user’s password. If the password is 
not available, you must reset it before re-configuring (post Content Engine upgrade) the Apache2 
service to run using this user.

• Note the GCD (sysinit file) path on each Content Engine server, in particular on the master GCD 
server. The GCD master is typically your initially installed Content Engine server. 

• Note your database connection string for each object store. 

http://metalink.oracle.com
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• Note you authentication connection provider string (default realm). 

• Note your Windows domain-based Service account name and group used to start CE Services. 

Process Engine 

• (HP-UX only) Collect kernel parameter information prior to upgrading the Process Engine software. 

Prior to upgrading, run the kmtune utility to collect current kernel parameter information and save the 
output. After the upgrade, use the HPjconfig utility to collect information on both required patches and 
recommended kernel parameters. The HPjconfig utility's recommendations for the kernel parameters 
are based upon analysis of historical data on the server. See the following website for configuration 
details.

http://www.hp.com/products1/unix/java/infolibrary/prog_guide/java1/configuration.htm 

• Note the User and Group Base specified in the LDAP Connection tab in Process Engine Task 
Manager. This information can be useful for troubleshooting during the upgrade process.  

• (Rules Engine Integration only) Note the location where iLog JRules software is installed on 
this Process Engine, or where iLog JRules software will be installed on Process Engine after the 
upgrade. During the upgrade, Process Engine Setup prompts for the full path to the iLog JRules 
software installation directory. 

Application Engine / Workplace

• Gather the J2EE application server Admin user name and password or have the Administrator 
available during the upgrade. 

User Name:

Password:

• Determine what components and installation option you used to install Application Engine 
3.0.0. When you upgrade Application Engine you must install the same components that are currently 
installed. If you installed Application Engine 3.0.0 using a Typical install, perform a Typical install; if you 
used a Custom install, perform a Custom install using the same selection of components. In particular, 
do not run a Typical upgrade if you initially ran a Custom installation (e.g., to install the Java API) or 
your Custom software component choices will not be updated as expected.

To find out what Application Engine 3.0.0 components are currently installed, look for the following 
folders:

– Process and Content Java APIs (only)

<App_Engine_install_path>/FileNet/lib2

<App_Engine_install_path>/FileNet/Router

– Workplace web applications and Process and Content Java APIs

<App_Engine_install_path>/FileNet/lib2

<App_Engine_install_path>/FileNet/Router

<App_Engine_install_path>/FileNet/Workplace

– Workplace Toolkit Source Code (for custom application development)

<App_Engine_install_path>/FileNet/Workplace/source

http://www.hp.com/products1/unix/java/infolibrary/prog_guide/java1/configuration.html
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• Record the current Process Router and Component Manager configuration data. Existing 
Process Router and Component Manager configuration data is not retained during Application Engine 
upgrade. Because it will be necessary to re-enter at least the Process Router data following the 
Application Engine upgrade, we recommend recording the current data prior to beginning the upgrade. 
If you did not modify the default Application Engine 3.0.0 configuration for the Component Manager, it 
is not necessary to record and re-enter the Component Manager configuration data; it will be set to the 
Application Engine 3.5.x default values during the upgrade.

To view the current configuration data, start Process Task Manager on Application Engine then, in the 
left pane:

– Click Routers and, for each configured Process Router, note the values displayed on the General 
and Advanced tabs.

– Click Component Manager and note the values displayed on the General and Required Librar-
ies tabs. 

• Record your current bootstrap settings. On upgrade, a new bootstrap.properties file is created. To 
preserve the Application Engine 3.0.0 bootstrap settings you must make a note of the current settings, 
and then re-enter these on first login to Workplace after the upgrade.

CAUTION The Preference Settings are particularly important, as they control what Site Preference file 
to use with the system. To preserve the Site Preferences you have to re-enter the Preference Settings 
values for Object Store Location and Preference name exactly as they were in 3.0.0.

Before You Begin the Upgrade

• Be sure to read the “What’s New” topic in the IBM FileNet P8 Platform Release Notes. Many of the new 
features may be interesting for your implementation of FileNet P8 Platform.

• Make sure the site has restorable backups of system and data of all FileNet P8 components. In case of 
an emergency, you may need to back out of the upgrade. For details on what to back up for FileNet P8 
components, see the topic FileNet P8 Documentation > Enterprise-wide Administration > Backup and 
Restore in the general FileNet P8 Platform help.

• In some cases it may be necessary for FileNet Engineering and Support personnel to access the 
system for support. To facilitate such access, we request that you implement a reliable remote access 
method.

• If high availability is configured (clusters, farms, etc.), be sure to see the IBM FileNet P8 Platform High 
Availability Technical Notice.

• The formats for stored searches and search templates in IBM FileNet P8 3.5.x are identical to those in 
IBM FileNet P8 3.0.0. Before upgrading to IBM FileNet P8 3.5.0, be sure to upgrade any stored 
searches and search templates from IBM FileNet P8 2.0.1 to IBM FileNet P8 3.0.0.
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• If you are upgrading Application Engine on a Windows server, you will need additional software to 
verify a process path in Step 3 on page 328. 

– Process Explorer for Windows, available from  http://www.sysinternals.com. 

NOTE  The software does not require installation.

or

– Software available as part of the Windows 2000 installation set. Follow the instructions found in 
Microsoft Knowledge Base Article 295714: How to Break Down the System Process. The article is 
available at  http://support.microsoft.com.

NOTE The software requires installation. 

• Before beginning the upgrade, make sure no users or processes are accessing the IBM FileNet P8 
system.

• Before beginning the upgrade, make sure you disable tasks such as:

– scheduled automated backups

– cron jobs

– virus scanning

http://www.sysinternals.com
http://support.microsoft.com
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Upgrade Core Components

To upgrade the core IBM FileNet P8 Platform components

CAUTION You must upgrade the core components as described in the topics listed below before 
upgrading the optional add-on components as described in “Upgrade Add-On Components” on page 335.

1. Review IBM FileNet P8 Platform requirements and other planning considerations. See “General 
Requirements for all IBM FileNet P8 Systems” on page 297.

2. Upgrade the IBM FileNet P8 Platform documentation. Do Task 1 on page 306.

3. Ensure that you are running the minimum required release of IBM FileNet P8 Platform software and 
patches for doing an upgrade. Do Task 2 on page 312.

4. If you’re using an Oracle database engine, do Task 3 on page 313. If the Oracle database is remote, do 
Task 4 on page 314 as well. (If you’re using a SQL Server database engine, no upgrade is required). 

5. Upgrade Content Engine. Do Task 5 on page 315.

6. Upgrade Process Engine. Depending on your server platform, do one of the following:

• Task 6 on page 322 (UNIX)

• Task 7 on page 325 (Windows 2000)

7. Upgrade Application Engine. Do Task 8 on page 328.

8. Install Service Packs and patches for core components. Do Task 9 on page 334.
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Task 1: Upgrade IBM FileNet P8 Platform Documentation

Overview

You have two methods available to you for updating an existing 3.x.x IBM FileNet P8 Documentation 
installation:

• “Refresh 3.5.x IBM FileNet P8 Documentation Without Uninstalling” on page 307. Use this option if you 
already have 3.5.0 IBM FileNet P8 documentation installed with functional expansion help added in 
(e.g., for eForms).

• “Update 3.x.x IBM FileNet P8 Documentation by Uninstalling and Reinstalling” on page 308. Use this 
option if you have 3.0.0 documentation currently installed and need to upgrade to 3.5.0, or if you have 
IBM FileNet P8 Platform 3.5.0 documentation installed without any functional expansion help.

NOTES 

• The refresh procedure assumes the following:

– You have IBM FileNet P8 3.5.0 Platform documentation installed.

– You have functional expansion documentation installed (for example, for Web Content Manager, 
IBM FileNet eForms, or IBM FileNet P8 Portlets).

– You wish to replace the documentation at the existing location with updated files.

– You are familiar with your application server’s procedures for reinstalling or redeploying web site 
applications.

• IBM FileNet no longer ships Web Content Manager (WCM) help with IBM FileNet P8 Platform 
documentation. Instead, WCM help will ship independently with the WCM software. IBM FileNet will 
take the same approach with all other functional expansion help (such as IBM FileNet eForms and 
Records Manager).

• Before installing any IBM FileNet P8 Platform documentation, review the IBM FileNet P8 Hardware and 
Software Requirements for the required software versions, Service Packs, and Hot Fix Packs for third-
party software.

• Under BEA WebLogic, IBM FileNet P8 documentation must be installed and deployed as a flat-file 
directory (\ecm_help). You cannot deploy as a WAR file or EAR file because, in both cases, the IBM 
FileNet P8 help remains packaged and the internal documentation search engine will not function as 
expected. 

• Although some versions of BEA WebLogic support deployment of WAR-file-based web applications, 
you cannot deploy ecm_help.war on this application server platform. You must instead use the fully 
expanded IBM FileNet P8 documentation directory structure. Otherwise, the searches within the IBM 
FileNet P8 documentation will not work (you will receive null pointer errors).

• Under WebSphere, IBM FileNet P8 documentation must be installed and deployed as a WAR file 
(ecm_help.war).  You cannot deploy as an EAR file because in that case the IBM FileNet P8 help 
remains packaged and the internal documentation search engine will not function as expected.  

• Before installing the latest IBM FileNet P8 documentation, be sure to back up your existing IBM FileNet 
P8 documentation web site according to your site and application server procedures. This precaution 
will allow you to restore the web site quickly if for any reason you have to back out or delay your IBM 
FileNet P8 software upgrade.
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• If you install any IBM FileNet P8 functional expansions as part of your upgrade (for example, Records 
Manager, IBM FileNet eForms, and Web Content Manager), be aware that:

– You must copy the associated help for all those functional expansions onto the IBM FileNet P8 
Platform documentation server.

– You must update the index for the help Search feature as documented below. This action ensures 
that searches return all expected results. If you add help for other functional expansions later, you 
must re-run the procedure below for updating the help Search index.

NOTE You must also update the help Search index if you intend to install FileNet-based help that 
you have customized or translated as part of your own application development. For further help-
customization details, see the IBM FileNet P8 3.5.0 Localizing and Customizing FileNet P8 Help 
Technical Notice.

– Any time you update the documentation search index, a backup of the files in the existing 
Index\core directory will be automatically copied to the Index\IndexOld subdirectory. You can 
reapply these backed-up files to the core subdirectory (after first removing the new files created 
there) if you need to return to your previous indexed state.

Refresh 3.5.x IBM FileNet P8 Documentation Without Uninstalling

You can refresh an existing 3.5.x installation of IBM FileNet P8 Platform documentation by simply copying 
the newer documentation files over the existing files, and then reindexing for Search. 

However, IBM recommends this alternative to the full upgrade procedure shown later in this topic only if 
you have IBM FileNet P8 Platform 3.5.x documentation already installed with at least one set of functional 
expansion documentation added in.

If you have only IBM FileNet P8 Platform 3.5.x documentation installed (with no functional expansion help 
added in), use the standard upgrade procedure described in “Update 3.x.x IBM FileNet P8 Documentation 
by Uninstalling and Reinstalling” on page 308.

NOTE  This refresh procedure requires that you copy the expanded ecm_help directory from the IBM 
FileNet P8 Platform Documentation CD over the existing documentation. This stipulation applies to all 
application servers, even those that required a WAR file for initial deployment of the existing 3.5.x 
documentation, namely WebSphere, Oracle, and Sun.

To refresh existing documentation without first uninstalling

1. Stop the server on which the existing documentation is deployed so that no processes can access the 
documentation.

2. On your application server, identify the deployment directory of the existing documentation. 

3. From the deployment directory, delete (or move to a safe location) the files located in 
<deployment_path>/ecm_help/search/index/core. This step removes the Search index, which you 
must recreate later for the newer set of documentation files.

4. From the IBM FileNet P8 Platform Documentation CD (or from an installation directory on your server 
where you've copied the contents of this CD), copy the expanded ecm_help directory over the 
deployed ecm_help directory.

NOTE  If you install any IBM FileNet P8 functional expansions as part of your upgrade (for example, 
Records Manager, IBM FileNet eForms, and Web Content Manager), perform this same procedure to 
refresh your functional expansion help.

5. Update the Search index as described in “Update Help Search Index” on page 309.
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6. Restart the server on which you refreshed the documentation.

Update 3.x.x IBM FileNet P8 Documentation by Uninstalling and Reinstalling

Use this option if you have 3.0.0 documentation currently installed and need to upgrade to 3.5.0, or if you 
have 3.5.0 IBM FileNet P8 Platform documentation installed without any functional expansion help.

To upgrade the IBM FileNet P8 Platform Documentation

1. Insert the IBM FileNet P8 Platform Documentation CD into the CD-ROM drive on, or have it accessible 
from, the machine where you intend to upgrade the documentation.

2. Update the documentation files from the CD or other location to your particular application server or 
installation location, as follows:

NOTE In environments where Windows NTFS is used, there is a 256 character limit on file and folder 
names (folder depth). When trying to delete an existing IBM FileNet P8 Platform documentation web 
site, you may encounter access denied errors. See Microsoft Knowledge Base article http://
support.microsoft.com/?kbid=320081 for more information.

On Oracle:

a. Stop the OC4J instance in which the IBM FileNet P8 Platform documentation application is run-
ning.

b. Undeploy the IBM FileNet P8 Platform documentation application from the OC4J instance.

NOTE  Undeploy should delete all of the deployed directories of the IBM FileNet P8 Platform 
documentation application. If there are some directories left behind, delete them manually.

c. If desired, copy the ecm_help.war file from the Documentation CD to a staging location from 
which to deploy the updated IBM FileNet P8 Platform documentation application. Alternatively, you 
can deploy the updated IBM FileNet P8 Platform documentation application directly from the CD.

d. Skip to “Deploy and Verify Documentation Web Site” on page 310.

On Sun Solaris:

a. Undeploy the IBM FileNet P8 Platform documentation application.

b. If desired, copy the ecm_help.war file from the Documentation CD to a staging location from 
which to deploy the updated IBM FileNet P8 Platform documentation application. Alternatively, you 
can deploy the updated IBM FileNet P8 Platform documentation application directly from the CD.

c. Skip to “Deploy and Verify Documentation Web Site” on page 310.

On WebSphere:

a. Uninstall the IBM FileNet P8 Platform documentation application from Enterprise Applications.

b. Delete the ecm_help_war folder from the <WebSphere_home>/WebSphere/AppServer/temp/
<node_name>/<server> directory. This step ensures that no temporary copies of existing help 
files remain on the machine after you install updated help files.

c. Copy the ecm_help.war file from the Documentation CD to the existing location on the application 
server (for example, to the ecm_help directory), or install directly from the CD.

http://support.microsoft.com/?kbid=320081
http://support.microsoft.com/?kbid=320081
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On WebLogic:

a. Undeploy and delete the IBM FileNet P8 Platform documentation application, removing the 
ecm_help directory. 

NOTE  You must stop the application server before you can delete the ecm_help directory.

b. Copy the ecm_help directory from the Documentation CD to the existing location on the applica-
tion server from which you just removed the old version of the directory.

On Tomcat:

a. Shut down the application server.

b. Remove the entire existing IBM FileNet P8 Platform documentation application directory.

c. Remove the temporary working directory for the IBM FileNet P8 Platform documentation applica-
tion from the <Tomcat_home>\work\Catalina\localhost directory.

d. Copy the ecm_help directory from the Documentation CD to the existing location on the applica-
tion server from which you just removed the old version of the directory.

On JBoss:

a. Shut down the application server.

b. Remove the entire existing IBM FileNet P8 Platform documentation application directory.

c. Remove the temporary working directory for the IBM FileNet P8 Platform documentation from the 
<JBoss_home>\work\MainEngine\localhost directory.

d. Copy the ecm_help directory from the Documentation CD to the existing location on the applica-
tion server from which you just removed the old version of the directory.

On a machine other than an application server:

a. Remove the entire existing ecm_help directory.

b. Copy the ecm_help directory from the Documentation CD to the existing location on the applica-
tion server from which you just removed the old version of the directory.

3. Update the documentation files from the CD or other location to your particular application server or 
installation location, as follows:

Update Help Search Index

Perform this procedure to update the Search index after you have installed all the IBM FileNet P8 Platform 
and functional expansion documentation on a supported application server.

To update the help Search index

NOTE  Perform this procedure only if you refreshed the core documentation, or you have installed 
functional expansion (or customized application) help onto your IBM FileNet P8 Platform documentation 
application server. Otherwise, skip to “Deploy and Verify Documentation Web Site” on page 310.

1. Make sure that the server is stopped on which the documentation is deployed, and that no processes 
are accessing the documentation.

2. If, for some reason, you have already deployed IBM FileNet P8 Platform documentation as a web 
application, undeploy that web application using the procedure for your application server.
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3. Make sure you have copied the help for all your various functional expansions to a designated 
application server location containing the IBM FileNet P8 Platform help. Otherwise, you will have to 
repeat this procedure if you add new help later.

4. Open a command prompt on the application server.

5. From the command line, navigate to the search subdirectory under your ecm_help root directory.

6. Using a text editor, open the search-indexing script file that is appropriate to your application server 
operating system:

(UNIX) indexFiles.sh

(Windows) indexFiles.bat

7. Modify the JAVA_HOME variable in the script file with the path to your JRE installation. The defaults are:

(UNIX) JAVA_HOME="/usr/java/j2sdk1.4.1_02"

(Windows) SET JAVA_HOME=c:\j2sdk1.4.2

8. Save your changes and close the text editor.

9. If you intend to run the search indexer on a UNIX application server, ensure that you add execute 
permissions (chmod 755) to the indexFiles.sh file.

10. Run the updated search-indexing script file.

By default, the script backs up the existing index files to indexOld, and then re-indexes all the help 
files starting from the root ecm_help directory.

NOTE  As you run the search-indexing script, you may notice periodic Parse Abort errors. You can 
ignore these error conditions, as they are benign and do not adversely affect the overall indexing 
process.

11. Go on to the next procedure.

Deploy and Verify Documentation Web Site

Perform this procedure after you have installed (and, if necessary, reindexed) the IBM FileNet P8 Platform 
documentation on a supported application server.

To deploy and verify the documentation web site

1. Deploy or install the copied IBM FileNet P8 Platform documentation as a web-site application. Use the 
appropriate instructions provided with your application server.

2. Verify that the application server and the new IBM FileNet P8 Platform documentation web site are 
running, as follows:

a. From your web browser, access the following URL. The documentation's Help Directory should 
open.

http://<docserver>:<port#>/<contextRoot>/

where:

docserver is the name of the Java web server.
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port# is the port number.

contextRoot is the value of the Map to URL field that you specified when you deployed the 
IBM FileNet P8 Platform documentation application. If you specified /ecm_help, then the 
contextRoot is ecm_help.

NOTE  You can use multi-part root folders (e.g., /docs/ecm_help) if your application server 
supports them.

b. Click the Search link on the Help Directory toolbar. The documentation Search page should open.

c. Select one of the Search query result links. The associated help page should open.

NOTE  When it is time to configure the online help location for the various IBM FileNet P8 components, 
either while running Setup programs or later via site preferences settings, use the URL in Step a on 
page 310.
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Task 2: Verify Current Release Level

Before you begin your IBM FileNet P8 Platform upgrade, you must first verify that your current system is 
running the software release and component patch levels supported for upgrade.

See the section “Plan the Upgrade” on page 296 for a list of upgrade paths, planning considerations, and 
pre-upgrade information and tasks that you must take into account, even before performing the task 
presented below.

To verify your IBM FileNet P8 system is ready for upgrade

1. Run the IBM FileNet P8 Platform 3.0.0 Version Tools. These tools will identify what release and patch 
level of IBM FileNet P8 software you are currently running. See the IBM FileNet P8 Platform 3.5.x Ver-
sion Tools Technical Notice to determine the minimum 3.0.0 patch levels required to upgrade to IBM 
FileNet P8 3.5.x. 

2. Ensure that all your users have closed their sessions and no longer have access to the system.

NOTE  You may choose to shut down all your IBM FileNet P8 Platform components as part of this step. 
(see the FileNet P8 Platform Shutdown and Startup topic at: FileNet P8 Administration > Enterprise-
wide Administration > Shutdown and Startup for instructions). However, be aware that some 
components (e.g., Content Engine) must be running to begin the actual upgrade process, so the 
associated setup programs will restart the software as needed.
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Task 3: Upgrade Oracle for Content Engine and Process Engine

Refer to the IBM FileNet P8 Hardware and Software Requirements for operating-system Service Pack and 
Oracle9i version and patch set requirements.

To upgrade Oracle

1. Install the required operating system patches or Service Pack on each Oracle database server. 

2. Download all the required Oracle9i database server patches from OracleMetaLink and install them.

After completing this Oracle upgrade, continue as follows:

• If the database is local to Process Engine and/or Content Engine software, continue at Task 5 on page 
315. 

• If the database is remote, then update the Oracle Client software as indicated in Task 4 on page 314.

http://metalink.oracle.com
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Task 4: Upgrade Oracle Client for Content Engine and Process Engine

Complete this task on all machines where Content Engine, Process Engine, and IBM FileNet Enterprise 
Manager software accesses a remote Oracle database via Oracle Client. If your database is local, skip this 
task and continue at Task 5 on page 315, “Upgrade Content Engine”.

Refer to the IBM FileNet P8 Hardware and Software Requirements for operating-system Service Pack and 
Oracle9i version and patch set requirements.

To upgrade Oracle Client

1. Install the required operating system patches or Service Pack on each machine where Oracle Client is 
installed. 

2. Download all the required Oracle9i Client patches from OracleMetaLink and install them. 

After completing this Oracle Client upgrade, continue at Task 5 on page 315 to upgrade Content Engine.

http://metalink.oracle.com
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Task 5: Upgrade Content Engine

Upgrading Content Engine from IBM FileNet P8 3.0.0 to 3.5.0 involves the following major steps:

• Stop all Content Engine-related services.

• Upgrade the Content Engine software (including Apache HTTP) on each machine where it is installed 
and update the Global Configuration Database (GCD).

• Reset the permissions for the P8Apache user on each machine where Object Store Service is 
installed.

• Upgrade the database corresponding to each object store.

In general, a machine in the FileNet P8 domain will contain one or more components of the Content 
Engine software. The first machine to be upgraded must be one that contains a Content Engine Object 
Store Service, which you can determine by looking for a Content Engine Object Store Service entry in the 
Services node of Windows Computer Management. After upgrading this machine, you can upgrade (in any 
order) the Content Engine software on the other machines (including standalone Enterprise Manager or 
Client Connectivity clients such as Capture) in the FileNet P8 domain.

NOTES

• The IBM FileNet P8 3.5.0 installer (which runs when you upgrade Content Engine) uninstalls the IBM 
FileNet P8 3.0.0 Content Engine software automatically and then installs the IBM FileNet P8 3.5.0 
Content Engine software. You may need to restart the machine after the upgrade completes if you 
have installed (as part of the upgrade) additional components.

• You do not need to check in checked-out documents before upgrading Content Engine software.

• To upgrade Content Engine software, you must be logged on as a local administrator and as a domain 
user and be logged onto the Active Directory domain in which the Content Engine software has been 
installed. You must also know the existing password of the FNCE_<machine_name> user that runs the 
Content Engine services and COM+ application.

• Back up the database before upgrading any Content Engine software.

• Back up each machine where you will be upgrading Content Engine software.

• Stop all FileNet P8 services, including Apache2, before upgrading any Content Engine software. This 
will ensure that no user is accessing the system while the upgrade is in progress.

• If you run the upgrade software over a network (rather than using a CD), you must map a network drive 
to the location of the upgrade software. Otherwise, the upgrade will fail when the machine restarts to 
continue with the configuration of Content Engine.

• During a Content Engine upgrade of Object Store Service from IBM FileNet P8 3.0.0 to 3.5.0, the 
upgrade process makes a backup copy of Windows registry keys that are in

HKEY_LOCAL_MACHINE\system\CurrentControlSet\Services\VWServices

and saves them in 

HKEY_CURRENT_USER\SOFTWARE\FileNet\ECM\Content Engine\VWServicesBak.

The registry keys might have customized data modified by other applications, such as Process Engine. 
If you have altered this data since installing IBM FileNet P8 3.0.0 and you want it to apply to the 
upgraded IBM FileNet P8 Platform installation, manually copy the registry keys from the backup after 
the Content Engine upgrade completes.
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• Take note of the directory where the Apache HTTP Server is installed on Object Store Service 
machines. You must install the updated Apache HTTP Server within this directory.

• You must have created a P8Apache user before doing this Content Engine upgrade if you haven’t 
already done so, as documented in the topics “Install Content Engine (Typical)” and “Install Content 
Engine (Custom)” in IBM FileNet P8 Platform Installation Guide Release 3.0.0.

Stop all Content Engine-related services

WARNING Before shutting down the Content Engine-related services, allow all ongoing transactions to 
complete. Transactions are complete when the transaction log files in C:\ProgramFiles\FileNet\
ContentEngine\Log\ contain zero bytes.

You can also verify that all transactions have been processed by launching IBM FileNet Enterprise 
Manager and doing the following for each object store:

1. In the list view, under the object store icon, select and right-click the Search Results folder, and choose 
New Search.

2. In the Content Engine Query Builder dialog box, choose QueueItem from the Select From Table list.

3. Leave all default settings as is and click OK.

4. If there are any event items remaining in the queue, you will see them in the Query Status dialog box. 
If no event items appear, then all events have been processed.

Shut down all Content Engine-related services on all servers in the FileNet P8 domain

1. Log on as a local administrator on all machines where IBM FileNet Content Engine server software is 
installed.

2. Stop the following services:

• Content Engine Object Store Service

• Content Engine File Store Service

• Content Engine Content Cache Service

• Wasp Server for Java

• FileNet Publishing HTML Plug-in Service

• Process Engine Services Manager

• Apache2

3. Right-click the Apache services monitor in the Windows system tray and click Exit.

For procedures and further details, see the Shutdown and Startup Procedures for the FileNet P8 Platform 
3.0.0 Components Technical Notice. This help topic describes how to shut down and restart IBM FileNet 
P8 Platform components and some functional expansions. Manual, command line, and some sample 
batch file procedures are provided.

To upgrade Content Engine software

Starting with any machine where Content Engine Object Store Service is installed, run the following 
upgrade procedure on each server where Content Engine software is installed. On machines where a 
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standalone IBM FileNet Enterprise Manager is installed, refer instead to “Upgrade IBM FileNet Enterprise 
Manager (standalone)” on page 336 for upgrade instructions.

1. Log on to the Windows server as a user who is both a local administrator and a domain user in the 
domain where Content Engine software is deployed.

2. If it is not already running, start the Microsoft Distributed Transaction Coordinator. (Choose Start > 
Programs > Administrative Tools > Services, right-click Distributed Transaction Coordinator, and 
choose Start.)

3. Insert the IBM FileNet P8 Content Engine 3.5.0 CD into the CD drive, navigate to the ContentEngine 
folder, and click setup.exe. The Content Engine Setup wizard opens.

NOTE If Process Engine software is on this machine, the Content Engine Setup wizard will display a 
message informing you of the possibility that a Process Engine-related registry key “might have 
customized data that you want to apply to the upgraded system”. Click OK.

4. Complete the Setup screens as follows:

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine upgrade.

License Agreement Review and accept the license agreement for IBM FileNet P8 
software products, and then click Next.

Minimum Requirement This screen appears only if the server where you are installing 
Content Engine software does not meet the suggested minimum 
system requirements posted in the IBM FileNet P8 Hardware and 
Software Requirements.

Click Next if you wish to proceed with the installation, or click Cancel 
to exit the wizard.

Customer Information Type your user name (required) and organization (optional). Accept 
or change the default install log location, and then click Next.

Custom Setup Note the Content Engine components that will be upgraded. Select or 
deselect any components to upgrade (but do not deselect Object 
Store Service), and then click Next.

NOTE If you wish to install Content Federation Services Server for 
Image Services, you’ll need the path to the CD for this component.

WebDAV Configuration This screen appears only if you selected Content Engine WebDAV 
Provider at the Custom Setup screen.

Type a Windows domain account (which must be in the same domain 
where Content Engine resides) and password, and then click Next.

NOTE This account is used for Microsoft Internet Information Server 
(IIS) logon authentication (not for Content Engine or object stores).

Install third-party software This screen appears only if you have not already installed third-party 
software required by Content Engine: MDAC and Apache HTTP 
Server.
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Ready to Install Do the following:

a. If you already have an IBM FileNet P8 Platform Documenta-
tion web site installed, you can configure Content Engine 
components to access it, as follows.

NOTE If you don’t yet have a documentation web site 
installed, the wizard will put an empty documentation icon on 
the system desktop. You can update the documentation URL 
(and the documentation icon) from IBM FileNet Enterprise 
Manager.

i. Select the provided check box.

ii. Type the URL of the web site in the following format:

http://<docserver>:<port#>/<ecm_help>)

where:

docserver is the name of the Java web server

port# is the port number

ecm_help is the root folder of the documentation web site

You can use multipart root folders if your application 
server supports them (e.g., /docs/ecm_help). 

iii. Click Test to verify that the browser opens at the docu-
mentation URL. Then exit the browser.

b. Click Install to install Content Engine. (The installation will 
take several minutes.)

P8 Domain Information Record the information in the window, and then click OK.

Content Engine Global 
Configuration Data

Type the existing password of the FNCE_<machine_name> 
Windows Service Logon account and then click Next.

NOTE If you have a Windows Service Logon account (for Content 
Engine services logon and the COM+ application) having fewer than 
13 characters, you will see an error message (saying there is no such 
object on the server) when you click Next. To work around this error, 
exit the wizard, and skip to the procedure “To edit the Windows 
registry” on page 319.

The wizard will now re-create all Content Engine-related services 
(including Apache2).

If it is not already running, start the Content Engine Object Store 
Service.

In this screen... Perform this action...
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5. Launch IBM FileNet Enterprise Manager and log on as the (fully distinguished) user that you logged on 
as in the AddOns wizard screen. If the logon fails, try logging on as another GCD administrator. 

A logon is successful if the Create New Object Store toolbar icon is enabled when you click the Object 
Stores folder icon in the tree view of IBM FileNet Enterprise Manager.

6. On a command line, run the following command (where C: is the installation drive letter):

C:\Program Files\FileNet\Content Engine\ConfigGCD -A

7. If the AddOns dialog box opens, continue at Step 8. If instead you are prompted to supply a Windows 
service user, do the following:

a. Launch the Windows registry editor (regedit).

b. Delete the registry key HKLM\Software\FileNet\ECM\CurrentInstalling\Upgrade.

c. Return to Step 6.

8. In the AddOns dialog box, specify the same user (and password) that successfully logged on to IBM 
FileNet Enterprise Manager in Step 5. Then click Finish to load the AddOns containers. If you are still 
unable to load the AddOns, contact your IBM services representative.

9.  If you have installed Content Federation Services Server for Image Services, you must reboot the 
machine.

10. Manually copy the Windows registry key HKEY_CURRENT_USER\SOFTWARE\FileNet\ECM\
Content Engine\VWServicesBak to the key HKEY_LOCAL_MACHINE\system\CurrentControlSet\
Services\VWServices.

11. If you have upgraded the Content Engine software on every server in the FileNet P8 domain, continue 
at “To reset permissions for the P8Apache user” on page 320; otherwise, choose the next machine 
where Content Engine software needs to be upgraded, and then return to Step 1. The sequence of 
wizard prompts you encounter will depend on which Content Engine software components you are 
upgrading.

To edit the Windows registry

Perform this procedure on any Content Engine server where an error message appeared when you 
specified a password and clicked Next at the Content Engine Global Configuration Data screen of the 
Content Engine Setup wizard (Step 4 of “To upgrade Content Engine software” on page 316).

1. Open the Windows registry on the Content Engine server.

AddOns Type a user name and password for a GCD administrative account, 
and then click Finish.

If the logon is successful, the AddOns will be loaded into the FileNet 
P8 domain, and a message box will announce the successful 
configuration of the GCD and Content Engine. In this case, click OK 
and continue at Step 9. 

Otherwise, click Cancel and continue at Step 5 to find an IBM FileNet 
P8 Administrator user that can successfully log on to IBM FileNet 
Enterprise Manager.

In this screen... Perform this action...



INSTALLATION AND UPGRADE GUIDE
Upgrade Content Engine

320
2. Navigate to HKEY_CURRENT_USER\Software\FileNet\ECM\Content Engine\GCDValues.

3. Locate the "Windows Service Account" key. The value of this key is most likely of the form 
<username>. Replace the key value with the following (in Windows SamAccount format): 

<windows domain>\<username>

NOTE The value of windows domain can be any string value, as long as it is followed by a slash (“\”).  
The value and slash will be stripped off when you re-run the GCD Wizard after the registry change.

4. (Windows 2000 only) Reboot the machine.

5. Continue at Step 3 of “To upgrade Content Engine software” on page 316.

To reset permissions for the P8Apache user

The authentication-domain P8Apache user logging on to the Apache2 service needs permissions on 
certain installed Apache folders. Run the following procedure on each server where Object Store Service is 
installed. You must use the P8Apache-designated Windows domain user you used in IBM FileNet P8 
Content Engine 3.0.0.

1. Navigate to the Apache installation folder (default location is Program Files\Apache 
Group\Apache2).

2. Give the Windows-domain P8Apache user the following rights to the script and document folders (\cgi-
bin and \htdocs): Read and Execute, List Folder Contents, and Read.

3. Give the Windows-domain P8Apache user the following rights to the Apache logs (\logs) folder: Read 
and Execute, List Folder Contents, Read, and Write.

4. Give the Windows-domain P8Apache user the following rights to the Apache.exe executable file 
(default location is Program Files\Apache Group\Apache2\bin\Apache.exe): Read and Execute, 
and Read.

5. Select Start > Programs > Administrative Tools > Services, right-click the Apache2 service, and 
stop the Apache2 service.

6. Right-click the Apache2 service, select Properties, select the Log On tab, and click This account.

7. Browse for or type the P8Apache user, type and confirm the password, and then click OK.

8. Click OK if the P8Apache user now has the privilege to log on as a service.

9. Select the General tab and click Start to start the Apache2 service.

10. Close the Apache2 Properties dialog box and the Services snap-in.

To upgrade the object stores

The running time of the object-store upgrade utility, FNCEUpgrade, depends on the number of objects to 
be upgraded. If the object store contains a large number (on the order of millions) of objects, 
FNCEUpgrade may run for many hours.

WARNING Do not stop FNCEUpgrade while it is running; otherwise, the object store being upgraded may 
become unusable. Also, for an Oracle database, be sure that you have sufficient space for the undo 
tablespace (which should have autoextend specified, as it will grow quite large when the object store 
contains millions of objects).

While FNCEUpgrade is running, you can gauge its progress by checking the database CPU activity and 
disk I/O. Tracing database events can also provide some information on the progress of the upgrade.
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Run the following procedure only once in your FileNet P8 domain.

1. Log on as a local administrator to a machine where an Object Store Service is installed. The local 
administrator must also be a domain user in the domain where Content Engine is deployed.

2. (SQL Server only) For more reliable database connectivity to SQL Server-based object stores, IBM 
strongly recommends that you enable TCP/IP Sockets, rather than Named Pipes, as the network 
protocol for the SQL Server client Net-Library. You can do this using the utility Cliconfg.exe, supplied 
with MDAC 2.8 and installed during Content Engine upgrade. Create a SQL Server alias if your SQL 
Server installation is a named instance or runs remotely and uses a non-default port.

3. Run the IBM FileNet P8 3.5.0 upgrade utility FNCEUpgrade.exe (default location C:\Program 
Files\FileNet\Content Engine).

4. In the Login box, type the user name and password for a GCD administrative account who is also an 
object store administrator for the object store you are upgrading. The upgrade utility will populate the 
list of object store servers and the list of object stores in the FileNet P8 domain.

5. Select an object store server (from among the Object Store Service servers) and an object store from 
the lists and click Upgrade. Then click OK in the message box that announces the successful upgrade 
of the object store.

6. (Oracle only). The upgrade utility prompts you to choose whether to drop unused table columns or not. 
Whatever your choice, these columns will be marked “unused” by Oracle (meaning that they are 
invisible but still present).

Only as part of the last step in the object store upgrade will Oracle actually drop the unused columns, if 
that was your choice. If you chose not to drop the columns, you can still do so later by running the 
following two-line SQL script. To run this script you must be the same Oracle user who created the 
object store, or another Oracle user with administrative privileges and the same default tablespace.

ALTER TABLE CvlElement DROP UNUSED COLUMNS;
ALTER TABLE Subscription DROP UNUSED COLUMNS;

Whether you have chosen to drop the columns now or later, the object store will be usable while the 
column drop is in progress.

7. Check the log file at (default location is %systemroot%\temp) on the machine where you are running 
the upgrade. This log file records the cumulative results of database actions associated with the 
upgrade utility.

8. Click OK to confirm a successful upgrade.

9. Repeat Step 5 through Step 8 for each object store and file store in the system.

NOTE If the upgrade of an object store times out (as indicated by an error code of 0x8004e002 or 
0x80004005 in a pop-up message box), navigate to Component Services/Computers/My Computer/
Properties/Options/Transaction Timeout in Microsoft Distributed Transaction Coordinator, and specify 
a larger timeout interval (for example, 300 seconds). Then reboot the machine, and repeat the 
upgrade. Be sure to restore the original value of the timeout interval (usually 60 seconds) after the 
Object Store upgrade is complete.

10. When all object stores are upgraded, choose Yes to exit the FNCEUgrade.exe program.

Continue at ““Upgrade Process Engine (Unix)” on page 322 or “Upgrade Process Engine (Windows)” on 
page 325.
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Task 6: Upgrade Process Engine (Unix)

Stop all Process Engine-related services and applications

1. Log on as root.

2. If the PPM and/or any routers are currently configured for automatic startup, set them for manual 
startup. Set the PPM and any routers to manual startup if they are currently configured to autostart. 
See “Enabling automatic startup” in Help for Task Manager for details. After you have finished 
upgrading Process Engine, you can reconfigure the PPM and/or routers for automatic startup.  

3. Stop the following components if they are running:

• Process Simulator

• Process Analyzer

• Custom applications that require a router

• Component Manager 

• Routers 

• Content Engine

• Pooled Process Manager (PPM)

• Process Service 

• Process Task Manager

For more information on shutting down the 3.0 software, see the topics under FileNet P8 Administration 
> Enterprise-wide Administration > Shutdown and Startup in the IBM FileNet P8 documentation. 
These topics describe how to shutdown and restart IBM FileNet P8 Platform components and some 
functional expansions. Manual, command line, and some sample batch file procedures are provided.

4. Enter the following at a command prompt after the FileNet software is shut down: 

killfnsw -D -A -y -S

5. On AIX, execute the following:

slibclean

Update Process Engine (UNIX)

1. Verify that there is a current system backup.

2. Log on to the server as the root user.

3. Insert the Process Engine CD. Using the procedures appropriate for your operating system, execute 
setup.sh.

4. When prompted, enter the Oracle sys password. The password is required to run the following SQL 
scripts: pe_upgrade_scripts.sql, pe_create_stored_procedures.sql, and pe_grant_sp_permissions.sql. 

These scripts recreate a set of stored procedures that were initially created during installation of 
Process Engine 3.0.0. Running these scripts prior to upgrading ensures that any changes made to the 
stored procedures since 3.0.0 will be reflected in your database. For further information about these 
scripts, see “Process Engine SQL Scripts (Oracle databases only)” on page 369.
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NOTE If you enter the password incorrectly, sqlplus will re-prompt for the user name, which you must 
enter exactly as: 

sys as sysdba 

The password prompt then re-displays; re-enter the sys password. The scripts then run; output will be 
spooled to the directory you executed the scripts from.

If an error message indicates that execution of the scripts failed, you must resolve the errors and re-run 
the scripts. Process Engine Setup cannot run successfully until these scripts have run.

5. Wait for files to finish unpacking.

6. Click Next at the Welcome screen.

7. Review and accept the license agreement for IBM FileNet P8 software products and then proceed with 
installation.

8. Enter the Documentation Server URL, which is where the IBM FileNet P8 Platform Documentation was 
installed. Your entry must be in the following format:

http://<docserver:port#>/<ecm_help>

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation website. You can use multi-part root folders 
(e.g.,/docs/ecm_help) if your application server supports them.

9. Indicate whether you want to configure the Rules Engine interface to run on this Process Engine.

• Click Yes if the iLog JRules software is already installed on this computer or if you know where on 
this computer JRules will be installed later. Setup then prompts you for the full path to the iLog 
JRules software installation directory. 

• Click No if the JRules software is not and will not be installed on this computer, or if you do not 
know exactly where on this computer JRules will be installed later. 

For details on completing the Rules Engine integration setup after the IBM FileNet P8 Platform 
upgrade is complete, see “Enable Rules Engine Integration” in the IBM FileNet P8 Platform 
Installation Guide.

10. A list of components and disk space requirements displays. Click Next.

11. Installation starts; when it completes, click Finish.

12. Check all log files and verify that there were no errors or failures. Correct any errors before proceeding. 
Log files to check include:

• All .lst and .log files in the /fnsw directory

• All .log files in the /fnsw/local/logs/PE directory

Set file permissions

Execute fn_setup -d / to set file permissions.
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Verify Oracle Version Number

1. Open a new X window and log on as the fnsw user. Start the configuration editor by entering the 
following:

fn_edit &

2. Click Relational Databases. The Oracle sub-tab should be on top.  If not, click the Oracle sub-tab to 
bring it to the front.

3. Scroll to the right and locate the Version Number field, which reflects the version of the Oracle server 
software.

4. If necessary, change the version number to reflect the version of Oracle currently installed.

Enable ports

When Solaris starts up, it takes the first several ports, called anon ports, to use for its communication 
daemons. By default, the maximum tcp_smallest_anon_port is 32768. IBM FileNet uses several ports 
higher than 32768.  See “IBM FileNet P8 Port Numbers” on page 364 for details on which ports IBM 
FileNet uses.

To use these ports on Solaris-based systems, you must first enable the ports by setting the smallest anon 
port to 32777. By doing so, the ports used by Solaris communication daemons will be 32777 or greater, 
leaving 32776 and lower available for IBM FileNet use.

The Solaris platform provides several different tools such as the netstat command to determine if a port is 
in use.

To determine the current tcp_smallest_anon_port setting enter the following at the command prompt:

ndd -get /dev/tcp tcp_smallest_anon_port

If the port is less than 32777, you must enable port 32776.

To enable port 32776 on Solaris, use a text editor to edit the /etc/rc2.d/S69inet file. 

Enter the following line: 

ndd -set /dev/tcp tcp_smallest_anon_port 32777

Reboot the Process Engine server. 
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Task 7: Upgrade Process Engine (Windows)

Stop all Process Engine-related services and applications

1. Log on as fnsw.

2. If the PPM and/or any routers are currently configured for automatic startup, set them for manual 
startup. Set the PPM and any routers to manual startup if they are currently configured to autostart. 
See “Enabling automatic startup” in Help for Task Manager for details. After you have finished 
upgrading Process Engine, you can reconfigure the PPM and/or routers for automatic startup.

3. Stop the following components if they are running:

• Process Simulator

• Process Analyzer

• Custom applications that require a router

• Component Manager 

• Routers 

• Content Engine

• Pooled Process Manager (PPM)

• Process Service 

For more information on shutting down the 3.0 software, see the topics under FileNet P8 Administration 
> Enterprise-wide Administration > Shutdown and Startup in the IBM FileNet P8 documentation. 
These topics describe how to shutdown and restart IBM FileNet P8 Platform components and some 
functional expansions. Manual, command line, and some sample batch file procedures are provided.

4. Enter the following at a command prompt after the IBM FileNet software is shut down: 

killfnsw -D -y -S

5. In the Services dialog box, stop the following services if they are running, and set them to manual 
startup.

• IMS ControlService (Process Engine)

• Process Engine Services Manager (Process Engine and Content Engine)

• CWConnector FileNet PE Connector (EAI only, on Process Engine, not required for 3.5.0)

• VisiBroker Smart Agent (EAI only, on Process Engine, not required for 3.5.0)

• VMAE Publisher service (Process Analyzer)

• AEEngine service (Process Analyzer)

Reset the fnsw password to the default value

The fnsw user’s password must be reset to the default value of BPMPassword1 before running Process 
Engine setup for the upgrade. After you change the password for the fnsw user, you must also use the 
Windows Services tool to update the Log On tab for the IMS ControlService and the Process Engine 
Services Manager accordingly.  If the password is not changed before the upgrade, the upgrade will fail.  
After successfully upgrading Process Engine, reset the password again.
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Update Process Engine (Windows)

1. Verify that there is a current system backup. 

2. Log on as fnsw.

3. Insert the Process Engine CD. If Autorun is enabled, the Setup program will start. Select Process 
Engine. Otherwise, execute Setup.exe. 

4. Click Next on the Welcome screen. Review and accept the license agreement for IBM FileNet P8 
software products and then proceed with installation.

5. Enter the Documentation Server URL, which is where the IBM FileNet P8 Platform Documentation was 
installed. Your entry must be in the following format:

http://<docserver:port#>/<ecm_help>

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation website. You can use multi-part root folders 
(e.g.,/docs/ecm_help) if your application server supports them.

6. Indicate whether you want to configure the Rules Engine interface to run on this Process Engine.

• Click Yes if the JRules software is already installed on this computer or if you know where on this 
computer JRules will be installed later. Setup then prompts you for the full path to the iLog JRules 
software installation directory.   

• Click No if the JRules software is not and will not be installed on this computer, or if you do not 
know exactly where on this computer JRules will be installed later. 

For details on completing the Rules Engine integration setup after the IBM FileNet P8 Platform 
upgrade is complete, see “Enable Rules Engine Integration” in the IBM FileNet P8 Platform 
Installation Guide.

7. (Oracle only) When prompted, enter the Oracle sys password. A number of Oracle scripts then run, all 
contained within a script called pe_upgrade_script.sql. See “Process Engine SQL Scripts (Oracle 
databases only)” on page 369 for details on those scripts.

NOTE If you enter the password incorrectly, sqlplus will re-prompt for the user name, which you must 
enter exactly as: 

sys as sysdba 

The password prompt then re-displays; re-enter the sys password. The scripts then run; output will be 
spooled to the directory you executed the scripts from.

If an error message indicates that execution of the scripts failed, you must resolve the errors and re-run 
the scripts. Process Engine Setup cannot run successfully until these scripts have run. 

8. Click Finish when all Process Engine files have been copied to the server.

9. Check all log files and verify that there were no errors or failures. Correct any errors before proceeding. 
Log files to check include:

• All .lst files in the <install drive>:\fnsw directory (Oracle databases only)

• All .log files in \fnsw_loc\logs directory and subdirectories
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10. Restart the computer.

11. Recreate Windows desktop shortcuts for Process Task Manager.  Using an old shortcut will return an 
error indicating the wrong version of Java was used when attempting to start a router.

12. Reset the fnsw user’s password.  After you change the password for the fnsw user, you must also use 
the Windows Services tool to update the Log On tab for the IMS ControlService and the Process 
Engine Services Manager accordingly.  

13. Start the following services and set them back to automatic startup.

• IMS ControlService

• Process Engine Services Manager 
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Task 8: Upgrade Application Engine

This task includes Application Engine upgrade instructions for WebSphere and WebLogic (UNIX and 
Windows), JBoss, and Tomcat (Windows).  

Before you upgrade Application Engine

1. Upgrade Content Engine and Process Engine. 

2. Review the Application Engine details of the “Upgrade Overview” on page 297 and verify that you have 
recorded all necessary settings as outlined in “Application Engine / Workplace” on page 302.

WARNING If you want to retain your existing Application Engine settings, it is essential to the success 
of the upgrade that you have recorded all necessary settings, and backed up the relevant configuration 
files before you start the upgrade installation.

• Some of the existing preference files will be overwritten as part of the upgrade procedure. 

• The existing Actions.xml and web.xml files will be merged with the 3.5.0 versions the very first time 
the Workplace page is initiated after being deployed. 

• In addition, all comments added to the Actions.xml file will be lost during the merge. 

You will make backup copies of all important configuration files in “Backup, undeploy, and remove the 
Workplace web application from the J2EE application server.” on page 329.

3. If necessary, upgrade the J2EE application server software. For information about supported 
application servers for Application Engine 3.5.0, see the IBM FileNet P8 Hardware and Software 
Requirements.

To upgrade Application Engine

1. Log on to the application server:

UNIX - logon as root.

Windows - log on as a member of the local Administrators group or a user with equivalent 
permissions.

2. Make sure the Process Router is stopped in the Process Task Manager.

a. Launch the Process Task Manager.

b. Stop the running router.

NOTE  This is the router configured and started as part of the IBM FileNet P8 Platform 3.0.0 
installation. For more information, see IBM FileNet P8 Platform Installation Guide, Release 3.0.0x, 
Task 16: Start the Process Router.

c. Exit the Process Task Manager.

3. (Windows only) Use Windows Task Manager to verify that the javaw.exe process is not running.

If there is one or more javaw.exe processes running, do the following:

a. Use either of the two methods below to identify the directory path to the javaw.exe process. 

• Download and run Process Explorer for Windows, available from http://www.sysinternals.com. 
The software does not require installation.

http://www.sysinternals.com
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Find and select the javaw.exe process in Process Explorer. In the bottom window, look for the 
path identified in Step b below with Type = File. You may have to scroll down to find the path as 
there will be other directory paths in the window.

• Follow the instructions found in Microsoft Knowledge Base Article 295714: How to Break 
Down the System Process to find the directory path for the javaw.exe process. 

The article is available at http://support.microsoft.com.  

NOTE  This method will require you to install software available as part of the Windows 2000 
installation set.

b. If you find a javaw.exe process with the directory path <AE_install_path>\_jvm\bin, use the Win-
dows Task Manager or the application you are running to kill the process. 

4. Backup, undeploy, and remove the Workplace web application from the J2EE application server.

NOTE  During this step you will create backup copies of all configuration files stored in the /WEB-INF 
directory in your deployed Workplace folder. You will use these files in “(Optional) Copy the retained 
configuration files.” on page 331 below if you would like to retain your previous settings.

• WebSphere

i. Make a backup copy of the deployed Workplace directory: 

<WAS_HOME>/installedApps/<node_name>/app_engine_war.ear/app_engine.war

ii. Stop the Workplace Application from the admin console.

iii. Uninstall the Workplace application from Enterprise Applications. 

iv. Save the changes and stop the WebSphere server.

v. Delete the temp Workplace directory (default: app_engine_war) from: 

<WebSphere_home>\WebSphere\AppServer\temp\<Node_name>\<Server>\app_engine
_war

• WebLogic 7.0.x

i. From the WebLogic administration console stop the Workplace Web Application.

ii. Make a backup copy of the Workplace folder:

<AE_install_path>/FileNet/Workplace 

iii. Undeploy and delete the Workplace Web Application.

iv. Stop the WebLogic server.

• WebLogic 8.1.x

i. From the WebLogic administration console stop the Workplace Web Application Module.

ii. Make a backup copy of the Workplace folder:

<AE_install_path>/FileNet/Workplace 

iii. Delete the Workplace Web Application Module.

iv. Stop the WebLogic server.

http://support.microsoft.com
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• JBoss

i. Stop the JBoss server.

ii. Make a backup copy of the deployed Workplace directory: 

<JBoss_HOME>/server/default/deploy/Workplace.war

iii. Delete the deployed Workplace directory: 

<JBoss_HOME>/server/default/deploy/Workplace.war

iv. Delete the temporary Workplace directory for JBoss:

<JBoss_HOME>\server\default\work\MainEngine\localhost\Workplace

• Tomcat 

i. Stop the Tomcat server.

ii. Make a backup copy of the deployed Workplace directory: 

<Tomcat_HOME>\webapps\Workplace

iii. Delete the deployed Workplace directory: 

<Tomcat_HOME>\webapps\Workplace

iv. Delete the temporary Workplace directory for Tomcat: 

<Tomcat_HOME>\work\Catalina\localhost\Workplace

5. Upgrade the Application Engine software. 

a. Run the Application Engine installer to upgrade your installation. 

For more information, see “Install Application Engine” on page 205.

NOTE  When you run the installer to upgrade Application Engine a confirmation screen will appear 
to verify there is a version of Application Engine installed that can be upgraded. Also, be aware 
that the following installer screens will not appear on an upgrade: 

• Choose an application server

• Content Engine Java API Configuration 

• Application Engine User Security 

• User Token Security 

• Documentation Configuration

• Folder Location of bootstrap.properties 

b. Re-deploy, configure, and start Application Engine: 

• WebSphere - See “Configure and start Application Engine (WebSphere)” on page 213.

• WebLogic - See “Configure and start Application Engine (WebLogic)” on page 220.

• JBoss/Tomcat - See “Configure and start Application Engine (JBoss/Tomcat)” on page 223.
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6. (Optional) Copy the retained configuration files.

CAUTIONARY NOTES 

• This step must be performed after you have deployed the application but before you bring up the 
Workplace login page for the first time.

• If you have made custom add-ons or modifications to the Application Engine installation being 
upgraded and any of these changes are referenced from the configuration files you should not 
include these changes in the Actions.xml and/or web.xml files until you have modified the newly 
installed Application Engine code with your add-ons or modifications. If you want to retain any 
other custom modifications to the Actions.xml and web.xml files you must manually copy the data 
from the version 3.0.0 backup files to the upgraded files listed above, after you have logged into 
Workplace. For more information see “Manually copy custom data.” on page 332 below. 

Any configuration files in the deployed directory that you had manually modified must be added back 
by replacing the newly created files with the backup copies you created in “Backup, undeploy, and 
remove the Workplace web application from the J2EE application server.” on page 329. 

Example: If you have enabled symmetric encryption after you first installed Application Engine you 
have added configuration details about the CryptoKeyFile.properties file and its location to the 
WcmApiConfig.properties file.

To copy the backed up configuration files:

For each of the files listed below copy the backup version of the file that you created in “Backup, 
undeploy, and remove the Workplace web application from the J2EE application server.” on page 329 
to the \WEB-INF folder in the deployed directory on your application server, overwriting the newly 
created corresponding file.

• Actions.xml 

• Infopages.xml 

• web.xml 

• WcmApiConfig.properties

• (If you use eForms) PolicyProcessors.xml

NOTE  For WebLogic there is normally no need to copy these files. By default the deployed directory is 
identical to the installed directory.

7. Reset bootstrap preferences.

Follow the instructions in “Set bootstrap preferences” on page 238 to reset your bootstrap properties. 
Use the notes you made of your bootstrap settings in “Application Engine / Workplace” on page 302 to 
complete this step. 

8. Restart the application server.

a. Stop the application server.
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b. (WebSphere only) Copy the web.xml file:

Copy the web.xml file located in:

<WAS_HOME>/installedApps/<node_name>/app_engine_war.ear/app_engine.war/
WEB-INF/

to: 

<WAS_HOME>/config/cells/<cell_name>/applications/app_engine_war.ear/
deployments/app_engine_war/app_engine.war/WEB-INF/

c. Start the application server.

9. (Actions.xml and web.xml files only) Verify that any custom changes made to the Actions.xml and 
web.xml files are retained.

CAUTION  If you have made custom modifications to the Actions.xml and/or web.xml files and would 
like to retain these changes after the upgrade, verify that the custom settings have been properly 
merged to the file(s). Do this after the initial sign into Workplace (Step 7) and restart of the application 
server (Step 8).

The Application Engine upgrades the .xml files when the Workplace site is brought up for the first time 
after deploying the upgraded Application Engine. New configuration files are created by merging the 
data stored in the existing web.xml and Actions.xml files with new configuration data stored in 
UpdateActions.xml and UpdateWeb.xml. 

The old files (the backup files you copied in Step 6 on page 331) are retained as backup copies in the 
\WEB-INF folder in the deployed directory on your server:

• <ApplicationServer_HOME>\...\WEB-INF\web.xml.old

• <ApplicationServer_HOME>\...\WEB-INF\Actions.xml.old

a. Verify custom changes.

After logging in, verify that all custom changes made in the Actions.xml and web.xml files were 
successfully transferred to the new files created by the installer in the \WEB-INF folder in the 
deployed directory on your server:

• <ApplicationServer_HOME>\...\WEB-INF\web.xml

• <ApplicationServer_HOME>\...\WEB-INF\Actions.xml

NOTE  Any comments added to the Actions.xml file will be lost during the merge. 

b. Manually copy custom data.

If your custom data was not retained in the upgrade you must manually copy the data from the 
version 3.0.0 backup files (<filename>.xml.old) to the upgraded files (<filename>.xml) listed above.

CAUTION  After you have modified the files, you must restart the application server for the 
changes to take effect.

NOTES  

• You must also copy any data you want to retain if you have made any custom add-ons or mod-
ifications to the Application Engine installation being upgraded and chose not to keep these 
changes after the upgrade, see Step 6 on page 331. Manually copy any other custom data you 
want to retain to the upgraded files listed above.
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• If your customizations include extended characters, save the web.xml or Actions.xml file as a 
UTF-8 encoded file. 

10. Start a Process Router for each working isolated region.

Process Router configuration data that existed prior to the Application Engine upgrade no longer 
exists, so you must re-enter it at this point. Use the settings you recorded earlier in the “Gather Pre-
upgrade Information” section under “Application Engine / Workplace” on page 302. For more 
information, see “Start Process Routers” on page 242.

11. (IBM FileNet P8 systems using Image Services Integration only) Verify that you are running a 
supported version of ISRA . 

See the IBM FileNet P8 Hardware and Software Requirements document for details on supported 
ISRA versions. 

For more information on how to upgrade ISRA and configure Image Services Integration, see your 
ISRA documentation and “Enable Application Engine to use ISRA” on page 287.
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Task 9: Apply Service Packs and patches for core components

To apply IBM FileNet P8 Platform Service Packs and patches

1. Install the Content Engine 3.5.x Service Pack. See the readme included on the Content Engine Ser-
vice Pack CD.

2. Install the Process Engine 3.5.x Service Pack. See the readme included on the Process Engine 
Service Pack CD.

3. Install the Application Engine 3.5.x Service Pack. See the readme included on the Application Engine 
Service Pack CD.

4. Install any patches or *SS fixes required for the IBM FileNet P8 Platform. To determine whether 
additional patches or *SS fixes are needed, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.

5. Depending on whether you are first installing IBM FileNet P8 Platform or upgrading from a previous 
release, continue with the procedure as follows:

• If you are installing for the first time, configure the IBM FileNet P8 installation by performing “Con-
figuration/Startup Tasks” on page 237.

• If you are upgrading directly from IBM FileNet P8 3.5.0, or from 3.0.0 via 3.5.0, complete the 
upgrade procedure by going on to “Upgrade Add-On Components” on page 335.
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Upgrade Add-On Components

You must upgrade all of the IBM FileNet P8 Platform core components before upgrading the add-on 
components listed in this topic. See “Upgrade Core Components” on page 305 for the tasks required to 
upgrade the IBM FileNet P8 Platform core components.

The IBM FileNet P8 Platform add-on components can be upgraded in any order except as noted below:

• You must upgrade Process Analyzer before upgrading Process Simulator.

To upgrade optional IBM FileNet P8 components

• Upgrade IBM FileNet Enterprise Manager (standalone). Do Task 10 on page 336.

• Upgrade Workplace Application Integration. Do Task 11 on page 337.

• Upgrade IBM FileNet Publishing components. Do Task 12 on page 338.

• Upgrade Custom Applications. Do Task 13 on page 339.

• Install patches for optional add-on components. Do Task 14 on page 345.
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Task 10: Upgrade IBM FileNet Enterprise Manager (standalone)

NOTES

• Refer to IBM FileNet P8 Hardware and Software Requirements for the operating systems that support 
IBM FileNet Enterprise Manager.

• The machine must be logged in as a member of the Windows domain where the domain controller is 
located.

• The IBM FileNet Enterprise Manager does not require any other supporting Content Engine services 
or files to be located on the machine.

• When installing Content Engine services (e.g., Object Store Service, File Store Service) or IBM FileNet 
Enterprise Manager, the machine that you are installing on must be a member of the "deployment" 
domain (whether that be the parent or child domain) prior to installing. 

To upgrade standalone Enterprise Manager system

1. Make sure you are logged in with an account that domain administrator privileges.

2. Insert the IBM FileNet P8 Content Engine CD  into the CD drive and click setup.exe.

3. At the Content Engine Welcome screen click Next.

4. In the License Agreement screen, review and accept the license agreement for IBM FileNet P8 
software products, and then click Next.

5. In the Customer Information screen, the User Name and Organization (optional) and click Next.

6. In the Custom Setup screen, verify that all Content Engine components except Administrative Tools 
are set not to be available, and click Next.

7. If you have an IBM FileNet P8 Platform Documentation Web site, select the check box and enter the 
Documentation URL. An example URL is:

http://<docserver:port#>/<ecm_help>

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation website.

 NOTE If you do not enter a Documentation URL, an empty icon will be created and placed on the 
system desktop. If the Documentation URL is updated from the IBM FileNet Enterprise Manager, the 
Documentation icon URL will be updated.

8. Click Test to verify the Documentation URL is correct.

9. Click Install to complete this portion of the setup wizard.

You should then see the wizard message: “If you are only installing the Content Engine client components 
in this machine, you should configure this machine to use a FileNet P8 domain. Enter the host name of a 
running Object Store Service in the domain to allow the wizard to obtain the Global Configuration Data.”

Type the host name, then continue to finish.
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Task 11: Upgrade Application Integration

Upgrading to Workplace Application Integration 3.5.1 involves installing the new version on top of your 
existing Workplace Application Integration 3.5.0 install. The upgrade installation program detects the 
earlier version and notifies you before proceeding with the upgrade. 

NOTE If you have the 3.0.0 version currently installed, you can upgrade directly to the 3.5.1 version. You 
do not need to first install the 3.5.0 version.

During the upgrade, the installer detects the Microsoft applications that were previously integrated with 
Workplace and retains that configuration. For example, if you had Microsoft Outlook integrated with 
Workplace in the 3.5.0 release, Microsoft Outlook is upgraded to 3.5.1 during the upgrade installation.

You cannot change your installed components during the upgrade. You can add or remove a Microsoft 
application from Application Integration after the upgrade using your Add/Remove Programs application.

To upgrade Workplace Application Integration

1. Log onto the machine with an account that has Administrator privileges. 

2. In Workplace, go to the Author page, General Tools view.

3. Scroll down and click  Download Office Integration. The File Download dialog box for your system 
appears. Do one of the following:

• Click Open to run the program from its current location. 

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save. Once the file is saved to your 
hard drive, double-click the file to run the upgrade installer.

NOTE If you have Workplace Application Integration 3.5.0 currently installed, you are prompted about 
the impending upgrade. Click Yes to upgrade to the current version you are installing or click No to 
end the installation. 

4. After the install is complete, click Finish to complete the upgrade process. 

To verify your Workplace Application Integration upgrade

1. Start Microsoft Word. 

2. From the File menu, click FileNet P8, point to Open Document, and then select Select Item. The 
Logon dialog box opens. 

3. Log on using any valid domain account. 

4. Click Options to view the Workplace address. The version number appears below the address.

5. Close all dialog boxes and close Microsoft Word.
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Task 12: Update IBM FileNet Publishing components

If you have IBM FileNet Rendition Engine and associated Publishing Plug-in software currently installed, 
you can upgrade to the latest 3.5.x Service Pack version. For details and instructions, see FileNet P8 
Documentation > FileNet P8 System Installation > Rendition Engine Installation and Upgrade. 
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Task 13: Upgrade Custom Applications

This release includes changes to following development tools that might impact custom applications:

Business Process Management (BPM)

Content Engine COM API

Content Java API

Process Java API

Web Application Toolkit

Workplace Application Integration Toolkit

If you have any custom applications that were written using any of these APIs, Toolkits, or BPM, then 
review the appropriate sections below for code changes that might be required.

Business Process Management

The following changes have been incorporated into the BPM components:

• Process Designer web services "parameter mode" behavior no longer supports duplicate parameter 
names.

• The name of the Windows NT® Service that is installed on the PE, PA, and PS has been changed. The 
new names are as follows:

• PE  |  Process Engine Services Manager | VWServicesPE

• PA  |  Process Analyzer Services Manager | VWServicesPA

• PS  |  Process Simulator Services Manager | VWServicesPS

Startup or shutdown scripts for the VWServices Windows NT service (i.e. net stop VWServices) 
must be updated to reference the new names.

• The UNIX setup files for Process Engine have been regrouped and renamed as follows:

• setupsun.bin, setupaix.bin, and setuphpux.bin are now setup.sh and setupsun2.bin

• setupaix2.bin and setuphpux2.bin are now setupsun.bin, setupaix.bin, and setuphpux.bin

User scripts which reference these files must be updated.

• The output format for user environment record dumps has changed for the Process Engine vwtool. 
The GUID in each record is now prefixed with "==". Applications which work programatically with 
output generated by vwtool must be updated.

• The Invoke workflows behavior for Process Orchestration has been changed as follows:

• Version 3.5 Invoke workflows may call version 3.0 Receive workflows.

• Version 3.0 Invoke workflows (or other web services clients) may not call version 3.5 Receive 
workflows without refreshing the Invoke partnerlinks and invoke steps (or for the case of another 
web services client, without regenerating their proxy classes). However, version 3.0 Invoke work-
flows may call a Receive workflow for a specific version (non-version-agnostic) that was upgraded 
from 3.0 to 3.5.
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Process Designer

• Process Designer web services "parameter mode" behavior no longer supports duplicate parameter 
names.

Process Engine

• The UNIX setup files for Process Engine have been regrouped and renamed as follows:

• setupsun.bin, setupaix.bin, and setuphpux.bin are now setup.sh and setupsun2.bin

• setupaix2.bin and setuphpux2.bin are now setupsun.bin, setupaix.bin, and setuphpux.bin

• The output format for user environment record dumps has been changed for the vwtool. The GUID in 
each record is now prefixed with "==".

Process Engine Services Manager

• The Windows NT Service name has changed for the Process Engine Services Manager. The new 
service name is VWServicesPE.

Process Orchestration

• The Invoke workflows behavior for Process Orchestration has been changed as follows:

• Version 3.5 Invoke workflows may call version 3.0 Receive workflows.

• Version 3.0 Invoke workflows (or other web services clients) may not call version 3.5 Receive 
workflows without refreshing the Invoke partnerlinks and invoke steps (or for the case of another 
web services client, without regenerating their proxy classes). However, version 3.0 Invoke work-
flows may call a Receive workflow for a specific version (non-version-agnostic) that was upgraded 
from 3.0 to 3.5.

Process Services Manager

• The Windows NT Service name and display name has changed for the Process Services Manager. 
The manager is now composed of two pieces: the Process Analyzer Services Manager and the 
Process Simulator Services Manager. The new service names are VWServicesPA and 
VWServicesPS, respectively.

Content Engine COM API

Several API members have been deprecated in this release of the Content Engine COM API. While these 
members have been deprecated, they remain functional in this release. However, they will become 
obsolete in future releases and applications should avoid using them.

• CreatePending property, use PendingOperation property instead.

• UpdatePending property, use PendingOperation property instead.

• DeletePending property, use PendingOperation property instead.

• DatabaseName property, use DatabaseConnectionString property instead.

• DatabaseServerName property, use DatabaseConnectionString property instead.

• DatabaseType property, use DatabaseConnectionString property instead.

• OIID property.
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• ObjectStore property.

• SystemType property.

• ObjectType property, use IsOfClass method instead.

• InstanceType property, use IsOfClass method instead.

• QueryOperatorDescriptions property, and is also only intended for internal use by Content Engine.

In addition, the following changes have been made to Content Engine:

• The EnableOn properties no longer have metadata, and therefore, cannot be queried.

• The Content Engine no longer fires an event on a version series for cancel_checkout. A distinct 
cancel_checkout event has been added as a result.

Content Java API

This release provides support for the new Content Engine event model (see the "What's New, Content 
Java API" section of the IBM FileNet P8 Platform Release Notes, Release 3.5.0 for more information on 
the new event model). As part of the API changes made for this new event model, all of the EnableOnXxx 
properties of Subscription and WorkflowSubscription objects have been deprecated.

Although existing code that sets these properties will continue to work in this release, we recommend you 
convert your code to use the new SubscribedEvents property instead as the EnableOnXxx properties 
might be removed in a future release. Existing code that retrieves these deprecated properties will also 
continue to work if you retrieve the properties by name (for example, by calling 
getProperties(propNames) or getPropertiesXML(propNames)). However, the deprecated properties 
will no longer be returned in a call to the no-parameter form of getProperties(). In addition, you can no 
longer perform a search on these deprecated properties.

Removed from the API

The interfaces listed below—which were previously deprecated—have been removed from the API.

• ClassDescription interface – getAuditDefinitions() method

• ObjectStore interface – installFeatureAddOn(FeatureAddOn, int) method

• Permission interface – PRINCIPAL_ID_SPECIAL field

• SecurityGrantee interface – getParentGroups(boolean) method

Process Java API

In this release, several JAR files in the Process Java API have been renamed to provide better support for 
localization. Any application with classpath settings that include the following JAR file names must be 
updated to specify the new file names as indicated:

• eProcess.jar has been renamed to pe.jar

• simclient.jar has been renamed to psclient.jar

• simulator.jar has been renamed to ps.jar

• fnpe3pt.jar has been renamed to pe3pt.jar

A new JAR file, peResources.jar, has also been created in this release. This file contains the two English 
resource bundle files, as well as a peResources-ver.properties file. Note that the introduction of this new 
JAR file will not break existing applications.
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Web Application Toolkit

A number of Web Application Toolkit members have been deprecated in this release, including the 
methods and fields listed below (broken down by class/interface) as well as the following classes and 
interface:

Removed from the API

The interfaces listed below—which were previously deprecated—have been removed from the API.

• WcmImageAnchor class

• WcmFieldUtil class

• WcmControllerBehaviorInterface interface

FormProcessor

• doMapParameters(WorkflowPolicy workflowPolicy, FormData formData)

WcmAuthoringDataProvider

• getRealmGroups(java.lang.String realmId, boolean refresh)

• getRealmUsers(java.lang.String realmId, boolean refresh)

WcmController

• CREATE_WINDOW_ID

• FIRST_WINDOWID_KEY

• HOME_KEY

• POPUP_KEY

• PROPOGATE_WINDOW_ID

• WINDOW_SIGNED_IN_KEY

• windowIdParams

• configurePage(javax.servlet.ServletContext applicationValue, javax.servlet.http.HttpServletRequest 
request, boolean windowIdRequired)

• configurePage(javax.servlet.ServletContext applicationValue, javax.servlet.http.HttpServletRequest 
request, int windowIdMode)

• configurePage(javax.servlet.ServletContext applicationValue, javax.servlet.http.HttpServletRequest 
request, int windowIdMode, java.lang.String[] windowIdParams)

• getHomeURLKey(java.lang.String windowId)

• getWindowIdFromReferer(java.util.Map popups, java.lang.String referer)

• isNewWindowIdRequired(javax.servlet.http.HttpServletRequest request)

• setAutoFixWindowId(boolean value)

WcmCredentialsServlet

• getCredentialsRequestURL(WcmDataStore ds, java.lang.String remoteHost, boolean wasBugFix, 
java.lang.String originScheme, java.lang.String originIP, java.lang.String originPort, java.lang.String 
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originSessionId, java.lang.String encodedSessionId, java.lang.String userId, java.lang.String 
password, java.util.Map extraParameters)

WcmDateUtil

• convertDateToW3CDate(java.util.Date date, boolean bDateOnly)

WcmEProcessDataProvider

• doEvaluateExpression(java.lang.String subscriptionName, java.lang.String expression, 
java.lang.String objectStoreId, java.lang.String objectId, java.lang.String verSerId, int objectType)

• findGroups(java.lang.String searchPattern, int searchType, int sortType, int maxBufferSize)

• findUsers(java.lang.String searchPattern, int searchType, int sortType, int maxBufferSize)

WcmException

• loadResource(java.io.InputStream in)

• loadResource(java.util.Map m)

WcmGetContentServlet

• handleExternalDocument(com.filenet.wcm.api.Document doc, 
javax.servlet.http.HttpServletResponse response, WcmDataStore ds)

WcmIcons

• load(java.lang.String sFilePath)

WcmModule

• getClassPropertyKeys()

• getModulePropertyKeys()

WcmSearchDataProvider

• checkForChoiceLists(org.w3c.dom.Document searchDefinition)

• checkForUserListProperties(org.w3c.dom.Document searchDefinition)

• getAllObjectStores(boolean refresh)

• getChoiceList(java.lang.String objectStoreName, java.lang.String searchID)

• getSearchRequest(java.util.Set selectProperties, java.util.Map propertyItems, java.util.Map 
verityItems, java.util.Set excludedClasses, int maxRecords)

WcmServerCredentials

• getSessionToken(WcmDataStore ds, java.lang.String appId, java.lang.String user, java.lang.String 
password, java.lang.String domain)

• getUserDomain()

WcmSignInPolicy

• createServerCredentials(WcmDataStore ds, java.lang.String appId, java.lang.String user, 
java.lang.String password, java.lang.String domain)

• getEncodedSessionId()
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• getLoginRoutingInfo()

WcmSignInPolicyInterface

• getLoginRoutingInfo()

WcmSSLInfo

• getSslHost()

• getSslHostDecoded()

WcmString

• loadResource(java.io.InputStream in)

• loadResource(java.util.Map m)

WcmStringEditor

• encode(java.lang.String str)

WcmStringResourceLoader

• load(java.lang.String path, java.lang.String name, java.lang.Class resourceClass)

WcmStringResources

• addLegacyPRB(boolean exception, java.io.InputStream in)

• addLegacyPRB(boolean exception, java.util.Map m)

WcmXSLUtil

• setXSLParameter(java.lang.String key, org.w3c.dom.Node node)

• setXSLParameter(java.lang.String key, java.lang.String value)

• setXSLParameter(java.lang.String key, org.w3c.dom.NodeList nodes)

Workplace Application Integration Toolkit

A number of Workplace Application Integration Toolkit members have been deprecated in this release, 
including the interfaces and methods listed below:

• ICheckinCmd interface, use ICheckinCmd2 interface instead.

• ISelectObjectCmd interface, use ISelectObjectCmd2 interface instead.

• ISessionLogin interface, use IStdSessionLogin interface instead.

• The ability to share a single, unified login between all FileNet Office Add-Ins is now available. The 
IStdSessionLogin interface has been introduced to include two new initialization methods to support 
this behavior. ISessionLogin::Initialize method has been deprecated; the new 
IStdSessionLogin::InitializeUnifiedLogin and IStdSessionLogin::InitializeViaSessionName 
methods should be used instead.
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Task 14: Install patches for add-on components

Install any patches or *SS fixes required for the IBM FileNet P8 Platform. To determine whether additional 
patches or *SS fixes are needed, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs” on page 9.
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Repair and Remove Software

This topic includes:

• “Remove the IBM FileNet P8 Platform documentation” on page 347

• “Remove Content Engine” on page 349

• “Repair Content Engine” on page 350

• “Remove Process Engine (Windows)” on page 352

• “Remove Process Engine (UNIX)” on page 354

• “Remove Application Engine (WebSphere)” on page 356

• “Remove Application Engine (WebLogic)” on page 357

• “Remove Application Engine (JBoss/Tomcat)” on page 358

• “Remove Application Engine (Oracle, Sun Java, and generic application servers)” on page 360

• “Remove the Application Engine ISRA Servlet” on page 361

For instructions on how to remove the Rendition Engine software, see FileNet P8 Documentation > FileNet 
P8 System Installation > Rendition Engine Installation and Upgrade.
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Remove the IBM FileNet P8 Platform documentation

The following topic details how to totally remove the IBM FileNet P8 Platform documentation. Due to the 
number of application server configuration possibilities, these examples should be used as reference only. 
Your specific installation directories and application names may vary. 

To remove the IBM FileNet P8 Platform documentation

NOTE  In some Windows installations where NTFS is used for the file system (Not FAT or FAT32), there is 
a known issue with deleting files (and folders) that are longer than 256 characters. For example, if you use 
a default WebSphere installation location, you may encounter an error where the IBM FileNet P8 Platform 
documentation files cannot be properly deleted due to the number of characters in the file/folder names. 
See the Microsoft Knowledge Base article http://support.microsoft.com/?kbid=320081 for additional 
information about deleting files (and folders) in this environment.

To remove the IBM FileNet P8 Platform documentation from a WebSphere server

1. Log on to the WebSphere IBM FileNet P8 Platform documentation server.

• UNIX - Log on as a user with write access to where the IBM FileNet P8 Platform documentation 
files are installed.

• Windows - Log on as a user with Administrative rights.

2. Verify the WebSphere server is running.

3. Log in to the WebSphere Administrative Console.

4. Stop the IBM FileNet P8 Platform documentation Enterprise Application (eg: ecm_help.war).

5. Uninstall the IBM FileNet P8 Platform documentation application (eg: ecm_help.war).

6. Save the changes.

7. Delete the IBM FileNet P8 Platform documentation folder from the installation location.

8. Delete any Temp folder(s) for the IBM FileNet P8 Platform documentation.

WARNING Do not remove any other IBM FileNet P8 application (eg: Workplace) files that are installed on 
the web application server.

9. Restart the WebSphere web server.

To remove the IBM FileNet P8 Platform documentation from a WebLogic server

1. Log on to the WebLogic application server.

• UNIX - Log on as a user with write access to where the ecm_help files are installed.

• Windows - Log on as a user with Administrative rights.

2. Verify the WebLogic server is running.

3. Log in to the WebLogic Administrative Console.

4. Undeploy the IBM FileNet P8 Platform documentation web application.

• WebLogic 7.0.x

i. Stop the Workplace Web Application (eg: ecm_help).

ii. Undeploy the Workplace Web Application (eg: ecm_help).

http://support.microsoft.com/?kbid=320081
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• WebLogic 8.1.x

i. Stop the Workplace Web Application Module (eg: ecm_help).

ii. Delete the Workplace Web Application Module (eg: ecm_help).

5. Delete any Temp folder(s) for the IBM FileNet P8 Platform documentation.

WARNING Do not remove any other IBM FileNet P8 application (eg: Workplace) files that are installed 
on the web application server.

6. Restart the WebLogic web server.

To remove the IBM FileNet P8 Platform documentation from an Apache/Tomcat server

1. Log on to the Apache/Tomcat application server:

• Linux/UNIX - Log on as a user with write access to where the ecm_help files are installed. 

• Windows - Log on as a member of the local Administrators group or a user with equivalent permis-
sions

2. Shut down the Apache/Tomcat server.

3. Remove the IBM FileNet P8 Platform documentation files from the ecm_help install location 
(eg:<Tomcat_HOME>\webapps\ecm_help).

4. Remove the Temp working directory (eg: <Tomcat_HOME>\work\Catalina\localhost\ecm_help).

WARNING Do not remove any other IBM FileNet P8 application (eg: Workplace) files that are installed 
on the web application server.

5. Restart the Apache/Tomcat web server.

To remove the IBM FileNet P8 Platform documentation from a JBoss server

1. Log on to the JBoss application server:

• Linux/UNIX - logon as a user with write access to where the ecm_help files are installed. 

• Windows - Log on as a member of the local Administrators group or a user with equivalent permis-
sions.

2. Shut down JBoss server.

3. Remove the IBM FileNet P8 Platform documentation .war folder (eg: 
<JBoss_HOME>\server\default\deploy\ecm_help.war).

4. Remove the Temp working directory (eg: 
<JBoss_HOME>\server\default\work\MainEngine\localhost\ecm_help.war).

WARNING Do not remove any other IBM FileNet P8 application (eg: Workplace) files that are installed 
on the web application server.

5. Restart the JBoss web server.
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Remove Content Engine

You can use Content Engine Setup wizard or the Windows Control Panel to remove a Content Engine 
installation.

NOTE  The following items will not be removed by removing a CE installation:

• Anything installed by the various wizards supplied with Content Engine, including the object stores 
created by the Create Object Store Wizard.

• The database containing Content Engine property information.

• Windows Active Directory entries.

• Users created to install or administer Content Engine.

• The directories identified as Content Engine Object Stores or Content Engine Content Cache 
Stores, as these contain content that presumably exists outside the need to have Content Engine 
manage them.

• The directory \Program Files\FileNet\Content Engine\sysconfig. This directory will not be 
removed because it contains the Global Configuration Data (GCD) or a copy of it (if the server is 
not the "GCD Master”).

• File Store directories containing the content (e.g., documents) and Verity indexes.

To remove a Content Engine installation using Content Engine Setup

1. Insert the IBM FileNet P8 Content Engine CD into the CD-ROM drive, navigate to the Content Engine 
folder, and click setup.exe.

2. Complete the Content Engine Setup wizard screens as follows:

3. If you want to completely remove all traces of the Content Engine installation, delete the C:\Program 
Files \FileNet directory.

To remove a Content Engine installation using the Windows Control Panel

1. Open the Windows Control Panel.

2. Double-click the Add/Remove Programs icon.

3. Highlight FileNet Content Engine in the list of currently installed programs and click Remove to launch 
the Content Engine Setup wizard.

4. Click Yes to confirm you want to remove the Content Engine installation.

5. If you want to completely remove all traces of the Content Engine installation, delete the C:\Program 
Files \FileNet directory.

In this screen... Perform this action...

Welcome Click Next to proceed with the removing the Content Engine 
installation.

Program Maintenance Click Remove and then click Next.

Remove the Program Click Remove.
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Repair Content Engine

NOTES 

• You can use the Content Engine Setup wizard, Windows Control Panel or from a Command Prompt to 
repair a Content Engine installation. Item such as missing files, corrupt files, program shortcuts, and 
registry entries will be repaired.

• When you run the Content Engine Setup wizard on a machine that already has the Content Engine 
software installed, the setup program will open in maintenance mode. This mode allows you to modify, 
repair or remove the previous installation. You must have the IBM FileNet P8 Content Engine CD 
available or a valid network connection to the Content Engine installation media.

To repair a Content Engine installation using Content Engine Setup

1. Insert the IBM FileNet P8 Content Engine CD into the CD-ROM drive, navigate to the Content Engine 
folder, and click setup.exe.

2. Complete the Content Engine Setup wizard screens as follows:

To repair a Content Engine installation using the Windows Control Panel

1. Insert the IBM FileNet P8 Content Engine CD into the CD-ROM drive.

2. Open the Windows Control Panel.

3. Double-click the Add/Remove Programs icon.

4. Highlight IBM FileNet Content Engine in the list of currently installed programs and click Change to 
launch the Content Engine Setup wizard.

5. Complete the Setup screens as follows:

In this screen... Perform this action...

Welcome Click Next to proceed with the repairing the Content Engine 
installation.

Program Maintenance Click Repair and then click Next.

Install third-party software Click Next.

Ready to Repair Click Repair to begin repairing the Content Engine installation. (The 
repair may take several minutes.)

Completing the Content 
Engine Setup wizard

Click Finish.

In this screen... Perform this action...

Welcome Click Next.

Program Maintenance Click Repair and then click Next.

Install third-party software Click Next.
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Ready to repair Click Repair to begin repairing the Content Engine installation. (The 
repair may take several minutes.)

Completing the Content 
Engine Setup wizard

Click Finish.

In this screen... Perform this action...
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Remove Process Engine (Windows)

NOTE  You must remove the software in the order listed below. Removing Image Services (step 6) prior to 
removing Process Engine (step 3) will leave the Process Engine software in a state that will not allow 
removal with this procedure.

1. Stop any of the following components that are running. For procedures and further details, see the  
FileNet P8 Platform Shutdown and Startup help topic found at: FileNet P8 Administration > Enter-
prise-wide Administration > Shutdown and Startup.

2. Start the Control Panel > Add/Remove Programs.

3. Click Remove for the Process Engine application.

4. Click Yes to confirm you want to remove Process Engine for Windows 3.5.0 installation.

5. Click Finish.

6. Click Remove for the FileNet Image Services 4.0.20 software.

7. Click Yes to confirm you want to remove the Image Services software.

8. Press Enter to continue with the uninstall.

9. Close the Add/Remove snap-in.

10. Close the Control Panel.

CAUTION (MS SQL Server only): If you plan to reinstall Process Engine and will configure Process 
Engine to use a different MS SQL database, you must remove the database that was configured for the 
Process Engine installation. In addition, you must remove the following FileNet user ids from the SQL 
Server Security folder before re-installing Process Engine software: 

• f_sw

• f_cso

Component Location

Process Simulator

Process Analyzer

Custom applications that require a router varies

Component Manager Application Engine

Routers Application Engine or Content Engine

Application Engine

Content Engine

Pooled Process Manager (PPM) Process Engine

Process Service Process Engine

Process Task Manager
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• f_maint

• f_open

• f_operator

• f_sqi
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Remove Process Engine (UNIX)

1. Stop any of the following components that are running. For procedures and further details, see the  
FileNet P8 Platform Shutdown and Startup help topic found at FileNet P8 Administration > Enter-
prise-wide Administration > Shutdown and Startup. 

2. Enter the following after the FileNet software is shut down: 

kill fnsw -A -D -y 

3. On AIX, execute the following:

slibclean

4. Log onto the Process Engine server as the root user.

5. At a command prompt, run the following command.

/fnsw/_pws_uninst/pws_uninstall.bin

6. Follow the prompts on the screen to remove the Process Engine software.

7. At a command prompt, run the following script.

/tmp/setup_dir/uninstall

Alternatively, you can run the uninstall script from the Process Engine installation media by running the 
following script:

/<cdrom>/<OS>/setup_dir/uninstall

where: 

<cdrom> = location of the cd mount point.

<OS> = Operating System version (AIX_#, HP-UX_#, SunOS_#) 

The uninstall script shuts down the Process Engine software, removes the software from the /fnsw 
directory, and removes the directory structure under /fnsw. The uninstall script removes the Process 

Component Location

Process Simulator

Process Analyzer

Custom applications that require a router varies

Component Manager Application Engine

Routers Application Engine or Content Engine

Application Engine

Content Engine

Pooled Process Manager (PPM) Process Engine

Process Service Process Engine

Process Task Manager
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Engine entries in the /etc/services, /etc/system, /etc/inittab and /etc/devlink.tab files. On an AIX-based 
Process Engine, the script also removes smit entries. 
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Remove Application Engine (WebSphere)

This task includes Application Engine removal instructions for WebSphere on UNIX and Windows 
platforms.

To remove the Application Engine software

1. Log on to the application server.

• UNIX - Log on as a user with write access to the /bin directory and the directory where Application 
Engine is installed.

• Windows - Log on as a user with Administrative rights.

2. Stop the Process router before closing the Process Task Manager.

NOTE (Windows) If the router command window is open, close it. 

3. Log in to the WebSphere Administrative Console.

4. Uninstall the Workplace application.

a. Stop the Workplace process in the admin console.

b. Uninstall the Workplace application from Enterprise Applications. 

5. Navigate to the /_uninst folder under the Application Engine installation location. The default location 
is:

• UNIX - /opt/

• Windows - C:\Program Files\

6. Run the uninstall program: 

• UNIX - filenet_app_engine_setup_uninstall.bin

• Windows - filenet_app_engine_setup_uninstall.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to remove the 
IBM FileNet Application Engine.

On Windows, when you click Next on the Application Engine Uninstaller Welcome screen, the second 
screen asks you to wait while Windows Task Manager service shuts down before continuing the 
uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the uninstall 
wizard from the next screen.

7. Delete the Workplace folder:

<WAS_HOME>/temp/<node_name>/<application_server_name>/Workplace

8. (If Application Engine is the only IBM FileNet P8 application installed on the server) Delete the 
<AE_install_path>\FileNet directory. 

9. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If Application Engine is the only FileNet P8 application running on the server you must remove the 
P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other FileNet P8 application is 
installed on the server.
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Remove Application Engine (WebLogic)

This task includes Application Engine removal instructions for WebLogic on UNIX and Windows platforms.

To remove the Application Engine software

1. Log on to the application server.

• UNIX - Log on as a user with write access to the /bin directory and the directory where Application 
Engine is installed.

• Windows - Log on as a user with Administrative rights.

2. Stop the Process router before closing the Process Task Manager.

NOTE (Windows) If the router command window is open, close it.

3. Undeploy the Workplace application.

• WebLogic 7.0.x

i. Stop the Workplace Web Application.

ii. Undeploy the Workplace Web Application.

• WebLogic 8.1.x

i. Stop the Workplace Web Application Module.

ii. Delete the Workplace Web Application Module.

4. Navigate to the /_uninst folder under the Application Engine installation location. The default location 
is:

• UNIX - /opt/

• Windows - C:\Program Files\

5. Run the uninstall program:

• UNIX - filenet_app_engine_setup_uninstall.bin

• Windows - filenet_app_engine_setup_uninstall.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to remove the 
IBM FileNet Application Engine.

On Windows, when you click Next on the Application Engine Uninstaller Welcome screen, the second 
screen asks you to wait while Windows Task Manager service shuts down before continuing the 
uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the uninstall 
wizard from the next screen.

6. (If Application Engine is the only IBM FileNet P8 application installed on the server) Delete the 
<AE_install_path>\FileNet directory. 

7. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If Application Engine is the only IBM FileNet P8 application running on the server you must remove the 
P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other IBM FileNet P8 application is 
installed on the server.
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Remove Application Engine (JBoss/Tomcat)

This task includes Application Engine removal instructions for JBoss and Tomcat on Windows and JBoss 
on Linux.

To remove the Application Engine software

1. Log on to the application server:

• Linux - logon as a user with write access to the /bin directory. 

• Windows - Log on as a member of the local Administrators group or a user with equivalent permis-
sions.

2. Stop the Process router before closing the Process Task Manager.

NOTE If the router command window is open, close it.

3. Shut down JBoss/Tomcat.

4. Navigate to the /_uninst folder under the Application Engine installation location. The default location 
is:

• Linux - /opt/

• Windows - C:\Program Files\

5. Run the uninstall program: 

• Linux - filenet_app_engine_setup_uninstall.bin

• Windows - filenet_app_engine_setup_uninstall.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to remove the 
IBM FileNet Application Engine.

On Windows, when you click Next on the Application Engine Uninstaller Welcome screen, the second 
screen asks you to wait while Windows Task Manager service shuts down before continuing the 
uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the uninstall 
wizard from the next screen.

The Uninstall Wizard will remove the following components:

• Workplace Web Applications 

• Process Java API and Content Java API

6. Remove temporary files and directories.

• JBoss:

i. Remove the Workplace.war folder from <JBoss_HOME>\server\default\deploy\.

ii. Remove the Temp working directory for Workplace from 
<JBoss_HOME>\server\default\work\MainEngine\localhost\

• Tomcat:

i. Remove the \Workplace folder from <Tomcat_HOME>\webapps\.

ii. Remove the Temp working directory for Workplace from <Tomcat_HOME>\work\Cat-
alina\localhost\
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7. (If Application Engine is the only IBM FileNet P8 application installed on the server) Delete the 
<AE_install_path>\FileNet directory. 

8. (LINUX) Remove the P8TASKMAN_HOME system environment variable.

If Application Engine is the only IBM FileNet P8 application running on the server you must remove the 
P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other IBM FileNet P8 application is 
installed on the server.



INSTALLATION AND UPGRADE GUIDE
Remove Application Engine (Oracle, Sun Java, and generic application servers)

360

Remove Application Engine (Oracle, Sun Java, and generic application 
servers)

This task includes Application Engine removal instructions for generic application servers on UNIX and 
Windows platforms. In addition, these instructions apply to Oracle Application Server and Sun Java 
Application Server installations.

To remove the Application Engine software

1. Log on to the application server:

• UNIX - Log on as a user with write access to the /bin directory and the directory where Application 
Engine is installed.

• Windows - Log on as a user with Administrative rights.

2. Stop the Process router before closing the Process Task Manager.

NOTE  (Windows) If the router command window is open, close it.

3. Undeploy the Workplace application.

If supported by your application server, use your application server’s console to undeploy/delete the 
deployed Workplace application. 

4. Navigate to the /_uninst folder under the Application Engine installation location. The default location 
is:

• UNIX - /opt/

• Windows - C:\Program Files\

5. Run the uninstall program: 

• UNIX - filenet_app_engine_setup_uninstall.bin

• Windows - filenet_app_engine_setup_uninstall.exe

NOTE  For Windows, you can also use Add/Remove Programs from the Control Panel to remove the 
IBM FileNet Application Engine.

On Windows, when you click Next on the Application Engine Uninstaller Welcome screen, the second 
screen asks you to wait while Windows Task Manager service shuts down before continuing the 
uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the uninstall 
wizard from the next screen.

6. (If Application Engine is the only IBM FileNet P8 application installed on the server) Delete the 
<AE_install_path>\FileNet directory. 

7. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If Application Engine is the only IBM FileNet P8 application running on the server you must remove the 
P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other IBM FileNet P8 application is 
installed on the server.
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Remove the Application Engine ISRA Servlet

This task includes Application Engine ISRA Servlet removal instructions for Windows and UNIX 
environments.

NOTE  Since the installed names for the ISRA Servlet are configurable on the supported application 
servers (WebLogic, WebSphere, JBoss and Tomcat), the information below may not be the same as your 
environment. Make the appropriate name changes as required for your environment.

To remove the Application Engine Servlet software

1. Log on to the application server.

UNIX - Log on as a user with write access to the /bin directory and the directory where ISRA Servlet is 
installed.

Windows - Log on as a user with Administrative rights.

2. Undeploy the ApplicationEngineISRAServlet application. This step is similar to that required to 
undeploy the Workplace application. 

WebSphere:

a. Stop the ApplicationEngineISRAServlet process in the Admin console

b. Uninstall the ApplicationEngineISRAServlet application from Enterprise Applications

WebLogic:

a. Stop the ApplicationEngineISRAServlet Web Application Module.

b. Undeploy or delete the ApplicationEngineISRAServlet Web Application Module.

JBoss:

No action to be performed.

3. Navigate to the /_uninstISRA folder under the ISRA Servlet installation location. The default location is:

UNIX - /opt/

Windows - C:\Program Files\

4. Run the uninstall program:

UNIX - filenet_ae_israservlet_setup_uninstall.bin

Windows - filenet_ae_israservlet_setup_uninstall.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to remove the 
IBM FileNet Application Engine ISRA Servlet.

5. Navigate to the FileNet directory. If there is no other IBM FileNet software installed under this directory, 
delete the FileNet directory. If there is some other IBM FileNet software installed under this directory, 
delete only the ApplicationEngineISRAServlet subdirectory.

6. Delete the following temporary working folders for the Application Engine ISRA Servlet:

WebSphere 5.*:

<WAS_Home>\WebSphere\AppServer\installedApps\<servername>\ApplicationEngineISRAServ
let.ear\

WebSphere 6.*:



INSTALLATION AND UPGRADE GUIDE
Remove the Application Engine ISRA Servlet

362
<WAS_Home>\WebSphere\AppServer\profiles\default\installedApps\<servername>\Applicat
ionEngineISRAServlet.ear\

JBoss:

<JBoss_Home>\server\default\deploy\ApplicationEngineISRAServlet.war\

<JBoss_Home>\server\default\work\MainEngine\localhost\ApplicationEngineISRAServlet

WebLogic:

No action to be performed.
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Appendixes

This appendixes section contains the following major topics:

• “IBM FileNet P8 Port Numbers” on page 364

• “Set Up Oracle tablespaces manually” on page 367

• “Process Engine SQL Scripts (Oracle databases only)” on page 369

• “IBM FileNet P8 Database Character Sets” on page 372

• “Configure an IBM FileNet P8 environment for Windows Server 2003 SP1 or R2” on page 375
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IBM FileNet P8 Port Numbers

The tables below list the port numbers used by the various IBM FileNet P8 components.

Content Engine Ports

WEBDAV Clients / SSL 80 / 443

LDAP / SSL 389 / 636

Application Engine Apache (SOAP) 8008

MSSQL Server / Oracle / DB2 1433 / 1521 / 446

Process Engine (RMI) 32771

DOM, RPC, DTC, etc.(if CE is in DMZ outside firewall) 135

Process Engine Ports

SMTP (E-mail Notification) 25

LDAP / SSL (LDAP Servers) 389 / 636

MSSQL Server / Oracle / DB2 1433 / 1521 / 446

Oracle Services for Microsoft Transaction Server (Windows) 2030

Process Engine (RMI) 32771

PPM (RMI) 32771

TMS 32768 / TCP

COR 32769 / TCP

NCH 32770 / UDP

fn_snmpd 161 / UDP

fn_trapd 35225 / UDP

SNMPD SMUX (AIX only) 199 / TCP

Rules Engine 32774 (TCP/IP)

Component Manager (Event Port) 32773

Process Engine to Extensible Authentication Communications 32776
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NOTE  No additional port is required for the Process Configuration Console Java applet.

Application Engine Ports

WebSphere / WebSphere SSL 9080 / 443

WebLogic / WebLogic SSL 7001 / 7002

JBoss / JBoss SSL 8080 / 8443

Tomcat / Tomcat SSL 8080 / 8443

Oracle Application Server / Oracle Application Server SSL (UNIX) 7777, (Windows) 80 / 
443

Sun Java Application Server / Sun Java Application Server SSL 8080 / 8181

Content Engine Apache (SOAP) 8008

Process Engine (RMI) 32771

Rendition Engine Ports

Liquent / Print Server on Local Port 1 Program Files\Common 
Files\Liquent\liquent.xml

Liquent / Print Server on Local Port 2 Program Files\Liquent\
Vista\ESPS.PS

Liquent notify port 2868

Liquent event port 2869

Liquent admin port 2870

MSSQL Server / Oracle 1433 / 1521

Web Content Manager 5000

Process Analyzer Ports

Registry Port 32771

Data Port 32772

Database Port 1433
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NOTE  On UNIX platforms, Image Services port assignments are made in the /etc/services file. For more 
information, see the IBM FileNet P8 Content Federation Services for Image Services Guidelines.

Process Simulator Ports

Process Analyzer 32772

Registry 32771

Database Port 1433

Return 0 (anonymous)

System Manager Ports

Listener (first) 32775

Listener (subsequent) OS defined

Content Federation Services for Image Services Ports

tms 32768 / TCP

cor 32769 / TCP

nch 32770 / UDP

fn_snmpd 161 / UDP

snmp trap 162 / UDP

fn_trapd 35225 / UDP

Native default SNMP port (HP only) 8000 / UDP

FileNet specific SNMP port (HP and Solaris only) 8001 / UDP

Migration notify anonymous

Content Federation Services for Content Services and NTFS Ports

MSSQL Server / Oracle / DB2 1433 / 1521 / 446

IICE Session Pool server and Single Sign-On server 1250

II CE RMI Bridge 1251
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Set Up Oracle tablespaces manually

If your database engine is Oracle, you need to set up a user as well as a permanent and a temporary 
tablespace for each object store in Content Engine. This section shows how to set up these users and 
tablespaces manually via the Oracle SQL commands, as in the following examples. There is also an 
example of how to edit the listener.ora file.

NOTE Refer to “Install Oracle Server for IBM FileNet P8” on page 63 for restrictions and recommendations 
regarding tablespace names and sizes.

To create the user and tablespaces for a Content Engine object store

The following two examples, for Windows and UNIX, show how to create permanent and temporary 
tablespaces for a user named test1 using SQL commands, assuming that your Oracle database is named 
orcl.

Windows:

DROP TABLESPACE test1 INCLUDING CONTENTS;
CREATE TABLESPACE test1 LOGGING 
DATAFILE '%ORACLE_HOME%\oradata\orcl\test1.dbf'
SIZE 200M REUSE 
AUTOEXTEND ON NEXT 10M MAXSIZE UNLIMITED EXTENT 
MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT AUTO; 

DROP TABLESPACE temptest1 INCLUDING CONTENTS;
CREATE TEMPORARY TABLESPACE temptest1
TEMPFILE '%ORACLE_HOME%\oradata\orcl\temptest1.dbf'
SIZE 400M REUSE
AUTOEXTEND ON NEXT 10M MAXSIZE UNLIMITED EXTENT
MANAGEMENT LOCAL;

DROP USER test1 CASCADE;
CREATE USER test1 PROFILE "DEFAULT"
IDENTIFIED BY test1
DEFAULT TABLESPACE test1
TEMPORARY TABLESPACE temptest1
ACCOUNT UNLOCK;
GRANT "CONNECT" TO test1;
GRANT "RESOURCE" TO test1;

UNIX:

DROP TABLESPACE test1 INCLUDING CONTENTS;
CREATE TABLESPACE test1 LOGGING
DATAFILE '$ORACLE_HOME/oradata/orcl/test1.dbf'
SIZE 200M REUSE
AUTOEXTEND ON NEXT 10M MAXSIZE UNLIMITED EXTENT
MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT AUTO;

DROP TABLESPACE temptest1 INCLUDING CONTENTS;
CREATE TEMPORARY TABLESPACE temptest1
TEMPFILE '$ORACLE_HOME/oradata/orcl/temptest1.dbf'
SIZE 400M REUSE
AUTOEXTEND ON NEXT 10M MAXSIZE UNLIMITED EXTENT
MANAGEMENT LOCAL;
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DROP USER test1 CASCADE; 
CREATE USER test1 PROFILE "DEFAULT" 
IDENTIFIED BY test1 
DEFAULT TABLESPACE test1 
TEMPORARY TABLESPACE temptest1 
QACCOUNT UNLOCK; 
GRANT "CONNECT" TO test1; 
GRANT "RESOURCE" TO test1;

To edit the listener.ora file

To manually update the listener.ora file (for example, to change the database name), refer to the following 
example, where sunblock is the dbname and BLK is the ORACLE_SID.

LISTENER =
  (DESCRIPTION_LIST =
    (DESCRIPTION =      
      (ADDRESS_LIST =
        (ADDRESS = (PROTOCOL = TCP)(HOST = vwnetra1.filenet.com)(PORT = 1521))
      )
    )
  )

SID_LIST_LISTENER =
  (SID_LIST =
    (SID_DESC =
      (GLOBAL_DBNAME = sunblock)
      (ORACLE_HOME = C:\oracle\ora92)
      (SID_NAME = BLK)
    )
  )
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Process Engine SQL Scripts (Oracle databases only)

Process Engine Setup prompts for the Oracle sys password near the beginning and the end of the 
installation. The password is required to run the following SQL scripts (the first four scripts listed in the 
table run near the beginning of installation, the last script runs near the end).

All the scripts are located at the root of the Process Engine installation CD. Process Engine Setup cannot 
complete until all these scripts have run successfully. If an error message indicates that any of the scripts 
did not run, you must resolve the errors before proceeding; see the IBM FileNet P8 Platform 
Troubleshooting Guide for further information.

Script Name Action

pe_install_scripts.sql A wrapper script that executes the following scripts: pe_filenet_site.sql, 
pe_create_stored_procedures.sql, and pe_grant_sp_permissions.sql.

The pe_install_scripts.sql script generates an Oracle output spool file.  
After the script completes, Process Engine Setup scans the output file 
for errors.

pe_upgrade_scripts.sql A wrapper script that executes the following scripts: 
pe_create_stored_procedures.sql, and pe_grant_sp_permissions.sql.

The pe_upgrade_scripts.sql script generates an Oracle output spool 
file.  After the script completes, Process Engine Setup scans the output 
file for errors.

pe_filenet_site.sql Creates the database users for FileNet P8. See “Changes made by 
pe_filenet_site.sql and pe_setup_users_defaults.sql” on page 370 for 
details. 

pe_create_stored_proce
dures.sql

Creates a number of stored procedures. See “Changes made by 
pe_create_stored_procedures.sql and pe_grant_sp_permissions.sql” 
on page 371 for details.

pe_grant_sp_permission
s.sql

Executes grants and creates synonyms for stored procedures. See 
“Changes made by pe_create_stored_procedures.sql and 
pe_grant_sp_permissions.sql” on page 371 for details.

pe_setup_users_defaults
.sql

 Sets user tablespace defaults and privileges for FileNet P8 users. See 
“Changes made by pe_filenet_site.sql and 
pe_setup_users_defaults.sql” on page 370 for details.
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Changes made by pe_filenet_site.sql and pe_setup_users_defaults.sql

The information in columns 1, 2 and 3 is created/set by SQL script pe_filenet_site.sql. The information in 
column 5 is set by SQL script pe_setup_users_defaults.sql 

* Changed automatically during Process Engine software installation from filenet to an internal secret 
password. 

** Manually changed after installation with set_f_maint_pw tool, as described in each “Install Process 
Engine <Platform>” section of this guide.

*** Default and temp tablespace names are set during installation. These names are used to set db user 
privileges.

FileNet DB 
user created

Granted Permissions/
privileges/roles

Initial 
password

Can  
delete 
post-
install?

Default and temp 
Tablespace 
privileges***

f_sw Connect, resource

Select on sys.dba_users

Select on 
sys.dba_tablespaces

Create public synonym

Drop public synonym

filenet* No Default  tablespace set

Temp tablespace set

Quota 0 on system

Quota unlimited on 
default tablespace

Quota unlimited on temp 
tablespace

f_maint DBA role change$this_ob
noxiou$_passwo
rd

Yes

f_operator Connect filenet** Yes

f_sqi Connect, resource

Create public synonym

Drop public synonym

filenet Yes Default  tablespace set

Temp tablespace set

Quota 0 on system

Quota unlimited on 
default tablespace

Quota unlimited on temp 
tablespace

f_open Connect, resource filenet Yes

f_cso Connect, resource filenet Yes
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Changes made by pe_create_stored_procedures.sql and pe_grant_sp_permissions.sql

The information in columns 1, 2 and 3 is created by pe_create_stored_procedures.sql. The information in 
columns 4 and 5 is created by pe_grant_sp_permissions.sql 

Procedure 
Name

Owner Description Grants Synonym

fn_error f_sw Displays text of a specified ORA 
error number. Calls SQL stored 
procedure fn_errortxt to get the 
text.

Execute to 
public

fn_error

fn_oraversion f_sw Displays version number of 
Oracle RDBMS. Calls SQL 
Stored procedure 
fn_oraversiontxt.

Execute to 
public

fn_oraversion

fn_errortxt f_sw Gets and returns the message 
text of a specified ORA SQL 
Error Code.

Execute to 
public

fn_errortxt

fn_oraversiontxt f_sw Gets and returns the version 
number of the Oracle RDBMS.

Execute to 
public

fn_oraversiontxt
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IBM FileNet P8 Database Character Sets

The table below lists the character sets supported for the FileNet P8 database components.

Additional Oracle character set information

The Oracle database character set you choose depends on whether the database is shared or dedicated. 

• The required character set for a database dedicated to Content Engine or shared with Process Engine 
is AL32UTF8 (Unicode 3.1 UTF-8 Universal character set).

RDBMS Character sets 
supported in the 
regular character set  
(via varchar and
char data types)

Character sets 
supported
in the National 
character set
(via nvarchar, 
nchar, and 
graphics
data types)

Character set 
utilized by CE

Character set
utilized by PE

Oracle 9i All Unicode
(except for AL16UTF16) 
and non-Unicode 
character sets

AL16UTF16
(aka UCS-2) 

Regular
character set

AL32UTF8 
required

Regular character 
set

(Oracle’s 
AL32UTF8 
Unicode character 
set or other single/
multi-byte 
character sets) 

Oracle 
10g

All standard Oracle 
character sets

AL32UTF8 Unicode 
character sets

Not used by FileNet 
P8

Regular
character set

AL32UTF8 
required

Regular character 
set

MS SQL 
Server

Only non-Unicode
code pages are 
supported here

UCS-2
(Generically
called Unicode on
SQL Server)

Unicode/National 
character set only

Regular character 
set only

DB2 UTF-8 and all
non-Unicode
character sets

UCS-2 National character 
set only

Regular character 
set only
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• If the database is dedicated to Process Engine, choose from among the supported character sets 
listed in the following table.

Be aware of the special NLS_LANG settings for character sets and locale on Oracle Client machines. 
Consider the following:

• You must ensure that the NLS_LANG Oracle environment variable on an Oracle Client machine 
matches the character set/locale of the client operating system. 

• Under Windows, by default the Oracle Client installer sets the NLS_LANG value in the Windows 
registry to match the locale of the Oracle Client machine's operating system. For Process Engine (and/
or Content Engine), you do not need to override the registry value with the user environment variable. 
The default NLS_LANG value is adequate for either a Unicode (e.g., AL32UTF8) and non-Unicode 
(e.g., WE8MSWIN1252) database character set. 

• Under UNIX, the Oracle Client installer does not automatically set the NLS_LANG (as it does under 
Windows). For this reason, after you have installed Process Engine on its server, you must manually 
set the locale and character set value on each UNIX Oracle Client machine from which users will 
access Process Engine.

• If the database uses a non-Unicode character set (e.g., WE8MSWIN1252), you can make the 
NLS_LANG value on the Oracle Client machine match the character set of the database by choosing 
the appropriate database character set during database creation. For example, when the client 
operating system locale is American ANSI 1252, then you can designate the WE8MSWIN1252 
character set when you create the database. The Windows Oracle Client install will set NLS_LANG to 
be AMERICAN_AMERICA.WE8MSWIN1252 because the client operating system locale is American 
ANSI 1252. Under UNIX, you would manually set this value.

• You set the NLS_LANG value manually on Oracle Client machines as follows:

Description Character set

Unicode 3.1 UTF-8 Universal character set AL32UTF8

Western European (UNIX) WE8ISO8859P1 or WE8ISO8859P15
(Windows) WE8MSWIN1252

Eastern European EE8ISO8859P2

South European SE8ISO8859P3

Northern & Northeastern Europe NEE8ISO8859P4

Latin/Cyrillic CL8ISO8859P5

Latin/Arabic AR8ISO8859P6

Latin/Greek FL8ISO8859P7

Latin/Hebrew IWISO8859P8

Western European & Turkish WEISO8859P9

North European NE8ISO8859P10

ASCII 7-bit American US7ASCII
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– (UNIX) Add NLS_LANG to the shell environment login files for each user who will be logging on to 
the machine to run FileNet P8 software. 

– (Windows) Set/modify the value of the NLS_LANG key via System Properties in the Control Panel 
for each user who will be logging on to the machine to run FileNet P8 software. 

Additional DB2 character set information

Content Engine requires a unicode (UTF-8) database. Process Engine will support the UTF-8 code set, 
code page 1208. Process Engine will also support all other single-byte character sets, for example:

Code Set Code Page #

ISO8859-15 923

ISO8859-1 819
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Configure an IBM FileNet P8 environment for Windows 
Server 2003 SP1 or R2

If you plan to install Microsoft Windows Server 2003 Service Pack 1 (SP1) or Release 2 (R2) in an IBM 
FileNet P8 environment, you must run the following procedure on the server(s) where the IBM FileNet P8 
components are configured.

At least one Windows domain (2000 or 2003) must be configured for the IBM FileNet P8 environment, 
regardless of the authentication provider (Windows, Sun, or Novell) that is utilized.

NOTES 

• For Windows Server 2003 SP1 or R2 servers where IBM FileNet P8 Content Engine components will 
be installed, Microsoft Distributed Transaction Coordinator (MSDTC) and COM+ must be properly 
enabled and configured; otherwise, the Content Engine components will not run correctly. For more 
information, see “Configure Content Engine and SQL Servers for Windows 2003” on page 46.

• If MSDTC and COM+ access is not enabled, object store creation will fail when loading the Content 
Engine Add-ons.

• To install the MSDTC or COM+ components, you will need the Windows Server 2003 media. 

• The boot drive partition where Windows Server 2003 is installed must be NTFS.

• If IBM FileNet P8 Content Engine is already installed, you must first shut down the Content Engine 
services before making these changes (i.e., Content Engine Content Cache Service, Content Engine 
File Store Service, and Content Engine Object Store Service). You can shut down these services using 
the Windows Services MMC snap-in.

• To install Process Engine onto a machine that is running Windows Server 2003 SP1 or R2, we 
recommend you use the 3.5.0a update of the Process Engine. If you use the earlier 3.5.0 release 
instead, you will have to remove the Windows Service Pack or Release before you install Process 
Engine, as indicated later in this appendix. Contact your IBM representative to get a 3.5.0a Process 
Engine update CD.

• To install Content Engine 3.5.0 and Process Engine 3.5.0 onto a single Windows Server 2003 
machine, you must do so prior to applying Windows Server 2003 SP1 or R2. However, as of Process 
Engine 3.5.0a refresh, you will be able to install this IBM FileNet software onto a machine where 
Windows Server 2003 SP1 or R2 is already installed. 

Windows Server 2003 SP1 or R2 and IBM FileNet P8

Windows Server 2003 SP1 and R2 include a number of changes which affect the IBM FileNet P8 Content 
Engine, primarily the default settings which, if left unchanged, prevent Content Engine from working 
properly. Specifically, the default settings and changes in SP1 and R2 that affect the operation of IBM 
FileNet P8 are in the following areas:

• DTC Network Security

• DCOM Security

For general information on Windows Server 2003 SP1, go to the associated Microsoft download site and 
locate the BookOfSP1Doc.doc file (URL: http://www.microsoft.com/downloads/
details.aspx?FamilyId=C3C26254-8CE3-46E2-B1B6-3659B92B2CDE&displaylang=en). Note that this 
URL may change in the future. If it does, search the Microsoft Web site for all SP1 related documents.

http://www.microsoft.com/downloads/details.aspx?FamilyId=C3C26254-8CE3-46E2-B1B6-3659B92B2CDE&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=C3C26254-8CE3-46E2-B1B6-3659B92B2CDE&displaylang=en
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For general information on Windows Server 2003 R2, go to the associated Microsoft download site and 
locate the link for What's New in Windows Server 2003 R2 (URL: http://www.microsoft.com/
windowsserver2003/default.mspx). Note that this URL may change in the future. If it does, search the 
Microsoft Web site for all R2 related documents.

To understand how Windows Server 2003 SP1 or R2 affects IBM FileNet P8, it is important to understand 
how IBM FileNet P8 components communicate using MSDTC and COM. Then, in order for Content Engine 
to function appropriately, you must evaluate any Windows 2003 Server SP1 or R2 servers in your IBM 
FileNet P8 environment that are running any of the following:

• Content Engine Object Store Service

• Content Engine File Store Service

• Content Engine Content Cache Service

• Microsoft SQL Server

Note that changes are not needed on Windows Server 2003 SP1 or R2 servers running any of the 
following:

• Windows Active Directory server

• Sun One or eDirectory LDAP server

• Oracle 9i database servers

• IBM FileNet P8 Enterprise Manager

• Workplace clients

• IBM FileNet P8 Java API clients

• Content Engine Web Services (CEWS) clients

• Process Engine Web Services (PEWS) clients

• Custom Content Engine COM API clients

• Application Engine

• Rendition Engine

To properly configure MSDTC and COM+ components, you must use the Component Services MMC 
snap-in.

To start the Component Services MMC snap-in

1. Click Start > Settings > Control Panel > Administrative Tools > Component Services.

2. Expand the Component Services and Computers containers.

3. Right-click the My Computer container and select Properties.

You should then see the My Computer Properties dialog. This dialog contains the MSDTC and COM 
Security tabs. You will use the properties in these tabs to configure the MSDTC and COM Security 
components.

Microsoft Distributed Transaction Coordinator (MSDTC)

This topic shows you where to modify MSDTC settings, defines those settings, and identifies the values 
required for your IBM FileNet P8 environment.

http://www.microsoft.com/windowsserver2003/default.mspx
http://www.microsoft.com/windowsserver2003/default.mspx
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WARNING  If Content Engine is already installed, you must first shut down the Content Engine services 
before making these changes (i.e., Content Engine Content Cache Service, Content Engine File Store 
Service, and Content Engine Object Store Service). You can do this via the Windows Services MMC snap-
in.

In order to modify the MSDTC Network Security settings, certain fields on the MSDTC Security settings 
properties page have to be changed. To see this page, use the following procedure.

NOTE IBM recommends restarting the server after the MSDTC changes have been made.

To set the MSDTC Security Configuration settings

1. Start the Component Services MMC snap-in if it is not already running.

2. Expand the Component Services and Computers containers.

3. Right-click the My Computer container and select Properties.

4. Select the MSDTC tab.

5. Click the Security Configuration button.

6. Apply the appropiate settings for your server, based on your IBM FileNet P8 server configuration. For 
configuration instructions, see “MSDTC Network Security settings for IBM FileNet P8” on page 378.

NOTE The following components are not relevant to IBM FileNet P8, and therefore, do not require changes 
to be made to the MSDTC configuration settings: Client and Administration (Allow Remote Clients & Allow 
Remote Administration), Enable Transaction Internet Protocol (TIP) Transactions and MSDTC Logon 
Account.

The MSDTC Security settings properties page features the following fields:

Network MSDTC Access

Determines whether MSDTC on the local computer is allowed to access the network.

Allow inbound

Allows a distributed transaction that originates from a remote computer to run on this computer.

Allow Outbound

Allows the local computer to initiate a transaction and run it on a remote computer.

Mutual Authentication Required

Adds support for mutual authentication in future versions and is the highest secured communication 
mode. In the current version, it is functionally equivalent to the Incoming Caller Authentication 
Required setting. This is the recommended transaction mode for servers running Windows Server 
2003 SP1 or R2.

NOTE Only Windows Server 2003 SP1 or R2 and Windows XP SP2 support this feature, so you 
should use this only if you know that the MSDTC on the remote computer runs either Windows Server 
2003 SP1 or R2, or Windows XP SP2.

Incoming Caller Authentication Required

Requires the local MSDTC to communicate with a remote MSDTC using only encrypted messages 
and mutual authentication. This setting is recommended for servers running Windows Server 2003 
SP1 or R2 that are operating in a cluster.
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NOTE Only Windows Server 2003 SP1 or R2 and Windows XP SP2 support this feature, so you 
should use this only if you know that the MSDTC on the remote computer runs either Windows Server 
2003 SP1 or R2, or Windows XP SP2.

No Authentication Required

Provides system compatibility between previous versions of the Windows operating system. This 
setting should be used if the MSDTC on the remote computer runs Windows 2000 or Windows Server 
2003 without SP1 or R2.

Enable XA Transactions

Enables distributed transactions with XA features. This setting must be used if you are using DB2 as 
your DBMS, and CE is running on Windows Server 2003 SP1 or R2.

How IBM FileNet P8 is affected

The following components are involved in distributed transactions and use the MSDTC:

• Content Engine Object Store Service 

• File Store Service

• Microsoft SQL Server

The Windows Server 2003 SP1 or R2 changes affect IBM FileNet P8 only if distributed transactions use 
the network. The Content Engine Object Store Service is the only IBM FileNet P8 component that initiates 
distributed transactions using the MSDTC, where it initiates outbound transactions. In addition, this service 
can enlist the File Store Service and Microsoft SQL Server in a distributed transaction, where these 
components accept inbound transactions.

The Authentication Required settings apply when processes on two or more servers are involved in a 
distributed transaction, coordinated by MSDTC. To be able to use a setting other than No Authentication 
Required, the servers participating in a distributed transaction must be running Windows Server 2003 SP1 
or R2 in the same domain or in separate domains with trust relationships. Windows Server 2003 SP1 or R2 
servers do not need to have the same Authentication Required settings.

If all of the components involved in a distributed transaction are to run on the same server, then IBM 
FileNet P8 will not use Network MSDTC Transactions and the MSDTC Network Security Settings will have 
no effect.

If any of the components involved in a distributed transaction are to run on a separate server, then IBM 
FileNet P8 will use Network MSDTC Transactions and changes must be made to the servers running 
Windows Server 2003 Server SP1 or R2.

MSDTC Network Security settings for IBM FileNet P8

If your IBM FileNet P8 environment will use Network MSDTC Transactions, the following changes must be 
made to the MSDTC configuration settings for identified components in your environment:

NOTE If you are using Windows Firewall to protect the computers in your organization, you must add 
MSDTC into the exception list in the Windows Firewall settings.
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MSDTC Network Security Settings

According to the configuration of your IBM FileNet P8 environment, use the conditions specified in the 
following table to make the indicated MSDTC changes on the identified servers.

NOTES 

• Specification of the Allow Inbound and Allow Outbound options represent the minimum required 
settings.

• The maximum permissible setting is achieved by setting the Authentication Required option to 
Mutual. However, note that IBM FileNet P8 will work with servers which have the Authentication 
Required option set to No.

COM Security

This topic shows where to modify COM security settings, defines those settings, and identifies the values 
required for your FileNet P8 environment.

In order to modify the COM Network Security settings, certain fields on the COM Security settings 
properties page have to be changed. To see this page, use the following procedure.

To set the COM Security settings

1. Start the Component Services snap-in if it is not already running.

Server

All other 
FileNet P8/
SQL services 
are located on 
the same 
physical 
machine

All other 
FileNet P8/
SQL servers 
are running 
Windows 
Server 2003 
SP1 or R2

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2003

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2000

Object Store Server running
Windows Server 2003 SP1 or R2

n/a Allow Outbound 
and Mutual 
Authentication 
Required

Allow Outbound 
and No 
Authentication 
Required

Allow Outbound 
and No 
Authentication 
Required

Object Store Server running
Windows Server 2000 or 2003

n/a n/a n/a n/a

File Store Server running
Windows Server 2003 SP1 or R2

n/a Allow Inbound 
and Mutual 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

File Store Server running
Windows Server 2000 or 2003

n/a n/a n/a n/a

SQL Server running
Windows Server 2003 SP1 or R2

n/a Allow Inbound 
and Mutual 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

SQL Server running
Windows Server 2000 or 2003

n/a n/a n/a n/a
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2. Expand the Component Services and Computers containers.

3. Right-click the My Computer container and select Properties.

4. Select the COM Security tab.

5. Depending on the FileNet P8 server configuration, make the appropriate settings for your server. For 
more information, see the recommendations identified in “COM Security permissions for IBM FileNet 
P8” on page 384.

The COM Security settings properties page features the following fields:

COM Security Limits

The COM security limits control access to all call, activation, or launch requests on the computer. Every 
call, activation, or launch of any COM application on the computer is checked against these access limits. 
If the access check fails, the call, activation, or launch request will be denied.

The COM security limits provide a minimum security standard that must be passed, regardless of the 
settings of the specific COM application.

Local and Remote permissions

Local and Remote permissions distinguish the COM access rights based on distance:

• Local permissions allow or deny the ability of users on the local machine to call, activate, or launch 
COM applications.

• Remote permissions allow or deny the ability of users on remote machines to call, activate, or 
launch COM applications.

COM Launch permissions

Launch permissions control authorization to start a COM application during COM activation if the 
application is not already running.

COM Activation permissions

Activation permissions control authorization to create a COM object from a COM application. Unless it 
is already running, the COM application will be started if the user making the COM activation call has 
activation and launch permissions.

COM Access permissions

Access permissions control authorization to make calls to COM objects in a running COM application.

In releases prior to Windows Server 2003 SP1, the access permissions included activation permissions. 
With the release of SP1, COM activation permissions are now offered as a separate set of permissions.

How IBM FileNet P8 is affected

The COM security settings described in this section intentionally duplicate some existing permission 
settings. With these settings, Content Engine should continue to function as expected, even if Microsoft 
should reduce the set of default COM security settings at some point in the future.

COM client applications

IBM FileNet P8 applications which are Content Engine COM API client applications make COM calls to the 
Content Engine Object Store Service only. Users running these COM API client applications need COM 
permissions in order to call or activate the service. The COM security settings for these users are made on 
Windows Server 2003 SP1 or R2 servers running the service.
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The Content Engine COM API client applications include:

• IBM FileNet P8 Enterprise Manager

• Custom Content Engine COM API clients

• Apache web server

Note that permissions are not granted to a user who logs in to IBM FileNet P8. Rather, permissions are 
granted or denied to the users running the FileNet P8 COM clients (or to the groups to which they belong). 
The following examples are provided to clarify this distinction.

Example 1: IBM FileNet P8 Workplace

Bob logs on to his Windows workstation and accesses the FileNet P8 Workplace sign-in page. Bob is a 
FileNet P8 Records Manager administrator and signs in to Workplace with the user name RMAdmin.

All the calls from Workplace go through the Apache web server. Apache makes COM calls to the Content 
Engine Object Store Service. Apache is set to run as the FileNet P8 Apache user, so the FileNet P8 
Apache user must have COM permissions on the server running the Content Engine Object Store Service. 
Neither Bob nor the RMAdmin user needs any COM permissions.

Example 2: IBM FileNet P8 Enterprise Manager

Jane logs on to her Windows workstation and starts the IBM FileNet P8 Enterprise Manager. She logs in to 
the IBM FileNet P8 Enterprise Manager with the user name CEAdmin. CEAdmin is both a GCD 
administrator and an Object Store administrator.

The IBM FileNet P8 Enterprise Manager makes COM calls to the Content Engine Object Store Service. 
The IBM FileNet P8 Enterprise Manager is running as the user Jane. All calls to the Content Engine Object 
Store Service use Jane's credentials, so Jane must have COM permissions on the server running the 
Service. The CEAdmin user does not need any COM permissions.

As you can see, it does not matter which user name is used to access IBM FileNet P8. Rather, COM 
permissions are needed by the Windows user who is running the Content Engine COM API client 
application.

COM server applications

COM security settings are made on Windows Server 2003 SP1 servers running FileNet P8 services.

The COM server applications include:

• Content Engine Object Store Service

• Content Engine File Store Service

• Content Engine Content Cache Service

Acting as both COM servers and COM clients, the Content Engine services make COM calls to each other. 
Therefore, the Content Engine services need COM permissions to call or activate each other. Permissions 
are granted to the users which these services run as (usually the Content Engine Servers group). The 
COM security settings for these users are made on all Windows Server 2003 SP1 or R2 servers running 
any of the Content Engine services.

COM Permissions

This section defines the users or groups for each FileNet P8 COM client application:

• Content Engine Servers group - This group is made up of the FNCE_<machine_name> accounts which 
are created during installation.
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• <Local Users> and <Remote Users> - Windows user/group accounts that access the Content Engine 
Object Store Service using the Content Engine COM API.

• FileNet P8 Apache user - Service user for the Apache2 service.

• <Local Administrators> and <Remote Administrators> - Windows user/group accounts which 
access the Content Engine Object Store Service using the Content Engine COM API, and which were 
defined as GCD administrative accounts during Content Engine installation.
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The following diagram identifies the COM calls and activations made by each component and the users 
making the COM calls. The users are shown on the Windows Server 2003 SP1 or R2 server where they 
are to be granted COM permissions.

Figure 1: COM Calls
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COM Security permissions for IBM FileNet P8

This section identifies the recommended COM Security settings that should be made for each FileNet P8 
server in your environment.
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COM Security Settings 

NOTE There are no required COM Security permission settings for Microsoft Windows Server 2003 SP1 or 

Access
Permission

Launch and Activation 
Permission

Limit Default Limit Default

Content Engine Object Store Server and
Content Engine Content Cache Service

Content Engine Servers group

A group that includes users 
like <FNCE_machinename>

Allow
Local / Remote
Access

n/a Allow
Local / Remote
Activation

Allow
Local / Remote
Activation

<Local Users>

Windows user/group 
accounts that used on the 
local machine. For example, 
administrator (local machine)

Allow
Local
Access

n/a Allow
Local
Activation

Allow
Local
Activation

<Remote Users>

Windows user/group 
accounts used on the remote 
machine. For example, 
administrator (remote 
machine)

Allow
Remote
Access

n/a Allow
Remote
Activation

Allow
Remote
Activation

<Local Administrators>

GCD administrative account 
(also a Windows user) used 
on the local machine, such as 
CEAdmin.

Allow
Local
Access

n/a Allow
Local
Activation

Allow
Local
Activation

<Remote Administrators>

GCD administrative accounts 
(also a Windows user) used 
on the remote machine, such 
as CEAdmin.

Allow 
Remote
Access

n/a Allow
Remote
Activation

Allow
Remote
Activation

FileNet P8 Apache user 

The Windows account that 
logs on and runs the Apache2 
service, for example, 
P8Apache.

Allow
Local
Access

n/a Allow
Local
Activation

Allow
Local
Activation

Content Engine File Store Server

Content Engine Servers group Allow
Local / Remote
Access

n/a Allow
Local / Remote
Activation

Allow
Local / Remote
Activation
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R2 servers running IBM FileNet P8 Remote Enterprise Manager, Microsoft SQL Server 2000 Database 
Server, Domain Controller with Active Directory, LDAP Server (Sun One or eDirectory), or other database 
servers.

COM Launch permissions

FileNet P8 component services should be directly stopped and started by administrators only and should 
not be started by a COM call from any user. The IBM FileNet P8 components were written to prevent 
themselves from being started by a COM call.

For added security, IBM recommends that all the users and groups defined above should be denied local 
and remote launch permissions. It is sufficient to apply these permissions to the Launch Permissions limits.

These permissions do not affect the use of IBM FileNet P8 Enterprise Manager or the Services tool to start 
COM servers or COM+ applications. Neither do they affect the auto-restart of the Content Engine services.

COM Activation permissions

All users of applications making COM activation calls need activation permissions on the COM server 
being activated (see the recommendations identified in “COM Security permissions for IBM FileNet P8” on 
page 384). The same permissions should be applied to the default activation permissions, as well as the 
activation permissions limits.

COM Access permissions

All users of applications making COM calls need access permissions on the COM server being called (see 
the recommendations identified in “COM Security permissions for IBM FileNet P8” on page 384). The IBM 
FileNet P8 components have security built into all of their COM interfaces which overrides any settings in 
the default access permissions. Permissions to make COM calls to IBM FileNet P8 components need only 
be applied to the access permissions limits.

Local and Remote COM permissions

Local and remote COM permissions should be granted as follows:

• If the Content Engine Services are running on more than one server, the Content Engine Servers 
group will require remote permissions on each Windows Server 2003 SP1 or R2 running a Content 
Engine service.

• If more than one Content Engine Service is running on one Windows Server 2003 SP1 or R2, the 
Content Engine Servers group will require local permissions on that server.

• If the IBM FileNet P8 Enterprise Manager or other Content Engine COM API admin tool is being 
used on a machine remote from the Content Engine Object Store Service, then the <P8 Adminis-
trators> will require remote permissions on the Content Engine Object Store Service server.

• If the IBM FileNet P8 Enterprise Manager or other Content Engine COM API admin tool is being 
used on the same machine as the Content Engine Object Store Service, then the <P8 Adminis-
trators> will require local permissions on the Content Engine Object Store Service server.

The Apache2 service makes COM calls to the Content Engine Object Store Service only. Because these 
two services must run on the same server, the FileNet P8 Apache user will require local permissions only.

Examples of IBM FileNet P8 systems on Windows Server 2003 SP1

In the following examples, the IBM FileNet P8 systems have Content Engine and associated components 
running on servers that have been upgraded to Windows Server 2003 SP1 or R2. The upgraded servers 
include the Domain Controller, LDAP server, the database management server, any COM API-based 
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application servers (including a remote IBM FileNet Enterprise Manager), and the Content Engine servers 
which include the Object Store Service, File Store service, and the Content Cache Service.

In this example environment, you would need to make the changes identified in this section on each of 
these servers in order for Content Engine to function properly.

NOTE For other environments, refer to the recommended settings identified in “MSDTC Network Security 
settings for IBM FileNet P8” on page 378 and “COM Security permissions for IBM FileNet P8” on page 384 
for additional configuration guidelines and server-specific information.

To configure the Content Engine Object Store and Content Cache Service Server

Configure the MSDTC Network and COM Security settings for the Content Engine Object Store and 
Content Cache Service Server as follows:

MSDTC Network Security settings

According to your configuration, use the conditions specified in the following table to make the 
indicated MSDTC changes.

All other 
FileNet P8/
SQL services 
are located on 
the same 
physical 
machine

All other 
FileNet P8/
SQL servers 
are running 
Windows 
Server 2003 
SP1 or R2

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2003

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2000

Windows Server
2003 SP1 or R2

n/a Allow Outbound 
and Mutual 
Authentication 
Required

Allow Outbound 
and No 
Authentication 
Required

Allow Outbound 
and No 
Authentication 
Required

Windows Server
2000 or 2003

n/a n/a n/a n/a
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COM Security Settings

To configure the Content Engine File Store Server

Configure the MSDTC Network and COM Security settings for the Content Engine File Store Server as 
follows:

MSDTC Network Security settings

According to the configuration of your FileNet P8 environment, use the conditions specified in the 
following table to make the indicated MSDTC changes on the identified servers.

Access
Permission

Launch and Activation 
Permission

Limit Default Limit Default

Content Engine Servers group Allow
Local / Remote
Access

n/a Allow
Local / Remote
Activation

Allow
Local / Remote
Activation

<Local Users> Allow
Local
Access

n/a Allow
Local
Activation

Allow
Local
Activation

<Remote Users> Allow
Remote
Access

n/a Allow
Remote
Activation

Allow
Remote
Activation

<Local Administrators> Allow
Local
Access

n/a Allow
Local
Activation

Allow
Local
Activation

<Remote Administrators> Allow 
Remote
Access

n/a Allow
Remote
Activation

Allow
Remote
Activation

FileNet P8 Apache user Allow
Local
Access

n/a Allow
Local
Activation

Allow
Local
Activation

All other 
FileNet P8/
SQL services 
are located on 
the same 
physical 
machine

All other 
FileNet P8/
SQL servers 
are running 
Windows 
Server 2003 
SP1 or R2

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2003

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2000

Windows Server
2003 SP1 or R2

n/a Allow Inbound 
and Mutual 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

Windows Server
2000 or 2003

n/a n/a n/a n/a
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COM Security Settings 

NOTE You must give full permissions to the file store shared folder(s) for the Content Engine 
Servers, FNCE_<CE_Machine_name>, as well as to any GCD administrative accounts that will be 
used to create the remote file store(s).

To configure the Microsoft SQL Server 2000 Database Server

Configure the MSDTC Network Security settings for the Microsoft SQL Server 2000 Database Server as 
follows:

MSDTC Network Security settings

According to your configuration, use the conditions specified in the following table to make the 
indicated MSDTC changes.

To configure the Process Engine server

No modifications are required for the Process Engine server in order for the software to function correctly 
when Windows Server 2003 SP1 or R2 is installed. However, to install Process Engine onto a Windows 
Server 2003 machine where SP1 or R2 is already installed, you must use the Process Engine 3.5.0a 
update CD. Follow the general procedures described in earlier installation or upgrade topics for Process 
Engine. Contact your IBM representative if you need a copy of the 3.5.0a Process Engine update.

NOTE  If you use the earlier 3.5.0 Process Engine CD, you must first install the Process Engine onto a 
base Windows Server 2003 machine, and then apply Service Pack 1 or Release 2. If the Windows Service 
Pack or Release is already installed, remove it using Control Panel > Add/Remove Programs before you 
install Process Engine 3.5.0, and then reapply the Windows Service Pack or Release. You will have to do 
this even if your site is already running Process Engine 3.0.0 on Windows Server 2003 SP1 or R2. 

Access
Permission

Launch and Activation 
Permission

Limit Default Limit Default

Content Engine Servers group Allow
Local / Remote
Access

n/a Allow
Local / Remote
Activation

Allow
Local / Remote
Activation

All other 
FileNet P8/
SQL services 
are located on 
the same 
physical 
machine

All other 
FileNet P8/
SQL servers 
are running 
Windows 
Server 2003 
SP1 or R2

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2003

At least one 
other FileNet 
P8/SQL 
server is 
running 
Windows 
Server 2000

Windows Server
2003 SP1 or R2

n/a Allow Inbound 
and Mutual 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

Allow Inbound 
and No 
Authentication 
Required

Windows Server
2000 or 2003

n/a n/a n/a n/a
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Troubleshooting

See the IBM FileNet P8 Platform Troubleshooting Guide if you should have any problems. This document 
provides troubleshooting information on all aspects of the product.
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Notices
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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ny performance data contained herein was determined in a controlled environment. Therefore, the
esults obtained in other operating environments may vary significantly. Some measurements may have
een made on development-level systems and there is no guarantee that these measurements will be the
ame on generally available systems. Furthermore, some measurements may have been estimated through
xtrapolation. Actual results may vary. Users of this document should verify the applicable data for their
pecific environment.

nformation concerning non-IBM products was obtained from the suppliers of those products, their
ublished announcements or other publicly available sources. IBM has not tested those products and
annot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
roducts. Questions on the capabilities of non-IBM products should be addressed to the suppliers of

hose products.

ll statements regarding IBM’s future direction or intent are subject to change or withdrawal without
otice, and represent goals and objectives only.

his information contains examples of data and reports used in daily business operations. To illustrate
hem as completely as possible, the examples include the names of individuals, companies, brands, and
roducts. All of these names are fictitious and any similarity to the names and addresses used by an
ctual business enterprise is entirely coincidental.

OPYRIGHT LICENSE:

his information contains sample application programs in source language, which illustrate programming
echniques on various operating platforms. You may copy, modify, and distribute these sample programs

any form without payment to IBM, for the purposes of developing, using, marketing or distributing
pplication programs conforming to the application programming interface for the operating platform for
hich the sample programs are written. These examples have not been thoroughly tested under all

onditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
rograms.
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IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at ″Copyright and trademark information″ at
www.ibm.com/legal/copytrade.shtml.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States,
other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.
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